Legal Information

The Schneider Electric brand and any trademarks of Schneider Electric SE and its subsidiaries referred to in this guide are the property of Schneider Electric SE or its subsidiaries. All other brands may be trademarks of their respective owners.

This guide and its content are protected under applicable copyright laws and furnished for informational use only. No part of this guide may be reproduced or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), for any purpose, without the prior written permission of Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the guide or its content, except for a non-exclusive and personal license to consult it on an "as is" basis. Schneider Electric products and equipment should be installed, operated, serviced, and maintained only by qualified personnel.

As standards, specifications, and designs change from time to time, information contained in this guide may be subject to change without notice.

To the extent permitted by applicable law, no responsibility or liability is assumed by Schneider Electric and its subsidiaries for any errors or omissions in the informational content of this material or consequences arising out of or resulting from the use of the information contained herein.
Safety information

Important information

Read these instructions carefully and look at the equipment to become familiar with the device before trying to install, operate, service or maintain it. The following special messages may appear throughout this bulletin or on the equipment to warn of potential hazards or to call attention to information that clarifies or simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning” safety label indicates that an electrical hazard exists which will result in personal injury if the instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal injury hazards. Obey all safety messages that follow this symbol to avoid possible injury or death.

<table>
<thead>
<tr>
<th><strong>DANGER</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER indicates a hazardous situation which, if not avoided, will result in death or serious injury.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>WARNING</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>WARNING indicates a hazardous situation which, if not avoided, could result in death or serious injury.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>CAUTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>CAUTION indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>NOTICE</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTICE is used to address practices not related to physical injury.</td>
</tr>
</tbody>
</table>

Please note

Electrical equipment should be installed, operated, serviced and maintained only by qualified personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of the use of this material. A qualified person is one who has skills and knowledge related to the construction, installation, and operation of electrical equipment and has received safety training to recognize and avoid the hazards involved.

Notices

FCC

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that the interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that any changes or modifications not expressly approved by Schneider Electric could void the user’s authority to operate the equipment.

This digital apparatus complies with CAN ICES-3 (B)/NMB-3(B).

Open source software components

This Schneider Electric product is provided with certain open source software components (collectively, “OSS”) developed by third parties. Refer to the “Open source software components” section in this document for details.

About this manual

This manual discusses features of the PowerLogic™ ION9000 series power meter and provides configuration instructions.

Throughout the manual, the term “meter” refers to all models of the ION9000 series meter. All differences between the models, such as a feature specific to one model, are indicated with the appropriate model number or description.

This manual assumes you have an understanding of power metering and are familiar with the equipment and power system in which your meter is installed.

This manual does not provide configuration information for advanced features where an expert user would perform advanced configuration. It also does not include instructions on how to incorporate meter data or perform meter configuration using energy management systems or software, other than ION Setup. ION Setup is a free configuration tool available for download from www.schneider-electric.com.

Please contact your local Schneider Electric representative to learn what additional training opportunities are available regarding the ION9000 series meter.

Make sure you are using the most up-to-date version of your meter’s firmware in order to access the latest features.

The most up-to-date documentation about your meter is available for download from www.schneider-electric.com.
## Related documents

<table>
<thead>
<tr>
<th>Document</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>ION9000 online document portal</td>
<td><a href="https://www.productinfo.schneider-electric.com/portals/ui/ion9000/">https://www.productinfo.schneider-electric.com/portals/ui/ion9000/</a></td>
</tr>
<tr>
<td>PowerLogic™ ION9000 series installation sheet</td>
<td>NVE78642</td>
</tr>
<tr>
<td>ION Reference</td>
<td>7EN02-0290</td>
</tr>
<tr>
<td>ION device template reference</td>
<td>—</td>
</tr>
<tr>
<td>PowerLogic™ ION9000 technical datasheet</td>
<td>PLSED310106EN</td>
</tr>
</tbody>
</table>
## Table of Contents

Safety precautions ...............................................................15

**Meter overview** ............................................................16

ION9000 series .................................................................16

Your meter in an energy management system ....................................17

Communications ....................................................................18

Supported protocols ................................................................18

Meter configuration ................................................................19

ION Setup device configuration tool ............................................19

Data display ...........................................................................19

Built-in webpages and web server feature ....................................19

Localization ...........................................................................19

Display ..................................................................................19

Notification ...........................................................................19

Active and historical alarms .....................................................19

Email messaging feature ..........................................................20

Meter models and accessories ..................................................20

Terminal covers .....................................................................20

Installation and commissioning ..................................................21

Installation ............................................................................21

Power system wiring ..............................................................21

Residual current measurement ..................................................22

Functional ground ..................................................................22

Removing the display from back-to-back mounting adapter .............23

Removing the meter from back-to-back mounting adapter ..............25

Option modules .....................................................................26

Maximum number of option modules ........................................27

Commissioning ......................................................................27

Factory default settings ..........................................................27

Commissioning using ION Setup ..............................................27

Configure basic metering parameters .........................................28

Using the phasor viewer ..........................................................29

Basic setup using the webpages or display ..................................29

Communications ....................................................................30

Communications overview .......................................................30

Ethernet communications ........................................................30

Ethernet communications connections .......................................30

Protocols, ports and connections ...............................................31

Self-discovery over Ethernet ....................................................32

Ethernet configuration .............................................................33

DHCP ..................................................................................40

Meter domain name ...............................................................41

Network protocol control .........................................................41

Serial communications ............................................................43

RS-485 wiring ........................................................................43

RS-485 configuration .............................................................44

Disabling serial communications ports .....................................47

ION ....................................................................................48

Modbus ...............................................................................48
PowerLogic™ ION9000 series

Inputs / outputs

Ethernet gateway ....................................................................................... .57
EtherGate ........................................................................................................... .58
Modbus Ethernet gateway ................................................................................ .59
Creating an Ethernet gateway site using ION Setup ........................................ .61

HTTP .................................................................................................................... .61
Changing HTTP protocol using ION Setup ...................................................... .61
Secure website indicator .................................................................................... .62
Default SSL certificate and webpages security ................................................ .62
Uploading a custom SSL certificate ................................................................... .63
Generating a new self-signed SSL certificate .................................................... .63
Deleting a custom SSL certificate ...................................................................... .63

SFTP ...................................................................................................................... .63
Transferring files using SFTP ............................................................................... .63
Freeing up flash memory .................................................................................... .64
SFTP folders and file permissions ...................................................................... .64
SFTP filename requirements ............................................................................... .64

Simple Network Management Protocol (SNMP) ................................................ .64
The meter in an SNMP system .......................................................................... .65
SNMP trapping .................................................................................................... .65
SNMP implementation ......................................................................................... .67
Default SNMP mapping ..................................................................................... .68

IEC 61850 ............................................................................................................ .70
Mapping additional data to IEC 61850 ............................................................... .70
Enabling IEC 61850 functionality ....................................................................... .70
Configuring digital outputs for IEC 61850 control ............................................ .71
Deleting an IEC 61850 configuration file ............................................................ .72

DNP ....................................................................................................................... .72
DNP supported features and default implementation ......................................... .72

DLMS/COSEM .................................................................................................... .73

Inputs / outputs .................................................................................................. .74
I/O overview ........................................................................................................ .74
Input/output ION modules .................................................................................. .74
Input/output ION modules, ports and labels ...................................................... .75
I/O option modules .............................................................................................. .76
  I/O option module data viewing ....................................................................... .76
  Option I/O modules configuration ................................................................... .76

Analog inputs ....................................................................................................... .77
  Analog input applications .................................................................................. .77
  Analog input voltage and current mode ............................................................ .77
  Analog input behavior ....................................................................................... .77
  Analog input zero scale and full scale values ................................................... .77

Analog outputs .................................................................................................... .78
  Analog output applications ............................................................................... .78
  Analog output behavior .................................................................................... .79
Managing user account lockouts and timeouts ........................................... 125
Passwords ................................................................................................. 126
  Default passwords and usernames .......................................................... 126
  Changing a password ............................................................................. 127
  Updating passwords on multiple meters .................................................. 127
Harden the device ...................................................................................... 128
  Disabling and enabling protocols and changing port numbers ................. 128
  Disabling and enabling meter configuration methods ................................ 129
  Disabling and enabling webpages and time sync sources ......................... 130
Fearless ...................................................................................................... 130
  Setting up cybersecurity event logs and alarms ....................................... 131
  Viewing and downloading event logs ....................................................... 132
Upgrades and patch management .............................................................. 133
Secure disposal guidelines ........................................................................ 133
  Secure disposal checklist ........................................................................ 133
  Wiping the device ................................................................................. 133
  Overwriting the meter template file ......................................................... 135
  Overwriting factory module registers ..................................................... 135
  Overwriting communication module registers ...................................... 135
  Disposal, reuse, recycling ...................................................................... 136
Alarms and alerts ........................................................................................ 138
  Alarms overview .................................................................................. 138
  Alarm types .......................................................................................... 138
  Relative setpoint .................................................................................. 140
  Transient alarms .................................................................................. 141
  Alarm event priorities ........................................................................... 141
  Alarm indicators ................................................................................... 141
  Default alarms ..................................................................................... 142
  Alarm information ................................................................................ 143
  Viewing and acknowledging alarms using the display .............................. 143
  Alarm configuration .............................................................................. 143
    Sag/swell overview ............................................................................ 146
    Configuring transient alarms using ION Setup ..................................... 147
  Alerting ................................................................................................ 148
  Setpoint learning overview .................................................................. 148
  Learning installation mode and learning duration .................................... 149
  Implementing standard alarm setpoint learning using ION Setup .............. 150
  Implementing transient learning using ION Setup .................................. 151
Power quality ............................................................................................ 153
  Power quality overview ....................................................................... 153
  Considerations for power quality configuration using ION Setup .......... 153
  Power quality logging .......................................................................... 153
    Sag/swell overview ............................................................................ 153
    Transient overview .......................................................................... 155
  Configuring Advanced PQ using ION Setup ......................................... 156
  Rapid Voltage Change overview ........................................................... 159
  Harmonics overview ............................................................................ 159
  Viewing harmonics information using the display ................................... 159
  Voltage crest factor ............................................................................. 159
  Current crest factor ............................................................................ 160
  K-factor ............................................................................................... 160
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time and timekeeping</td>
<td>200</td>
</tr>
<tr>
<td>Time overview</td>
<td>200</td>
</tr>
<tr>
<td>Internal clock temperature compensation</td>
<td>200</td>
</tr>
<tr>
<td>Time synchronization</td>
<td>200</td>
</tr>
<tr>
<td>Supported time synchronization sources</td>
<td>200</td>
</tr>
<tr>
<td>Clock source</td>
<td>201</td>
</tr>
<tr>
<td>Clock source time quality flag</td>
<td>202</td>
</tr>
<tr>
<td>PTP system setting recommendations</td>
<td>202</td>
</tr>
<tr>
<td>Configuring time information using ION Setup</td>
<td>203</td>
</tr>
<tr>
<td>Configuring time information using the display</td>
<td>205</td>
</tr>
<tr>
<td>Measurements</td>
<td>206</td>
</tr>
<tr>
<td>Energy</td>
<td>206</td>
</tr>
<tr>
<td>Demand</td>
<td>206</td>
</tr>
<tr>
<td>Instantaneous measurements</td>
<td>206</td>
</tr>
<tr>
<td>Harmonics</td>
<td>206</td>
</tr>
<tr>
<td>Min/max recording</td>
<td>207</td>
</tr>
<tr>
<td>Power quality</td>
<td>207</td>
</tr>
<tr>
<td>Power and power factor</td>
<td>207</td>
</tr>
<tr>
<td>Power demand</td>
<td>209</td>
</tr>
<tr>
<td>Incremental energy</td>
<td>210</td>
</tr>
<tr>
<td>Conditional energy</td>
<td>212</td>
</tr>
<tr>
<td>Trending and forecasting overview</td>
<td>212</td>
</tr>
<tr>
<td>Resets</td>
<td>214</td>
</tr>
<tr>
<td>Meter resets</td>
<td>214</td>
</tr>
<tr>
<td>Option modules reset</td>
<td>214</td>
</tr>
<tr>
<td>Available resets</td>
<td>214</td>
</tr>
<tr>
<td>Performing meter resets using ION Setup</td>
<td>215</td>
</tr>
<tr>
<td>Performing meter resets using the meter webpages</td>
<td>215</td>
</tr>
<tr>
<td>Performing meter resets using the display</td>
<td>216</td>
</tr>
<tr>
<td>Maintenance</td>
<td>218</td>
</tr>
<tr>
<td>Maintenance overview</td>
<td>218</td>
</tr>
<tr>
<td>Firmware and templates</td>
<td>218</td>
</tr>
<tr>
<td>Firmware and templates overview</td>
<td>218</td>
</tr>
<tr>
<td>Typical workflows</td>
<td>218</td>
</tr>
<tr>
<td>Laptop computer upgrade considerations</td>
<td>219</td>
</tr>
<tr>
<td>Firmware upgrade considerations</td>
<td>219</td>
</tr>
<tr>
<td>Editing accumulated energy values using ION Setup</td>
<td>220</td>
</tr>
<tr>
<td>Loading meter firmware using ION Setup</td>
<td>221</td>
</tr>
<tr>
<td>Loading webpages using ION Setup</td>
<td>222</td>
</tr>
<tr>
<td>Loading webpages using SFTP</td>
<td>222</td>
</tr>
<tr>
<td>Loading remote display firmware using ION Setup</td>
<td>223</td>
</tr>
<tr>
<td>Loading option module firmware using ION Setup</td>
<td>224</td>
</tr>
<tr>
<td>Loading option module firmware using SFTP</td>
<td>225</td>
</tr>
<tr>
<td>Test mode</td>
<td>225</td>
</tr>
<tr>
<td>Test mode default screens</td>
<td>226</td>
</tr>
</tbody>
</table>
Putting your meter in test mode using the display ........................................ 226
Device-specific information................................................................. 226
Troubleshooting ................................................................. 227
  Option module troubleshooting ...................................................... 227
  Technical assistance ............................................................. 227

Repayment .................................................................................... 228
  Revenue metering overview .......................................................... 228
  Revenue metering components ....................................................... 228
  Revenue firmware security features .................................................. 228
  Protected features and settings ......................................................... 228
  Revenue locking ........................................................................ 228
    Revenue-locking summary ............................................................. 229
    Revenue lock switch ................................................................. 229
    Revenue lock LED behavior ......................................................... 229
  Anti-tamper sealing .................................................................... 230
  PT/CT correction ....................................................................... 231
  Transformer loss compensation ....................................................... 231
  Time of use ............................................................................. 232
  Energy pulsing LED behavior ......................................................... 232

Verifying accuracy ........................................................................ 233
  Overview of meter accuracy .......................................................... 233
  Accuracy test requirements ............................................................. 233
  Energy pulsing ........................................................................ 234
  Verifying accuracy test meter settings ................................................ 234
  Verifying accuracy test ................................................................. 235
  Calculate the number of required pulses ........................................... 236
  Percentage error calculation for accuracy verification testing .......... 236
  Typical sources of test errors ......................................................... 237
  Accuracy verification test points ...................................................... 237

ION9000 Specifications ................................................................ 239
  Specifications overview ................................................................. 239
    Mechanical characteristics .......................................................... 239
    Electrical characteristics ............................................................. 239
    Environmental characteristics ....................................................... 241
    LEDs .................................................................................... 242
    EMC (electromagnetic compatibility) ............................................ 242
    Safety .................................................................................. 243
    Ethernet communications ........................................................... 243
    RS-485 communications ............................................................... 243
    Real-time clock .................................................................... 243
    Display ................................................................. 243
    Option modules ................................................................. 244
    Other ............................................................................. 245

Open source software components .................................................. 246
Safety precautions

Installation, wiring, testing and service must be performed in accordance with all local and national electrical codes.

⚠️ DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

- Apply appropriate personal protective equipment (PPE) and follow safe electrical work practices. See NFPA 70E in the USA, CSA Z462 or applicable local standards.
- Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
- Always use a properly rated voltage sensing device to confirm that all power is off.
- Follow guidelines in the Wiring section of the related Installation Sheet.
- Treat communications and I/O wiring connected to multiple devices as hazardous live until determined otherwise.
- Do not exceed the device’s ratings for maximum limits.
- Never short the secondary of a potential/voltage transformer (PT/VT).
- Never open circuit a current transformer (CT).
- Always use grounded external CTs for current inputs.
- Do not use the data from the meter to confirm power is off.
- Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

NOTE: See IEC 60950-1:2005, Annex W for more information on communications and I/O wiring connected to multiple devices.

⚠️ WARNING

UNINTENDED OPERATION

- Do not use this device for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.
- Do not use this device if a wrench icon appears on the top corner of the display screen or if the value under Meter Status is not “OK”.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

⚠️ WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND CONFIDENTIALITY

- Change default passwords to help prevent unauthorized access to device settings and information.
- Disable unused ports/services and default accounts, where possible, to minimize pathways for malicious attacks.
- Place networked devices behind multiple layers of cyber defenses (such as firewalls, network segmentation, and network intrusion detection and protection).
- Use cybersecurity best practices (for example: least privilege, separation of duties) to help prevent unauthorized exposure, loss, modification of data and logs, interruption of services, or unintended operation.

Failure to follow these instructions can result in death, serious injury, or equipment damage.
Meter overview

ION9000 series

The ION9000 series advanced energy and power quality meter helps meet the needs of your energy management, power management, and cost management applications within your EcoStruxure™ Power architecture.

ION9000 series revenue-accurate meters comply to international metering standards. The meters feature flexible ION programmability that enhances functionality through customization by loading specialized frameworks. You can add optional modules and incorporate mounting accessories into the physical installation to meet a variety of installation and application needs.

Measurement accuracy

Third-party international standards-certified
- Class 0.1S for energy
- Power Quality Instrument - Class A (PQI-A) for all normative IEC 61000-4-30 power quality metrics
- IEC 62053-22, -23, -24 and ANSI C12.20

Power quality

Third-party international standards-certified
- IEC 62586-1, IEC 62586-2, and IEC 61000-4-30
- EN 50160, including flicker monitoring
- IEEE 519

Root cause analysis and sequence-of-events support

- Disturbance Direction Detection
- High-speed RMS data capture with pre and post event records
- Extended waveform capture
- Time quality flag for GPS or PTP time sources
- Time synchronization to 1 ms accuracy
- High-speed voltage transient capture with 10 Mhz sampling rate (ION9000T only)

Cybersecurity

- Standard and advanced meter security with multiple users and access levels
- Total control for each communications port and protocol, including protocol lockout
- Secure webpages (HTTPS)
- Support for meter event logging to a remote server (syslog)

Account management

If your meter’s user access information is lost, you must return the meter to the factory, where your meter is reset to its factory defaults and all logged data is lost.
Your meter in an energy management system

As a key piece in your energy and power management system, the PowerLogic™ ION9000 series meter provides highly accurate measurements and calculations to enable a variety of energy and power management applications.

It performs analysis on collected data, alerts you of potential issues and integrates with a variety of edge control software such as EcoStruxure™ Power SCADA Operation and Power Monitoring Expert. For further analysis, you can also connect your meter with EcoStruxure™ Power Advisor to enhance the performance and maintenance of power networks.
Measure

- Simple configuration
- Highly accurate metering
- Alarming and alerting
- Data and event logging
- Trending and forecasting
- Power quality monitoring
- Easy access to information
- Configurable security
- Energy efficiency

Act

- Cost allocation/tenant billing
- Time of use
- Asset and network management
- Inputs/outputs

Understand

- Powerful customization
- Power quality monitoring
- Energy efficiency
- Asset and network management
- Configurable security

Communications

Supported protocols

Your meter’s fundamental protocol and architecture is ION.

You can integrate the meter into various industry-standard networks. Data that the meter measures can be made available to other devices using Modbus, DNP 3.0, DLMS and SNMP, as well as the MV-90 billing software. You can configure the meter to import data from other devices on these networks. Your meter supports the IEC 61850 protocol and COMTRADE waveform data format.

Your meter also supports IPv6, DPWS and RSTP Ethernet protocols.
Meter configuration

ION Setup device configuration tool

ION Setup is a free configuration tool for your meter that allows you to remotely configure your meter’s features over Ethernet or serial communications.

• Use the setup screens to guide you through the process of configuring your meter.
• Use the real-time data screens to verify your meter’s configuration.
• Use the data screens to view your meter’s recorded data.
• Use the charting function to view your meter’s recorded waveforms.

You can download ION Setup from www.schneider-electric.com.

See the online help in ION Setup for instructions on connecting to your meter.

Data display

Built-in webpages and web server feature

Your meter’s onboard internal web server and built-in web pages provide quick and easy access to real-time energy, basic power quality information and meter configuration without having to use specialized software.

Localization

The meter can be customized to use different regional settings.

Localization settings determine:

• The language used for the display and webpages
• Time, date and digit formats
• Displayed phase labels (123/ABC)
• IEEE (Institute of Electrical and Electronics Engineers) or IEC (International Electrotechnical Commission) conventions for power, power factor and energy

You can configure your meter’s localization settings through the display or using ION Setup.

Display

Use the meter’s display to view real-time and historical power quality data, access monitoring tools, receive and acknowledge alarms, and perform basic device configuration.

The touch-screen color display has multiple mounting options to suit your environment and an eight-language interface with external LED indicators for power, alarms, and energy pulsing applications.

Notification

Active and historical alarms

The meter’s display shows an alarm icon and the alarm LED flashes if your meter detects an active alarm condition.

Depending on the priority of the alarm, your meter’s display also flashes. You can view and acknowledge active alarms and historic alarms and events through the
display and software webpages. An active alarm becomes a historic alarm when the alarm condition no longer exists.

**Email messaging feature**

You can configure your meter to automatically email information such as notification of a high-priority event or a regularly scheduled send of logged data.

Specify the type of event that triggers an email alert, such as a power quality disturbance or interval for logged data. Email messages from your meter are received like any other email message.

**Meter models and accessories**

Commercial references for the ION9000 series meter and accessories.

<table>
<thead>
<tr>
<th>Commercial reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>METSEION92030</td>
<td>ION9000 series meter</td>
</tr>
<tr>
<td>METSEION92830</td>
<td>ION9000 series meter with RD192 remote display</td>
</tr>
<tr>
<td>METSEION92040</td>
<td>ION9000T series meter</td>
</tr>
<tr>
<td>METSEION92840</td>
<td>ION9000T series meter with RD192 remote display</td>
</tr>
<tr>
<td>METSEION95030</td>
<td>RD192 192 x 192 mm remote display with ION9000 series back-to-back adapter and 1/4 DIN (92 x 92 mm) panel cutout mounting adapter</td>
</tr>
<tr>
<td>METSEION95040</td>
<td>PM89RD96 92 x 92 mm remote display with 1/4 DIN (92 x 92 mm) panel cutout mounting adapter</td>
</tr>
<tr>
<td>METSEPM89M2600</td>
<td>Digital I/O option module (2 outputs, 6 inputs)</td>
</tr>
<tr>
<td>METSEPM89M0024</td>
<td>Analog I/O option module (2 outputs, 4 inputs)</td>
</tr>
<tr>
<td>METSE9B2BMA</td>
<td>ION9000 series back-to-back adapter</td>
</tr>
<tr>
<td>METSE9HWK</td>
<td>ION9000 series replacement hardware connectors and terminal covers</td>
</tr>
<tr>
<td>METSE9USBK</td>
<td>RD192 replacement USB cover</td>
</tr>
<tr>
<td>METSERD192HWK</td>
<td>RD192 replacement hardware kit</td>
</tr>
<tr>
<td>METSECAB10</td>
<td>Remote display cable, 10 m</td>
</tr>
</tbody>
</table>

Refer to your meter’s catalog pages, available from www.schneider-electric.com, for updated information on meter types and accessories.

**Terminal covers**

The voltage and current terminal covers help prevent tampering with the meter’s voltage and current measurement inputs.

The terminal covers enclose the terminals, the conductor fixing screws and a length of the external conductors and their insulation. The terminal covers are secured by tamper-resistant meter seals.

These covers are included for meter models where sealable voltage and current covers are required to comply with revenue or regulatory standards.

The meter terminal covers must be installed by a qualified installer.

Refer to your meter’s installation sheet or the instructions that came with your terminal covers for instructions on installing the terminal covers.
Installation and commissioning

This section supplements the meter installation sheets and provides guidance on commissioning your meter.

- See your device installation sheets for information related to installation.
- See your product catalog pages at Schneider Electric for information about your device, its options and accessories.

For the latest information about your product, or for assistance in advanced features and custom functionality, contact your local Schneider Electric representative.

Installation

Installation, wiring, testing and service must be performed in accordance with all local and national electrical codes.

⚠️ DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

- Apply appropriate personal protective equipment (PPE) and follow safe electrical work practices. See NFPA 70E in the USA, CSA Z462 or applicable local standards.
- Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
- Always use a properly rated voltage sensing device to confirm that all power is off.
- Treat communications and I/O wiring connected to multiple devices as hazardous live until determined otherwise.
- Do not exceed the device’s ratings for maximum limits.
- Never short the secondary of a potential/voltage transformer (PT/VT).
- Never open circuit a current transformer (CT).
- Always use grounded external CTs for current inputs.
- Do not use the data from the meter to confirm power is off.
- Replace all devices, doors and covers before turning on power to this equipment.

Failure to follow these instructions will result in death or serious injury.

Power system wiring

You can connect the meter’s voltage inputs directly to the phase voltage lines of the power system if the power system’s line-to-line or line-to-neutral voltages do not exceed the meter’s direct connect maximum voltage limits.

The maximum voltage allowed for direct connection may be lower than the manufacturer-specified limits, depending on the local electrical codes and regulations.

If your system voltage is greater than the specified direct connect maximum voltage, you must use voltage (potential) transformers (VTs/PTs) to step down the voltages. Use high-bandwidth voltage transformers in high-speed transient capture applications (ION9000T only).
Residual current measurement

The meter can calculate or measure the residual current, depending on how the inputs are wired.

3 CT wiring

For a 3-phase 3-wire system, the meter calculates residual current for Ground.

For a 3-phase 4-wire system, the meter measures residual current for Neutral.

4 CT wiring

For a 3-phase 4-wire system, the meter calculates residual current for Ground.

For a 3-phase 4-wire system, the meter measures residual current for Ground at I5.

Functional ground

The meter’s functional ground terminal must be wired for optimum performance.

Use the supplied ferrite when terminating the functional ground terminal to earth ground. Make sure the ground wire is looped through, around and back through the ferrite as shown.
Removing the display from back-to-back mounting adapter

Instructions on how to remove the display, for example, if you want to connect it to another meter.

**NOTE:** Refer to the display installation sheet QGH42230 for installation instructions.
1. Holding the display, turn the tightening wheel with a flat-head screwdriver until it disengages from the display.

2. Carefully pull the display away, just far enough to access the cable connector on the display.
3. Disconnect the display cable.

Removing the meter from back-to-back mounting adapter

You can uninstall the meter from the optional back-to-back mounting adapter.

**NOTE:** Refer to the meter installation sheet NVE78642 for installation instructions.

1. Use a flat-head screwdriver to unlock the meter retainer clips.
2. Holding the meter firmly, swing it outwards and pull slightly upwards to detach it from the top retaining hooks.

Option modules

Option modules are ordered separately from your meter, and can be connected to your meter without specialized equipment.

Option modules are identified based on how they physically connect to the meter’s external I/O bus.

The first connected module, attached directly to the meter, is Module A. The second module, attached to Module A, is Module B. The meter supports up to 4 external modules:
The option modules are monitored and controlled by the meter’s ION modules. External I/O modules are mapped to the corresponding ION modules:

<table>
<thead>
<tr>
<th>Option module physical position</th>
<th>ION module mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module A to Module D</td>
<td>Port A to Port D</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option module terminal connector label</th>
<th>ION module mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog inputs A1 to A(n)</td>
<td>Analog Input module A1 to A(n)</td>
</tr>
<tr>
<td>Analog outputs Q1 to Q(n)</td>
<td>Analog Output module Q1 to Q(n)</td>
</tr>
<tr>
<td>Digital inputs S1 to S(n)</td>
<td>Digital Input module S1 to S(n)</td>
</tr>
<tr>
<td>Digital/relay outputs R1 to R(n)</td>
<td>Digital Output module R1 to R(n)</td>
</tr>
</tbody>
</table>

**Maximum number of option modules**

The maximum number of option modules supported by the device is four. However, there are limitations.

Depending on the type and quantity of option modules attached to your meter, you may need to reduce your meter’s maximum operating temperature or limit the number of option modules. Refer to *Maximum operating temperature with option modules, page 242* for more information.

**Commissioning**

**Factory default settings**

Use these default values the first time you connect to your meter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password to log onto meter webpages or access display</td>
<td>0</td>
</tr>
<tr>
<td>Username to log onto meter webpages</td>
<td>9000</td>
</tr>
<tr>
<td>IP address(^1)</td>
<td>169.254.0.10</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>Gateway</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>RS-485</td>
<td>COM1 Unit ID: 100 COM4 Unit ID: 103</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
</tbody>
</table>

\(^1\) The IPv6 link local address can also be used. Refer to "Self-discovery over Ethernet", page 32 for details.

**Commissioning using ION Setup**

Use ION Setup to commission the meter for integration into your energy management system.

Connect to your meter using ION Setup then use the Setup Assistant to configure the meter. Setup parameters are arranged in logical groupings and category folders.

Before exiting the Setup Assistant, ION Setup performs a meter configuration test and displays the results. You can review the results and make changes as needed.

To turn off the meter configuration test:
1. Click **Tools > Options**.
2. Click the Assistant tab and clear the Configuration Checklist check box.

**NOTE:** ION Setup also performs a configuration test and displays results when configuring certain features such as the Sag/Swell or Transient Logging wizard in the Power Quality setup assistant.

### Configure basic metering parameters

Use ION Setup’s Metering setup assistant to configure the meter’s basic metering functionality.

1. Start ION Setup then open the Setup assistant for your meter.
2. Configure the parameters in **Metering Setup > Basic**.

#### Basic tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volts Mode</td>
<td>4W-WYE, DELTA, 3W-WYE, SINGLE, DEMO</td>
<td>Power system type (note DEMO is demonstration mode only, and does not use the meter input terminals to display values)</td>
</tr>
<tr>
<td>PT Prim</td>
<td>1 to 999,999</td>
<td>Potential transformer's primary winding voltage rating</td>
</tr>
<tr>
<td>PT Sec</td>
<td>1 to 999,999</td>
<td>Potential transformer's secondary winding voltage rating</td>
</tr>
<tr>
<td>CT Primary</td>
<td>1 to 999,999</td>
<td>Current transformer's primary winding current rating</td>
</tr>
<tr>
<td>CT Secondary</td>
<td>1 to 999,999</td>
<td>Current transformer's secondary winding current rating</td>
</tr>
<tr>
<td>Nominal Voltage</td>
<td>1 to 999,999</td>
<td>Nominal voltage (V) used for metering functions such as harmonic calculations and sag/swell detection</td>
</tr>
<tr>
<td>Nominal Current</td>
<td>1 to 999,999</td>
<td>Nominal current (A) used for metering functions such as harmonic calculations and sag/swell detection</td>
</tr>
<tr>
<td>Nominal Frequency</td>
<td>50, 60</td>
<td>Nominal frequency (Hz) used for metering functions such as alarms</td>
</tr>
</tbody>
</table>

3. Configure the parameters in **Metering Setup > Advanced** if appropriate.

#### Advanced tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PhaseOrder</td>
<td>ABC, ACB</td>
<td>Power system’s rotation order of voltage phases</td>
</tr>
<tr>
<td>V4 PT Prim</td>
<td>1 to 999,999</td>
<td>V4 potential transformer's primary winding voltage rating</td>
</tr>
<tr>
<td>V4 PT Sec</td>
<td>1 to 999,999</td>
<td>V4 potential transformer's secondary winding voltage rating</td>
</tr>
<tr>
<td>I4 Prim</td>
<td>1 to 999,999</td>
<td>I4 current transformer’s primary winding current rating</td>
</tr>
<tr>
<td>I4 Sec</td>
<td>1 to 999,999</td>
<td>I4 current transformer’s secondary winding current rating</td>
</tr>
<tr>
<td>I5 Prim</td>
<td>1 to 999,999</td>
<td>I5 current transformer’s primary winding current rating</td>
</tr>
<tr>
<td>I5 Sec</td>
<td>1 to 999,999</td>
<td>I5 current transformer’s secondary winding current rating</td>
</tr>
<tr>
<td>Scale Rev Param</td>
<td>ON, OFF</td>
<td>Specifies whether revenue readings are presented as primary or secondary side values (ON = primary side, OFF = secondary side)</td>
</tr>
</tbody>
</table>
Using the phasor viewer

Phasor diagrams can help verify or troubleshoot issues with voltage and current input wiring. Use ION Setup’s Phasor Viewer to display a real-time phasor diagram of the voltage and current input signals.

1. Start ION Setup then open the Setup assistant for your meter.
2. Select **Metering Setup > Phasor**.
3. Select **Phasor Viewer** and click **Show**.
4. To change the polarity of the voltage or current inputs, click **Show Setup** to display the Polarity Settings.
   - Select the box beside the inputs you want to invert polarity, then click **Apply to Meter**.

Basic setup using the webpages or display

You can use the meter webpages or display to configure basic metering parameters.

• Using the webpages: Navigate to **Setup > Metering**.
• Using the display: Navigate to **Setup Menu > Meter Setup**.
Communications

Communications overview

Communications is the transfer of data to and from the meter and is controlled by a combination of hardware and software components in the meter.

For each connected communications port, the meter uses the applicable communications protocol to establish communications with other devices or software. The protocol manages the communications session and defines the set of rules, commands and packet structure of the transmitted data. You can also control which protocols are enabled or disabled on the meter.

**NOTE:** To maximize the performance of your power management system, it is recommended that devices be connected directly to an Ethernet network.

Other means of controlling communications, such as who can access certain types of meter data, are discussed in the security topics for the meter.

Your meter’s default protocol settings meet the needs of most systems with only basic configuration. You can customize these settings to meet your specific needs. These are advanced procedures that require an understanding of your meter’s architecture, supported protocols, and the communications network and power system that your meter is connected to.

Ethernet communications

Your Ethernet connection source should be installed in a location that helps minimize the overall Ethernet cable routing length and complexity of your network.

The meter supports a single IP address for both physical Ethernet connections.

Your device’s second Ethernet port acts as an Ethernet switch to help simplify network connections and reduce installation time and costs, by having shorter Ethernet cable runs between devices without needing additional Ethernet routers or repeaters. You cannot connect your meter to two different Ethernet networks. The two Ethernet ports do not split the signal, so connecting both of the ports should not impact your communications speed.

The meter uses dual-stack IPv4/IPv6 routing technology to manage network communications and allow network hosts to communicate with the meter using either IPv4 or IPv6.

**Ethernet communications connections**

Your meter’s dual port Ethernet connections enable you to use straight-line or network loop (ring) topology.

If local network loop Ethernet topology is required, you must enable RSTP for your meter’s Ethernet communications to function.

Use CAT5 (or higher) Ethernet cables with unshielded RJ45 modular connectors to wire your meter’s Ethernet communications.
**Ethernet loop topology**

A. Ethernet switch or hub  
B. Ethernet connected meters  
C. LAN / WAN

---

**Protocols, ports and connections**

The Ethernet protocols supported by your device allow simultaneous connections through the IP service ports.

**NOTE:** Some protocol port numbers are read-only and not configurable.

---

### Protocol, ports and connections

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Port (default)</th>
<th>Number of connections</th>
</tr>
</thead>
<tbody>
<tr>
<td>ION</td>
<td>7700</td>
<td>8¹</td>
</tr>
<tr>
<td>Modbus TCP</td>
<td>502</td>
<td>8¹</td>
</tr>
<tr>
<td>Modbus RTU over Ethernet²</td>
<td>7701</td>
<td>8¹</td>
</tr>
<tr>
<td>DNP</td>
<td>20000</td>
<td>8¹</td>
</tr>
<tr>
<td>DLMS</td>
<td>4059</td>
<td>8¹</td>
</tr>
<tr>
<td>Modbus TCP (dedicated)²</td>
<td>502</td>
<td>32</td>
</tr>
<tr>
<td>EtherGate (Com1)</td>
<td>7801</td>
<td>1</td>
</tr>
<tr>
<td>EtherGate (Com4)</td>
<td>7802</td>
<td>1</td>
</tr>
<tr>
<td>DHCP</td>
<td>67 (68)</td>
<td>1</td>
</tr>
<tr>
<td>SFTP</td>
<td>22</td>
<td>2</td>
</tr>
<tr>
<td>Webserver (HTTP)³</td>
<td>80</td>
<td>10</td>
</tr>
<tr>
<td>Secure webserver (HTTPS)³</td>
<td>443</td>
<td>10</td>
</tr>
<tr>
<td>SNMP</td>
<td>161</td>
<td>N/A</td>
</tr>
<tr>
<td>SMTP server (email) outgoing only</td>
<td>25</td>
<td>1</td>
</tr>
<tr>
<td>NTP</td>
<td>123</td>
<td>1</td>
</tr>
<tr>
<td>IEC 61850</td>
<td>102</td>
<td>5</td>
</tr>
</tbody>
</table>

By enabling or disabling TCP/IP protocols, you can control whether or not your meter accepts new socket connection requests. Changing settings for one port does not impact the other existing connections. Depending on the protocol, you can also change the port number.

---

1. These 8 simultaneous connections are shared by ION, Modbus TCP, Modbus RTU over Ethernet, DLMS and DNP. You can have a maximum of 3 DNP connections. You can have a maximum of 1 DLMS connection.
2. These protocols must be enabled for Modbus gateway functionality.
3. These are used for the meter’s webpages.
Self-discovery over Ethernet

Your meter supports DPWS (devices profile for web services) which allows for self-discovery of the meter when it is connected to your local area network.

When you connect your meter to your network, your meter automatically appears in your network in Windows Explorer under Other Devices. By default, the meter is named <meter type>-<last six digits of MAC address>. For example, a meter with a MAC address of 006078173393 appears on the network as <meter type>-173393.

| A | Computer connected to the network with IPv6 enabled |
| B | LAN / WAN (Local Area Network / Wide Area Network), common subnet, no routers |
| C | Meters with self-discovery over Ethernet connected to the network |

Considerations for using self-discovery over Ethernet

- For self-discovery, the meter must be connected directly to the network using only a cable or switches, and not going through a router.
- You must use a computer running Windows 7 or later with IPv6 enabled in order to use self-discovery over Ethernet.
- The computer and the meter must be on the same subnet.
- You do not need to configure your meter’s IP address for self-discovery over Ethernet. An IPv6 address is automatically generated from your meter’s MAC address and self-discovery takes place over IPv6.

Accessing the meter through self-discovery

You can use Windows Explorer to locate and access the meter on your Local Area Network (LAN).

**NOTE:** Some networks restrict device self-discovery over a wireless connection. If this is the case, make sure your computer is connected to the network using an Ethernet cable.

1. Connect the meter’s Ethernet port to the LAN.
2. Start Windows Explorer.
3. Click Network.
   - The connected network devices display.
4. Locate your meter with the name <Device Name>-<Last 6 digits of MAC address>.
5. Double-click the icon to open the meter webpages.
Ethernet configuration

In order to use Ethernet communications, you must configure your device’s IP settings.

You need to enter network information for any Ethernet servers used by the device (for example, a DNS or email server). Contact your network system administrator for your IP address and other Ethernet network configuration values.

**NOTE:** For meters that do not have a display, you must connect your meter directly to your computer to set a unique IP address for each device or configure the meter to use a DHCP server to acquire IP addresses.

It is recommended that you test your communications with the meter after changing any communications-related settings (for example, communicating with the meter using the fully-qualified domain name if using DNS or with assigned addresses after these are provided by the DHCP server). In addition, make sure that any software or other devices communicating with the meter are using the new settings.

Initial Ethernet configuration versus changing existing Ethernet settings

There are two scenarios when configuring your meter’s Ethernet communications settings: initial configuration and changing the existing addresses when the meter is in use.

- **Initial configuration:** Configure your device’s Ethernet settings manually using the display or by connecting your meter directly to your computer and using a web browser to access the device’s webpages. Alternately, you can connect your meter to the network and configure it to use a DHCP server to acquire an IP address.

  **NOTE:** It is recommended during initial configuration that you use a connection method other than the one you are trying to configure. For example, if you are configuring DHCP IPv4 settings, connect to the meter using the IPv6 Link Local address or a serial connection. This allows you to configure the meter without being disconnected.

- **Changing existing IP settings:** After the meter’s Ethernet port is configured and connected to the LAN, you can use ION Setup to configure meter settings, in addition to using the display or meter webpages.

In either case, modify your meter’s Ethernet settings to those provided by your network system administrator before connecting the device to your local area network (LAN).

IP address format and ranges

When you set your meter’s IPv4 or IPv6 addresses, make sure you use the correct format and valid ranges.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4</td>
<td>0.0.0.0 to 255.255.255</td>
</tr>
<tr>
<td>IPv6</td>
<td>:: to FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF:FFFF</td>
</tr>
<tr>
<td></td>
<td>The double colon indicates that gaps are filled with zeroes to make the IPv6 address the correct length (32 hexadecimal numbers)</td>
</tr>
</tbody>
</table>

All meters ship from the factory with the IPv6 global address and IPv6 gateway undefined (set to “::”). To communicate with the meter using IPv6 outside the local network, you must configure these settings manually or use DHCP to assign the addresses to the meter. Within the local network, you can use the meter’s IPv6 Link Local address.
IP addresses and network port numbers

To specify a port for an outgoing IP address, append a colon then the port number to the end of the IP address. For IPv6 addresses, enclosed the address in square brackets then add the port number. For example, to specify the default port for SFTP (port 22):
  • IPv4: 169.254.0.10:22
  • IPv6: [FE80::260:78FF:FE04:5943]:22

Configurable Ethernet settings

‘W’ indicates the setting can be configured (written) while ‘R’ indicates it is read-only.

**NOTE:** Some additional Ethernet settings are available in the Advanced Ethernet menu in ION Setup and on the meter webpages.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Display</th>
<th>ION Setup</th>
<th>Webpages</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 address</td>
<td>W</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>IPv4 Subnet mask</td>
<td>W</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>IPv4 Default gateway</td>
<td>W</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>IPv4 Assignment Mode (DHCP/Stored)</td>
<td>W</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>IPv6 Assignment Mode (DHCP/Stored)</td>
<td>W</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Ethernet Device name</td>
<td>R</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Domain name</td>
<td>R</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>IPv6 enabled</td>
<td>W</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>IPv6 Link Local Address</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>IPv6 global address</td>
<td>R</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>IPv6 gateway</td>
<td>R</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Ethernet Rx timeout</td>
<td>—</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Modbus TCP timeout</td>
<td>—</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Modbus gateway</td>
<td>—</td>
<td>W</td>
<td>—</td>
</tr>
<tr>
<td>MAC address</td>
<td>R</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>Ethernet primary DNS</td>
<td>R</td>
<td>W</td>
<td>W</td>
</tr>
<tr>
<td>Ethernet secondary DNS</td>
<td>R</td>
<td>W</td>
<td>W</td>
</tr>
</tbody>
</table>

Configuring IPv4 / IPv6 communications settings using ION Setup

You can configure your device’s IPv4 and IPv6 address settings, such as stored addresses or address assignment mode, using ION Setup.

When configuring communications parameters, ensure you maintain at least one communication path that allows full access to your device; otherwise you may permanently lose the ability to change your device’s configuration and access additional data.
NOTICE

LOSS OF ACCESS

Ensure you maintain sufficient access to communicate with and configure your device.
Failure to follow these instructions can result in loss of access to the device.

Contact your network system administrator for your IP addresses and other Ethernet network configuration values.

1. Start ION Setup.
2. Open the Setup Assistant for your device.
3. Select Communications > Basic Ethernet and click the IPv4 or IPv6 tab.
4. Select the IP address then click Edit.
5. Select your IP address assignment mode.

**IPv4**

<table>
<thead>
<tr>
<th>Selection</th>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use DHCP to obtain an IPv4 address</td>
<td>DHCP</td>
<td>The meter acquires its IP addresses from your network’s DHCP server. The Device Name and Domain Name fields are used to define the meter’s fully-qualified domain name (FQDN).</td>
</tr>
<tr>
<td>Use the following IPv4 address</td>
<td>Stored</td>
<td>The meter uses the IP addresses that you manually enter for IPv4 (address, subnet mask and gateway).</td>
</tr>
</tbody>
</table>

For IPv6, select the IPv6 Enabled checkbox to enable IPv6 communications or clear it to disable IPv6 communications.

**NOTE:** The IPv6 Link Local address itself is factory set and is read-only.

**IPv6**

<table>
<thead>
<tr>
<th>Selection</th>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use DHCP to obtain an IPv6 address</td>
<td>DHCPv6</td>
<td>The meter acquires its IP addresses from your network’s DHCPv6 server. The Device Name and Domain Name fields are used to define the meter’s fully-qualified domain name (FQDN).</td>
</tr>
<tr>
<td>Use the following IPv6 address</td>
<td>Stored</td>
<td>The meter uses the IP addresses that you manually enter for IPv6 (global address and default gateway).</td>
</tr>
</tbody>
</table>

You can have different assignment modes for IPv4 and for IPv6.

6. Configure the settings for the selected mode then click OK.
   The changes are saved to the meter. If ION Setup detects that the connection information is already in use, you are prompted to confirm the change.

7. Click Yes to confirm the change or No to cancel.
   An example of an instance where you might want to confirm the change is if you are programming the meter to replace another meter already in service.
DHCP settings available using ION Setup

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device name</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Ethernet device name is used by DPWS for self-discovery over Ethernet and as the hostname to uniquely identify your meter for DHCP and DNS. By default, this is set to the meter model plus the last six-digits of the MAC address.</td>
</tr>
<tr>
<td>Domain name</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Ethernet domain name for the network that the meter resides on.</td>
</tr>
</tbody>
</table>

Stored IPv4 settings available using ION Setup

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The IP address of your device.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The subnet IP address of your network.</td>
</tr>
<tr>
<td>Gateway</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The gateway IP address of your network.</td>
</tr>
</tbody>
</table>

Stored IPv6 address settings available using ION Setup

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Address</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Internet protocol address of your device.</td>
</tr>
<tr>
<td>Default Gateway</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The address the meter uses to route communications to a different network or subnet. If you do not set this or the address is incorrect, you may see slow communications or communications errors.</td>
</tr>
</tbody>
</table>

ION Setup reconnection

If you change the settings for the Ethernet connection method you are currently using to connect to the meter, ION Setup tries to reconnect to the meter using the updated information. You can view the process in the Device reconnection dialog box that appears.

- If ION Setup can successfully communicate using the new setting, this setting appears in the IP Address dropdown list and the checkbox is selected. Click OK to copy this information into the IP address field in the Device Properties. ION Setup will now use this address to communicate with the device.

- If ION Setup cannot successfully communicate using the new setting, the new address appears in the IP Address but the checkbox is not selected. Either select the checkbox and click OK (for example, you may want to use the new setting if you are replacing a meter in service) OR select another address option from the dropdown list. Click Test to check that ION Setup can communicate with the meter using the new address, select the checkbox, then click OK.
Communications PowerLogic™
ION9000 series

Configuring general Ethernet settings using ION Setup

You can configure your device’s general Ethernet settings using ION Setup.

1. Start ION Setup.
2. Open the **Setup Assistant** for your device.
3. Select **Communications > Basic Ethernet** and click the **TCP/IP** tab.
4. Select a setting and then click **Edit**.

**NOTE:** Contact your network system administrator for the appropriate values.

**General Ethernet settings available using ION Setup**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet device name</td>
<td>configurable</td>
<td>This name is associated with your meter when using DPWS. By default, it is the meter type and the last 6 characters of its MAC address.</td>
</tr>
<tr>
<td>Rx timeout</td>
<td>configurable</td>
<td>Specifies the number of seconds the meter waits for communication acknowledgments.</td>
</tr>
<tr>
<td>Modbus TCP Timeout</td>
<td>configurable</td>
<td>Specify number of seconds the meter waits before disconnecting an idle Modbus TCP connection.</td>
</tr>
<tr>
<td>Modbus Gateway †</td>
<td>Disabled</td>
<td>Specify the port on which Modbus Gateway sends/receives Modbus TCP requests. For Modbus Gateway to function properly, the serial port protocol must be set to Modbus Master. For example, change CM1 from FACTORY TO MODBUS MASTER.</td>
</tr>
<tr>
<td></td>
<td>COM1 (CM1 Protocol)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>COM4 (CM4 Protocol)</td>
<td></td>
</tr>
<tr>
<td>MAC address</td>
<td>Read-only</td>
<td>The media access control (MAC) address is factory set and is for reference only.</td>
</tr>
</tbody>
</table>

† Modbus Gateway is supported only on one serial port at any given time.

Configuring basic Ethernet settings using the meter webpages

You can use the meter webpages to configure the IPv4, IPv6 and TCP/IP settings for the meter.

When configuring communications parameters, ensure you maintain at least one communication path that allows full access to your device; otherwise you may permanently lose the ability to change your device’s configuration and access to additional data.

**NOTICE**

**LOSS OF ACCESS**

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.
Contact your network system administrator for your IP addresses and other Ethernet network configuration values.

1. Connect to your meter’s webpages.

   Until you configure other Ethernet connection settings, you can connect to the meter using its default IPv4 address or its IPv6 link local address, or by using self-discovery over Ethernet then double-clicking the meter’s network icon.

2. Navigate to Setup > Ethernet.

3. Enter the appropriate value for the settings.

4. Click Advanced Settings to configure additional Advanced Ethernet settings, such as timeouts and enabling/disabling certain protocols over Ethernet, if needed.

5. Click Apply.

   **NOTE:** If you are changing the address you used to access the webpages, you will need to reconnect to the webpages after you click Apply.

---

**Ethernet settings available using the webpages**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAC address</td>
<td>Read-only</td>
<td>The media access control (MAC) address is factory set and is for reference only.</td>
</tr>
<tr>
<td>Ethernet device name</td>
<td>configurable</td>
<td>The Ethernet device name is used by DPWS for self-discovery over Ethernet and as the hostname to uniquely identify your meter for DHCP and DNS. By default, this is set to the meter model plus the last six-digits of the MAC address.</td>
</tr>
<tr>
<td>Domain name</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Ethernet domain name for the network that the meter resides on.</td>
</tr>
<tr>
<td>Primary DNS</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The IP address of your network’s primary DNS server, if your network uses DNS.</td>
</tr>
<tr>
<td>Secondary DNS</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The IP address of your network’s secondary DNS server, if your network uses DNS.</td>
</tr>
</tbody>
</table>

---

**IPv4 settings available using the webpages**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv4 Assignment mode</td>
<td>Stored DHCP</td>
<td>Stored: The meter uses the IP addresses that you manually enter for IPv4 (address, subnet mask and gateway).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DHCP: The meter acquires its IP addresses from your network’s DHCP server.</td>
</tr>
<tr>
<td>Stored IPv4 address</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Internet protocol address of your device.</td>
</tr>
<tr>
<td>Stored IPv4 Subnet Mask</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Ethernet IP subnetwork address of your network.</td>
</tr>
</tbody>
</table>
IPv4 settings available using the webpages (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stored IPv4 Gateway</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Ethernet IP gateway address of your network.</td>
</tr>
</tbody>
</table>

The webpage also displays the acquired IPv4 settings if the Assignment mode is set to DHCP.

**NOTE:** To disable communications using IPv4, set the Assignment mode to Stored and the IPv4 Address to 0.0.0.0.

IPv6 settings available using the webpages

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPv6 Assignment Mode</td>
<td>Stored DHCPv6</td>
<td>Stored: The meter uses the IP addresses that you manually enter for IPv6 (Global address, gateway address). DHCPv6: The meter acquires its IP addresses from your network’s DHCP server.</td>
</tr>
<tr>
<td>IPv6 Link Local Address</td>
<td>Read-only</td>
<td>The IPv6 Link Local address is factory set and is read-only.</td>
</tr>
<tr>
<td>Stored IPv6 Global Address</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The Internet protocol address of your device.</td>
</tr>
<tr>
<td>Stored IPv6 Gateway</td>
<td>Contact your local network administrator for parameter values.</td>
<td>The address the meter uses to route communications to a different network or subnet. If you do not set this or the address is incorrect, you may see slow communications or communications errors.</td>
</tr>
</tbody>
</table>

The webpage also displays the acquired IPv6 settings if the Assignment mode is set to DHCP.

**NOTE:** To disable communications over IPv6, set Enable IPv6 in Advanced Settings to “No”.

**NOTE:** You must enclose an IPv6 address in square brackets when typing it in a web browser, for example: "http://[fe80::260:78ff:fe04:5943]".

Configuring Ethernet communications settings using the display

You can configure basic Ethernet communications settings using the display.

Obtain your meter’s IP address and other network information from your network administrator or IT department before you begin.

You can use the display to select the IP address assignment mode for IPv4 and IPv6, configure stored IPv4 addresses, and view other settings. To configure the Ethernet settings that are not available on the display or are read-only, use the meter’s webpages or ION Setup.

1. Go to Setup Menu > Communications Setup.
2. Scroll through the screens until you reach the setting you want to configure then press the edit icon.
3. Select the IPv4 or IPv6 **Assignment Mode**, if required.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stored</td>
<td>The meter uses the IP addresses that you manually enter for IPv4 (address, subnet mask and gateway) and IPv6 (Global address, gateway address).</td>
</tr>
<tr>
<td>DHCP / DHCPv6</td>
<td>The meter acquires its IP addresses from your network’s DHCP server.</td>
</tr>
</tbody>
</table>

You can have different assignment modes for IPv4 and for IPv6.

If you set the **IPv4 Assignment Mode** to Stored, continue with the remaining steps to configure stored IPv4 addresses. If you are using addresses acquired from a DHCP server, press the down arrow to view the assigned addresses.

4. Go to the **Stored IPv4 Address Setup** screen and press the edit icon.

5. Configure your meter’s stored IPv4 Addresses, as required.

### Stored IPv4 address settings available using the display

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
</table>
| IP Address      | Contact your local network administrator for parameter values. | Sets the IP address for the meter  
Your meter’s default IP address is 169.254.0.10 |
| Subnet Mask     | Contact your local network administrator for parameter values. | Used if subnetting applies to your network  
Your meter’s default subnet address is 255.255.0.0 |
| Gateway         | Contact your local network administrator for parameter values. | Used in networks with multiple segments  
Your meter’s default gateway address is 0.0.0.0 |
| MAC Address     | Read-only                                      | Your meter’s media access control (MAC) address                           |

**DHCP**

The meter can function as a DHCP (Dynamic Host Configuration Protocol) client, allowing a DHCP server to assign IP addresses to the meter.

The meter supports assignment of the following addresses by a DHCP server when the Assignment Mode is set to DHCP:

- IPv4 IP Address
- IPv4 Subnet mask
- IPv4 Gateway
- IPv6 Global Address
- IPv6 Gateway

**Considerations for using DHCP**

- It is recommended that you also set up a DNS server and configure software and other devices to use the meter’s name to communicate with it. Alternatively, you can configure the DHCP server to always provide the same address to the meter.
- When you switch the assignment mode from DHCP to Stored, the meter reverts to using its default IP addresses as the Stored addresses.
- When you switch the assignment mode from Stored to DHCP, the acquired addresses display as **None** until the meter receives addresses from the DHCP server.
• When using IPv6, the meter’s fully-qualified domain name (FQDN) is not sent to the DHCP server. It is important that you make sure what is configured on the meter matches what is configured on your network.

• If the meter is not able to communicate to the DHCP server:
  ◦ When using IPv4, the meter will try to connect to the DHCP server for approximately one minute. If the meter cannot connect to the DHCP server, it will revert to the default IP address, but the Assignment Mode will remain DHCP.
  ◦ When using IPv6, the meter will continue to try to connect to the DHCP server, even if it does not receive an address.
    
    **NOTE:** If the DHCP server has not assigned an IP address and you need to reconnect to the meter, use the meter's IPv6 link local address.
  ◦ For IPv4, if the meter’s fully-qualified domain name (FQDN) is not found on the DHCP server, an event is logged in the event log. For IPv6, if the meter’s fully-qualified domain name (FQDN) is not found on the DHCP server, no event is logged; this is important to keep in mind when troubleshooting communications issues in a system using DHCP.

**Meter domain name**

You can configure the meter as a DNS client in systems using a DNS server.

**Domain name resolution (DNS)**

A DNS (domain name system) server maps domain names to IP addresses. If you configure the meter to use a DNS server, the meter can communicate with other network resources using their domain names, rather than their IP addresses, and vice versa. For example, if your network has an SMTP server with the domain name of smtp.company.com, you can enter smtp.company.com as the SMTP Server address in the meter’s communications settings.

**The meter’s fully-qualified domain name (FQDN)**

To allow other network resources to communicate to the meter using its domain name, you must configure the meter’s Ethernet Device Name setting to match that used by the DNS server. The meter’s fully-qualified domain name is its Ethernet name plus its Domain name. For example, if the meter’s Ethernet name is ElectricityHQ and its Domain name is companyXYZ.com, the FQDN will be ElectricityHQ.companyXYZ.com.

    **NOTE:** This domain name is used for both IPv4 and IPv6 communications. It is used to identify the meter in a system using DNS and to identify the meter when using DPWS for self-discovery over Ethernet.

**Network protocol control**

The network protocol control feature allows you to enable, disable or change the port number of the network protocols supported on your meter.

Disabling unused ports is considered a cybersecurity best practice to help minimize unauthorized access to your meter.

    **NOTE:** The protocol port number may not be configurable on all protocols.

**Network protocol control using ION Setup**

Use ION Setup to enable, disable or change the port number of the network protocols supported on your meter.

When configuring communications parameters, ensure you maintain at least one communication path that allows full access to your device; otherwise you may
permanently lose the ability to change your device’s configuration and access to additional data.

**NOTICE**

<table>
<thead>
<tr>
<th>LOSS OF ACCESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure you maintain sufficient access to communicate with and configure your device.</td>
</tr>
<tr>
<td>Failure to follow these instructions can result in loss of access to the device.</td>
</tr>
</tbody>
</table>

1. Open the Setup Assistant for your meter.
   See the ION Setup Help for instructions.
2. Select **Communications** > **Advanced Ethernet** and click the **Protocols** tab.
   Enter your login credentials as required.
3. Select a protocol from the list and click **Edit**.
4. Select the **Enabled** checkbox to enable the port. Clear the check box to disable the port.
   **NOTE:** The IEC61850 port is enabled when a valid CID file is uploaded to the meter. The port is disabled by removing the CID file.
   **NOTE:** For EtherGate functionality, the EtherGate protocol must be enabled and the applicable serial port set to EtherGate.
5. Select a port number from the **Port Number** drop-down list or by clicking in the **Port Number** field and entering a port number.
6. Click **OK**.
   If multiple ports are set to the same number, ION Setup responds with a message indicating that the port is already in use by another protocol.

**Network protocol control using the meter webpages**

Use the meter webpage to enable, disable or change the port number of the network protocols supported on your meter.

The Setup tab contains configurable elements for enabling, disabling and changing the port numbers for your network protocols.

When configuring communications parameters, ensure you maintain at least one communication path that allows full access to your device; otherwise you may permanently lose the ability to change your device’s configuration and access to additional data.

**NOTICE**

<table>
<thead>
<tr>
<th>LOSS OF ACCESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure you maintain sufficient access to communicate with and configure your device.</td>
</tr>
<tr>
<td>Failure to follow these instructions can result in loss of access to the device.</td>
</tr>
</tbody>
</table>

1. Open a web browser and enter your meter’s IP address in the address box.
   The webpage login is displayed.
2. Enter your login credentials.
3. Navigate to **Setup > Ethernet**.
4. Click **Advanced Settings** at the bottom of the screen.
5. Select YES or NO to enable or disable each configurable protocol.
6. Enter the port number for each configurable protocol.
7. Click **Apply** to send these settings to your meter.

**Network protocol control using the meter display**

The Ethernet Port Enable Setup allows you to enable or disable your network protocols through your meter’s display.

When configuring communications parameters, ensure you maintain at least one communication path that allows full access to your device; otherwise you may permanently lose the ability to change your device’s configuration and access to additional data.

**NOTICE**

<table>
<thead>
<tr>
<th>LOSS OF ACCESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure you maintain sufficient access to communicate with and configure your device.</td>
</tr>
<tr>
<td><strong>Failure to follow these instructions can result in loss of access to the device.</strong></td>
</tr>
</tbody>
</table>

**NOTE:** You cannot change the Ethernet port number assignments through your meter’s display.

1. Press the **Home** button on the display.
2. Navigate to **Setup Menu > Ethernet Port Enable Setup**.
3. Press Edit. Enter your meter’s password, if prompted.
4. Press the up or down icons to navigate available Ethernet protocols. A gray bar appears behind the active selection.
5. Press Enable/Disable.
6. Press Select to accept the change.
7. Press Select to confirm.

**Serial communications**

The meter supports serial communications through its onboard RS-485 ports.

**RS-485**

In an RS-485 network, there is one master device, typically an Ethernet to RS-485 gateway. It provides the means for RS-485 communications with multiple slave devices (for example, meters). For applications that require only one dedicated computer to communicate with the slave devices, a USB to RS-485 converter can be used to connect to the master device.

Up to 32 devices can be connected on a single RS-485 bus.

**RS-485 wiring**

Connect the devices on the RS-485 bus in a point-to-point configuration, with the (+) and (-) terminals from one device connected to the corresponding (+) and (-) terminals on the next device.
**RS-485 cable**

Use a shielded 2 twisted pair or 1.5 twisted pair RS-485 cable to wire the devices. Use one twisted pair to connect the (+) and (-) terminals, and use the other insulated wire to connect the C terminals.

The total distance for devices connected on an RS-485 bus should not exceed 1200 m (4000 ft).

**RS-485 terminals**

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Common. This provides the voltage reference (zero volts) for the data plus and data minus signals</td>
</tr>
<tr>
<td>Shield</td>
<td>Connect the bare wire to this terminal to help suppress signal noise that may be present. Ground the shield wiring at one end only (either at the master or the last slave device, but not both.</td>
</tr>
<tr>
<td>-</td>
<td>Data minus. This transmits/receives the inverting data signals.</td>
</tr>
<tr>
<td>+</td>
<td>Data plus. This transmits/receives the non-inverting data signals.</td>
</tr>
</tbody>
</table>

**NOTE:** If some devices in your RS-485 network do not have the C terminal, use the bare wire in the RS-485 cable to connect the C terminal from the meter to the shield terminal on the devices that do not have the C terminal.

**RS-485 configuration**

Before connecting your device to the RS-485 bus, use ION Setup, the meter webpages or display to configure your meter’s default RS-485 settings.

Your meter has two RS-485 connections.

Each RS-485 connection must have a unique unit identifier (Unit ID) and have the following settings match the rest of the devices on the RS-485 bus:
- Protocol
- Baud rate
- Parity and stop bits

You can configure the following settings to help optimize communications performance:
- RTS delay
- RS-485 bias

You can use a communications converter (USB to RS-485 or RS-232 to RS-485) or an Ethernet gateway device to connect to your meter.

**RS-485 Bias**

You can use the RS-485 bias setting to fine tune communications.

Set the RS-485 bias to ON when the meter is acting as a master over RS-485 communications, and set the RS-485 bias to OFF when the meter is acting as a slave. You can configure RS-485 biasing through ION Setup, the meter webpages or display.

**Serial protocols and ports**

Your meter supports serial communications protocols on its RS-485 ports.
Communications

ION9000 series

- ION
- Modbus RTU
- Modbus Master
- DNP 3.0
- DLMS

- EtherGate
- GPS: TrueTime/Datum
- GPS: Arbiter
- GPS: Arbiter-Vorne
- None

1 These protocol settings are used for connecting to a GPS receiver communicating in serial ASCII format.
2 This protocol setting stops communications using this port.

Configuring serial communications settings using ION Setup

Use ION Setup to configure the meter’s serial communications settings.

Before configuring serial parameters, make sure you have a unique unit ID for your meter and know the serial network settings (protocol, baud rate, parity and stop bits).

1. Start ION Setup.
2. Open the Setup Assistant for your device.
3. Select Communications > Serial Settings.
4. Select Com1 or Com4 tab, depending on which hardware serial port you are configuring.
5. Select a setting and then click Edit to configure the setting to match your communications system.

Serial communications settings available using ION Setup

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>ION, Modbus RTU, Modbus Master, DNP v3.0, DLMS, EtherGate, GPS: TrueTime/Datum, GPS: Arbiter, GPS: Arbiter-Vorne, Factory, None</td>
<td>Sets the communications protocol for your meter’s RS-485 port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE: the NONE setting stops communications using this port.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>2400, 4800, 9600, 19200, 38400, 57600, 115200</td>
<td>Sets the data rate, in bits per second</td>
</tr>
<tr>
<td>Rx Timeout</td>
<td>0.1-15</td>
<td>Sets the transmit delay (timeout for receiving an entire message from a device) in seconds</td>
</tr>
<tr>
<td>Unit ID</td>
<td>1 to 9999</td>
<td>Sets the meter’s unique ID on the RS-485 network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE: Modbus serial device range 1 to 247</td>
</tr>
<tr>
<td>Serial Port</td>
<td>8N1, 8N2, 8E1, 8E2, 8O1, 8O2</td>
<td>Sets the parity and stop bits for the port</td>
</tr>
<tr>
<td>RS485 Bias</td>
<td>Off, On</td>
<td>Turns on biasing when mastering devices over the RS-485 port</td>
</tr>
</tbody>
</table>

1 Only applies to a subset of protocols

Configuring serial communications settings using the webpages

You can use the meter’s webpages to configure your serial communications settings.

Before configuring serial parameters, make sure you have a unique unit ID for your meter and know the serial network settings (protocol, baud rate, parity and stop bits).
1. Connect to your meter’s webpages using the meter’s IPv4 address or its IPv6 link local address, or use self-discovery then double-clicking the meter’s network icon.

2. Navigate to Setup > Serial Port.

3. Enter the appropriate value for the settings.

4. Click Advanced Settings to configure additional settings, if needed (for example, RS485 biasing or Rx Timeout).

**Basic serial communications settings available using the webpages**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>ION, Modbus RTU, Modbus Master, DNP v3.00, DLMS, EtherGate, GPS: Truetime/Datum, GPS: Arbiter, GPS: Arbiter-Vorne, Factory, None</td>
<td>Sets the communications protocol for your meter’s RS-485 port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE: the <strong>NONE</strong> setting stops communications using this port.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>2400, 4800, 9600, 19200, 38400, 57600, 115200</td>
<td>Sets the data rate, in bits per second</td>
</tr>
<tr>
<td>Unit ID</td>
<td>1 to 9999</td>
<td>Sets the meter’s unique ID on the RS-485 network</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOTE: Modbus serial device range 0 to 247</td>
</tr>
</tbody>
</table>

**Advanced serial communications settings available using the webpages**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTS Delay</td>
<td>0–1</td>
<td>The delay in seconds before the transmission of the packet.</td>
</tr>
<tr>
<td>Rx Timeout</td>
<td>0.1–15</td>
<td>Sets the transmit delay (timeout for receiving an entire message from a device) in seconds</td>
</tr>
<tr>
<td>Serial Port</td>
<td>8N1, 8N2, 8E1, 8E2, 8O1, 8O2</td>
<td>Sets the parity and stop bits for the port</td>
</tr>
<tr>
<td>RS485 Bias</td>
<td>OFF, ON</td>
<td>Turns on biasing when mastering devices over the RS-485 port</td>
</tr>
</tbody>
</table>

1 Only applies to a subset of protocols

**Configuring serial communications using the display**

You can configure your meter’s basic serial communications settings using the display.

Before configuring serial parameters, make sure you have a unique unit ID for your meter and know the serial network settings (protocol, baud rate, parity and stop bits).

1. Press the **Home** button.

2. Navigate to **Setup Menu > Communications Setup**.

3. Press the up and down icons to scroll and select **COM1 Setup** or **COM4 Setup**.
4. Configure your meter’s serial settings as required.

### Serial communications settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
</table>
| Protocol      | ION, Modbus RTU, Modbus Master, DNP v3.0, DLMS, EtherGate, GPS: TrueTime/Datum, GPS: Arbiter, GPS: Arbiter-Vorne, Factory, None | Sets the communications protocol for your meter’s RS-485 port  
**NOTE:** the NONE setting stops communications using this port. |
| Baud Rate     | 2400, 4800, 9600, 19200, 38400, 57600, 115200     | Sets the data rate, in bits per second                                                        |
| Rx Timeout    | 0.1-15                                           | Sets the transmit delay in seconds                                                            |
| Unit ID       | 1 to 9999                                        | Sets the meter’s unique ID on the RS-485 network  
**NOTE:** Modbus serial device range 1 to 247                                                  |
| Serial Port   | 8N1, 8N2, 8E1, 8E2, 8O1, 8O2                     | Sets the parity and stop bits for the port                                                    |
| RS485 Bias    | OFF, ON                                          | Turns biasing off or on when mastering devices over the RS-485 port                          |

### Disabling serial communications ports

#### Disabling serial communications using ION Setup

You can disable serial communications ports (COM1 or COM4) through ION Setup.

Disabling unused ports is considered a cybersecurity best practice to help minimize unauthorized access to your meter.

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.
2. Select **Communications > Serial Settings**.
3. Click the **COM1** or **COM4** tab.
4. Select **Protocol** and click **Edit**.
5. Select **None** from the dropdown list and click **OK**.

#### Disabling serial communications using the meter webpages

You can disable serial communications ports (COM1 or COM4) through the meter webpages.

Disabling unused ports is considered a cybersecurity best practice to help minimize unauthorized access to your meter.

1. Open a web browser and enter your meter’s IP address in the address box. The webpage login prompt is displayed.
2. Enter your login credentials.
3. Navigate to **Setup > Serial Port** and expand the **Basic Settings** section.
4. Choose **COM1/ RS485#1 - Protocol** or **COM4/ RS485#2 - Protocol** from the drop-down list box and select **None** to disable the port.
5. Click **Apply**. When prompted, click **Yes** to save the changes.
Disabling serial communications using the display

You can disable serial communications ports (COM1 or COM4) through the display.

Disabling unused ports is considered a cybersecurity best practice to help minimize unauthorized access to your meter.

1. Press the **Home** button.
2. Navigate to **Setup Menu > Communications Setup**.
3. Press **Select**.
4. Scroll then select **COM1 Setup** or **COM4 Setup**.
5. Press the navigation icon to scroll and select **Protocol**.
6. Press **Edit**. Enter user credentials if prompted.
7. Press the down icon and select **None** to disable the port.
8. Press **Select** when you are finished. If prompted, press **Select** again to accept the changes.

ION

ION is the native protocol and architecture of your meter.

The basic building blocks of ION architecture are the ION modules, each of which is specialized to perform a specific task and contains data and instructions on how to manage that data. ION modules are combined (linked) together to create the meter’s functions and features. ION modules that are linked together to perform a specialized task are called a framework, such as the Power Quality framework. These different functional frameworks are then grouped together to define the entire meter, and are collectively referred to as the device template.

Your meter ships with a default device template which provides extensive capabilities. You can also configure your meter’s template to modify your meter’s existing functions or to create new functions.

See the ION Reference, available from www.schneider-electric.com for further information about ION architecture and a detailed description of the different ION modules. See the ION Device Template Reference, available from www.schneider-electric.com, for details on the modules and their configuration in your meter’s default template.

Modbus

Modbus is a master/slave communications protocol where the master initiates transactions and the slave(s) responds with the requested information or action.

Your device can function as a Modbus slave or Modbus master, depending on how it is configured. Your device comes with Modbus slave functionality configured and ready to use. You can add custom Modbus information to the default Modbus slave data provided by your device.

### Key terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus gateway</td>
<td>A communications method that lets you communicate through an Ethernet gateway device to a Modbus serial network connected to that device.</td>
</tr>
<tr>
<td>Modbus master</td>
<td>A device that issues commands and receives responses from Modbus slave devices. Serial Modbus networks can only have one Modbus master per network.</td>
</tr>
</tbody>
</table>
**Modbus best practices for Ethernet**

In order for your meter to operate as an Ethernet Modbus device, you must complete some prerequisite configuration.

**NOTE:** You do not need to perform any Modbus-specific configuration for your meter to function as a Modbus slave device over Ethernet.

<table>
<thead>
<tr>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet</td>
<td>All devices must have a working Ethernet connection.</td>
</tr>
<tr>
<td>IP address</td>
<td>All devices must have a unique IP address.</td>
</tr>
<tr>
<td>Port</td>
<td>All devices must be communicating over Ethernet port 502 for Modbus TCP.</td>
</tr>
</tbody>
</table>

**NOTE:** Devices supporting multiple simultaneous Modbus TCP connections can have communications delays. Adjust your network timeout settings to accommodate this.

**Modbus best practices for serial**

In order for your meter to operate as a serial Modbus device, you must complete some prerequisite configuration.

<table>
<thead>
<tr>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wiring</td>
<td>The device’s serial connection must be wired correctly. The Modbus slave devices must have communications wiring to the Modbus master.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Slave: for your meter to be a serial Modbus slave, the meter’s protocol must be set to Modbus RTU. Master and slave devices must use the same format. Master: for your meter to be a serial Modbus master, the meter’s protocol must be set to Modbus Master.</td>
</tr>
<tr>
<td>Baud rate</td>
<td>The baud rate must be the same for all devices on the serial Modbus network.</td>
</tr>
<tr>
<td>Stop bits and parity</td>
<td>The communication stop bits and parity (for example, 8N1) must be the same for all devices on the serial Modbus network.</td>
</tr>
<tr>
<td>Unit ID</td>
<td>Each device on the serial Modbus network must have a unique unit ID (also called the device address).</td>
</tr>
</tbody>
</table>

**Your meter as a Modbus master**

**Your meter as a Modbus master with Ethernet Modbus slave devices**

Your meter can function as a Modbus master with Ethernet Modbus slave devices.
For Modbus mastering, you must add the Modbus slave devices using ION Setup.

**Your meter as a Modbus master with serial Modbus slave devices**

Your meter can function as a Modbus master with serial Modbus slave devices.

For Modbus mastering, you must add the Modbus slave devices using ION Setup.

**Modbus master best practices**

In order for your meter to operate as a Modbus master, you must complete some prerequisite configuration.

**NOTE:** These settings are required in addition to the serial or Ethernet Modbus prerequisites.

<table>
<thead>
<tr>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modbus slave devices</td>
<td>All Modbus slave devices must be communicating and appropriately configured.</td>
</tr>
<tr>
<td>Protocol</td>
<td>• Modbus mastering serial devices: the master’s serial port protocol must be set to Modbus master.</td>
</tr>
<tr>
<td></td>
<td>• Modbus mastering Ethernet devices: the master must be communicating to the slave devices over Ethernet port 502.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Having more than one Modbus master on a serial Modbus network may cause communication conflicts.</td>
</tr>
<tr>
<td>Mastered devices</td>
<td>The Modbus master device must have the slave device information entered for mastering.</td>
</tr>
</tbody>
</table>

**Configuring your meter as a Modbus master using ION Setup**

You can configure your device to Modbus master slave devices over serial or Ethernet.

Make sure your master and slave devices have the prerequisite communications wiring and configuration before configuring your meter as a Modbus master.
If the meter is a Modbus master over TCP/IP, the Modbus TCP/IP and Modbus RTU protocols must be enabled.

**NOTE:** Devices supporting multiple simultaneous Modbus TCP connections can have communications delays. Adjust your network timeout settings to accommodate this.

The meter as a Modbus master over TCP/IP attempts to communicate with a slave device for up to 100 seconds (as per the RFC1122 standard) before moving on to the next slave device.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Communications > 3rd Party Protocols** and click on the **Modbus Master** tab.
4. Click **Add** to add a Modbus slave device.
   
   The Modbus Device dialog appears.

5. Enter the Modbus slave information:
   - Enter the Modbus slave device’s name and a label suffix (if applicable).
   - Select the device type of the slave device from **Device Type**.
   - Enter the unit ID of the Modbus slave device into **Slave ID**.
   - Select the serial or TCP connection from **Connected via**. This is the connection from the Modbus master to the slave device.

6. Click **Connections**. The Modbus Master Connections dialog appears.

7. Select the tab that corresponds to the connection you are configuring (for example, if you selected TCP Connection 1 from **Connected via**, select the **TCP 1** tab) and configure it based on the connection type.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial connection</td>
<td>Select the serial communications port that is connected to the Modbus slave devices from the Assigned Port list.</td>
</tr>
<tr>
<td>TCP connection</td>
<td>Enter the IP address of the Modbus slave device, making sure that the IP port is set to 502.</td>
</tr>
<tr>
<td></td>
<td>Make sure that the Modbus RTU and Modbus TCP/IP protocols are enabled.</td>
</tr>
</tbody>
</table>

8. Click **OK** to return to the Modbus Device dialog.
9. Click **OK** to add the slave device. The device now appears on the list. Repeat these steps to add all of your Modbus slave devices.

### Your meter as a Modbus slave

**Your meter as a Modbus slave over Ethernet**

Your meter can function as a Modbus slave over Ethernet.

Your meter does not require any Modbus-specific configuration to act as a Modbus slave device over Ethernet.
Your meter as a Modbus slave on a serial network

Your meter can function as a Modbus slave on a serial network.

A. Modbus master  
B. RS-485 Modbus RTU  
C. Your meter  
D. Modbus slaves

Your meter’s serial connection must be wired and configured correctly. The same mode of serial communication must be used for all devices on the network.

Configuring your meter as a Modbus slave using ION Setup

You can use ION Setup to configure your meter as a Modbus slave.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to Communications > Serial settings. Select the tab for the serial port you want to configure.
4. Highlight the parameter and click Edit to configure the serial port’s Modbus parameters as required.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Modbus RTU or Modbus Master</td>
</tr>
</tbody>
</table>
| RS485 Bias  | • OFF if the meter is a Modbus slave  
              • ON if the meter is a Modbus master |

5. Configure the meter’s other serial port parameters as required.

For Modbus mastering, you must add the Modbus slave devices using ION Setup.


Configuring your meter as a Modbus slave using the webpages

You can use the meter webpages to configure your meter as a Modbus slave.

1. Connect to your meter’s webpages.
2. Navigate to Setup > Serial Port.
3. Expand Basic Settings or Advanced Settings and configure the serial port’s Modbus parameters as required.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Modbus RTU or Modbus Master</td>
</tr>
</tbody>
</table>
| RS485 Bias  | • OFF if the meter is a Modbus slave  
              • ON if the meter is a Modbus master |

4. Configure the meter’s other serial port parameters as required.

For Modbus mastering, you must add the Modbus slave devices using ION Setup.

**Configuring your meter as a Modbus slave using the display**

You can use the display to configure your meter as a Modbus slave.

1. Press the **Home** button.
2. Navigate to **Setup Menu > Communications Setup**, scroll and select **COM1** or **COM4** Setup.
3. Configure the serial port’s Modbus parameters as required.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Modbus RTU or Modbus Master</td>
</tr>
<tr>
<td>RS485 Bias</td>
<td>• OFF if the meter is a Modbus slave</td>
</tr>
<tr>
<td></td>
<td>• ON if the meter is a Modbus master</td>
</tr>
</tbody>
</table>

4. Configure the meter’s other serial port parameters as required.
   - For Modbus mastering, you must add the Modbus slave devices using ION Setup.


**Supported Modbus features**

Your meter supports specific Modbus data classes, data formats, function codes and commands.

**Modbus data classes**

<table>
<thead>
<tr>
<th>Class</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Coils</td>
<td>Digital bits that can be read and written to</td>
</tr>
<tr>
<td>Input status</td>
<td>Digital bits that can be read</td>
</tr>
<tr>
<td>Input registers</td>
<td>16-bit integers that can be read</td>
</tr>
<tr>
<td>Holding registers</td>
<td>16-bit integers that can be read and written to</td>
</tr>
</tbody>
</table>

**Modbus data formats**

<table>
<thead>
<tr>
<th>Format</th>
<th>Type</th>
<th># of Modbus registers used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsigned 16-bit</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Signed 16-bit</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Unsigned 32-bit</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>Signed 32-bit</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>Unsigned 32B-M10K</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>Signed 32B-M10K</td>
<td>Integer</td>
<td>2</td>
</tr>
<tr>
<td>IEEE float¹</td>
<td>Floating point</td>
<td>2</td>
</tr>
<tr>
<td>Packed Boolean for inputs</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Packed Boolean for coils</td>
<td>Integer</td>
<td>1</td>
</tr>
<tr>
<td>Unsigned 16-bit read/write</td>
<td>Integer</td>
<td>1</td>
</tr>
</tbody>
</table>
1 Meters acting as Modbus masters support two versions of IEEE float with different word orders: high/low = Big Endian, low/high = Little Endian.

16-bit data (one word) is transmitted with most-significant byte first and least-significant byte second.

32-bit data (two words) is transmitted with the most-significant word first and the least-significant word second.

### Modbus function codes

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Master/slave</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Read coil status</td>
<td>Master and slave</td>
</tr>
<tr>
<td>2</td>
<td>Read input status</td>
<td>Master and slave</td>
</tr>
<tr>
<td>3</td>
<td>Read holding registers</td>
<td>Master and slave</td>
</tr>
<tr>
<td>4</td>
<td>Read input registers</td>
<td>Master</td>
</tr>
<tr>
<td>5</td>
<td>Write to a coil</td>
<td>Master</td>
</tr>
<tr>
<td>6</td>
<td>Write to a holding register</td>
<td>Master and slave</td>
</tr>
<tr>
<td>15</td>
<td>Write to multiple coils</td>
<td>Master</td>
</tr>
<tr>
<td>16</td>
<td>Write to multiple holding registers</td>
<td>Master and slave</td>
</tr>
<tr>
<td>17</td>
<td>Report slave ID (serial only)</td>
<td>Master and slave</td>
</tr>
<tr>
<td>43 (sub code 14)</td>
<td>Read device identification</td>
<td>Master and slave</td>
</tr>
<tr>
<td>100</td>
<td>Read scattered holding registers</td>
<td>Master and slave</td>
</tr>
</tbody>
</table>

### Modbus commands

A Modbus master command to unit ID 0 is broadcast (sent to) all Modbus slave devices. The only supported broadcast command is preset multiple registers.

For serial Modbus networks with only one slave device, the master can send commands using the single connection, one-to-one address of unit ID 248, regardless of the slave device’s actual unit ID.

### Modbus implementation

Your meter’s Modbus implementation includes exception codes, invalid register responses, fixed and configurable register maps, and security.

### Modbus exception codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Illegal function</td>
<td>The requested command is invalid.</td>
</tr>
<tr>
<td>02</td>
<td>Illegal address</td>
<td>This code indicates one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The requested address is invalid for that function.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The requested address is not within the valid register range for this device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The requested address is protected by device security.</td>
</tr>
<tr>
<td>03</td>
<td>Illegal value</td>
<td>This code indicates one of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The requested value is not allowed for that register in the device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The requested register is part of a multi-word value.</td>
</tr>
</tbody>
</table>
**Modbus invalid read registers responses**

<table>
<thead>
<tr>
<th>Invalid type</th>
<th>Read response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unmapped (unused)¹ register</td>
<td>0x8000</td>
</tr>
<tr>
<td>Reserved¹ register responses by type</td>
<td></td>
</tr>
<tr>
<td>Signed integer 16-bit</td>
<td>0x8000</td>
</tr>
<tr>
<td>Unsigned integer 16-bit</td>
<td>0xFFFF</td>
</tr>
<tr>
<td>Signed integer 32-bits</td>
<td>0x80000000</td>
</tr>
<tr>
<td>Unsigned integer 32-bits</td>
<td>0xFFFFFFFF</td>
</tr>
<tr>
<td>Signed integer 64-bits</td>
<td>0x8000000000000000</td>
</tr>
<tr>
<td>Float32</td>
<td>0xFFC000000 (NaN = Not a number)</td>
</tr>
</tbody>
</table>

¹ IRIG-B can only be connected to one of the digital inputs located on the meter base, not an option module. Unmapped (unused) registers are registers that will never be used by the meter, and therefore have no defined format. Reserved registers have a defined format and are intended for use by the meter, its options or its variants.

**Modbus invalid write registers response**

If the meter receives a write command to a Modbus register address that does not have a register mapped, the meter does not respond. No data is written or stored, and the meter does not send back a rejection to the request.

If the meter receives a write command to a read-only Modbus register address, exception code 3 (illegal value) is returned.

**Fixed and configurable Modbus map**

Your device has a fixed (static) register map for meter data and a flexible, user-configured register map.

**Modbus security**

Your meter’s onboard security options include Modbus-specific settings. These security settings may need to be configured in order to write Modbus data to the meter.

**Modbus map**

Your meter’s default Modbus register information (map) is available for download from www.schneider-electric.com.

The Modbus register information includes:

- registers and mapped values
- formats and scaling
- additional details where applicable

**NOTE:** Your meter’s Modbus registers are specified differently than previous devices using ION architecture. If you are configuring Modbus slave information on your meter, confirm you are using the appropriate Modbus register addressing. Refer to your meter’s Modbus map for more information.

Your meter has a fixed (static) register map which contains the most common metering values. This map is defined by a series of Data Mapping modules, which also determine the values shown on your device’s display and webpages. The Data Mapping modules are named based on the type of information they map to Modbus:
<table>
<thead>
<tr>
<th>Data Mapping module</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Mapping Dmd Modules</td>
<td>Maps kW, kVA and kVAR demand data such as kW sd del (sliding demand kilowatts delivered) as well as current demand such as I a sd (sliding demand phase A current).</td>
</tr>
<tr>
<td>Data Mapping Egy Modules</td>
<td>Maps kWh, kVAh and kVArh delivered and received data, including conditional, quadrant and incremental energies.</td>
</tr>
<tr>
<td>Data Mapping EN Modules</td>
<td>Maps present interval EN50160 power quality compliance data.</td>
</tr>
<tr>
<td>Data Mapping EN Prev Modules</td>
<td>Maps previous interval EN50160 power quality compliance data.</td>
</tr>
<tr>
<td>Data Mapping I/O Modules</td>
<td>Maps input metering data, alarms, resets and reset counts.</td>
</tr>
<tr>
<td>Data Mapping Meas Modules</td>
<td>Maps measured data from the standard and high-speed Power Meter module. The Cfg Modbus Map Enable setup register may exist in this module.</td>
</tr>
<tr>
<td>Data Mapping PQ Modules</td>
<td>Maps power quality data such as Crest Factor, K Factor and total harmonic distortion, including IEC 61000-4-30 power quality compliance data.</td>
</tr>
<tr>
<td>Data Mapping Stats Modules</td>
<td>Maps statistical low, mean and high data values, such as I a mean (phase A current average value).</td>
</tr>
<tr>
<td>Data Mapping TOU Modules</td>
<td>Maps time-of-use (TOU) data, such as seasons, rates, and per-season demand such as kW sd rec A (sliding demand kilowatts received in season A).</td>
</tr>
</tbody>
</table>

You can add extra Modbus information or duplicate information that is already in the fixed map to different Modbus registers using Modbus Slave modules.

See the ION Reference available from www.schneider-electric.com for detailed information about Data Mapping modules and Modbus Slave modules.

**Configuring custom Modbus data using ION Setup**

You can add custom data to your meter’s default Modbus map, completely customize your meter’s Modbus map, or revert your meter’s Modbus map back to its default configuration using ION Setup.

You can download your meter’s Modbus map information from www.schneider-electric.com.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Communications > 3rd party protocols** and click on the **Modbus Slave** tab.
   
   The name of the meter’s current Modbus map is displayed, along with the quantity of custom registers and their start and end addresses.
4. Select the map name and click **Edit**.
   
   The **Modbus Slave Mode Setup** screen is displayed.
5. Select your meter’s method of Modbus slave mapping. If you select Default or Disabled, click Finish to configure your meter and return to the Setup Assistant, otherwise select Next to access the Modbus Slave Map Setup screen.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default    | Sets your meter to use the default Modbus map. Any custom Modbus slave data is removed.  
  **NOTE:** You can download your meter’s Modbus map information from www.schneider-electric.com. |
| Modified   | Add Modbus information in addition to the meter’s default Modbus map.         |
| Custom     | Removes the meter’s default Modbus map so that all registers are available so you can create a completely custom Modbus map.  
  **NOTE:** Use this option if you want to make your meter’s Modbus map identical to a device that it is replacing, for example in a retrofit application. |
| Disabled   | Removes your meter’s Modbus data map. Modbus functions are unaffected but no meter Modbus data is available. |

6. In the Modbus Slave Map Setup screen, you can modify parameters by clicking Edit, or add parameters by clicking Add.

The Modbus Register screen is displayed.

7. Configure the Modbus register information and click OK to return to the Modbus Slave Map Setup screen.

   a. **Source**: click Select and chose a source from the Parameter Selection screen. Select Show all available registers to see a complete list of the parameters available on your meter. Click OK.

   b. **Address**: enter the Modbus address that will hold the Source data.  
  **NOTE:** If you hover your mouse over the Address field, a tooltip indicates the Modbus function code and start address to send for retrieving the data.

   c. **Format**: select the Modbus data format from the list.

   d. **Scaling**: select the scaling value from the list, or select Custom and click Scales to configure custom scaling.

8. In the Modbus Slave Map Setup screen you can click Delete to remove a Modbus register, Set Name to create a new name for the set of additional data mapped to Modbus, or Save As to save the additional data you have mapped to Modbus as a separate file.

9. Click Finish to complete your meter’s Modbus slave configuration and return to the Setup Assistant.

**Ethernet gateway**

Ethernet gateway is a communications method that allows you to communicate through a gateway device to a serial network.

When a meter with gateway capabilities is installed on an Ethernet network, a master device (such as an energy management system) can communicate through the gateway meter to a serial network of devices connected to the gateway meter’s serial port(s). The maximum number of devices on the serial network is determined by the limitations of the gateway meter’s serial port.
There are two types of Ethernet gateways that you can configure on your meter:

- **EtherGate:** a single TCP connection communicates through the gateway meter to a serial network of devices.
- **Modbus gateway:** up to a maximum of 32 Modbus master TCP connections communicate through the gateway meter to a serial network of Modbus devices.

**EtherGate**

The meter can function as an Ethernet gateway (EtherGate).

EtherGate is a protocol-agnostic communications method that lets you communicate through a gateway meter to a serial network of devices letting ION or other RTU over TCP data pass through the gateway meter to other networks, including third party systems. When a meter installed on the Ethernet network has EtherGate enabled, a master device (such as an energy management system) can communicate through the gateway meter to a serial network of devices wired to the gateway meter’s COM port. You must create an additional communications connection to the gateway meter in order to read its information.

**NOTE:** EtherGate supports only one master device.

Before proceeding, make sure you have completed the following tasks:

- Confirm the serial network of devices are wired to the gateway meter’s serial communication port.
- Confirm all serial devices are configured to have the same baud rate, serial port settings (for example, 8N1), and protocol (ION).
- Confirm each serial device has a unique unit identifier (unit ID/address).
- Confirm your gateway meter is communicating over Ethernet.

**Configuring EtherGate using ION Setup**

Use ION Setup to configure EtherGate communications on your meter.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Communications > Serial settings**.
4. Select the tab (**Com1** or **Com4**) for the serial port you want to configure.
5. Highlight the parameter and click **Edit**. Enter the meter password if prompted, change the setting, then click **OK** to save the changes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>EtherGate</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Serial port settings must match the settings for all connected serial devices</td>
</tr>
<tr>
<td>Serial Port</td>
<td></td>
</tr>
</tbody>
</table>

6. Create an Ethernet gateway site to access the serial network of devices through your gateway meter.

**Configuring EtherGate using the webpages**

You can use the meter’s webpages to configure EtherGate communications on your meter.

1. Connect to your meter’s webpages.
2. Navigate to **Setup > Serial Port**.
3. Expand Basic Settings or Advanced Settings and modify the settings for the serial port you are configuring for EtherGate communications (COM1 / RS485#1 or COM4 / RS485#2).
4. Change the settings, then click **Apply**. Click **Yes** to save the changes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>EtherGate</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Serial port settings must match the settings for all connected serial devices</td>
</tr>
<tr>
<td>Serial Port</td>
<td></td>
</tr>
</tbody>
</table>

You can use ION Setup to create an Ethernet gateway site and access the serial network of devices connected through the EtherGate meter.

**Configuring EtherGate using the display**

Use the meter’s display to configure a serial port to use the EtherGate protocol.

1. Press the **Home** button.
2. Navigate to **Setup Menu > Communications Setup**.
3. Press **Select**.
4. Scroll then select **COM1 Setup** or **COM4 Setup**.
5. Highlight the parameter and press **Edit**. Enter the meter password if prompted, change the setting, then press **Select** to save the changes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>EtherGate</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Serial port settings must match the settings for all connected serial devices</td>
</tr>
<tr>
<td>Serial Port</td>
<td></td>
</tr>
</tbody>
</table>

You can use ION Setup to create an Ethernet gateway site and access the serial network of devices connected through the EtherGate meter.

**Modbus Ethernet gateway**

A Modbus Ethernet gateway allows multiple Modbus masters on the LAN / WAN to connect to downstream serial Modbus slave devices.
A Modbus master device, such as an energy management system, can communicate through the gateway meter to a serial network of devices connected to the gateway meter’s serial port(s). The meter receives Modbus TCP/IP data on TCP port 502, translates it to Modbus RTU then forwards it to the addressed slave device.

This functionality allows the use of monitoring software to access information from slave devices for data collection, trending, alarm/event management, analysis, and other functions.

**Modbus Ethernet gateway implementation**

There are some specific aspects to your meter’s Modbus Ethernet gateway implementation.

A Modbus request is sent through Ethernet using Modbus/TCP to the gateway meter. If this request is addressed with the slave ID of one of the downstream serial devices, the meter forwards the message to that device using Modbus RTU. When the downstream device responds, the gateway meter forwards the response back to the Modbus master. In addition to Modbus slave addresses 1 - 247, the Modbus gateway supports slave address 255, which sends a Modbus request to the gateway meter only.

For Modbus gateway, you must install the serial Modbus slave devices, configure them and connect them to your Ethernet-connected Modbus gateway meter. Ensure that each serial device is configured to communicate over Modbus with the same baud rate and has a unique unit ID. Configure the gateway meter’s serial port to use the Modbus master protocol and enable the Modbus gateway feature, create a Modbus gateway site in ION Setup or an energy management system, and add the serial devices to the Modbus gateway site.

**NOTE:** Modbus Ethernet gateway supports up to 32 Modbus TCP connections.

**Configuring a Modbus gateway using ION Setup**

You can configure Modbus gateway on your meter using ION Setup.

Before you begin, make sure you have completed the following tasks:

- Confirm the serial network of devices are wired and configured to have the same baud rate, serial port settings (for example, 8N1), and protocol (Modbus).
- Confirm each serial device has a unique unit identifier.
- Confirm the serial network of devices are connected to the gateway meter’s serial communication port.
- Confirm your gateway meter is communicating over Ethernet.
- Confirm that the Modbus RTU and Modbus TCP/IP Ethernet protocols are enabled on your gateway meter.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Communications > Serial settings** and select the tab for the communications port that the serial network is connected to.
4. Select **Protocol** and click **Edit**.
   The protocol selection screen appears.
5. Set the protocol to **Modbus Master**.
6. Navigate to **Communications > Basic Ethernet** and select the **TCP/IP** tab.
7. Select **Modbus Gateway** and click **Edit**.
   The Modbus gateway selection screen is displayed.
8. Select the communications port that the serial network is connected to (and you just set to use the Modbus master protocol) and click OK. The Modbus gateway connection is created.

9. Create an Ethernet gateway site to access the serial network of devices through your gateway meter.

Creating an Ethernet gateway site using ION Setup

You can create an EtherGate or Modbus gateway site in ION Setup to view serial devices connected to your meter when it is functioning as an Ethernet gateway.

You must have Ethernet gateway communications configured and your gateway and serial devices connected and communicating.

1. Start ION Setup.
2. Right-click on your workstation icon and select Insert Item. The New Network Item dialog appears.
3. Select Site and click OK. The New Site dialog appears.
4. Select the General tab and configure the site.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values/Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>-</td>
<td>Ethernet gateway site name</td>
</tr>
<tr>
<td>Comm Link</td>
<td>Ethernet</td>
<td>Ethernet communications</td>
</tr>
<tr>
<td>Ethernet options</td>
<td>Gateway</td>
<td>Ethernet gateway communications</td>
</tr>
<tr>
<td>Gateway Info: IP Addr</td>
<td>-</td>
<td>IP address of the Ethernet gateway meter</td>
</tr>
</tbody>
</table>
| Gateway Info: Port | 7801, 7802, 502| • 7801 for EtherGate (Com1)  
• 7802 for EtherGate (Com4)  
• 502 for Modbus gateway |

5. Click OK to create the site.
6. Right-click on your newly created site and select Insert Item. The New Network Item dialog appears.
7. Make sure your newly created Ethernet gateway site is selected in Attach to.
8. Select Device and click OK. The New Device dialog appears.
9. Enter the details of your serial device. Click OK to add the serial device to your Ethernet gateway site.
10. Repeat for all the serial devices on the gateway meter.

    NOTE: Use a separate standard Ethernet connection in ION Setup to connect to and read data from your Ethernet gateway meter.

HTTP

HTTP (HyperText Transfer Protocol) is the standard protocol used by a web browser to establish communication between a client computer and the meter’s web server.
You can view the meter’s webpages by entering the meter’s IP address on a web browser.

HTTP is not a secure communications protocol. To reduce the risk of security threats and help prevent unauthorized access to the meter and the network, configure the meter to always use HTTPS (HyperText Transfer Protocol Secure). The meter uses Ethernet port 80 for HTTP or port 443 for HTTPS.

**HTTPS**

HTTPS uses Transport Layer Security (TLS) encryption to secure the communications channel and protect exchanged data between the client and the server. When configured to use HTTPS, the meter uses the self-signed certificate installed on its webserver.

**Changing HTTP protocol using ION Setup**

You can change the protocol setting for accessing the meter webpages.

It is recommended to use HTTPS or HTTPS with HTTP redirect to avoid compromising the security of your local network.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Communications > Advanced Ethernet** and click the **Protocols** tab.
4. Select the **Web** protocol and click **Edit**. If prompted, enter the meter password.
5. Select the web protocol setting:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>Turns off the meter’s web functionality and blocks all access to the meter web server</td>
</tr>
<tr>
<td>HTTP</td>
<td>Allows non-secure access and unencrypted communications between the client computer and the meter web server</td>
</tr>
<tr>
<td>HTTPS</td>
<td>Allows only secure access and encrypted communications between the client computer and the meter web server</td>
</tr>
<tr>
<td>HTTPS With HTTP Redirect</td>
<td>Redirects all HTTP requests to use the HTTPS web protocol.</td>
</tr>
</tbody>
</table>

You can change the default Assigned Port Numbers for HTTP and HTTPS. This requires appending the changed port number for HTTP or HTTPS access to the meter’s webpages. For example, `<meter IP address>:<changed http or https port number>`.

**Secure website indicator**

A secure website displays a visible indicator such as a lock icon on the web browser.

The web address prefix https:// also indicates that the website is secure.

Web browsers typically prompt or display a message to warn you if a website you are trying to access is not secure. For https connections, this indicates that the website’s SSL certificate is not configured properly or is missing.

**Default SSL certificate and webpages security**

The meter web server protocol is factory-set to HTTPS with HTTP Redirect.
The meter ships from the factory with a self-signed certificate installed, and is set to use HTTPS protocol when accessing the webpages. Because the SSL certificate is self-signed and not signed by a trusted Certificate Authority (CA), almost all browsers will flag the webpages as unsafe.

- If your meter is accessible only inside a secure network, you can add a security exception to override how the browser identifies the webpages.
- If your meter is outside a secure network, you can install an SSL certificate issued by a CA.

**Uploading a custom SSL certificate**

You can upload a custom SSL certificate through the meter webpages. Your meter supports .pem certificate file formats.

1. Use a browser to log in to your meter.
2. Navigate to **Setup > HTTPS**.
3. Click **Upload certificate**.
4. Browse to where you saved the custom certificate, select it then click **Open**.

The certificate is uploaded to the meter, then the browser session is restarted.

**Generating a new self-signed SSL certificate**

You can generate a new self-signed certificate through the meter webpages. A self-signed certificate is valid during the lease period. Generating a new certificate renews the lease.

1. Use a browser to log in to your meter.
2. Navigate to **Setup > HTTPS**.
3. Click **Generate new self-signed certificate**.
   - The meter prompts that the custom certificate will be deleted and that you will be logged out.
4. Click **OK** to proceed.

**Deleting a custom SSL certificate**

You can delete a custom certificate through the meter webpages.

1. Use a browser to log in to your meter.
2. Navigate to **Setup > HTTPS**.
3. Click **Delete custom certificate**.
   - The meter prompts that you will be logged out and that a self-signed certificate will be used.
4. Click **OK** to proceed.

**SFTP**

Your meter has an internal SSH server that can be accessed using an encrypted connection with SFTP (Secure File Transfer Protocol) client software. The SSH server hosts an internal SFTP site and stores files in the meter’s flash memory, such as webpages, COMTRADE records and firmware files.

**Transferring files using SFTP**

Required for this procedure:
• Your meter’s IP address.
• SFTP port number.
• SFTP client software, such as FileZilla or WinSCP.

1. Start the SFTP client software.
2. Navigate to the desired folder > select file(s) for upload.
3. Close the SFTP client software to disconnect from the meter.

Freeing up flash memory

Error messages related to available site space for storing files can be resolved by deleting files using an SFTP client application. Available site space is affected by the number and size of stored files and by features that use flash memory, such as increasing the number of COMTRADE waveform records.

SFTP folders and file permissions

SFTP folder structure:
- **COMTRADE_1 to COMTRADE_3**: View COMTRADE files from these folders. Users have read permission of files.
- **documents**: Add any file type to this folder. Users have full control of files.
- **IEC61850**: Add an IEC 61850 configuration (CID) file to this folder to activate IEC 61850 functionality. Users have full control of files in the root and read permission of files in the log folder.
- **optionModuleUpg** and **rmdUpg**: Upload firmware upgrade files for your meter’s display or option modules to these folders. Users have full control of files.
- **web**: Add custom webpages to the meter by transferring them into web subfolders. This folder is where default meter webpages are stored. Users have full control of files.

SFTP filename requirements

Files uploaded to flash memory using SFTP cannot include: spaces, ",", "/", ",", <, >. Maximum filename length is 68 characters, including the file extension.

Simple Network Management Protocol (SNMP)

Your meter supports SNMP once you have enabled SNMP on your meter. You need to upload the meter’s MIB file (available from www.schneider-electric.com) into the NMS managing your meter.

Simple Network Management Protocol (SNMP) is part of the Transmission Control Protocol/Internet Protocol (TCP/IP) protocol suite. SNMP is an application layer protocol that enables the exchange of network management information between devices, allowing you to manage network performance and to identify and solve problems on networks with devices of various types.

SNMP configuration assumes that you have an advanced understanding of SNMP and the communications network and power system that your meter is connected to.
Key terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Software resident on the managed device which interfaces between the</td>
</tr>
<tr>
<td></td>
<td>device and the NMS.</td>
</tr>
<tr>
<td>Managed device</td>
<td>Your meter in the SNMP network.</td>
</tr>
<tr>
<td>Community name/</td>
<td>A text string that helps authenticate requests between the managed</td>
</tr>
<tr>
<td>string</td>
<td>device and the NMS.</td>
</tr>
<tr>
<td>Managed object</td>
<td>Any parameter referenced in the MIB file.</td>
</tr>
<tr>
<td>MIB</td>
<td>A management information base which organizes the OIDs in a</td>
</tr>
<tr>
<td></td>
<td>hierarchical tree.</td>
</tr>
<tr>
<td>NMS</td>
<td>A network management station, manager or client that executes</td>
</tr>
<tr>
<td></td>
<td>applications to monitor and control devices. An NMS must have the</td>
</tr>
<tr>
<td></td>
<td>standard and custom MIB files and SNMP manager software.</td>
</tr>
<tr>
<td>OID</td>
<td>An object identifier that uniquely identifies and labels a managed object</td>
</tr>
<tr>
<td></td>
<td>in the MIB.</td>
</tr>
<tr>
<td>Trap receiver</td>
<td>An NMS that is configured to receive traps and whose IP address is an</td>
</tr>
<tr>
<td></td>
<td>SNMP trap destination.</td>
</tr>
</tbody>
</table>

The meter in an SNMP system

Your meter is a managed device with an SNMP agent in an SNMP network.

![Diagram](image)

A. Trap receiver(s)  
B. SNMP agent (meter)  
C. NMS with SNMP manager software and MIB file installed

**NOTE:** The NMS computer can also function as a trap receiver.

SNMP trapping

SNMP trapping allows your meter’s agent to notify the NMS of events with an unsolicited SNMP message (a “trap” of the meter’s alarm event).

You can enter up to four IP addresses for SNMP trap notification for generic and enterprise-specific traps. For enterprise traps, you must also define the number of events or maximum time delay before SNMP traps are sent to the NMS.

SNMP trapping is only supported on SNMP v2.
Configuring SNMP using ION Setup

You can enable SNMP and configure SNMP trapping using ION Setup.

You must download the ION MIB file from www.schneider-electric.com

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to Communications > Advanced Ethernet and select the SNMP tab.
4. Configure your meter’s SNMP parameters by selecting the parameter and clicking Edit. Click OK in the editing screen to set the parameter value.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNMP</td>
<td>Enables or disables SNMP on your meter.</td>
</tr>
<tr>
<td>Enable Traps</td>
<td>Enables or disables SNMP trapping on your meter.</td>
</tr>
<tr>
<td>Trap Rcvr1 Addr — Trap Rcvr4 Addr</td>
<td>Enter up to four trap receiver IP addresses where trap messages will be sent.</td>
</tr>
<tr>
<td>Read only community</td>
<td>Enter the community string used for SNMP get (read-only) requests.</td>
</tr>
<tr>
<td>Read write community</td>
<td>Enter the community string used for SNMP set (read/write) requests.</td>
</tr>
<tr>
<td>System contact</td>
<td>Enter the name of your SNMP system administrator.</td>
</tr>
<tr>
<td>System name</td>
<td>Enter a descriptive name for your meter.</td>
</tr>
<tr>
<td>System location</td>
<td>Enter your meter’s location.</td>
</tr>
</tbody>
</table>

5. Review the rest of the SNMP information and modify if necessary.

Configuring SNMP using your meter’s webpages

You can configure SNMP trapping using your meter’s webpages.

You must download the ION MIB file from www.schneider-electric.com.

1. Connect to your meter’s webpages.
2. Go to Setup > SNMP Parameters.
3. Configure your meter’s SNMP parameters by selecting the parameter value.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNMP</td>
<td>Yes/no</td>
<td>Enables or disables SNMP on your meter.</td>
</tr>
<tr>
<td>SNMP Port Number</td>
<td>161 (default)</td>
<td>Enter your meter’s SNMP port number.</td>
</tr>
<tr>
<td>System contact</td>
<td>—</td>
<td>Enter the name of your SNMP system administrator.</td>
</tr>
<tr>
<td>System name</td>
<td>—</td>
<td>Enter a descriptive name for your meter.</td>
</tr>
<tr>
<td>System location</td>
<td>—</td>
<td>Enter your meter’s location.</td>
</tr>
<tr>
<td>Read-only Community Name</td>
<td>—</td>
<td>Enter the community string used for SNMP get (read-only) requests.</td>
</tr>
<tr>
<td>Read-write Community Name</td>
<td>—</td>
<td>Enter the community string used for SNMP set (read/write) requests.</td>
</tr>
<tr>
<td>Enable SNMP Traps</td>
<td>Enable/disable</td>
<td>Enables or disables SNMP trapping on your meter.</td>
</tr>
<tr>
<td>Enable High Priority Alarms</td>
<td>Yes/no</td>
<td>Enables trapping of events that create high priority alarms.</td>
</tr>
<tr>
<td>Enable Med Priority Alarms</td>
<td>Yes/no</td>
<td>Enables trapping of events that create medium priority alarms.</td>
</tr>
<tr>
<td>Enable Low Priority Alarms</td>
<td>Yes/no</td>
<td>Enables trapping of events that create low priority alarms.</td>
</tr>
<tr>
<td>Report Buffer Size</td>
<td>1 - 30</td>
<td>Enter the maximum number of trap messages to be stored before the trap messages are sent. Traps are sent when the number of trap messages is equal to or greater than this value.</td>
</tr>
<tr>
<td>Report Hold Time</td>
<td>1 - 300 seconds</td>
<td>Enter the maximum duration for trap messages to be held. Trap messages are sent when the time after a trap event has occurred is equal to or greater than this value.</td>
</tr>
<tr>
<td>Trap Rcvr1 Addr - Trap Rcvr4 Addr</td>
<td>—</td>
<td>Enter up to four trap receiver IP addresses, where trap messages will be sent.</td>
</tr>
</tbody>
</table>

4. Click **Apply** to configure the meter’s SNMP parameters.

**SNMP implementation**

**MIB files**

Your meter is compliant with MIB-II as defined by the standard MIB file RFC 1213.

SNMP requires that you load your meter’s ION MIB file (available for download from www.schneider-electric.com) into the NMS.

You must install RFC 1213, which is required to read basic network information for the meter (for example, TCP/IP traffic or number of packets received), if it is not included with your SNMP manager software.

**Community strings**

A community string is a text string which acts to help authenticate requests from the NMS to your meter.

There are two community strings on your meter:

- Read Only Community: this community string is used by SNMP get (read-only) requests. The read only community string’s initial factory-set value is **public**.
- Read Write Community: this community string is used by SNMP set (read/write) requests. The read write community string’s initial factory-set value is **private**.

**NOTE:** You can also use the read write community string for SNMP get (read-only) requests.

If your meter receives an incorrect community string, it generates an AuthenticationFailure trap.
System strings

A system string is a text string which can be configured to provide information about your meter.

There are three system strings on your meter:
- System contact: enter the name of the SNMP system administrator.
- System name: enter a descriptive name for your meter.
- System location: enter a description of your meter’s location.

SNMP trapping implementation

Generic SNMP traps supported by your meter are:
- Coldstart: the meter (SNMP agent) is starting.
- Linkup: the SNMP agent is enabled.
- AuthenticationFailure: the meter (SNMP agent) has received an incorrect community value.

Enterprise-specific SNMP traps supported by your meter are:
- Low: trap of events with a low event priority.
- Medium: trap of events with a medium event priority.
- High: trap of events with a high event priority.

<table>
<thead>
<tr>
<th>Trap</th>
<th>Event priority range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>64–127</td>
</tr>
<tr>
<td>Medium</td>
<td>128–191</td>
</tr>
<tr>
<td>High</td>
<td>192–255</td>
</tr>
</tbody>
</table>

**NOTE:** The number of events or maximum time delay settings only apply to enterprise SNMP traps.

See the ION Reference, available from www.schneider-electric.com, for detailed information on the SNMP Mapping, SNMP Options and Alarm Options modules.

Default SNMP mapping

Enabling SNMP provides SNMP access to the meter values linked to the SNMP Mapping module.

You can configure the SNMP Mapping module to link to different meter values. By default, the following meter values are linked to the SNMP Mapping module:

<table>
<thead>
<tr>
<th>Ia</th>
<th>kVAR tot</th>
<th>Vll ca</th>
<th>Vln avg</th>
<th>Ic mean</th>
<th>kW sd mx del-rec</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ib</td>
<td>kVA tot</td>
<td>Vll avg</td>
<td>Freq</td>
<td>lc mx</td>
<td>kW sd del</td>
</tr>
<tr>
<td>Ic</td>
<td>PF sign tot</td>
<td>Vln a</td>
<td>la mx</td>
<td>lc mean</td>
<td>kW sd rec</td>
</tr>
<tr>
<td>I avg</td>
<td>Vll ab</td>
<td>Vln b</td>
<td>la mean</td>
<td>kW sd mx del</td>
<td>kW sd del-rec</td>
</tr>
<tr>
<td>kW tot</td>
<td>Vll bc</td>
<td>Vln c</td>
<td>lb mx</td>
<td>kW sd mx del</td>
<td>kW sd del-rec</td>
</tr>
<tr>
<td>kVAR sd mx rec</td>
<td>kVAR sd mx del-rec</td>
<td>kVAR sd del</td>
<td>kVAR sd rec</td>
<td>kVAR sd del-rec</td>
<td></td>
</tr>
<tr>
<td>kVA sd mx rec</td>
<td>kVA sd mx del-rec</td>
<td>kVA sd del</td>
<td>kVA sd rec</td>
<td>kVA sd del-rec</td>
<td></td>
</tr>
<tr>
<td>kWh rec</td>
<td>kWh del-rec</td>
<td>kVARh del</td>
<td>kVARh rec</td>
<td>kVARh del-rec</td>
<td></td>
</tr>
<tr>
<td>kVAh rec</td>
<td>kVAh del-rec</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following meter information is always provided by default and cannot be configured:
If you change your meter’s default values, you must modify the custom MIB file to reflect the new values.

Changing your meter’s default SNMP configuration assumes that you have an advanced understanding of ION architecture, SNMP, and the communications network and power system that your meter is connected to.

See the ION Reference, available from www.schneider-electric.com, for detailed information on the SNMP Mapping module.

**Configuring your SNMP MIB file**

You must configure your MIB file if you have modified the default SNMP information provided by the meter in order for the MIB file labels to reflect the modified values.


**NOTE:** You should only configure the variable name and description. Changing other fields in your MIB file may cause the client software to report problems or return errors when trying to retrieve or view parameters.

The variable name must conform to the following rules:

- The first character must be a letter.
- The first character must be lower case.
- The name must not contain any special characters such as *, ?, &.
- The name must not contain spaces.

1. Open your meter’s MIB file in a text editing program (such as Notepad).
2. Update the variable name and description so they match the meter values connected to the SNMP Mapping module.
3. Save your meter’s MIB file. Keep the original file extension of .MIB.

This example shows an original and an updated OID entry in an MIB file, where the default meter value of voltage line-to-neutral phase A is modified in the meter’s SNMP Mapping module and is now connected to voltage line-to-neutral phase C.

<table>
<thead>
<tr>
<th>Original OID entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vln_a OBJECT-TYPE</td>
</tr>
<tr>
<td>SYNTAX DisplayString (SIZE (0..255))</td>
</tr>
<tr>
<td>ACCESS read-only</td>
</tr>
<tr>
<td>STATUS mandatory</td>
</tr>
<tr>
<td>DESCRIPTION &quot;Host Meter Voltage Line A to Neutral Units = V (Volts)&quot; ::= { Schneider Electric 34 }</td>
</tr>
</tbody>
</table>

You must update the variable name and description to match the meter values connected to the SNMP Mapping module:

<table>
<thead>
<tr>
<th>Value</th>
<th>Original</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable name</td>
<td>Vln_a</td>
<td>Vln_c</td>
</tr>
<tr>
<td>Description</td>
<td>&quot;Host Meter Voltage Line A to Neutral Units = V (Volts)&quot; ::= { Schneider Electric 34 }</td>
<td>Host Meter Voltage Line C to Neutral Units = V (Volts)&quot; ::= { Schneider Electric 34 }</td>
</tr>
</tbody>
</table>

The SNMP client software reads the original and updated file as follows:
IEC 61850

IEC 61850 is an Ethernet-based communications protocol designed for electrical substations.

Your meter can be integrated into an IEC 61850 system as an Intelligent Electronic Device (IED) or server that supports concurrent IEC 61850 client connections and an SFTP connection.

Go to the IEC International Electrotechnical Commission website at www.iec.ch for more information on the IEC 61850 protocol.

Refer to the IEC 61850 and ION technology protocol document at www.schneider-electric.com for information about setup and configuration.

Mapping additional data to IEC 61850

Map additional data, such as Inputs and Outputs, to IEC 61850. It is not necessary to have IEC 61850 enabled on your meter to perform this procedure.

1. OpenION Setup > select the meter > Setup Assistant.
3. Highlight a parameter to add to IEC 61850 data. Select analog for numeric information and digital for Boolean or binary information.
4. Click Edit. The custom configuration screen is displayed.
5. Select the desired meter value. If the value you want is not shown, select Show all available registers.
6. Select an IEC 61850 item:
   – Click >> to map the value.
   – Click << to unmap values.
7. Click OK.

Enabling IEC 61850 functionality

Your meter is configured with a default set of data available to IEC 61850 that can be integrated into a IEC 61850 system. To enable this functionality, upload a CID (Configured IED Description) file to your meter.

If more than one CID file is stored in the meter, IEC 61850 functionality is deactivated until additional files are deleted.

Required for this procedure:
- CET850 IEC 61850 configuration tool installed on your computer. Download the software at www.schneider-electric.com.
- Meter connection using ION Setup over IPv4 Ethernet.
- Download the firmware package for your meter and select an ICD (IED Capability Description) file that matches your meter’s profile. Go to www.schneider-electric.com and search for firmware and associated files (ZIP) for your meter.
1. Open the CET850 IEC 61850 configuration tool.
2. File > New.
3. **Add > IED.** The Add IED dialog box opens.

4. Click the more options ... button in the IED identification area. The Add a Device dialog box opens.

5. Select Other device.

6. Click the more options ... button.

7. Browse to the location of the ICD file, select it and click Open.

8. Click OK.

9. Enter values for the device in the IED dialog box and click OK.

10. **File > Build a CID file.**

11. Click Yes on the CET850 message box.

12. Save the file as a SCD file. The Save as dialog box opens.

13. Ensure CID files (cid) is selected and click Save.

14. Close the CET850 IEC 61850 configuration tool.

15. Open ION Setup > select the meter > Setup Assistant.

    **NOTE:** The CID file can also be uploaded using SFTP. Refer to SFTP folders and file permissions, page 64 for more information.

16. **Communications folder > 3rd Party Protocols > IEC 61850 > Upload CID.**

17. Navigate to the CID file, select it and click Open. CID file validation can take several minutes.

    The CID status on the IEC 61850 tab indicates if the meter is operating as an IEC 61850 IED or server.

    Watch the video on *How to Enable IEC 61850 Functionality on Your Meter*

### Configuring digital outputs for IEC 61850 control

Configure default settings for digital outputs to use IEC 61850 for non-critical control of the meter’s digital outputs.

This procedure is optional. Your meter has a comprehensive default settings for IEC 61850 that meets the needs of most systems without configuration. This is an advanced procedure that requires in-depth knowledge of your meter, its underlying architecture and the system in which it is installed.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
</table>

**UNINTENDED OPERATION**

Do not use this device for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

**Failure to follow these instructions can result in death, serious injury, or equipment damage.**

1. Open ION Setup.

2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

3. **IEC 61850 GGIO Onb Modules** folder > double-click module > **Setup Registers.**

4. Select the desired **SPCS Control Mode** register > Edit. A dialog opens.

5. Select IEC 61850 CtlVAL from the drop-down list > **OK** > Inputs.
6. Select the digital output Status register > **Delete**.
   
   **NOTE:** This digital input register must be deleted in order to prevent a circular reference that will cause the affected modules to go offline.

7. Click **Send**.

8. Navigate to the **Digital Out Modules** folder > double-click on the module selected to control via IEC 61850.

9. Select the **Setup Registers** tab and confirm that the Digital Output module’s setup registers are configured.

10. **Inputs** > **Source** register > **Edit**.

11. Navigate to the IEC 61850 Ggio Onb folder and select the **SPCS.stVal** output register that corresponds to the digital output.

12. Click **OK** > **Send**.

   Refer to the ION Reference document at www.schneider-electric.com for information about IEC 61850 Ggio and Digital output modules.

### Deleting an IEC 61850 configuration file

1. Open SFTP client software. See “SFTP”, page 63 for information connecting with SFTP client software.

2. Connect to the meter using the meter’s IP address and SFTP port number. See “Protocols, ports and connections”, page 31 for information on port numbers.

3. Open the **IECG1850** folder in SFTP file directory and delete the CID file.


### DNP

Your meter can be integrated into a DNP network as a DNP slave.

The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used in the electric utility industry for communications and interoperability among substation computers, Remote Terminal Units (RTUs), Intelligent Electronic Devices (IEDs, e.g. meters), and master stations.

### DNP supported features and default implementation

Your meter is pre-configured for basic DNP Slave functionality.

Your meter supports a maximum of three concurrent connections (sessions) using the DNP 3.0 protocol; one for each serial port, up to three using Ethernet, or a combination of both. Combinations available depend on the meter’s communications options. A session consists of all incoming and outgoing DNP Master/Slave traffic on one of the meter’s communications ports.

For serial DNP communications, you must assign the DNP protocol to the appropriate serial communication port on your meter; you do not have to configure your meter’s Ethernet port(s).

You can modify your meter’s default DNP map using configuration software.

Data can be imported into the meter from a DNP control relay or analog output device. This is an advanced feature intended for users with an in-depth understanding of the DNP 3.0 and ION protocols.

See the online ION Setup help for instructions on connecting to your meter and accessing the Setup Assistant, which can be used to modify your meter’s DNP port settings and default DNP map. Go to www.schneider-electric.com to
download the *Multiport DNP 3.0 and ION technology* technical note for more information on how your meter supports DNP 3.0.

**DLMS/COSEM**

The Device Language Message Specification (DLMS) is described by the international standard IEC 62056. It defines structured modeling and meter data exchange for an interoperable environment.

DLMS supports applications such as remote meter reading, remote control, and value-added services for metering different kinds of energy, such as electricity, water, gas or heat.

COSEM stands for Companion Specification for Energy Metering. It is an interface model for communicating with energy metering equipment, providing a view of the functionality available through the communications interfaces. The model uses an object-oriented approach.

The COSEM model allows for a manufacturer-independent and controlled method to identify, retrieve and interpret the information held in any meter.

See the *DLMS/COSEM and ION technology* technote for more information about how DLMS is implemented on your meter.
Inputs / outputs

I/O overview

Your meter has onboard digital I/O which can be increased by adding optional digital and analog I/O modules to expand your meter’s I/O capabilities.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UNINTENDED OPERATION</strong></td>
</tr>
<tr>
<td>Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.</td>
</tr>
<tr>
<td><strong>Failure to follow these instructions can result in death, serious injury, or equipment damage.</strong></td>
</tr>
</tbody>
</table>

Your meter base has:
- eight digital inputs
- four form A digital outputs
- two form C relays
- kWh energy pulsing LEDs (one visible, one infrared)
- kWVARh energy pulsing LEDs (one visible, one infrared)

You can view information about your meter’s I/O through the display and webpages, and configure your meter’s I/O using ION Setup.

Input/output ION modules

ION modules are used to configure your meter’s digital or analog inputs/outputs (I/O).

You need to configure the following ION modules in order to use the meter’s digital or analog I/O.
- Digital input: uses the Digital Input module, which tells the meter how to interpret incoming signals.
- Digital output: uses one of three ION modules depending on the application.
  - Digital Output module: monitors a change of state to control relay operation via a hardware output device.
  - Pulser module: transfers high-speed pulses to a hardware pulse counting device that is used to track energy usage.
  - Calibration Pulser module: integrates instantaneous power inputs, then outputs high-speed pulses to an LED that can be monitored for energy accuracy verification.
- Analog input: uses the Analog Input module, which tells the meter how to interpret an incoming analog voltage or current signal from transducers.
- Analog output: uses the Analog Output module to deliver a continuous direct voltage or current analog signal to transducers.

**NOTE:** All of these modules can act as intermediaries between the physical hardware port and the other modules in the meter. They define the characteristics of the incoming and outgoing signals.
Input/output ION modules, ports and labels

You can configure the Digital Output, Digital Input, Analog Input, Analog Output, Pulser and Calibration Pulser ION modules to specify which port handles the outgoing or incoming signals.

To assign a port to one of these modules, simply modify the Port setup register by picking a port from the enumerated list.

**NOTE:** If the port you want to use does not appear in the Port setup register list, that port is in use by another module. Edit the Port setup register of the module using that port and set it to Not Used. The port is then available to other modules.

Factory configured settings

### Onboard input and output ports

<table>
<thead>
<tr>
<th>ION module type</th>
<th>ION module name</th>
<th>Hardware port (device label)</th>
<th>Port setup register name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Output</td>
<td>Port D1 – D4</td>
<td>D1 – D4</td>
<td>Port D1 – D4</td>
<td>Form A relay</td>
</tr>
<tr>
<td></td>
<td>Port R1 – R2</td>
<td>R1 – R2</td>
<td>Port R1 – R2</td>
<td>Form C relay</td>
</tr>
<tr>
<td>Calibration Pulser</td>
<td>WATT LED</td>
<td>kWATT</td>
<td>WATT LED</td>
<td>kW energy pulsing (total)</td>
</tr>
<tr>
<td></td>
<td>VAR LED</td>
<td>kVAR</td>
<td>VAR LED</td>
<td>kVAR energy pulsing (total)</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Port S1 – S8</td>
<td>S1 – S8</td>
<td>Port S1 – S8</td>
<td>Internally/ externally excited</td>
</tr>
</tbody>
</table>

### Option module(s) input and output ports

<table>
<thead>
<tr>
<th>ION module type</th>
<th>ION module name</th>
<th>Hardware port (device label)</th>
<th>Port setup register name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Input</td>
<td>Port A/B/C/D S1- S6</td>
<td>S1 - S6</td>
<td>Port A S1 - S6</td>
<td>Option module digital inputs</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port B S1 - S6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port C S1 - S6</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port D S1 - S6</td>
<td></td>
</tr>
<tr>
<td>Digital Output</td>
<td>Port A/B/C/D D1 - D2</td>
<td>Relay 1 - Relay 2</td>
<td>Port A D1 - D2</td>
<td>Option module digital output</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port B D1 - D2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port C D1 - D2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port D D1 - D2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port B A1 - A4</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port C A1 - A4</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port D A1 - A4</td>
<td></td>
</tr>
<tr>
<td>Analog Output</td>
<td>Port A/B/C/D Q1 - Q2</td>
<td>Q1 - Q2</td>
<td>Port A Q1 - Q2</td>
<td>Option module analog output</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port B Q1 - Q2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port C Q1 - Q2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Port D Q1 - Q2</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** When configuring your meter, the configuration interface may show all of the possible ports, regardless of what is physically available on your meter.

See the ION Reference, available from www.schneider-electric.com for more information about ION modules.
I/O option modules

I/O option modules provide increased digital and analog input/output (I/O) capabilities for your meter.

These I/O modules can be used to monitor the status of breakers, control analog or digital transducers, or receive signals that can be interpreted to provide WAGES data for your energy system. For applications requiring high accuracy, such as energy pulsing to verify accuracy, the digital output on the meter base is recommended.

**NOTE:** Your meter’s digital and analog outputs may change state during a firmware upgrade. Option modules are offline during an option module firmware upgrade; they will not communicate to the meter and the outputs may change state during the upgrade process.

Your meter’s analog I/O option modules can measure and output either low voltage or current using standard analog transducers such as 4 - 20 mA current transducers.

I/O option module data viewing

View I/O option module data using ION Setup, meter webpages or through the display.

To view option module data using ION Setup, start ION Setup and open the Setup Assistant for your meter. Select **Expansion Modules > Option I/O Modules** then select the desired I/O option module tab. If there are no I/O option modules connected, no information other than column headers is displayed.

To view option module data using meter webpages, connect to your meter’s webpages, go to **Monitoring > Inputs/Outputs** and select **Digital Inputs**, **Digital Outputs**, **Analog Inputs** or **Analog Outputs**. If there are no I/O option modules of the specified type, no entries other than column headers are displayed.

To view option module data using the display, go to **Inputs/Outputs** and select **Digital Inputs**, **Digital Outputs**, **Analog Inputs** or **Analog Outputs**.

Option I/O modules configuration

You can configure your meter’s I/O option modules using ION Setup.

The Option I/O Modules screen has tabs corresponding to the possible option modules, which are identified based on how the option modules are connected to the meter. Each tab indicates the module’s type and status, and has an area where the module’s ports are listed for viewing and configuration. You can also reset your meter’s option modules using ION Setup.

<table>
<thead>
<tr>
<th>Status examples</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No option module detected</td>
</tr>
<tr>
<td>Normal</td>
<td>The option module is operating normally</td>
</tr>
<tr>
<td>Option module added</td>
<td>A new option module is detected</td>
</tr>
<tr>
<td>Option module removed</td>
<td>The option module has been removed</td>
</tr>
<tr>
<td>Invalid S19</td>
<td>The option module’s firmware is not supported</td>
</tr>
<tr>
<td>Invalid card</td>
<td>The option module type is not supported</td>
</tr>
</tbody>
</table>
Analog inputs

Analog input applications

You can use an analog input to monitor an analog signal, for example a flowmeter, to monitor how much water flows through a pipe.

For analog input operation, your meter takes an analog input signal and provides the resulting scaled value.

Your meter’s analog I/O option modules can measure either low voltage or current using standard analog transducers such as 4 - 20 mA current transducers.

Analog input voltage and current mode

You can set the analog input’s mode for voltage or current sensing.

In current mode, the analog inputs have a low input resistance while the meter is powered on, and a high input resistance when the meter is powered off. In voltage mode, the analog inputs have a high input resistance regardless of whether the meter is powered or not.

**NOTE:** When unpowered, your meter’s analog inputs act like they are in voltage mode (high input resistance).

When connected to a current output transducer, this high resistance can create a high voltage. Standard (i.e., 4 to 20 mA) current transducers have open circuit protection and are able to handle a high input resistance; however, if non-standard transducers are used high voltages may be generated. Your meter’s analog input has circuitry to limit this voltage, but it may not be sufficient with a very high-power current source.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
</table>

**EQUIPMENT DAMAGE**

- Ensure the analog input is configured for the correct voltage or current mode before connecting or activating the current transducer.
- Do not exceed the device’s ratings for maximum limits.

**Failure to follow these instructions will result in equipment damage.**

Analog input behavior

Analog inputs may show a value below zero scale if an open circuit is detected on the input port.

Analog input zero scale and full scale values

Configure your analog input’s zero and full scale values.

In most cases the output range of the sensor feeding the analog input matches the hardware limits of your meter’s analog input port. In that case, the analog input’s zero scale and full scale values are the same as the sensor’s represented range. For example:
### Analog sensor

| 0 - 50 psi represented by a 4 - 20 mA signal | 4 - 20 mA analog input range Input value: 12 mA | Full scale = 50 (psi)  
Zero scale = 0 (psi)  
Scaled value: 25 (psi) |

| 0 - 50 psi represented by a 0 - 20 mA signal | 0-20 mA analog input range Input value: 12 mA | Full scale = 50 (psi)  
Zero scale = 0 (psi)  
Scaled value: 30 (psi) |

If the sensor’s output range does not match your meter’s hardware limits, you must calculate the full scale and/or zero scale values by analyzing the system.

See the ION Reference, available from www.schneider-electric.com, for detailed information about the Analog Input module and full scale and zero scale calculations.

### Configuring option module analog inputs using ION Setup

You can configure analog inputs using ION Setup.

Analog inputs are available on the optional I/O modules.

Calculate your zero scale and full scale values based on the analog source and the input range of your meter.

Make sure that the analog input port that you want to use is properly configured and connected to a valid external analog signal source.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Expansion Modules > Option I/O Modules** and select the module tab that corresponds to the option module with the analog input you want to configure.
4. Select the analog input channel and click **Edit**. Enter the meter password if prompted. The setup screen for that analog input is displayed.
5. Configure the analog input by selecting the parameter and clicking **Edit**.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero scale</td>
<td>0 to ±10^9</td>
<td>The minimum source value that matches the minimum analog input signal.</td>
</tr>
<tr>
<td>Full scale</td>
<td>0 to ±10^9</td>
<td>The maximum source value that matches the maximum analog input signal.</td>
</tr>
<tr>
<td>Port</td>
<td>–</td>
<td>The physical analog input port connection.</td>
</tr>
<tr>
<td>Mode</td>
<td>Voltage, current</td>
<td>Determines whether the analog input is monitoring voltage or current.</td>
</tr>
<tr>
<td>Update Rate</td>
<td>One Second/High Speed</td>
<td>Defines how frequently the input is updated.</td>
</tr>
</tbody>
</table>

### Analog outputs

### Analog output applications

You can use an analog output to send a signal to an external analog input, for example an analog-controlled valve, to modify a water pipe’s valve position in order to change the flow rate.

---

4. Analog I/O option module must have firmware version v1.2 or later.
For analog output operation, your meter takes an input value and scales it to the appropriate signal value to send out the physical analog output port.

Your meter’s analog I/O option modules can output either low voltage or current using standard analog transducers such as 4 - 20 mA current transducers.

**Analog output behavior**

Your meter’s analog output, once configured, outputs voltage or current signals. If your meter’s analog output source becomes unavailable (N/A) the analog output level should go to zero (0 V / 0 mA) under most conditions.

When your meter is powered off or configured to send voltage, the meter registers as a high impedance.

The electrical signal on the analog output is DC; make sure proper polarity is observed when wiring external devices to the analog output ports.

**Analog output zero scale and full scale values**

Configure your analog output’s zero and full scale values.

In most cases, your meter’s analog output range matches the range of the analog sensors that your meter’s outputs are connected to. In that case, your meter’s analog output zero scale and full scale values are the maximum and minimum values of the source driving your meter’s analog output. These values are used to normalize the source value to a value between 0 and 1 which is applied to the operating range of the analog output port to determine the analog output current or voltage. For example:

<table>
<thead>
<tr>
<th>Source value</th>
<th>Analog output register values</th>
<th>Meter’s analog output signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 to 120 kW range</td>
<td>Full scale = 120 (kW) Zero scale = 0 (kW) Normalized: 0.83</td>
<td>4 - 20 mA range Output: 17.33 mA</td>
</tr>
<tr>
<td>100 kW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0 to 120 kW range</td>
<td>Full scale = 120 (kW) Zero scale = 0 (kW) Normalized: 0.83</td>
<td>0 - 20 mA range(^5) Output: 16.67 mA</td>
</tr>
<tr>
<td>100 kW</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If your meter’s analog output range does not match the range of the connected analog sensor, you must calculate the full scale and zero scale values by analyzing the system.

See the *ION Reference*, available from www.schneider-electric.com for detailed information about the Analog Output module and full scale and zero scale calculations.

**Configuring option module analog outputs using ION Setup**

You can configure option module analog outputs using ION Setup.

Analog outputs are available on the optional I/O modules you can connect to the base of your meter.

Calculate your zero scale and full scale values based on the measured value and the analog output range of your meter.

Make sure that the analog output port that you want to use is properly connected to an analog receiver.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.

\(^5\) Analog I/O option module must have firmware version v1.2 or later.
3. Navigate to Expansion Modules > Option I/O Modules and select the module tab that corresponds to the option module with the analog output you want to configure.

4. Select the analog output channel and click Edit. Enter the meter password if prompted. The setup screen for that analog output is displayed.

5. Configure the analog output by selecting the parameter and clicking Edit.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero scale</td>
<td>0 to ±10³</td>
<td>The minimum source value that matches the minimum analog output signal.</td>
</tr>
<tr>
<td>Full scale</td>
<td>0 to ±10³</td>
<td>The maximum source value that matches the maximum analog output signal.</td>
</tr>
<tr>
<td>Port</td>
<td>–</td>
<td>The physical analog output port connection.</td>
</tr>
<tr>
<td>Mode</td>
<td>Voltage, current</td>
<td>Determines whether the analog output is monitoring voltage or current.</td>
</tr>
</tbody>
</table>

**Digital inputs**

**Digital input applications**

Digital inputs are typically used for monitoring the status of switches or contacts, such as status contacts on circuit breakers.

They can also be used for pulse counting or input metering applications, such as WAGES (water, air, gas, electricity, steam) monitoring, or conditional energy applications, or IRIG-B time synchronization.

**Pulse mode**

If you set Input Mode to PULSE, a pulse is generated at the Trigger output when the State output changes from OFF-to-ON. No pulse is generated when State changes from ON-to-OFF.

**KYZ mode**

If you set Input Mode to KYZ, a pulse is generated at the Trigger output for each change of state transition, i.e. from OFF-to-ON and from ON-to-OFF transitions.
**A/C mode**

If you set Input Mode to A/C, the digital input port is configured to detect the presence of a low voltage AC signal. The next illustration shows how a digital input can be used to monitor the operation of a low voltage AC fan controller.

![Diagram of fan operation](image)

**IRIG-B time synchronization**

You can use a digital input to synchronize the meter time to an IRIG-B time source.

You can connect an IRIG-B time source to one of meter’s digital inputs for IRIG-B time synchronization; for improved accuracy use the digital inputs on the meter base. For IRIG-B time synchronization, you must configure both the meter’s digital input and the meter’s clock.

**Configuring onboard digital inputs using ION Setup**

You can use ION Setup to configure your meter’s digital inputs.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Onboard I/O > Digital Inputs**. The tabs correspond to each digital input. Click on the tab for the digital input you want to edit.
4. Configure the digital input by selecting the parameter and clicking **Edit**.
5. Once the parameter has been configured, click **OK** to save the setting to the meter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/range</th>
<th>Description</th>
</tr>
</thead>
</table>
| Input Mode      | Pulse, KYZ, A/C, IRIG-B\(^1\) | Specifies how the meter processes the signal:  
  • Pulse: the meter counts an entire pulse (from off-on to on-off) as one input.  
  • KYZ: the meter counts a transition (from off-on or from on-off) as one input.  
  • A/C: the meter detects analog signals where the ON condition is based on the presence of an AC signal  
  • IRIG-B\(^1\): the meter detects an IRIG-B time synchronization signal. |
| Polarity        | Inverting/Non-Inverting      | Specifies if the signal from the digital port is inverted or not inverted.                                                                    |
| Debounce        | 0.000 - 1.000                | Specifies how long (in seconds) the signal must remain in a state to be considered a valid state change.                                        |
| Assigned Port   | Defined by your meter’s hardware | Your meter’s physical digital input port.                                                                                                   |
| EventLog Mode   | Log Off/Log On               | Specifies if events generate log entries.                                                                                                    |
| State           | OFF/ON                       | Indicates the status of the digital input.                                                                                                   |

\(^1\) IRIG-B can only be connected to one of the onboard digital inputs, not an option module. You must also configure your meter’s clock to use IRIG-B time synchronization.

## Configuring option module digital inputs using ION Setup

You can configure option module digital inputs using ION Setup.

Digital inputs are available on your meter. You can add more digital inputs using optional I/O modules.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Expansion Modules > Option I/O Modules** and select the module tab that corresponds to the option module with the digital input you want to configure.
4. Select the digital input channel and click **Edit**.  
The setup screen for that digital input is displayed.
5. Configure the digital input by selecting the parameter and clicking **Edit**.
6. Once the parameter has been configured, click OK to save the setting to the meter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Mode</td>
<td>Pulse, KYZ, A/C, IRIG-B</td>
<td>Specifies how the meter processes the signal:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Pulse: the meter counts an entire pulse (from off-on to on-off) as one input.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• KYZ: the meter counts a transition (from off-on or from on-off) as one input.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• A/C: the meter detects analog signals where the ON condition is based on the presence of an AC signal.</td>
</tr>
<tr>
<td></td>
<td>IRIG-B1</td>
<td>• IRIG-B1: the meter detects an IRIG-B time synchronization signal.</td>
</tr>
<tr>
<td>EvLog Mode</td>
<td>Log Off/Log On</td>
<td>Specifies if events generate log entries.</td>
</tr>
<tr>
<td>Event Priority</td>
<td>0 - 255</td>
<td>Specifies the priority of an event.</td>
</tr>
<tr>
<td>Polarity</td>
<td>Inverting/Non-Inverting</td>
<td>Specifies if the signal from the digital port is inverted or not inverted.</td>
</tr>
<tr>
<td>Debounce</td>
<td>0.000 - 1.000</td>
<td>Specifies how long (in seconds) the signal must remain in a state to be considered a valid state change.</td>
</tr>
<tr>
<td>Port</td>
<td>Defined by your meter's hardware</td>
<td>Your meter’s physical digital input port.</td>
</tr>
<tr>
<td>Enable</td>
<td>Enabled/Disabled</td>
<td>Specifies whether the module is enabled or disabled.</td>
</tr>
<tr>
<td>Alarm Trigger Mode</td>
<td>Alarm off OFF/Alarm on ON</td>
<td>Specifies the behavior of the digital input alarm.</td>
</tr>
</tbody>
</table>

1 IRIG-B can only be connected to one of the digital inputs located on the meter base, not an option module.

**WAGES monitoring**

WAGES monitoring allows you to record and analyze all energy sources and utilities usage.

Your system may use several different types of energy. For example, you may consume steam or compressed air for industrial processes, electricity for lights and computers, water for cooling and natural gas for heating. WAGES monitoring collects the usage information from all these different energy sources to enable a more complete energy analysis.

WAGES information can help you:

- Identify losses or inefficiencies.
- Modify demand to reduce costs.
- Optimize energy source usage.

**WAGES example**

This example shows WAGES monitoring for a water flow meter.

You can connect your meter’s digital input to a transducer that sends a pulse for every 15 kiloliters (4000 US Gal) of water. After configuring an input metering channel and assigning it to the digital input, the meter is able to detect and record the incoming pulses. An energy management system can then use the information from the meter to perform WAGES analysis.
Input metering

Your meter’s digital inputs can be used to count pulses from transducers and convert the pulses to energy measurements.

Your meter’s input metering channels count pulses received from the digital inputs assigned to that channel. The incoming pulses are used in calculating and measuring consumption data (e.g., BTU, kWh, L, kg). Each channel must have the following values configured to match the pulse data:

- **Pulse Weight**: the pulses per unit value.
- **Unit Code**: the unit of measure associated with the monitored value.
- **Demand Code**: for time-based values (such as kWh), this provides the associated demand units (kW) for demand calculations; for other values (such as kg), this can be configured to provide rate information (kg/h or kg/s).
- **Mode**: whether a pulse is based on a complete pulse or a transition.

For example, if each complete pulse represents 125 Wh, you can configure for Wh pulsing as follows:

- **Pulse Weight** = pulses/Wh = 1/125 = 0.008
- **Unit Code** = Wh
- **Demand Code** = kW (this is automatically set)
- **Mode** = pulse

If you want to configure for kWh pulsing, you must adjust the pulse weight calculation and unit code as follows:

- **Pulse Weight** = pulses/kWh = 1/0.125 = 8
- **Unit Code** = kWh

See “Meter resets”, page 214 for details about performing a meter reset.

Configuring standard input metering using ION Setup

You can configure input metering with standard units and rates using ION Setup

When configuring your meter, the configuration interface may show all of the possible ports, regardless of what is physically available on your meter.

**NOTE**: Your device’s digital input must be connected to the input metering pulse source. Review the digital inputs assigned to applications to help you understand your existing configuration.

**NOTE**: To disable an input metering channel and remove any port associations, set Assigned Input to No connection.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Energy Applications > Digital Input Based**.
4. Select the input metering channel you want to configure and click **Edit**. The **Input Metering Channel Setup** screen is displayed.
5. Select **Enabled** to enable the input metering feature.

6. Click **Select** to define which digital input is the pulse source for the input metering channel.

7. Configure the remaining parameters as required.

8. Click **OK** to save your configuration.

9. Configure your meter to log the input metering data if required.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Weight</td>
<td>Enter the value per pulse.</td>
</tr>
<tr>
<td>Units</td>
<td>Select the measurement units associated with the pulse.</td>
</tr>
<tr>
<td>Demand Period</td>
<td>Enter the frequency in minutes that input metering data is calculated in your energy management system.</td>
</tr>
<tr>
<td>Rate</td>
<td>Select the rate associated with the defined Units.</td>
</tr>
<tr>
<td>Source ID</td>
<td>Enter a data identifier. This value is added to the input metering channel’s output register labels to uniquely identify the data within your energy management system. <strong>NOTE:</strong> You must select a Unit for this field to appear.</td>
</tr>
</tbody>
</table>

### Configuring custom input metering using ION Setup

You can configure input metering with custom units and rates using ION Setup.

When configuring your meter, the configuration interface may show all of the possible ports, regardless of what is physically available on your meter.

**NOTE:** Your device’s digital input must be connected to the input metering pulse source. Review the digital inputs assigned to applications to help you understand your existing configuration.

**NOTE:** To disable an input metering channel and remove any port associations, set Assigned Input to No connection.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Navigate to **Energy Applications > Digital Input Based**.

4. Select the input metering channel you want to configure and click **Edit**. The **Input Metering Channel Setup** screen is displayed.

5. Select **Enabled** to enable the input metering feature.

6. Click **Select** to define which digital input is the pulse source for the input metering channel.

7. Clear the **Standard quantity** checkbox. The screen changes to display custom input metering parameters.

8. Configure the remaining parameters as required.

9. Click **OK** to save your configuration.
10. Configure your meter to log the input metering data if required.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse Weight</td>
<td>Enter the value per pulse.</td>
</tr>
<tr>
<td>Units</td>
<td>Select the measurement units associated with the pulse.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Include source identification information by entering &quot;@&quot;</td>
</tr>
<tr>
<td></td>
<td>followed by the source identifier.</td>
</tr>
<tr>
<td>Demand Period</td>
<td>Enter the frequency in minutes that input metering data is calculated in</td>
</tr>
<tr>
<td></td>
<td>your energy management system.</td>
</tr>
<tr>
<td>Rate</td>
<td>Select the rate associated with the defined Units.</td>
</tr>
<tr>
<td>Scaling</td>
<td>Select the scaling value based on the relationship between Units and Rate.</td>
</tr>
<tr>
<td>Time Base</td>
<td>Select the value and units to match the Rate.</td>
</tr>
</tbody>
</table>

**Digital outputs**

**Digital output applications**

Digital outputs are typically used in switching applications, for example, to provide on/off control signals for switching capacitor banks, generators, and other external devices and equipment.

The digital output can also be used in demand synchronization applications, where the meter provides pulse signals to the input of another meter to control its demand period. The digital output can also be used in energy pulsing applications, where a receiving device determines energy usage by counting the kWh pulses coming from the meter’s digital output port.

**Configuring onboard digital outputs using ION Setup**

You can use ION Setup to configure your meter’s digital outputs.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
4. Configure the digital output by selecting the parameter and clicking **Edit**. Enter the meter password if prompted.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Digital/Boolean</td>
<td>Link this input to the value that drives the state of the digital output.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If Source is not linked, the digital output state is driven by the Force ON, Force OFF values.</td>
</tr>
<tr>
<td>Force ON</td>
<td>Pulse</td>
<td>Link this input to a pulse that forces the digital output on for the PulseWidth duration, regardless of the Source input.</td>
</tr>
<tr>
<td>Force OFF¹</td>
<td>Pulse</td>
<td>Link this input to a pulse that forces the digital output off.</td>
</tr>
<tr>
<td>Normal¹</td>
<td>Pulse</td>
<td>Pulsing this input will switch the driver of the digital output from Force ON to Source.</td>
</tr>
<tr>
<td>Polarity</td>
<td>Inverting/non-inverting</td>
<td>Specifies if the signal to the digital port is inverted or not inverted.</td>
</tr>
<tr>
<td>PulseWidth</td>
<td>0 - 2,000,000</td>
<td>Specifies the duration of the pulse, in seconds. Setting this parameter to 0 sets the digital output continuously on.</td>
</tr>
<tr>
<td>Assigned Port</td>
<td>—</td>
<td>The physical digital output port connection. Only available ports are shown.</td>
</tr>
<tr>
<td>State</td>
<td>Open/Closed/Not Available</td>
<td>Indicates the status of the digital output.</td>
</tr>
</tbody>
</table>

¹ These parameters are only valid when pulse width is set to 0.

**Configuring option module digital outputs using ION Setup**

You can configure option module digital outputs using ION Setup.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.

3. Navigate to **Expansion Module > Option I/O Modules** and select the module tab that corresponds to the option module with the digital output you want to configure.

4. Select the digital output channel and click **Edit**. The setup screen for that digital output is displayed.
5. Configure the digital output by selecting the parameter and clicking **Edit**.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source</strong></td>
<td>Digital/Boolean</td>
<td>Link this input to the value that drives the state of the digital output. If Source is not linked, the digital output state is driven by the Force ON, Force OFF values.</td>
</tr>
<tr>
<td><strong>Force ON</strong></td>
<td>Pulse</td>
<td>Link this input to a pulse that forces the digital output on for the PulseWidth duration, regardless of the Source input.</td>
</tr>
<tr>
<td><strong>Force OFF</strong></td>
<td>Pulse</td>
<td>Link this input to a pulse that forces the digital output off.</td>
</tr>
<tr>
<td><strong>Normal</strong></td>
<td>Pulse</td>
<td>Pulsing this input will switch the driver of the digital output from Force ON to Source.</td>
</tr>
<tr>
<td><strong>EventLog Mode</strong></td>
<td>Log Off/Log On</td>
<td>Specifies if events generate log entries.</td>
</tr>
<tr>
<td><strong>Polarity</strong></td>
<td>Inverting/non-inverting</td>
<td>Specifies if the signal to the digital port is inverted or not inverted.</td>
</tr>
<tr>
<td><strong>PulseWidth</strong></td>
<td>0 - 2,000,000</td>
<td>Specifies the duration of the pulse, in seconds. Setting this parameter to 0 sets the digital output continuously on.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>–</td>
<td>The physical digital output port connection. Only available ports are shown.</td>
</tr>
</tbody>
</table>

1 These parameters are only valid when pulse width is set to 0.

### Energy pulsing

You can configure the meter’s energy pulsing LEDs or onboard digital outputs for energy pulsing applications.

When an LED or output is set to energy pulsing, the meter sends a readable pulse or signal based on the measured energy source value. This pulse can be used for accuracy verification or as an input to another energy monitoring system.

### Default energy pulsing LED sources

Your meter’s energy pulsing LEDs have default energy source values configured for accuracy verification testing.

For LED locations, see your meter’s installation guide.

<table>
<thead>
<tr>
<th>Calibration Pulser LED</th>
<th>LED</th>
<th>Default energy pulsing source</th>
</tr>
</thead>
<tbody>
<tr>
<td>WATT LED</td>
<td>kWh pulsing LED</td>
<td>kW del-rec</td>
</tr>
<tr>
<td></td>
<td>kWh pulse infrared LED</td>
<td></td>
</tr>
<tr>
<td>VAR LED</td>
<td>kVARh pulse LED</td>
<td>kVAR del-rec</td>
</tr>
<tr>
<td></td>
<td>kVARh pulse infrared LED</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** The energy pulsing LEDs are configured in pairs. For example, changing the energy source value will change it for both the regular and infrared LEDs.
NOTE: To modify your default energy source value, go into the advanced mode of ION Setup and modify the associated Calibration Pulser module. This is an advanced procedure that should only be performed if you have advanced knowledge of ION and the power system your meter is connected to.

See the ION Reference, available from www.schneider-electric.com, for more information.

See Alarm and status LED indicators, page 104 for information about other LED indicators.

Configuring LED energy pulsing using ION Setup

You can configure your meter’s energy pulsing LEDs for energy pulsing using ION Setup.

1. Start ION Setup.
2. Open the Setup Assistant for your device.
3. Select LED pulsing.
4. Select the tab that corresponds to the energy pulsing LED you want to configure.
5. Configure the following basic parameters for your meter’s energy pulsing LEDs.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Link this input to the value that you want to pulse on the LED.</td>
</tr>
<tr>
<td>Enable</td>
<td>Configuring this setting should only be performed by users with advanced knowledge of ION, the device template and the power system the device is connected to.</td>
</tr>
<tr>
<td>Int Mode</td>
<td>Specifies the integration mode for the LED (forward, reverse, absolute or net).</td>
</tr>
<tr>
<td>Kt</td>
<td>The amount of source energy required to make the LED pulse.</td>
</tr>
<tr>
<td>Pulse Width</td>
<td>The minimum time in seconds between LED pulse transitions.</td>
</tr>
</tbody>
</table>
| Pulser Mode | Select when the energy pulsing LEDs will pulse:  
  - Always: the energy pulsing LEDs are always pulsing based on their energy source value. |
| Pulse ovrld | Pulsing normally indicates that the energy pulsing LED should be operating normally.  
Pulsing suspended indicates that the energy pulsing LED is not able to pulse quickly enough. Modify the Kt value to decrease the number of energy pulses or decrease the pulse width, if supported by the device collecting pulses. |

NOTE: To perform specialized configuration go into the advanced mode of ION Setup and modify, disable or add a new Calibration Pulser module. These are advanced procedures that should only be performed if you have advanced knowledge of ION and the power system your meter is connected to.

See the ION Reference, available from www.schneider-electric.com, for more information.

Configuring digital output energy pulsing using ION Setup

You can configure your meter’s onboard digital outputs for energy pulsing using ION Setup.

Ensure that the digital output port is available for energy pulsing and not associated with another function.
When configuring your meter, the configuration interface may show all of the possible ports, regardless of what is physically available on your meter.

**NOTE:** For applications where accuracy is important, use the digital output located on the meter base.

1. Start ION Setup.
2. Open the Setup Assistant for your device.
3. Select **Energy pulsing**.
4. Select an energy pulsing source tab (such as Wh Del) to configure energy pulsing using your meter’s digital output.

### Digital output energy pulsing parameters available through ION Setup

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kt</td>
<td>The amount of energy source required to trigger the digital output. For example, in the Wh Del tab, the Kt value would be amount of real energy delivered (Wh Del) per pulse.</td>
</tr>
<tr>
<td>Pulse Width</td>
<td>The minimum time in seconds between pulse transitions.</td>
</tr>
</tbody>
</table>
| OutputMode | Select the desired output mode:  
  - Pulse: the digital output sends a complete pulse when triggered.  
  - KYZ: the digital output makes a transition (off to on, or on to off) when triggered. |
| Port | Select an output port from the list. Only available output ports are shown (ports that are not associated with another function). |
| (energy source) ovrld | Pulsing normally indicates that the output port should be operating normally.  
Pulsing suspended indicates that the output port is not able to pulse quickly enough. Modify the Kt value to decrease the number of energy pulses. |

**NOTE:** To perform specialized configuration go into the advanced mode of ION Setup and modify or add a new Calibration Pulser module. This is an advanced procedure that should only be performed if you have advanced knowledge of ION and the power system your meter is connected to.

See the ION Reference, available from www.schneider-electric.com, for more information.

### Calculate your maximum kWh/pulse (pulse weight) value

To calculate the kWh/pulse (pulse weight) value, divide the highest kW value you can expect by the required pulse rate.

Make sure the required pulse rate does not exceed the maximum pulse rate for the digital output.

**NOTE:** To convert from kWh/pulse to pulse/kWh you must invert (take the reciprocal) of the value. For example, 1.8 kWh/pulse becomes 0.556 pulse/kWh.

### Example pulse weight calculation

For a maximum load of 1600 kW and a pulse rate of 2 pulses per second, calculate the kWh/pulse value as follows:

1. Convert 1600 kW load into kWh/second:
   - \[(1600 \text{ kW}) \times (1 \text{ hr}) = 1600 \text{ kWh}\]
   - \[(1600 \text{ kWh}) \div (3600 \text{ sec}) = \frac{(X \text{ kWh}) \times (1 \text{ sec})}{1 \text{ sec}}\]
   - \[X = 0.444 \text{ kWh/sec}\]
2. Calculate the kWh required per pulse:
(0.444 kWh/sec)/(2 pulses per second) = 0.222 kWh/pulse

3. If using KYZ Output Mode, adjust for the KY giving one pulse per 2 transitions if necessary.

(0.222 kWh/pulse)/(2) = 0.111 kWh/pulse

See the ION Reference, available from www.schneider-electric.com for detailed information about the Calibration Pulser module.
Webpages

Webpage interface

Your meter comes with default webpages that contain typical elements.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Meter type and model, device name</td>
</tr>
<tr>
<td>B</td>
<td>Username</td>
</tr>
<tr>
<td>C</td>
<td>Main menu</td>
</tr>
<tr>
<td>D</td>
<td>Webpage menu</td>
</tr>
<tr>
<td>E</td>
<td>Webpage content</td>
</tr>
</tbody>
</table>

**NOTE:** This graphic is representative only, and your meter’s webpages may appear differently than shown.

Default meter webpages

Default webpages are available on your meter.

**Monitoring**

<table>
<thead>
<tr>
<th>Webpage menu</th>
<th>Webpage content</th>
</tr>
</thead>
</table>
| Instantaneous Readings | • Basic Readings  
• Energy Readings  
• Demand Readings  
• Voltage Readings  
• Power Quality |
| Trending & Forecasting | Select the target and interval for trending and forecasting and view the results. |
| Power Quality Summary | • Harmonics Chart  
• ITI (CBEMA)-SEMI  
• NEMA Motor Derating Curve  
• EN50160  
• IEEE 519 Harmonics  
• HSTC (ION9000T only) |
| Inputs/Outputs | • Digital Inputs  
• Digital Outputs  
• Analog Inputs  
• Analog Outputs |

**Waveforms**

View waveforms from your meter, using the meter’s COMTRADE files

**Control**

<table>
<thead>
<tr>
<th>Webpage menu</th>
<th>Webpage content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resets</td>
<td>Perform resets, and view when previous resets were performed.</td>
</tr>
</tbody>
</table>
Diagnostics

<table>
<thead>
<tr>
<th>Webpage menu</th>
<th>Webpage content</th>
</tr>
</thead>
</table>
| Statistics         | • Communications  
                     |   • Ethernet  
                     |   • Serial Port  
                     |   • Meter - Basic  
                     |   • Meter - Advanced |
| Phasor Diagram     | View the phasor diagram and numeric values.                                    |

Setup

<table>
<thead>
<tr>
<th>Webpage menu</th>
<th>Webpage content</th>
</tr>
</thead>
</table>
| Ethernet Basic     | • Basic Settings  
                     |   • Advanced Settings |
| Ethernet Advanced  | • Basic Settings  
                     |   • Advanced Settings |
| Serial Port Basic   | • Basic Settings  
                     |   • Advanced Settings |
| SNMP Parameters     | Configure your meter’s SNMP parameters.                                      |
| NTP                 | Configure your meter’s NTP parameters.                                        |
| SMTP                | Configure your meter’s SMTP parameters.                                        |
| Date & Time         | Configure your meter’s time and time synchronization.                         |
| Preferences         | Enter your meter’s nameplate information.                                      |
| Metering Basic      | • Basic Settings  
                     |   • Advanced Settings |
| Metering Advanced   | • Basic Settings  
                     |   • Advanced Settings |
| HTTPS               | Certificate Management.                                                        |

Maintenance

<table>
<thead>
<tr>
<th>Webpage menu</th>
<th>Webpage content</th>
</tr>
</thead>
<tbody>
<tr>
<td>—</td>
<td>Custom. No default content.</td>
</tr>
</tbody>
</table>

By default the Maintenance menu is empty, and the menu is not displayed until information is added to it.

Accessing webpages for data viewing and meter configuration

You can access the meter’s webpages through the meter’s Ethernet connection using a web browser.

You must have cookies enabled in order to access your meter’s webpages.

You may need to configure your meter’s security settings in order to view webpages and configure your meter using webpages.

On a hardware-locked meter, you cannot add, delete or modify any webpage files.

If you are connected to your device over Ethernet, changing Ethernet configuration parameters without another method of configuration enabled may cause loss of communications with your device and render it inaccessible.

**NOTICE**

**LOSS OF ACCESS**

Ensure you maintain sufficient access to communicate to and configure your device.

Failure to follow these instructions can result in loss of access to the device.
1. Open a web browser and enter your meter’s IP address in the address box. The webpage login prompt is displayed. If the browser cannot connect to the webserver, check the web protocol setting.

2. Enter a valid username and password.

   **NOTE:** The username and password are defined by your meter’s security configuration; if standard security is enabled, the password is the same as the display password with a default username of 9000. The default display password is 0 (zero). To help increase the security of your meter’s configuration and data, configure your meter’s username and passwords to be different from the default values.

3. Select your desired **Language** from the dropdown list, and click **Log In**. Your meter’s webpages are displayed. The default page is the **Monitoring** webpage, showing real-time data.

4. Select the main menu tab that corresponds to the category of information you want to view, and select the webpage menu from the list on the left. The webpage content is displayed.

5. Click the webpage content headings to expand and view the meter’s data.

6. Select **Setup** to view and edit your meter’s configuration.

### Embedding images and files in meter webpages

Upload images, documents, audio and video files to meter webpages using SFTP.

   **NOTE:** Images cannot be scaled once uploaded. Format images to the desired size before uploading.

1. Access your meter’s internal SFTP site.

2. Open the web folder. Copy your file into the subfolder that corresponds to the webpage main menu tab you want to access your file from.

3. Connect to your meter’s webpages. Select the main menu item that corresponds to the folder you previously selected. Your file is listed in the webpage menu.

4. Select your file from the webpage menu to view it.

### Creating custom webpages

You can create custom webpages to view data or access configuration parameters from your meter.

Download the meter’s Modbus registers map from www.schneider-electric.com.

1. Open SFTP client software.

2. Go to `web > examples`. Select samplereadings.html to create a data value webpage, or select sampleconfiguration.html to create a configuration parameters webpage.

3. Save a copy of the sample file. This filename is the webpage name.

4. Open your webpage in an HTML or webpage editor program.

5. Modify the webpage to reference the desired meter data or parameters from the Modbus registers map, and update the other fields where required.

6. Save your custom webpage.

The meter will display translated content if it exists in the meter’s memory. If translated content is not available, English is displayed.
7. Connect to your meter’s internal SFTP site.
   – If you have created a data viewing webpage, copy your custom webpage to web > monitoring.
   – If you have created a configuration webpage, copy your custom webpage to web > setup.

8. Login to your meter’s webpages.

Your custom webpage is available from the webpage menu under the Monitoring (data viewing) or Setup (configuration) tab.

Watch the video on how to create custom webpages: How to Create Custom Webpages for Your Meter

Deleting custom webpages

1. Open SFTP client software.
2. Connect to the meter using the meter’s IP address and SFTP port number. See “Protocols, ports and connections”, page 31 for information on port numbers.
3. Open the web folder in SFTP file directory and delete all files in subfolders.

Sample data viewing webpage

You can create custom data viewing webpages using the sample webpage stored on your meter.

The sample webpages are stored in the documents folder on your meter’s internal SFTP site.


If required, your meter’s ION handles document is packaged with the meter firmware file which is available for download from www.schneider-electric.com.

The data viewing webpage must be stored on your meter’s internal SFTP site in the folder for Monitoring. The custom webpage is viewed by selecting the Monitoring main menu tab on your meter’s webpage.

Configuring the HTML code other than where described is an advanced procedure and should only be performed by those with an advanced understanding of webpages and how your meter processes them.

Sample webpage data viewing result

NOTE: This graphic is representative only, and your meter’s webpages may appear different than shown.
Sample HTML code for data viewing webpage content

Content and formatting of a data viewing webpage is controlled by its HTML code.

Sample data viewing webpage content

<table>
<thead>
<tr>
<th>Line #</th>
<th>Sample HTML</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SampleMonitorPane.html</td>
</tr>
<tr>
<td>2</td>
<td>&lt;div class=&quot;content-fit&quot;&gt;</td>
</tr>
<tr>
<td>3</td>
<td>&lt;div class=&quot;accordion&quot;&gt;</td>
</tr>
<tr>
<td>4</td>
<td>&lt;h3 target=&quot;sample-readings&quot;&gt;$%localizedString(Basic Readings)#$&lt;/h3&gt;</td>
</tr>
<tr>
<td>5</td>
<td>&lt;div id=&quot;sample-readings&quot;&gt;</td>
</tr>
<tr>
<td>6</td>
<td>&lt;table class=&quot;datatable&quot;&gt;</td>
</tr>
<tr>
<td>7</td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td>8</td>
<td>&lt;th&gt; &lt;/th&gt;</td>
</tr>
<tr>
<td>9</td>
<td>&lt;th&gt;$%localizedString(Minimum)#$&lt;/th&gt;</td>
</tr>
<tr>
<td>10</td>
<td>&lt;th&gt;$%localizedString(Present)#$&lt;/th&gt;</td>
</tr>
<tr>
<td>11</td>
<td>&lt;th&gt;$%localizedString(Maximum)#$&lt;/th&gt;</td>
</tr>
<tr>
<td>12</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>13</td>
<td>&lt;tr class=&quot;minor&quot;&gt;</td>
</tr>
<tr>
<td>14</td>
<td>&lt;td&gt;$%localizedString(I a)#$ &lt;span unitsreg=&quot;I a&quot;&gt;&lt;/span&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>15</td>
<td>&lt;td regname=&quot;I a mn&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>16</td>
<td>&lt;td regname=&quot;I a&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>17</td>
<td>&lt;td regname=&quot;I a mx&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>18</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>19</td>
<td>&lt;tr class=&quot;minor&quot;&gt;</td>
</tr>
<tr>
<td>20</td>
<td>&lt;td&gt;$%localizedString(I b)#$ &lt;span unitsreg=&quot;I b&quot;&gt;&lt;/span&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>21</td>
<td>&lt;td regname=&quot;I b mn&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>22</td>
<td>&lt;td regname=&quot;I b&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>23</td>
<td>&lt;td regname=&quot;I b mx&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>24</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>25</td>
<td>&lt;/table&gt;</td>
</tr>
<tr>
<td>26</td>
<td>&lt;/div&gt;</td>
</tr>
<tr>
<td>27</td>
<td>&lt;h3 target=&quot;sample-energy&quot;&gt;$%localizedString(Energy Readings)#$&lt;/h3&gt;</td>
</tr>
<tr>
<td>28</td>
<td>&lt;div id=&quot;sample-energy&quot;&gt;</td>
</tr>
<tr>
<td>29</td>
<td>&lt;table class=&quot;datatable&quot;&gt;</td>
</tr>
<tr>
<td>30</td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td>31</td>
<td>&lt;th&gt; &lt;/th&gt;</td>
</tr>
<tr>
<td>32</td>
<td>&lt;th&gt;$%localizedString(Present)#$&lt;/th&gt;</td>
</tr>
</tbody>
</table>
**Sample data viewing webpage content (Continued)**

<table>
<thead>
<tr>
<th>Line #</th>
<th>Sample HTML</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>34</td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td>35</td>
<td>&lt;td&gt;$%localizedString(Active Energy)#$ &lt;span unitsreg=&quot;kWh del-rec&quot;&gt;&lt;/span&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>36</td>
<td>&lt;td regname=&quot;kWh del-rec&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>37</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>38</td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td>39</td>
<td>&lt;td&gt;$%localizedString(Reactive Energy)#$ &lt;span unitsreg=&quot;kVARh del-rec&quot;&gt;&lt;/span&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>40</td>
<td>&lt;td regname=&quot;kVARh del-rec&quot;&gt;&lt;/td&gt;</td>
</tr>
<tr>
<td>41</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>42</td>
<td>&lt;/table&gt;</td>
</tr>
<tr>
<td>43</td>
<td>&lt;/div&gt;</td>
</tr>
<tr>
<td>44</td>
<td>&lt;/div&gt;</td>
</tr>
<tr>
<td>45</td>
<td></td>
</tr>
<tr>
<td>46</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>&lt;script type=&quot;text/javascript&quot;&gt;</td>
</tr>
<tr>
<td>48</td>
<td>instantaneousReadings.initInstantaneousReadings('sample-readings');</td>
</tr>
<tr>
<td>49</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td>&lt;/script&gt;</td>
</tr>
<tr>
<td>52</td>
<td>&lt;/div&gt;</td>
</tr>
</tbody>
</table>

**Sample webpage data viewing content description**

<table>
<thead>
<tr>
<th>Line #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SampleMonitorPane.html The HTML filename, including the HTML extension (.html). This filename must comply with SFTP filename requirements (no spaces or special characters). The filename (without the HTML extension) is the name shown on the webpage menu.</td>
</tr>
<tr>
<td>4</td>
<td>&lt;h3 target=&quot;sample-readings&quot;&gt; This creates the first webpage content pane. &quot;sample-readings&quot; is the name of the webpage content. This name must be unique. $%localizedString(Basic Readings)#$&lt;/h3&gt; Basic Readings is the title of the webpage content pane. This title is translated if possible.</td>
</tr>
<tr>
<td>5</td>
<td>&lt;div id=&quot;sample-readings&quot;&gt; This must match the name of the webpage content in line 4.</td>
</tr>
<tr>
<td>9</td>
<td>&lt;th&gt;$%localizedString(Minimum)#$&lt;/th&gt; Minimum is the heading for the first column. This heading is translated if possible.</td>
</tr>
<tr>
<td>10</td>
<td>&lt;th&gt;$%localizedString(Present)#$&lt;/th&gt; Present is the heading for the second column. This heading is translated if possible.</td>
</tr>
<tr>
<td>11</td>
<td>&lt;th&gt;$%localizedString(Maximum)#$&lt;/th&gt; Maximum is the heading for the last column. This heading is translated if possible.</td>
</tr>
<tr>
<td>14</td>
<td>&lt;td&gt;$%localizedString(I a)#$ I a is the row heading. This heading is translated if possible. &lt;span unitsreg=&quot;I a&quot;&gt;&lt;/span&gt;&lt;/td&gt; This displays the units that the meter has defined for the named register I a.</td>
</tr>
<tr>
<td>15</td>
<td>&lt;td regname=&quot;I a mn&quot;&gt;&lt;/td&gt; This displays the instantaneous value of the named register I a mn.</td>
</tr>
<tr>
<td>16</td>
<td>&lt;td regname=&quot;I a&quot;&gt;&lt;/td&gt; This displays the instantaneous value of the named register I a.</td>
</tr>
<tr>
<td>17</td>
<td>&lt;td regname=&quot;I a mx&quot;&gt;&lt;/td&gt; This displays the instantaneous value of the named register I a mx.</td>
</tr>
</tbody>
</table>
Sample setup webpage

You can create custom setup webpages using the sample webpage stored on your meter.

Sample webpages are stored in the documents folder on your meter’s internal SFTP site.


If required, your meter’s ION handles document is packaged with the meter firmware file which is available for download from www.schneider-electric.com.

Custom setup webpages must be stored on your meter’s internal SFTP site in the setup folder. The custom webpage is viewed by selecting the Setup main menu tab on your meter’s webpage.

Configuring the HTML code other than where described is an advanced procedure and should only be performed by those with an advanced understanding of webpages and how your meter processes them.
Sample webpage setup result

NOTE: This graphic is representative only, and your meter’s webpages may appear different than shown.

Sample HTML code for setup webpage content

Content and formatting of a setup webpage is controlled by its HTML code.

Sample setup webpage content

<table>
<thead>
<tr>
<th>Line #</th>
<th>Sample HTML</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SampleSetupPane.html</td>
</tr>
<tr>
<td>2</td>
<td>&lt;div class=&quot;content-fit&quot;&gt;</td>
</tr>
<tr>
<td>3</td>
<td>&lt;form id=&quot;formSampleSettings&quot;&gt;</td>
</tr>
<tr>
<td>4</td>
<td>&lt;/form&gt;</td>
</tr>
<tr>
<td>5</td>
<td>&lt;div class=&quot;accordion&quot;&gt;</td>
</tr>
<tr>
<td>7</td>
<td>&lt;h3 target=&quot;sample-basic&quot;&gt;$%localizedString(Basic Settings)#$&lt;/h3&gt;</td>
</tr>
<tr>
<td>8</td>
<td>&lt;div id=&quot;sample-basic&quot;&gt;</td>
</tr>
<tr>
<td>9</td>
<td>&lt;table class=&quot;formtable&quot;&gt;</td>
</tr>
<tr>
<td>10</td>
<td>&lt;tr&gt;</td>
</tr>
<tr>
<td>11</td>
<td>&lt;th&gt; &lt;/th&gt;</td>
</tr>
<tr>
<td>12</td>
<td>&lt;th&gt; &lt;/th&gt;</td>
</tr>
<tr>
<td>13</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>15</td>
<td>&lt;td&gt;$%localizedString(Ethernet)#$&lt;/td&gt;</td>
</tr>
<tr>
<td>17</td>
<td>&lt;/tr&gt;</td>
</tr>
<tr>
<td>19</td>
<td>&lt;td&gt;$%localizedString(MAC Address)#$&lt;/td&gt;</td>
</tr>
<tr>
<td>20</td>
<td>&lt;td&gt;ренаме=&quot;MAC Address&quot;&lt;/td&gt;</td>
</tr>
<tr>
<td>21</td>
<td>&lt;/tr&gt;</td>
</tr>
</tbody>
</table>
Sample setup webpage content (Continued)

<table>
<thead>
<tr>
<th>Line</th>
<th>Sample HTML</th>
</tr>
</thead>
<tbody>
<tr>
<td>22</td>
<td><code>&lt;tr class=&quot;minor&quot;&gt;</code></td>
</tr>
<tr>
<td>23</td>
<td><code>&lt;td&gt;</code>$%localizedString(Ethernet Device Name)%<code>&lt;/td&gt;</code></td>
</tr>
<tr>
<td>24</td>
<td><code>&lt;td&gt;&lt;input name=&quot;Ethernet Device Name&quot; type=&quot;text&quot; /&gt;&lt;/td&gt;</code></td>
</tr>
<tr>
<td>25</td>
<td><code>&lt;/td&gt;</code></td>
</tr>
<tr>
<td>26</td>
<td><code>&lt;tr class=&quot;minor&quot;&gt;</code></td>
</tr>
<tr>
<td>27</td>
<td><code>&lt;td&gt;</code>$%localizedString(IP Address)%<code>&lt;/td&gt;</code></td>
</tr>
<tr>
<td>28</td>
<td><code>&lt;td&gt;&lt;input name=&quot;IP Address&quot; type=&quot;text&quot; /&gt;&lt;/td&gt;</code></td>
</tr>
<tr>
<td>29</td>
<td><code>&lt;/td&gt;</code></td>
</tr>
<tr>
<td>30</td>
<td><code>&lt;/table&gt;</code></td>
</tr>
<tr>
<td>31</td>
<td><code>&lt;/div&gt;</code></td>
</tr>
<tr>
<td>32</td>
<td><code>&lt;/div&gt;</code></td>
</tr>
<tr>
<td>33</td>
<td><code>&lt;h3 target=&quot;sample-advanced&quot;&gt;</code>$%localizedString(Advanced Settings)%<code>&lt;/h3&gt;</code></td>
</tr>
<tr>
<td>34</td>
<td><code>&lt;/div&gt;</code></td>
</tr>
<tr>
<td>35</td>
<td><code>&lt;div id=&quot;sample-advanced&quot;&gt;</code></td>
</tr>
<tr>
<td>36</td>
<td><code>&lt;table class=&quot;formtable&quot; id=&quot;frameFormatDropdownContainer&quot;&gt;</code></td>
</tr>
<tr>
<td>37</td>
<td><code>&lt;tr&gt;</code></td>
</tr>
<tr>
<td>38</td>
<td><code>&lt;th&gt;&amp;nbsp;&lt;/th&gt;</code></td>
</tr>
<tr>
<td>39</td>
<td><code>&lt;th&gt;&amp;nbsp;&lt;/th&gt;</code></td>
</tr>
<tr>
<td>40</td>
<td><code>&lt;/tr&gt;</code></td>
</tr>
<tr>
<td>41</td>
<td><code>&lt;tr&gt;</code></td>
</tr>
<tr>
<td>42</td>
<td><code>&lt;td&gt;</code>$%localizedString(TCP Keep Alive Minutes)%<code>&lt;/td&gt;</code></td>
</tr>
<tr>
<td>43</td>
<td><code>&lt;td&gt;&lt;input type=&quot;text&quot; name=&quot;TCP Keep Alive Minutes&quot; class=&quot;small&quot; /&gt; &lt;span unitsreg=&quot;TCP Keep Alive Minutes&quot;&gt;&lt;/span&gt;&lt;/td&gt;</code></td>
</tr>
<tr>
<td>44</td>
<td><code>&lt;/td&gt;</code></td>
</tr>
<tr>
<td>45</td>
<td><code>&lt;/tr&gt;</code></td>
</tr>
<tr>
<td>46</td>
<td><code>&lt;tr&gt;</code></td>
</tr>
<tr>
<td>47</td>
<td><code>&lt;td&gt;</code>$%localizedString(Enable Web Server)%<code>&lt;/td&gt;</code></td>
</tr>
<tr>
<td>48</td>
<td><code>&lt;td&gt;&lt;select name=&quot;Enable Web Server&quot;&gt;&lt;/select&gt; &lt;/td&gt;</code></td>
</tr>
<tr>
<td>49</td>
<td><code>&lt;/tr&gt;</code></td>
</tr>
<tr>
<td>50</td>
<td><code>&lt;/table&gt;</code></td>
</tr>
<tr>
<td>51</td>
<td><code>&lt;/div&gt;</code></td>
</tr>
<tr>
<td>52</td>
<td><code>&lt;/div&gt;</code></td>
</tr>
<tr>
<td>53</td>
<td><code>&lt;input type=&quot;submit&quot; class=&quot;apply&quot; value='</code>$%localizedString(Apply)%'<code> /&gt;</code></td>
</tr>
<tr>
<td>54</td>
<td><code>&lt;/input&gt;</code></td>
</tr>
<tr>
<td>55</td>
<td><code>&lt;/form&gt;</code></td>
</tr>
<tr>
<td>56</td>
<td><code>&lt;script type=&quot;text/javascript&quot;&gt;</code></td>
</tr>
<tr>
<td>57</td>
<td><code>SetupPane.init('formSampleSettings');</code></td>
</tr>
<tr>
<td>58</td>
<td><code>formChangeDetection.initFormChangeDetection('#formSampleSettings', '#dialogFormChanges');</code></td>
</tr>
</tbody>
</table>
Sample setup webpage content (Continued)

<table>
<thead>
<tr>
<th>Line #</th>
<th>Sample HTML</th>
</tr>
</thead>
<tbody>
<tr>
<td>64</td>
<td>&lt;/script&gt;</td>
</tr>
<tr>
<td>65</td>
<td>&lt;/div&gt;</td>
</tr>
</tbody>
</table>

Sample setup webpage content description

<table>
<thead>
<tr>
<th>Line #</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1      | SampleSetupPane.html  
The HTML filename, including the HTML extension (.html). This filename must comply with SFTP filename requirements (no spaces or special characters). The filename (without the HTML extension) is the name shown on the webpage menu. |
| 4      | <form id="formSampleSettings">  
"formSampleSettings" is the name of the webpage content. This name must be unique |
| 7      | <h3 target="sample-basic">  
This creates the first webpage content pane. "sample-basic" is the name of the webpage content. This name must be unique.  
$smarty%localizedString(Basic Settings)#$</h3>  
Basic Settings is the title of the webpage content pane. This title is translated if possible. |
| 8      | <div id="sample-basic">  
This must match the name of the webpage content in line 7. |
| 15     | <td>$smarty%localizedString(Ethernet)#$</td>  
Ethernet is the subheading. This heading is translated if possible. |
| 19     | <td>$smarty%localizedString(MAC Address)#$</td>  
MAC Address is the row heading. This heading is translated if possible. |
| 20     | <td regname="MAC Address"></td>  
This displays the value of the read-only named register MAC Address. |
| 23     | <td>$smarty%localizedString(Ethernet Device Name)#$</td>  
Ethernet Device Name is the row heading. This heading is translated if possible. |
| 24     | <td><input name="Ethernet Device Name" type="text" /></td>  
This displays the instantaneous value of the configurable named register Ethernet Device Name in a text-edit field.  
The type must match the named register type, in this case, an alphanumeric string. |
| 27     | <td>$smarty%localizedString(IP Address)#$</td>  
IP Address is the row heading. This heading is translated if possible. |
| 28     | <td><input name="IP Address" type="text" /></td>  
This displays the instantaneous value of the configurable named register IP Address in a text-edit field.  
The type must match the named register type, in this case, an alphanumeric string. |
| 34     | <h3 target="sample-advanced">  
This creates the second webpage content pane. Sample-advanced is the name of the webpage content. This name must be unique.  
$smarty%localizedString(Advanced Settings)#$</h3>  
Advanced Settings is the title of the webpage content pane. This title is translated if possible. |
| 35     | <div id="sample-advanced">  
This must match the name of the webpage content in line 34. |
| 42     | <td>$smarty%localizedString(TCP Keep Alive Minutes)#$</td>  
TCP Keep Alive Minutes is the row heading. This heading is translated if possible. |
| 43     | <td><input type="text" name="TCP Keep Alive Minutes" class="small" /></td>  
This displays the instantaneous value of the configurable named register TCP Keep Alive Minutes in a text-edit field.
### Sample setup webpage content description (Continued)

<table>
<thead>
<tr>
<th>Line #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The type must match the named register type, in this case, an alphanumeric string. This displays the units that the meter has defined for the named register TCP Keep Alive Minutes. <strong>NOTE:</strong> There are no defined units for TCP Keep Alive Minutes, so no units are displayed.</td>
</tr>
<tr>
<td>46</td>
<td><code>&lt;span unitsreg=&quot;TCP Keep Alive Minutes&quot;&gt;&lt;/span&gt;</code>&lt;br&gt;Enable Web Server is the row heading. This heading is translated if possible.</td>
</tr>
<tr>
<td>47</td>
<td><code>&lt;select name=&quot;Enable Web Server&quot;&gt;&lt;/select&gt;</code>&lt;br&gt;Enable Web Server is the named register that is displayed. Named registers are listed in the meter’s registers map. The type must match the named register type, in this case, an enumerated value that is displayed as a drop-down list.</td>
</tr>
<tr>
<td>61</td>
<td><code>SetupPane.init('formSampleSettings');</code>&lt;br&gt;This must match the webpage content name from line 4.</td>
</tr>
<tr>
<td>62</td>
<td><code>formChangeDetection.initFormChangeDetection('#formSampleSettings', '#dialogFormChanges');</code>&lt;br&gt;This must match the webpage content name from line 4. This HTML code updates all of the webpage's values.</td>
</tr>
</tbody>
</table>
Display

Display overview

The display allows you to view meter data and perform basic configuration.

NOTE: The display backlight dims after a defined period of inactivity. When the meter detects an unacknowledged active high priority alarm, the display flashes until the alarm is acknowledged.

<table>
<thead>
<tr>
<th>Display</th>
<th>A</th>
<th>Display port</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Optional 24 V DC AUX power input (label not pictured)</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Date and time</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Mode indicator</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Revenue lock icon</td>
<td></td>
</tr>
<tr>
<td>F</td>
<td>Alarm icon</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>Touch-screen display</td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>USB ports cover</td>
<td></td>
</tr>
<tr>
<td>I</td>
<td>USB host port (Type A)</td>
<td></td>
</tr>
<tr>
<td>J</td>
<td>USB device port (Mini-B)</td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>Home button</td>
<td></td>
</tr>
<tr>
<td>L</td>
<td>Power/status LED, green or red</td>
<td></td>
</tr>
<tr>
<td>M</td>
<td>Alarm LED, red</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>VAR visible energy pulsing LED, orange</td>
<td></td>
</tr>
<tr>
<td>O</td>
<td>VAR infrared energy pulsing LED, 940 nm</td>
<td></td>
</tr>
<tr>
<td>P</td>
<td>Watt visible energy pulsing LED, orange</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>Watt infrared energy pulsing LED, 940 nm</td>
<td></td>
</tr>
<tr>
<td>R</td>
<td>ANSI optical port</td>
<td></td>
</tr>
<tr>
<td>S</td>
<td>IEC optical port adapter (optional)</td>
<td></td>
</tr>
</tbody>
</table>

Mode indicator

The display mode indicator identifies whether the meter is in normal (NORM), alternate display (ALT) or test (TEST) mode.

Home button

Press the Home button to access display menus or return to the active menu.

Press the Home button twice to access the last data screen displayed or the Summary screen, if in ALT mode.

The function of the home button varies:

- **NORM mode**: Displays Energy and Demand screens.
- **ALT mode**: Displays ALT mode display and setup menus. Select Normal Display Mode from the ALT display menu to exit the ALT display mode.
• TEST mode: Displays Test mode and Setup menus.
• Setup Menu: Displays active menu item.

**Revenue lock icon**

The revenue lock icon indicates the lock status of the meter.

When gray and open, the meter is unlocked. When green and closed, the meter is locked. You can lock and unlock your meter using the revenue lock switch located on the body of your meter.

**Alarm icon**

The alarm icon indicates the highest level and state of alarms detected by your meter.

For example, if the meter detects a low priority and a high priority active alarm, the alarm icon indicates a high priority active alarm.

**NOTE:** Alarms can only be viewed and acknowledged through your display.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Alarm Icon](image) | Active alarm indicator:  
  • Red: high priority alarm state detected  
  • Yellow: medium priority alarm state detected  
  • Blue: low priority alarm state detected  
  The alarm indicator flashes until you acknowledge the alarm.  
  The alarm indicator changes to the historic alarm indicator of the appropriate level when the alarm state is no longer detected by the meter.  
  **NOTE:** Your display backlight flashes for unacknowledged high priority active alarms. |
| ![Alarm Icon](image) | Unacknowledged historic alarm indicator:  
  • Red: unacknowledged high priority historic alarm  
  • Yellow: unacknowledged medium priority historic alarm  
  **NOTE:** Low priority historical alarms are not indicated.  
  The active alarm indicator changes to the historic alarm indicator of the appropriate level when the alarm state is no longer detected by the meter. |
| ![Alarm Icon](image) | No active or unacknowledged high or medium priority historic alarms |

**Alarm and status LED indicators**

Your meter has alarm and status LEDs.

These LEDs cannot be configured for other uses.

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
</table>
| Status | Off: unpowered  
  Steady green: normal operation  
  Flashing red: no communications (remote display only)  
  Steady red: firmware upgrade required (remote display only)  
  Flashing red/green: startup or firmware upgrade sequence in progress |
| Alarm | Off: no active or unacknowledged historic alarms  
  On: acknowledged active alarm  
  Flashing: active alarm  
  **NOTE:** The display backlight flashes for unacknowledged high priority active alarms. |
Display icons

Icons are displayed on the bottom of the screen.

**NOTE:** If the icon is gray, the function is not available.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Tap <strong>More</strong> to access additional screens.</td>
</tr>
<tr>
<td>👈</td>
<td>Tap <strong>Left arrow</strong> to select item to the left or to return to the previous screen.</td>
</tr>
<tr>
<td>➤</td>
<td>Tap <strong>Right arrow</strong> to select item to the right.</td>
</tr>
<tr>
<td>⬆</td>
<td>Tap <strong>Up</strong> to navigate menu items or screens.</td>
</tr>
<tr>
<td>⬇</td>
<td>Tap <strong>Down</strong> to navigate menu items or screens.</td>
</tr>
<tr>
<td>✔️</td>
<td>Tap <strong>Select</strong> to confirm selection or change.</td>
</tr>
<tr>
<td>✗</td>
<td>Tap <strong>Cancel</strong> to exit and return to previous screen.</td>
</tr>
<tr>
<td>🎨</td>
<td>Tap <strong>Graphic</strong> to view graphical representation of data.</td>
</tr>
<tr>
<td>🌐</td>
<td>Tap <strong>Numeric</strong> to view numerical representation of data.</td>
</tr>
<tr>
<td>🌐</td>
<td>Tap <strong>Info</strong> to display screen details.</td>
</tr>
<tr>
<td>🌐</td>
<td>Tap <strong>Edit</strong> to enter parameter values or select setting.</td>
</tr>
<tr>
<td>✔️</td>
<td>Tap <strong>Check Box</strong> to perform an action.</td>
</tr>
<tr>
<td>🔄 ⬅ ➤</td>
<td>Tap <strong>double-arrow</strong> to select parameter.</td>
</tr>
</tbody>
</table>

More screens access

You can access additional screens.

Pressing the More icon opens a list of additional screens related to the active screen. Press cancel to close the list. If you do not select a screen, you are returned to the last data screen displayed.

Overrange indication

If any value measured by the meter is too large to fit on the display, the meter initially reduces the size of the text to try and make the value fit.

If the value is still too large to be displayed, the meter truncates the value starting with the least significant digit, and encloses the truncated value in a red box.
Interrupted display data

Display data is updated by the meter every second during normal operation. If the display detects a data interruption, the following occurs:

- Date/time information is cleared.
- Display mode indicator is set to normal (NORM) mode.
- Revenue lock icon indicates a locked state (green and closed).
- Alarm icon indicates an unacknowledged high priority historic alarm (red outline bell).
- All parameter labels and associated parameter data are cleared.

Display screen title bar and display icons are retained.

Auto-scaling feature

Measurement units on the meter display and webpages automatically scale, depending on the value of PT Primary and CT Primary.

Voltage units are scaled based on the PT Primary value:

<table>
<thead>
<tr>
<th>PT Primary value</th>
<th>Units or scaling</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 1000</td>
<td>V</td>
</tr>
<tr>
<td>1000 to 999,999</td>
<td>kV</td>
</tr>
</tbody>
</table>

Current units are scaled based on the CT Primary value:

<table>
<thead>
<tr>
<th>CT Primary value</th>
<th>Units or scaling</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 1000</td>
<td>A</td>
</tr>
<tr>
<td>1000 to 999,999</td>
<td>kA</td>
</tr>
</tbody>
</table>

Power units are scaled according to the value of (CT Primary x PT Primary x 3):

<table>
<thead>
<tr>
<th>(CT Primary x PT Primary x 3) value</th>
<th>Units or scaling</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 1,000,000</td>
<td>kW, kVAR or kVA</td>
</tr>
<tr>
<td>1,000,000 to 999,999,999</td>
<td>MW, MVAR or MVA</td>
</tr>
<tr>
<td>≥ 1,000,000,000</td>
<td>GW, GVAR or GVA</td>
</tr>
</tbody>
</table>

Display screens

Display modes

Your meter has three display modes and provides access to your meter’s setup screens:

- Normal Mode Screens (NORM). In Norm mode, your meter automatically scrolls through a series of customizable display screens. You can add or remove Norm mode display screens. If there are no Norm mode display screens, the meter displays a message that there are no available screens. To exit Norm mode, press the home button to access the display modes selection screen.

- Alt Display Mode (ALT): In Alt mode, you can navigate to view the different alternate screens. You cannot modify the default Alt mode display screens, but you can add custom screens. To exit Alt display mode, select Normal Display Mode to access the display modes selection screen.

- Test Mode (TEST): In Test mode, you can manually scroll through a series of default screens. To exit Test mode, press the home button and select Exit Test Mode.
NOTE: In Test mode, your meter’s billing quantities stop accumulating and the data is sent to special test mode registers. These registers are cleared when you exit Test mode.

Access your meter’s setup screens by pressing the home button in NORM, ALT or TEST mode. To exit the setup screens, press the home button.

Norm mode display menu

The Norm mode display screens show measured and calculated information about the power system being monitored.

NOTE: Your meter’s menus may appear slightly different than shown depending on your display settings.

<table>
<thead>
<tr>
<th>Normal Mode Screens</th>
<th>Active Energy</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reactive Energy</td>
</tr>
<tr>
<td></td>
<td>Apparent Energy</td>
</tr>
<tr>
<td></td>
<td>Peak Demand Delivered</td>
</tr>
<tr>
<td></td>
<td>Peak Demand Reset Count</td>
</tr>
</tbody>
</table>

Alt mode display menu

The alt mode display menu allows you to view data screens and access the setup menu.

NOTE: Display menus may appear slightly different than shown depending on your display settings.
Alt mode data display screens

Your meter’s alt mode display screens show measured and calculated information about the power system being monitored.

**NOTE:** Minimum, maximum (peak), average and time of use (TOU) values are typically accessed by pressing More to open a list of additional screens.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu screens</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td>Summary</td>
<td>Power system summary.</td>
</tr>
<tr>
<td>Alarms</td>
<td>Active alarms,</td>
<td>Active and historical alarms can be viewed and acknowledged.</td>
</tr>
<tr>
<td></td>
<td>historical alarms</td>
<td></td>
</tr>
<tr>
<td>Basic readings</td>
<td>Voltage, current,</td>
<td>• Power system voltage (line-to-line or line-to-neutral), current and frequency values.</td>
</tr>
<tr>
<td></td>
<td>frequency</td>
<td>• Average, minimum and maximum values are also provided.</td>
</tr>
</tbody>
</table>

See Setup menu section for details.
<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu screens</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Power summary, demand, power factor</td>
<td>• Per-phase and total kW, kVAR and kVA values, along with minimum and maximum values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Delivered and received demand values including peak demand.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Per-phase and total power factor along with minimum and maximum values.</td>
</tr>
<tr>
<td>Energy</td>
<td>Energy</td>
<td>Energy delivered-received, delivered and received.</td>
</tr>
<tr>
<td>Events</td>
<td>Events</td>
<td>Meter event log entries listing and details.</td>
</tr>
<tr>
<td>Power quality</td>
<td>EN50160, harmonics, phasors</td>
<td>• EN50160 values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Voltage and current harmonics, with individual and total harmonic values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Phasor diagram with magnitude and angle values.</td>
</tr>
<tr>
<td>Inputs/outputs</td>
<td>Digital inputs, digital outputs, analog inputs, analog outputs</td>
<td>Digital and analog I/O values and counts.</td>
</tr>
<tr>
<td>Nameplate</td>
<td>Nameplate</td>
<td>• Meter model, serial number, firmware version and feature set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Owner and tag information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• RMD serial number and firmware version.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Demand configuration values.</td>
</tr>
<tr>
<td>Custom screens</td>
<td>—</td>
<td>Custom screens.</td>
</tr>
<tr>
<td>Normal Display</td>
<td>—</td>
<td>Access to the display mode selection screen.</td>
</tr>
<tr>
<td>Mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setup Menu</td>
<td>—</td>
<td>Access to the setup menu screens.</td>
</tr>
</tbody>
</table>

### Setup menu

Meter configuration can be performed through the display.

Configure your meter’s security settings to allow front panel (display) programming in order to set up the meter using the display.

**NOTE:** Your display may appear differently than shown, depending on your meter’s power system, configuration and display settings.

**NOTE:** Some setup parameters cannot be configured when revenue security is enabled.
# Meter setup using your display

Navigate to Setup screens and enter parameters to configure your meter.

Your meter’s default display password is 0 (zero).

**NOTE:** Your meter locks you out of display configuration after you have exceeded the maximum number of attempts to enter a password.

The following example shows how to use the navigation icons to select parameters, enter numeric information or select parameter values from lists.

**NOTE:** Your display may appear differently than those shown, depending on your meter’s power system and display and localization settings.

## Example: setting volts mode and PT/CT ratios

Use the display navigation icons to set your meter’s volts mode and PT ratios.

**NOTE:** Potential transformers (PT) are also known as voltage transformers (VT).
1. Press ⬆️ to display the menu. Press ✔️ until Setup Menu is highlighted. Press ✔️ to display the Setup Menu. The Setup Menu lists the setup selections on your meter.

2. Press ⬆️ or ✔️ to highlight the different setup menu selections. Highlight Meter Setup and press ✔️ to select the meter setup screens. The Volts Mode setup screen is displayed.

3. Press ✔️ to highlight Volts Mode. Press ⬆️ to edit the volts mode. The Enter Password screen is displayed.

4. Press ⬆️ to change the value of the highlighted digit (0 - 9). Press ⬅️ to go to the next digit. Press ✔️ to enter your password using the onscreen keyboard. The Volts Mode configuration screen is displayed.

5. Press ⬆️ or ✔️ to highlight the desired volts mode from the list, in this case, 3W-WYE. Press ✔️ to select the highlighted volts mode. A confirmation screen is displayed, showing your meter’s previous setting and newly selected setting.
6. Press ✅ to confirm, and the new setting is applied to your meter. Press ✗ to cancel and maintain your meter’s original setting.

7. In the **Volts Mode** screen, press ✅ to go to the **PT/CT Setup** screen.

8. In the **PT/CT Setup** screen, press ✅ to highlight the potential transformer (PT) or current transformer (CT) value for editing. Press ✗ to edit the highlighted value.

   **NOTE:** If you have exceeded the password timeout period, you are prompted to enter your meter’s display password.

9. Press ✅ to change the value of the highlighted digit (0 - 9). Press ✅ to go to the next digit. Press ✅ to enter the new value. When the confirmation screen is displayed, press ✅ to confirm the new value or ✗ to revert to the original value.

### Display setup

You can configure basic display parameters using the display.

### Screen setup

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlight Timeout</td>
<td>0 to 7200</td>
<td>Specifies how many seconds the display’s backlight remains lit after the last button press</td>
</tr>
</tbody>
</table>

### Label & symbol setup

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase Lbls</td>
<td>ABC, 123</td>
<td>Sets the voltage and current phase labels</td>
</tr>
<tr>
<td>Measurement Symbols</td>
<td>IEEE, IEC</td>
<td>Specifies whether IEEE or IEC measurement symbols are applied to displayed values</td>
</tr>
<tr>
<td>PF Convention</td>
<td>IEEE, IEC</td>
<td>Specifies whether IEEE or IEC power factor conventions are applied to displayed values</td>
</tr>
</tbody>
</table>
**Numeric format setup**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digit Grouping</td>
<td>1000.0, 1,000.0, 1,000.0</td>
<td>Specifies how digits are grouped for display</td>
</tr>
<tr>
<td>Volts Resolution</td>
<td>1., 1.X, 1.XX, 1.XXX, 1.XXXX</td>
<td>Specifies the number of decimal places displayed for voltages</td>
</tr>
<tr>
<td>Current Resolution</td>
<td>1., 1.X, 1.XX, 1.XXX, 1.XXXX</td>
<td>Specifies the number of decimal places displayed for currents</td>
</tr>
<tr>
<td>Power Resolution</td>
<td>1., 1.X, 1.XX, 1.XXX, 1.XXXX</td>
<td>Specifies the number of decimal places displayed for power and energy measurements</td>
</tr>
</tbody>
</table>

**Language setup**

Select the language to be shown on the display.

By default, your meter has the following languages:

- English
- Spanish
- French
- German
- Italian
- Portuguese
- Russian
- Chinese (simplified)

**Creating custom displays using ION Setup**

You can use ION Setup to create new custom displays.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to Displays.
4. Select Displays from the Front Panel tab and click Edit.
   ION Setup loads your meter’s display information into the Display Editor screen.
5. Select the display mode of the custom screens from the dropdown list, and rename, delete, or change the order of custom displays.
   a. Click New to add a new display screen in the selected display mode.
   b. Click Edit to bring up the Display setup screen, where you can configure new or existing custom displays.
6. Configure your screen.
   - **Screen Type**: Specify the number of parameters displayed on the screen.
   - **Screen Title**: Enter the title to be shown at the top of your custom display.
7. Click Edit to select the displayed parameters.
   The number of parameters displayed is determined in the Screen Type selection described above.
8. Select your digit display properties.
   - **Resolution**: Specifies the number of decimal places displayed.
   - **Last Digit**: Specifies if the last digit is rounded or truncated.
9. Click Send to save the changes in the meter.
Display scaling

You can customize the units for metered values shown on the display and webpages.

You can configure the units for voltage, current, power and energy values shown on the display and webpages from their default units, and you can set the resolution for the display. To identify which values will have the modified units, refer to the display and web units information in your meter’s Modbus map, available from www.schneider-electric.com.

Configuring display units scaling using ION Setup

You can customize the units for metered values shown on the display and webpages using ION Setup.

Configuring display units scaling is an advanced procedure that requires in-depth knowledge of your meter, its underlying architecture, and the system in which it is installed.

To identify which values will have the modified units, refer to the display and web units information in your meter’s Modbus map, available from www.schneider-electric.com.

**NOTE:** Custom units and resolution settings are automatically adjusted for current and voltage values to help prevent your meter’s display from showing incorrect zero values.

1. Start ION Setup.
2. Connect to your meter in advanced mode.
3. Navigate to the Display Options Modules folder and double-click on the module in the righthand pane.
   The Display Options screen is displayed.
4. Select the Setup Registers tab.
5. Select the display units you want to configure: Voltage Units, Current Units, Power Units or Energy Units. Click Edit.
   A unit selection screen is displayed.
6. Select the desired units from the dropdown list, and click OK.
7. When you have finished configuring the display units, click Send to send your changes to the meter and close the Display Options screen.
   See the ION Reference, available from www.schneider-electric.com, for more information about the Display Options module and your meter’s ION architecture.

Remote display troubleshooting icons

The remote display shows troubleshooting icons in addition to the meter’s status LED information.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Your remote display is connecting to your meter.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Your remote display cannot communicate to your meter. Check the connection between your meter and the display. Check the meter’s status LED to confirm that the meter is operating normally.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Warning Icon" /></td>
<td>Your remote display needs updated firmware for compatibility with your meter.</td>
</tr>
<tr>
<td><img src="image" alt="Download Icon" /></td>
<td>Your remote display is downloading a firmware upgrade. Do not disconnect your remote display from your meter.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh Icon" /></td>
<td>Your remote display is undergoing a firmware upgrade. Do not disconnect your remote display from your meter.</td>
</tr>
</tbody>
</table>
Cybersecurity

Cybersecurity overview

This chapter contains up-to-date information about your product’s cybersecurity. Network administrators, system integrators and personnel that commission, maintain or dispose of a device should:

• Apply and maintain the device’s security capabilities. See “Device security capabilities”, page 116 for details.
• Review assumptions about protected environments. See "Protected environment assumptions", page 118 for details.
• Address potential risks and mitigation strategies. See “Potential Risks and compensating controls”, page 119 for details.
• Follow recommendations to optimize cybersecurity.

Your device has security capabilities that:

• Allow it to be part of a NERC CIP compliant facility. Go to the North American Electric Reliability Corporation website for information on NERC Reliability Standards.

To communicate a security topic affecting a Schneider Electric product or solution, go to www.schneider-electric.com/en/work/support/cybersecurity/vulnerability-policy.jsp.

⚠️ WARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND CONFIDENTIALITY

• Change default passwords to help prevent unauthorized access to device settings and information.
• Disable unused ports/services and default accounts, where possible, to minimize pathways for malicious attacks.
• Place networked devices behind multiple layers of cyber defenses (such as firewalls, network segmentation, and network intrusion detection and protection).
• Use cybersecurity best practices (for example: least privilege, separation of duties) to help prevent unauthorized exposure, loss, modification of data and logs, interruption of services, or unintended operation.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

Product defense-in-depth

Use a layered network approach with multiple security and defense controls in your IT and control system to minimize data protection gaps, reduce single-points-of-failure and create a strong cybersecurity posture. The more layers of security in your network, the harder it is to breach defenses, take digital assets or cause disruption.

Device security capabilities

This section describes the security capabilities available with your device.

Information confidentiality
These security capabilities help protect the confidentiality of information through secure protocols that employ cryptographic algorithms, key sizes and mechanisms used to help prevent unauthorized users from reading information in transit, i.e. SSH, SFTP and HTTPS.

**Physical security**

These security capabilities together with perimeter security help prevent unauthorized access to revenue-related parameters and settings or leave clear evidence that the device has been physically tampered with:

- Physical revenue-lock switch on the meter is used to help prevent unauthorized access to the meter, parameter values and settings.
- Meter lock status indicators are used to determine if the meter is revenue locked, i.e. LED lock status indicator on device and revenue lock icon on the display.
- Multiple anti-tamper sealing points are used to help prevent access and leaves evidence of tampering.

See “Revenue locking”, page 228 for details about physically locking and sealing the device.

**Configuration**

These security capabilities support the analysis of security events, help protect the device from unauthorized alteration and records configuration changes and user account events:

- Internal time synchronization.
- Time source integrity protection and meter configuration event logging.
- Timestamps, including date and time, match the meter clock.
- SSH server hosts an internal SFTP site and stores files in the meter’s flash memory, such as: webpages, COMTRADE records and firmware files.
- Settings can be saved as a Security Configuration File (.scf) using ION Setup.
- Embeds user information with changes.
- Offload information to syslog or a protected storage or retention location.

**User accounts and privileges**

These security capabilities help enforce authorizations assigned to users, segregation of duties and least privilege:

- User authentication is used to identify and authenticate software processes and devices managing accounts.
- Least privilege configurable in multiple dimensions: read, peak demand reset, time sync, test mode, meter configuration and security communications configuration.
- User account lockouts configurable with number of unsuccessful login attempts.
- Use control is used in Advanced security mode to restrict allowed actions to the authorized use of the control system.
- Supervisors can override user authorizations by deleting their account.
- Password strength feedback using ION Setup.

**Hardening**

These security capabilities help prohibit and restrict the use of unnecessary functions, ports, protocols and/or services:

- Least functionality can be applied to prohibit and restrict the use of unnecessary functions, ports, protocols and/or services.
- Port numbers can be changed from default values to lower the predictability of port use.
- Session lock is used to require sign in after a configurable time-period of inactivity for webpages, display, but not ION protocol.
• Session termination is used to terminate a session automatically after a configurable time-period of inactivity or manually by the user who initiated the session.

• Concurrent session control to limit the number of concurrent sessions with each interface.

System upgrades and backups

This security capability helps protect the authenticity of the firmware running on the meter and facilitates protected file transfer: digitally signed firmware is used to help protect the authenticity of the firmware running on the meter and only allows firmware generated and signed by Schneider Electric.

Threat intelligence

These security capabilities help provide a method to generate security-related reports and manage event log storage:

• Machine and human-readable reporting options for current device security settings.

• Audit event logs to identify:
  ◦ Meter configuration changes.
  ◦ Energy management system events.

• Audit record storage capacity communication to notify a user when the threshold is approaching.

• Audit storage capacity of 5,000 event logs by default and alternate methods for log management.

• Time source integrity protection and event logged when changed.

Secure disposal

These security capabilities help release the device from active service and prevent the potential disclosure of data:

• Purging of shared memory resources through device wiping and other decommissioning tasks.

• Physical (recommended) or sustainable device disposal possibilities.

Protected environment assumptions

• Cybersecurity governance – available and up-to-date guidance on governing the use of information and technology assets in your company.

• Perimeter security – installed devices, and devices that are not in service, are in an access-controlled or monitored location.

• Emergency power – the control system provides the capability to switch to and from an emergency power supply without affecting the existing security state or a documented degraded mode.

• Firmware upgrades – meter upgrades are implemented consistently to the current version of firmware.

• Controls against malware – detection, prevention and recovery controls to help protect against malware are implemented and combined with appropriate user awareness.

• Physical network segmentation – the control system provides the capability to:
  ◦ Physically segment control system networks from non-control system networks.
  ◦ Physically segment critical control system networks from non-critical control system networks.

• Logical isolation of critical networks – the control system provides the capability to logically and physically isolate critical control system networks from non-critical control system networks. For example, using VLANs.
• Independence from non-control system networks – the control system provides network services to control system networks, critical or non-critical, without a connection to non-control system networks.

• Encrypt protocol transmissions over all external connections using an encrypted tunnel, TLS wrapper or a similar solution.

• Zone boundary protection – the control system provides the capability to:
  ◦ Manage connections through managed interfaces consisting of appropriate boundary protection devices, such as: proxies, gateways, routers, firewalls and encrypted tunnels.
  ◦ Use an effective architecture, for example, firewalls protecting application gateways residing in a DMZ.
  ◦ Control system boundary protections at any designated alternate processing sites should provide the same levels of protection as that of the primary site, for example, data centers.

• No public internet connectivity – access from the control system to the internet is not recommended. If a remote site connection is needed, for example, encrypt protocol transmissions.

• Resource availability and redundancy – ability to break the connections between different network segments or use duplicate devices in response to an incident.

• Manage communication loads – the control system provides the capability to manage communication loads to mitigate the effects of information flooding types of DoS (Denial of Service) events.

• Control system backup – available and up-to-date backups for recovery from a control system failure.

## Potential risks and compensating controls

Address potential risks using these compensating controls:

<table>
<thead>
<tr>
<th>Area</th>
<th>Issue</th>
<th>Risk</th>
<th>Compensating controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>User accounts</td>
<td>Default account settings are often the source of unauthorized access by malicious users.</td>
<td>If you do not change the default password, unauthorized access can occur.</td>
<td>Change the default password of 0 (zero) to help reduce unauthorized access. See “Passwords”, page 126.</td>
</tr>
<tr>
<td></td>
<td>User credentials are stored unencrypted in the device.</td>
<td>If a malicious user gained access to your device, they could extract user credentials from storage media.</td>
<td>See “Protected environment assumptions”, page 118. Store devices that are not in service in an access-controlled or monitored location. See “Secure disposal guidelines”, page 133.</td>
</tr>
<tr>
<td>Secure protocols</td>
<td>ION, Modbus, DNP, DLMS, IEC 61850 and some IT protocols are insecure. The device does not have the capability to transmit data encrypted using these protocols.</td>
<td>If a malicious user gained access to your network, they could intercept communications.</td>
<td>For transmitting data over an internal network, physically or logically segment the network. For transmitting data over an external network, encrypt protocol transmissions over all external connections using an encrypted tunnel, TLS wrapper or a similar solution. See “Protected environment assumptions”, page 118.</td>
</tr>
<tr>
<td>HTTP is insecure</td>
<td>If a malicious user gained access to your network, they could compromise the security of your local network.</td>
<td>Configure meter to use these web protocol settings: • HTTPS • HTTPS with HTTP Redirect</td>
<td>See “Disabling and enabling protocols and changing port numbers”, page 128.</td>
</tr>
</tbody>
</table>
Cybersecurity configuration

Security configuration settings selected in ION Setup are applied to the meter and can be saved as a Security Configuration File (.scf). The security log file (SECURITY.LOG) contains the history of Security Configuration Files saved from ION Setup.

The security log and Security Configuration Files are saved to the C:\ProgramData\Schneider Electric\ION Setup\Security folder.

**NOTE:** The security log file can be changed by anyone with access to the ProgramData folder.

Recommendations to optimize cybersecurity in a protected environment:

- Store your meter’s Security Configuration File (.scf) in a protected location.
- Revenue-lock the meter, confirm it is revenue-locked and use anti-tamper sealing points before putting the meter into service. This helps prevent unauthorized access to the meter, parameter values and settings. See “Revenue locking”, page 228 for more information.

Default security settings

<table>
<thead>
<tr>
<th>Area</th>
<th>Setting</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications protocols</td>
<td>HTTPS with HTTP redirect</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>SSH Terminal</td>
<td>Disabled</td>
</tr>
<tr>
<td></td>
<td>SFTP</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Modbus TCP</td>
<td>Enabled</td>
</tr>
<tr>
<td>Time and time keeping</td>
<td>Broadcast time synchronization</td>
<td>Enabled</td>
</tr>
<tr>
<td>Webpages</td>
<td>Webpages</td>
<td>Enabled</td>
</tr>
<tr>
<td>Configuration</td>
<td>Configuration using the display</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Configuration using webpages</td>
<td>Disabled</td>
</tr>
<tr>
<td></td>
<td>Configuration using Modbus programming</td>
<td>Disabled</td>
</tr>
<tr>
<td>Security mode</td>
<td>Standard security mode (standard.scf)</td>
<td>Enabled</td>
</tr>
<tr>
<td></td>
<td>Advanced security mode (advanced.scf)</td>
<td>Disabled</td>
</tr>
</tbody>
</table>

See “Harden the device”, page 128 for information about changing default security settings.

Setting up standard or advanced security

Using Advanced security mode is recommended because it has stronger user login, user privilege management and password complexity.

<table>
<thead>
<tr>
<th>Security capability</th>
<th>Security configuration option</th>
<th>Standard security mode</th>
<th>Advanced security mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>User credentials and password robustness</td>
<td>Use a single account to access the meter with a numeric password for login.</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Create multiple user accounts with alphanumeric passwords for login and configuration changes.</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Password strength feedback using ION Setup.</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>
User account lockouts and timeouts | Define user account lockout criteria after unsuccessful login attempts and define session timeout length.
---|---
User privileges | User accounts with variable permissions to read access, test mode or configuration privileges.
Webpages | Disable or enable webpages for viewing meter data online using a web browser (Active Web Server).
Configuration | Disable or enable ability to configure the meter using:
- Modbus communications programming.
- The Display.
- Webpages (Web Server programming).
Cybersecurity event logs and reports | Set-up cybersecurity event logs and alarms using event priorities.

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.

1. Open ION Setup > select the meter > Setup Assistant.
3. Select the default standard.scf or advanced.scf security configuration file.
4. Click Open. The Standard Options or Advanced Options dialog box opens.
5. On the Standard or Advanced Options dialog box:
   - Select or clear Allow Web Server to enable or disable webpages for viewing meter data online using a web browser.
   - Select or clear Active Web Server programming to enable or disable the ability to change meter settings using webpages.
   - Select or clear Allow Modbus programming to enable the ability to program some meter settings using Modbus.
   - Select or clear Allow Front Panel programming to enable or disable the ability to change meter settings using the display.
6. Click Next to go through Setup Assistant screens and select the security options you want.
   - See “Passwords”, page 126 for recommendations.
   - See “Managing user account lockouts and timeouts”, page 125 for details about lockouts after unsuccessful login attempts and ION protocol session timeouts.
   - See “Managing user accounts”, page 124 for details about adding users and assigning privileges.
   If an option is grayed out, it is not available with your meter type or firmware.
7. Click Finish. The Save As dialog box opens.
8. Click Yes. The Save As dialog box opens.
9. Save the file with a unique file name to avoid overwriting default Security Configuration Files.
10. Click Exit.
Viewing and validating security settings

Generate a Meter Configuration Report to view security settings and user privileges.

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.

1. Open ION Setup > select the meter > Setup Assistant.
2. Reports > Meter Configuration > Display. The Meter Configuration Report for your meter opens.
3. Scroll down to the Security section to view settings:

![Meter Configuration Report]

4. Click Close or Save As to save the report as a .txt file.

Applying security settings to multiple meters

A Security Configuration File (.scf) can be applied to other meters. If differences in capabilities between meters exist, a message will open communicating when a capability is not available.

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.
- Saved Security Configuration File (.scf).

**NOTICE**

**DATA LOSS**

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.

1. Open ION Setup > select the meter > Setup Assistant.
2. **Security > Security Mode > Send.** The Open Security Configuration file dialog box opens.

3. Select the Security Configuration File (.scf) that contains the current meter settings you want and click **Open.** The Standard Options or Advanced Options dialog box opens.

   **NOTE:** Open the security log file to determine the .scf file you want. See “Cybersecurity configuration”, page 120 for more information.

4. Click **Exit.**

### Restoring default security configuration

Required for this procedure:

- Meter connection using ION Setup.
- Login credentials.

**NOTICE**

**DATA LOSS**

Record your device’s user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.

1. Open ION Setup > select the meter > **Setup Assistant.**


3. Select the **standard.scf** and click **Open.**

4. Enter 0 for the Meter password. This returns the meter password to its factory default of 0.

5. Click **Next.** The ION Setup dialog box opens.

6. Click **Yes** to confirm use of the default password.

7. Click **Finish.** The Confirmation message box opens.

8. Click **No.**

9. Click **Exit.**

10. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.

11. Double-click **Security User Modules.**

12. Right-click on each **Security User > Delete.**

### User accounts and privileges

Recommendations to optimize cybersecurity in a protected environment:

- Assign users only the essential privileges needed to perform their role.
- Revoke user privileges when no longer needed due to role change, transfer or termination. User credentials do not expire.
- Follow user account management tasks as described by your organization or contact your network administrator.
Managing user accounts

User privileges can be modified. Users can be added or removed at any time. The maximum number of users is 50.

Required for this procedure

- Meter connection using ION Setup.
- Login credentials.
- Advanced Security Mode enabled.
- Advanced security access.

**NOTICE**

**DATA LOSS**

Record your device’s user and password information in a secure location.

Failure to follow these instructions can result in equipment damage.

1. Open ION Setup > select the meter > **Setup Assistant**.
3. Select the Security Configuration File (.scf) that contains the current meter settings and click **Open**. The Standard Options or Advanced Options dialog box opens.
   
   **NOTE:** Open the security log file to determine the .scf file you want. See “Cybersecurity configuration”, page 120 for more information.
4. Click **Next** to navigate to the Define individual users/passwords screen.
5. Select each user and assign individual permissions:

<table>
<thead>
<tr>
<th>Permission level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Sync Access</td>
<td>Set the meter’s time and time synchronization parameters.</td>
</tr>
<tr>
<td>Read Access</td>
<td>View parameters, except security configuration.</td>
</tr>
<tr>
<td>Peak Demand Reset Access</td>
<td>Reset peak demand values.</td>
</tr>
<tr>
<td>Comm Config Access</td>
<td>Configure communication settings.</td>
</tr>
<tr>
<td>Test Mode Access</td>
<td>Switch the meter to test mode, if available with your meter type.</td>
</tr>
<tr>
<td>Full Meter Config Access</td>
<td>Configure meter settings.</td>
</tr>
<tr>
<td>Security Config Access</td>
<td>Configure security settings.</td>
</tr>
</tbody>
</table>
6. Click **Finish**. A Confirmation message box opens.

7. Click **Yes**. The Save As dialog box opens.

8. Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default Security Configuration Files.

9. Click **Exit**.

**Managing user account lockouts and timeouts**

If a user account is locked out, that user can still access the device by entering the correct credentials over a different protocol and communications method. Lockout is applied to each user, protocol and connection type, including webpages. For example, serial and Ethernet protocols are locked out separately.

User account lockouts and timeouts options include:

- Lockout after unsuccessful login attempts.
- Session timeout for ION protocol only.
- Lockout duration.

**Required for this procedure:**

- Meter connection using ION Setup.
- Login credentials.
- Advanced Security Mode enabled.
- Advanced security access.

1. Open ION Setup > select the meter > **Setup Assistant**.


3. Select the Security Configuration File (.scf) that contains the current meter settings and click **Open**. The Standard Options or Advanced Options dialog box opens.

   **NOTE:** Open the security log file to determine the .scf file you want. See “Cybersecurity configuration”, page 120 for more information.

4. Click **Next** to navigate to the Select protocol lockout options screen:

5. Select each protocol and click **Edit** to change lockout and session timeout values for:

   - Protocol lockout after unsuccessful login attempts.
   - Session timeout for ION protocol only. This is configurable because there is no login and logout action for ION protocol sessions.

6. Enter a value for the **Lockout duration** for user lockout occurrences.
8. Click Yes. The Save As dialog box opens.
9. Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default Security Configuration Files.

**Passwords**

Recommendations to optimize cybersecurity in a protected environment:

- Document and store passwords and usernames in a protected location.
- Change the default password of 0 (zero) to help reduce unauthorized access. Default account settings are often the source of unauthorized access by malicious users.
- View the Device Configuration Checklist to quickly determine if the default password in Standard Security mode is used:

![Device Configuration Checklist](image)

Still using a front panel password of 0 (zero).

- Use Advanced Security Mode
- Use complex passwords or passphrases with a minimum length of six characters.
- Follow user account management tasks as described by your organization or contact your network administrator, for example, maximum password age or history policies.

**Default passwords and usernames**

<table>
<thead>
<tr>
<th>Security mode</th>
<th>Range</th>
<th>Limit</th>
<th>Default password</th>
<th>Username(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>0 to 999999999</td>
<td>8 characters</td>
<td>0 (zero)</td>
<td>9000</td>
</tr>
<tr>
<td>Advanced</td>
<td>Any combination of letters and numbers</td>
<td>6 characters</td>
<td>0 (zero)</td>
<td>User1, User2, User3, etc.</td>
</tr>
</tbody>
</table>
Changing a password

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.
- Advanced security access, if Advanced Security Mode is enabled.

**NOTICE**

**DATA LOSS**
Record your device's user and password information in a secure location.
Failure to follow these instructions can result in equipment damage.

1. Open ION Setup > select the meter > Setup Assistant.
3. Select the Security Configuration File (.scf) that contains the current meter settings and click Open. The Standard Options or Advanced Options dialog box opens.
   **NOTE:** Open the security log file to determine the .scf file you want. See “Cybersecurity configuration”, page 120 for more information.
4. Select a user and do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
  **NOTE:** Leading zeros are not allowed. |
| Change the password in Advanced Security mode | Click Next to navigate to the Define individual users/passwords screen. Select each user and assign passwords.  
  **NOTE:** Select the Show password checkbox to display the user password after its been changed. |

5. Click Finish.
6. Click Yes. The Save As dialog box opens.
7. Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default Security Configuration Files.

You can also change the password using the display, ION Setup Diagnostics tool, Security Options Module using ION Setup Advanced Mode, EcoStruxure Power SCADA Operation or Power Monitoring Expert.

**Updating passwords on multiple meters**

Use the ION Setup Diagnostics tool to update passwords on multiple meters at the same time.

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.
- Advanced Security Mode enabled.
- Advanced security access.
NOTICE

DATA LOSS
Record your device's user and password information in a secure location.
Failure to follow these instructions can result in equipment damage.

1. Open ION Setup > select the system.
2. **Tools > Diagnostics.** The Systems diagnostics: System dialog box opens.
3. Select the **Tools tab > Advanced Security Password Updater.**
4. Click **Open.**
5. Select the meters that need a password update.
6. Click **Set Info.**
7. Click **Start.**
8. Click **Allow passwords to be visible.**
9. Select each user, click **Password** and enter a new password.
If the meter is connected to a display, update the password for the Front Panel.
10. Click **Start.** A Notice message box opens.
11. Click **Proceed.** A result is displayed for each device.
12. Click **Save As** to save a copy of updated meter passwords in a .txt file. The Save As dialog box opens.
13. Save the file with a unique file name to a protected location. An ION Setup message box opens
14. Click **OK.**
15. Click **Exit.**
16. Click **Close.**

Harden the device

Recommendations to optimize cybersecurity in a protected environment:
• Harden the meter according to your company’s policies and standards.
• Review assumptions about protected environments and address potential risks and mitigation strategies. See “Product defense-in-depth”, page 116 for details.
• Change the default password. See “Passwords”, page 126 for details.
• Change the communication protocol ports from their default values. This lowers the predictability of port use.
• Disable communication protocol ports when they are not in use. This reduces the attack surface.

Disabling and enabling protocols and changing port numbers

Disabling unnecessary and unused communication protocol ports, such as SFTP, and network ports, reduces the attack surface. Changing port number default values reduces the predictability of use. See “Protocols, ports and connections”, page 31 for port defaults.
Leave ION protocol enabled for configuration changes and upgrades. If ION protocol is disabled, use the display, Modbus programming or webpages to access the meter.

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.
- Advanced Security Mode enabled.
- Advanced security access.

**NOTICE**

**LOSS OF ACCESS**

Ensure you maintain sufficient access to communicate with and configure your device.

Failure to follow these instructions can result in loss of access to the device.

1. Open ION Setup > select the meter > Setup Assistant.
2. **Communications** > **Advanced Ethernet** > **Protocols**.
3. Change the default port number.
4. Enable or disable the protocol.
5. Click **OK**.
6. Click **Exit**.

**Disabling and enabling meter configuration methods**

Limiting configuration methods, such as Modbus, webpages and the display, and providing read-only access reduces the attack surface.

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.
- Advanced Security Mode enabled.
- Advanced security access.

1. Open ION Setup > select the meter > Setup Assistant.
2. **Security** > **Security Mode** > **Edit**. The Open Security Configuration file dialog box opens.
3. Select the Security Configuration File (.scf) that contains the current meter settings and click **Open**. The Standard Options or Advanced Options dialog box opens.

   **NOTE:** Open the security log file to determine the .scf file you want. See “Cybersecurity configuration”, page 120 for more information.

4. On the Standard or Advanced Options dialog box:
   - Select or clear **Active Web Server programming** to enable or disable the ability to change meter settings using webpages.
   - Select or clear **Allow Front Panel programming** to enable or disable the ability to change meter settings using the display.
   - Select or clear **Allow Modbus programming** to enable ability to program some meter settings using Modbus.
5. Click **Next**.
6. Click **Finish**.
7. Click Yes.

8. Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default Security Configuration Files.

9. Click Exit.

**Disabling and enabling webpages and time sync sources**

Disabling webpages removes the ability to access meter data online using a web browser. If your meter can be accessed by a web browser outside your protected network, a malicious user could intercept communications.

See “Disabling and enabling protocols and changing port numbers”, page 128 for details on enabling HTTPS.

Disabling the ability to modify the meter’s time source helps protect against disguised communication from an unknown source as being trusted and possibly invalidating timestamps.

**Required for this procedure:**

- Meter connection using ION Setup.
- Login credentials.
- Advanced Security Mode enabled.
- Advanced security access.

1. Open ION Setup > select the meter > Setup Assistant.


3. Select the Security Configuration File (.scf) that contains the current meter settings and click Open. The Standard Options or Advanced Options dialog box opens.

   **NOTE:** Open the security log file to determine the .scf file you want. See “Cybersecurity configuration”, page 120 for more information.

4. On the Standard or Advanced Options dialog box:
   - Select or clear Allow Web Server to enable or disable webpages for viewing meter data online using a web browser.
   - Select or clear Allow Broadcasting Time Synchronization to enable or disable the ability to modify the meter’s time synchronization source.

5. Click Next to go through Setup Assistant screens.

6. Click Finish. The Confirmation message box opens.

7. Click Yes. The Save As dialog box opens.

8. Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default Security Configuration Files.

9. Click Exit.

See “Configuring time information using ION Setup”, page 203 for detailed steps on setting up the time source.

**Threat intelligence**

Event logs and alarms can assist with monitoring suspicious activity and identifying the cause of cybersecurity breaches that could lead to a cybersecurity incident.
Setting up cybersecurity event logs and alarms

The event log can be used to monitor user logins and user account lockouts. The record limit for the event log is 5,000 by default. When the limit is reached, new records overwrite older ones.

To be notified when the Event Log record limit is approaching, see "Assigning a designated reader for event log notification", page 193.

To extend record retention, offload information to syslog or a protected storage or retention location, see “Configuring Syslog network settings using ION Setup”, page 194.

Required for this procedure:

- Meter connection using ION Setup.
- Login credentials.

1. Open ION Setup > select the meter > Setup Assistant.


3. Select the Security Configuration File (.scf) that contains the current meter settings and click Open. The Standard Options or Advanced Options dialog box opens.

   NOTE: Open the security log file to determine the .scf file you want. See “Cybersecurity configuration”, page 120 for more information.

4. Click Next to navigate to the Select protocol lockout options screen:

5. Click Events. The Event Priorities dialog box opens:
6. Leave default values or enter values for each event priority according to your reporting requirements:

<table>
<thead>
<tr>
<th>Priority</th>
<th>Description</th>
<th>Value range</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Not recorded in the event log.</td>
<td>0</td>
</tr>
<tr>
<td>Info Only</td>
<td>Recorded in the event log. Event log cut-off range. Will not appear in Event Log reports or syslog records.</td>
<td>1 to 5</td>
</tr>
<tr>
<td></td>
<td>Recorded in the event log.</td>
<td>6 to 63</td>
</tr>
<tr>
<td>Low</td>
<td>Recorded in the event log. Produces alarm low alarm.</td>
<td>64 to 127</td>
</tr>
<tr>
<td>Medium</td>
<td>Recorded in the event log. Produces medium alarm.</td>
<td>128 to 191</td>
</tr>
<tr>
<td>High</td>
<td>Recorded in the event log. Produces alarm low alarm. Recorded in syslog records.</td>
<td>192 to 255</td>
</tr>
</tbody>
</table>

7. Click **OK**.
8. Click **Next**.
9. Click **Finish**. A Confirmation message box opens.
10. Click **Yes**. The Save As dialog box opens.
11. Save the Security Configuration File (.scf) with a unique file name to avoid overwriting default Security Configuration files.
12. Click **Exit**. The Device Configuration Checklist message box opens.
13. Click **Exit**.

You can also change event priorities for cybersecurity events using ION Setup Advanced Mode. Refer to the ION Reference document at [www.schneider-electric.com](http://www.schneider-electric.com) for information about working with modules.

**Viewing and downloading event logs**

Generate an event log report to assist with cybersecurity incident investigations.

Event logs contain:
- Meter configuration changes.
- Energy management system events.

Required for this procedure:
- Meter connection using ION Setup.
- Login credentials.
- Configured event logs and alarms.

1. Open ION Setup > select the meter > **Setup Assistant**.
2. **Reports** > **Event Log** > **Display**. The Log reports dialog box opens.
3. Select a record range for the report and click **OK**:

![Upload Log Report](image)

The Event Log for your meter opens.

**NOTE:** Only All available records and Last options are available for Event Logs.
4. **Click Save As:**

5. **Select CSV or TXT > Save.**

6. **Click Close.**

### Upgrades and patch management

When meter firmware or ION Setup software is upgraded – security configuration remains the same until changed, including usernames and passwords. It is recommended security configuration is reviewed after an upgrade to analyze privileges for new or changed device features and revoke or apply them according to your company’s policies and standards.

See “Maintenance”, page 218 for information about firmware and templates.

### Secure disposal guidelines

Use the Secure disposal checklist when disposing a meter to help prevent potential disclosure of data.

**Secure disposal checklist**

- **Record activities:** Document disposal actions according to your company’s policies and standards to keep a record of activities.
- **Wipe the device:** See “Wiping the device”, page 133 for detailed steps.
- **Decommission related rules and sanitize records:**
  - Follow decommission and sanitization tasks as described by your organization or contact your network administrator.
  - Decommission network and security rules, e.g. a firewall rule that could be used to get past the firewall.
  - Perform records tracking sanitization tasks to remove records in related systems, e.g. monitoring SNMP servers.
- **Disposal and reuse:** See “Disposal, reuse, recycling”, page 136 for more information.

### Wiping the device

Follow tasks in the order listed, performing the Overwriting the Communications module registers task last to keep connectivity.

Required for this procedure:

- Meter connection using ION Setup.
- Login credentials.
• Advanced Security Mode enabled.
• Advanced security access.

### NOTICE

**DATA LOSS**

Ensure all important data from the device has been saved before performing a reset.

**Failure to follow these instructions can result in data loss.**

### NOTICE

**LOSS OF ACCESS**

Ensure you maintain sufficient access to communicate with and configure your device.

**Failure to follow these instructions can result in loss of access to the device.**

1. Overwrite the meter template file. This overwrites the meter template with the default factory template. See “Overwriting the Meter template file”, page 135 for detailed steps.

2. Delete files in the documents folder in SFTP file directory using SFTP client software. See “SFTP”, page 63 for more information.

3. Delete the custom SSL certificate. See “Deleting a custom SSL certificate”, page 63 for more information.


5. Delete the IEC 61850 configuration file. This deactivates functions related to the IEC 61850 protocol. See “Deleting an IEC 61850 configuration file”, page 72 for more information.


7. Overwrite factory module registers. This deletes values for:
   - Device owner.
   - Device tag.
   - Device location.
   - Device name.

   See “Overwriting factory module registers”, page 135 for more information.

8. Perform a master reset. This deletes values for:
   - Event log, data and waveform records.
   - Power quality event (COMTRADE) files.
   - Energy, metering, min./max., revenue and test mode, and peak demand values.
   - Disturbance (sag/swell event) counter, EN50160 parameters and statistics.

9. Overwrite communications module registers. This deletes values for network infrastructure details. See “Overwriting communications module registers”, page 135 for more information.
Overwriting the meter template file

1. Go to www.schneider-electric.com and search for the meter template for your device.
2. Download the ZIP file and extract files.
3. Open ION Setup.
4. Click the meter to select it > Setup Assistant.
5. Template > Send to Meter tab.
6. Click Send.
7. Navigate to the extracted files and select the DCF file.
   NOTE: FWN file type is also an option.
8. Click Open.
9. Click Proceed. The Template Paste Options dialog box opens.
10. Clear all check boxes and click OK.
11. Click Yes. The overwriting process could take a few minutes.
12. Click OK.
13. Click Exit and then OK.

Overwriting factory module registers

1. Open ION Setup.
2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced mode.
3. Double-click Factory Modules folder > select meter type.
4. Select the Setup Registers tab.
5. Type text or characters to replace values for these setup registers by selecting them and click Edit:
   – FAC1 Device Namespace.
   – FAC1 Device Name.
   – FAC1 Owner.
   – FAC1 Tag1.
   – FAC1 Tag2.
6. Click Send.

Overwriting communication module registers

1. Open ION Setup.
2. Ctrl + click on the meter to select it. This switches ION Setup to Advanced.
3. Double-click Comm Modules folder > Ethernet > Setup Registers.
4. Type text or characters to replace values for network infrastructure setup registers by selecting them and clicking **Edit**. Some registers include:
   - Stored IPv4 Address.
   - Stored IPv4 Subnet Mask.
   - Stored IPv4 Gateway.
   **NOTE:** IP values can be replaced with text.
   - Primary DNS.
   - Secondary DNS.
   - All servers.
   - All port numbers.
   - Ethernet Device Name.
   - Domain Name.

5. Click **Send**.

**Disposal, reuse, recycling**

Before removing the device from its intended environment, follow the **Secure disposal guidelines** in this document.

Follow device removal tasks described by your organization or contact your network administrator to determine a responsible method of disposal.

Dispose the device according to the legislation of the country. Some regulatory organizations include:

- The United States **Environmental Protection Agency (EPA)** for guidance on the sustainable management of electronics.
  - The EPA provides an **Electronic Product Environmental Assessment Tool (EPEAT)** that helps assess the environmental attributes of electronics.
- The European **Restriction of Hazardous Substances Directive (RoHS)** directive on the restriction of the use of certain hazardous substances in electrical and electronic equipment.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UNAUTHORIZED OR UNINTENDED ACCESS TO CONFIDENTIAL DATA</strong></td>
</tr>
<tr>
<td>- Store devices that are not in service in an access-controlled or monitored location.</td>
</tr>
<tr>
<td>- Physically destroy devices that are decommissioned.</td>
</tr>
</tbody>
</table>

*Failure to follow these instructions can result in unauthorized or unintended access to sensitive or secure customer data.*

**Device disposal**

It is recommended that the entire device is physically destroyed. Destroying the device helps prevent potential disclosure of data contained in the device that was not removed.

**Device reuse**

Store the device in a location that is access controlled or monitored if there is potential for reuse.

**Device recycling**
Go to www.schneider-electric.com and search for the Product Environmental Profile for your meter type to get instructions on managing e-waste.
Alarms and alerts

Alarms overview

An alarm is the meter’s means of notifying you when an alarm condition is detected, such as an error or an event that falls outside of normal operating conditions.

Alarms are typically setpoint-driven and can be programmed to monitor certain behaviors, events or unwanted conditions in your electrical system.

You can configure your meter to generate and display high, medium and low priority alarms when predefined events are detected in the meter’s measured values or operating states. Your meter also logs the alarm event information.

The meter ships with some alarms already enabled from the factory. Other alarms need to be configured before the meter can generate alarms.

Customize meter alarms as required, such as changing the priority. You can also create custom alarms using the advanced features of your meter.

Alarm types

Your meter has five types of alarms.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setpoint (standard)</td>
<td>Setpoint alarms compare the actual value of a parameter to a specified limit or range of values. These include measured voltage and current values and calculated power quality values. Some setpoint alarms use high-speed measurements for up to 1 millisecond resolution.</td>
</tr>
<tr>
<td>Digital</td>
<td>Digital alarms are triggered on a digital input’s on/off state.</td>
</tr>
<tr>
<td>Disturbance (sag/swell)</td>
<td>Disturbance alarms are triggered on a measured sag or swell.</td>
</tr>
<tr>
<td>Transient</td>
<td>Transient alarms are triggered on a measured transient event.</td>
</tr>
<tr>
<td>Unary</td>
<td>Unary alarms are not configurable and generate an alarm based on the meter’s state, for example, the meter powering up.</td>
</tr>
</tbody>
</table>

Alarms have two states:

• Active: the meter detects the alarm condition is met.
• Historical: the alarm condition previously existed but the condition has since returned to a non-alarm state.

See the ION Reference, available from www.schneider-electric.com, for more information about Setpoint, Relative Setpoint, Digital Input, Disturbance Analyzer, Transient, High-Speed Transient (ION9000T only) and Sag/Swell modules.

Standard and high-speed alarms

Alarm speed is determined by the update rate of the framework for the particular alarm.

Standard alarm

Standard alarms have a detection rate of once every 1 second.
High-speed alarm

High-speed alarms have a detection rate of once every half-cycle.

3-phase alarms

Alarms on 3-phase systems are evaluated per phase and reported for each phase.

Some alarms, such as the sag/swell alarm, are evaluated per phase, but reported as a single alarm: Each of the three phases are evaluated for the setpoint condition individually, but there is only one alarm generated. The alarm pickup occurs when the first phase exceeds the alarm pickup magnitude for the pickup time delay. The alarm is active as long as any phase remains in an alarm state. The alarm dropout occurs when the last phase drops below the dropout magnitude for the dropout time delay.

Example of over and under setpoint (standard) alarm operation

The meter supports over and under setpoint conditions on standard alarms.

A setpoint condition occurs when the magnitude of the signal being monitored crosses the limit specified by the pickup setpoint setting and stays within that limit for a minimum time period specified by the pickup time delay setting.

The setpoint condition ends when the magnitude of the signal being monitored crosses the limit specified by dropout setpoint setting and stays within that limit for a minimum time period specified by dropout time delay setting.

Over setpoint

When the value rises above the pickup setpoint setting and remains there long enough to satisfy the pickup time delay period (ΔT1), the alarm condition is set to ON. When the value falls below the dropout setpoint setting and remains there long enough to satisfy the dropout time delay period (ΔT2), the alarm condition is set to OFF.

Under setpoint

When the value falls below the pickup setpoint setting and remains there long enough to satisfy the pickup time delay period (ΔT1), the alarm condition is set to ON. When the value rises above the dropout setpoint setting and remains there long enough to satisfy the dropout time delay period (ΔT2), the alarm condition is set to OFF.
The meter records the date and time when the alarm event starts (EV1) and when it ends (EV2). The meter also performs any task assigned to the event, such as operating a digital output. The meter also records minimum values (Min1, Min2) before, during or after the alarm period.

### Relative setpoint

The meter’s Relative Setpoint modules behave similarly to the Setpoint modules, except the pickup and dropout levels are set relative to the Nominal input source.

For more information on Relative Setpoint modules, download ION Reference at www.schneider-electric.com.

### Sag/swell alarms

Your meter monitors your power system’s voltage and current for sags and swells (INCITS (CBEMA) Type 2 and Type 3 disturbances); it then reports the disturbance’s magnitude and duration.

You must configure nominal voltage and current for these alarms to function.

You can manually enter the limits (criteria) used by the meter to identify a sag or swell, or you can have your meter learn sag/swell limits by monitoring your power system.

For more information on the Sag/Swell and Disturbance Analyzer modules, download ION Reference at www.schneider-electric.com.

### Digital alarms

These alarms are triggered when the associated digital input changes state.

You can configure the alarm to be active when the digital input is on or off, depending on the alarm’s purpose.

For example, if you used a digital input to monitor a breaker that is always supposed to be on, you would set the alarm to be active when the breaker has tripped.

**NOTE:** To stop a digital alarm from being displayed, set the alarm priority to **Info Only**. Disabling the digital alarm (setting it to Force Off) will disable all alarming functions of the associated digital input.

Transient alarms

These alarms are triggered by voltage transient activity (i.e., ITI CBEMA Type 1 disturbances).

You must configure nominal voltage for these alarms to function.

The Threshold setup register in the Transient module defines what voltage disturbance magnitude should be considered as transient activity. Threshold is interpreted as a percentage of the nominal system voltage, plus 100. For example, if you want transients recorded when voltage deviates from nominal by 20%, enter 120 into the Threshold setup register.

See “Transient overview”, page 155 for an overview about transients.

For more information on the Transient module, download the ION Reference at www.schneider-electric.com.

Alarm event priorities

Your meter’s alarm priorities correspond to event priority ranges.

<table>
<thead>
<tr>
<th>Alarm priority</th>
<th>Event priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>High (red)</td>
<td>192 - 255</td>
</tr>
<tr>
<td>Medium (yellow)</td>
<td>128 - 191</td>
</tr>
<tr>
<td>Low (blue)</td>
<td>64 - 127</td>
</tr>
<tr>
<td>Info Only (no alarm)¹</td>
<td>1 - 63</td>
</tr>
<tr>
<td>None (no alarm or event)¹</td>
<td>0</td>
</tr>
</tbody>
</table>

¹ Alarms with priority of Info Only or None are not indicated or displayed.

Info Only and None event priority

Alarms with a priority of Info Only or None are not shown on the meter’s display, and do not function as alarms. If the alarm’s priority is set to Info Only, and the event priority is greater than the event log cutoff value, the associated event is recorded in the meter’s event log. If the alarm’s priority is set to None, the event priority is automatically set to zero, and no associated event is logged in the meter’s event log.

For events that you want to log for future reference or troubleshooting, but don’t want alarm functions, set the alarm priority to Info Only.

For nuisance events that frequently occur and you have no desire to log for reference or troubleshooting, set the alarm priority to None.

Alarm indicators

Your meter’s display has an alarm indicator to show you what alarm levels have been detected (active or historic) and whether they have been acknowledged.

For active high priority alarms, the meter’s display will also flash until the alarm is acknowledged. There is also an alarm LED to indicate the meter’s alarm condition.
### PowerLogic™ ION9000 series

#### Alarms and alerts

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Alarm icon</th>
<th>Alarm icon flash</th>
<th>Alarm LED</th>
<th>Meter display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active high</td>
<td>Red solid bell</td>
<td>Flash if not acknowledged</td>
<td>• Flash if not acknowledged</td>
<td>Flash if not acknowledged</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Steady if acknowledged</td>
<td></td>
</tr>
<tr>
<td>Active medium</td>
<td>Yellow solid bell</td>
<td>Flash if not acknowledged</td>
<td>• Flash if not acknowledged</td>
<td>No flash</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Steady if acknowledged</td>
<td></td>
</tr>
<tr>
<td>Active low</td>
<td>Blue solid bell</td>
<td>Flash if not acknowledged</td>
<td>• Flash if not acknowledged</td>
<td>No flash</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Steady if acknowledged</td>
<td></td>
</tr>
<tr>
<td>Historic high</td>
<td>Red outline bell</td>
<td>Flash if not acknowledged</td>
<td>• Flash if not acknowledged</td>
<td>No flash</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Steady if acknowledged</td>
<td></td>
</tr>
<tr>
<td>Historic medium</td>
<td>Yellow outline bell</td>
<td>Flash if not acknowledged</td>
<td>• Flash if not acknowledged</td>
<td>No flash</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Steady if acknowledged</td>
<td></td>
</tr>
<tr>
<td>Historic low</td>
<td>Gray solid bell</td>
<td>No flash</td>
<td>Off</td>
<td>No flash</td>
</tr>
<tr>
<td>No active or</td>
<td>Gray solid bell</td>
<td>No flash</td>
<td>Off</td>
<td>No flash</td>
</tr>
<tr>
<td>unacknowledged alarms</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If there are multiple active alarms, the meter displays the alarm condition associated with the most important active alarm. If there are multiple unacknowledged historic alarms, the meter displays the alarm condition associated with the most important unacknowledged historic alarm.

**NOTE:** To stop an alarm from being displayed without impacting other metering features, set the alarm priority to **Info Only**.

### Default alarms

Your meter comes with default alarms. Some alarms are enabled by default.

**NOTE:** Some alarms require configuration in order to operate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Priority</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Sag Ph1 - 3</td>
<td>High</td>
<td>Current sag alarms for phase 1, 2, 3</td>
<td>Disabled</td>
</tr>
<tr>
<td>Current Swell Ph1 - 3</td>
<td>High</td>
<td>Current swell alarms for phase 1, 2, 3</td>
<td>Disabled</td>
</tr>
<tr>
<td>Sag/Swell</td>
<td>High</td>
<td>Voltage sag/swell alarm</td>
<td>Disabled</td>
</tr>
<tr>
<td>Over I unbal</td>
<td>Medium</td>
<td>Over unbalanced current alarm</td>
<td>Disabled</td>
</tr>
<tr>
<td>Over V unbal</td>
<td>Medium</td>
<td>Over unbalanced voltage alarm</td>
<td>Disabled</td>
</tr>
<tr>
<td>Over THD V1 - 3</td>
<td>Medium</td>
<td>Over total harmonic distortion (THD) voltage alarms</td>
<td>Enabled</td>
</tr>
<tr>
<td>Over kW (P) sd</td>
<td>Medium</td>
<td>Over kW sliding demand alarm</td>
<td>Disabled</td>
</tr>
<tr>
<td>Over I a - c, (1 -3) 4</td>
<td>Medium</td>
<td>Over current alarms</td>
<td>Disabled</td>
</tr>
<tr>
<td>V1 - V3 Setpoint</td>
<td>Medium</td>
<td>Voltage setpoint alarms</td>
<td>Disabled</td>
</tr>
<tr>
<td>Freq Setpoint</td>
<td>Medium</td>
<td>Frequency setpoint alarm</td>
<td>Enabled</td>
</tr>
<tr>
<td>4-30 Volt Intrp Ph1 - 3</td>
<td>Low</td>
<td>4-30 voltage interruption power quality alarms</td>
<td>Enabled</td>
</tr>
<tr>
<td>Transient/Waveshape</td>
<td>High</td>
<td>Transient alarm</td>
<td>Disabled</td>
</tr>
</tbody>
</table>
### Alarm information

You can view information about an alarm from your meter’s display. Only alarms with a priority of low, medium or high are displayed.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm</td>
<td>The name of the alarm (for example, Over THD V1).</td>
</tr>
<tr>
<td>Priority</td>
<td>Low, medium or high alarm priority.</td>
</tr>
<tr>
<td>Date</td>
<td>The date and time the alarm was triggered.</td>
</tr>
<tr>
<td>Duration</td>
<td>The duration of the alarm (only applies to inactive alarms).</td>
</tr>
<tr>
<td>Ack</td>
<td>The date and time when the alarm was acknowledged (only applies to acknowledged alarms).</td>
</tr>
<tr>
<td>Value</td>
<td>Active alarm: The minimum or maximum value detected when the alarm was triggered. Historic alarm: The minimum or maximum value detected during the duration of the alarm.</td>
</tr>
</tbody>
</table>

### Viewing and acknowledging alarms using the display

You can view and acknowledge alarms using your meter’s display.

1. Press the **Home** button on the display.
2. Navigate to **Alarms > Active Alarms** or **Historical Alarms**.
3. Press **Select**.
4. Press the up or down icons to navigate alarms. A gray bar appears behind the active selection. **NOTE:** You can press Info to display alarm details.
5. To acknowledge alarms press **Acknowledge All**.

### Alarm configuration

**Alarm setup using the display**

You can enable and disable alarms through the display.
**WARNING**

**INACCURATE DATA RESULTS**

- Do not use data displayed on the display or in software as a substitute for proper workplace practices or equipment maintenance.
- Confirm your alarm is properly configured.

*Failure to follow these instructions can result in death, serious injury, or equipment damage.*

---

**Default alarms available on the display**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Over I unbal</td>
<td>Over unbalanced current alarm</td>
</tr>
<tr>
<td>Over THD V1</td>
<td>V1 over total harmonic distortion (THD) voltage alarm</td>
</tr>
<tr>
<td>Over THD V2</td>
<td>V2 over total harmonic distortion (THD) voltage alarm</td>
</tr>
<tr>
<td>Over THD V3</td>
<td>V3 over total harmonic distortion (THD) voltage alarm</td>
</tr>
<tr>
<td>Over kW sd</td>
<td>Over kW sliding demand alarm</td>
</tr>
<tr>
<td>Over Ia</td>
<td>Ia over current alarm</td>
</tr>
<tr>
<td>Over Ib</td>
<td>Ib over current alarm</td>
</tr>
<tr>
<td>Over Ic</td>
<td>Ic over current alarm</td>
</tr>
<tr>
<td>Over I4</td>
<td>I4 over current alarm</td>
</tr>
<tr>
<td>Over V unbal</td>
<td>Over unbalanced voltage alarm</td>
</tr>
<tr>
<td>V1 Setpoint</td>
<td>V1 setpoint alarm</td>
</tr>
<tr>
<td>V2 Setpoint</td>
<td>V2 setpoint alarm</td>
</tr>
<tr>
<td>V3 Setpoint</td>
<td>V3 setpoint alarm</td>
</tr>
<tr>
<td>Freq Setpoint</td>
<td>Frequency setpoint alarm</td>
</tr>
<tr>
<td>Sag/Swell 1</td>
<td>Voltage sag/swell alarm</td>
</tr>
<tr>
<td>Current Sag Ph1</td>
<td>Current sag alarms for phase 1</td>
</tr>
<tr>
<td>Current Sag Ph2</td>
<td>Current sag alarms for phase 2</td>
</tr>
<tr>
<td>Current Sag Ph3</td>
<td>Current sag alarms for phase 3</td>
</tr>
<tr>
<td>4-30 Volt Intrp Ph1</td>
<td>4-30 voltage interruption power quality alarm for phase 1</td>
</tr>
<tr>
<td>4-30 Volt Intrp Ph2</td>
<td>4-30 voltage interruption power quality alarm for phase 2</td>
</tr>
<tr>
<td>4-30 Volt Intrp Ph3</td>
<td>4-30 voltage interruption power quality alarm for phase 3</td>
</tr>
<tr>
<td>Current Swell Ph1</td>
<td>Current swell alarms for phase 1</td>
</tr>
<tr>
<td>Current Swell Ph2</td>
<td>Current swell alarms for phase 2</td>
</tr>
<tr>
<td>Current Swell Ph3</td>
<td>Current swell alarms for phase 3</td>
</tr>
<tr>
<td>HSTC 1 (ION9000T only)</td>
<td>High-speed transient alarm</td>
</tr>
</tbody>
</table>

Configure alarms using ION Setup.

Alarms with a priority less than **Low (Info Only or None)** are not displayed.

You must configure all the parameters related to the alarm for alarm functions to operate. For example, for the Over Ia alarm to operate, you must enter the nominal value and the conditions that define an alarm state, even if the alarm is shown as Enabled on the Alarm Setup screen.

---

6. Any Setpoint or Relative Setpoint module with an event priority greater than or equal to the Low alarm event priority is also displayed on this screen.

7. Enabling or disabling one phase for each alarm type will enable or disable all phases for that type.
Disabling and enabling alarms using the display

You can disable alarms using the meter’s display when you are performing maintenance tasks on your system and want to prevent nuisance alarms.

**NOTE:** To stop an alarm from being displayed without impacting other metering features, set the alarm priority to **Info Only**.

1. Press the **Home** button on the display.
2. Navigate to **Setup Menu > Alarm Setup**.
3. Press Select.
4. Press Edit. Enter your meter’s password, if prompted.
5. Press the up or down icons to navigate alarms. A gray bar appears behind the active selection.
6. To select the item(s) press Select for Enable/Disable.
7. Press Select to accept the change.
8. Press Select to confirm.
9. Complete the system maintenance tasks.
10. Enable the alarms you disabled.

Configuring setpoint/standard alarms using ION Setup

You can use ION Setup to configure the standard alarm settings.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Alarming** and click the **Standard** tab.
4. Select a setpoint and click **Edit**.
5. Enter the password and click **OK**, if required.
6. The **Setpoint Setup** screen is displayed.
7. Configure the setpoint values as required.
8. Click **Save** to save the settings to your meter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>By Percentage</td>
<td>By Percentage/By Value</td>
<td>When available, specifies if the Pickup and Dropoff entries are by percentage or by value. If the option is not available, pickup and dropoff entries are by value.</td>
</tr>
<tr>
<td>Force Off</td>
<td>Checked/Unchecked</td>
<td>Forcing the alarm off disables all functions of the associated input. To stop an alarm from being displayed without affecting other meter features, set the alarm priority to Info Only.</td>
</tr>
<tr>
<td>Label</td>
<td>String value</td>
<td>When available, lets you modify the default label so it more clearly identifies the alarm. Letters, numbers, and underscores are permitted.</td>
</tr>
<tr>
<td>Pickup</td>
<td>Numeric value</td>
<td>Use this setting to provide a value for when the alarm turns on.</td>
</tr>
<tr>
<td>Pickup Delay</td>
<td>Numeric value</td>
<td>This specifies the number of seconds the input must be over the alarm pickup value before the alarm turns on.</td>
</tr>
<tr>
<td>Dropout</td>
<td>Numeric value</td>
<td>Use this setting to provide a value for when the alarm turns off.</td>
</tr>
<tr>
<td>Dropout Delay</td>
<td>Numeric value</td>
<td>This specifies the number of seconds the input must be below the alarm dropoff value before the alarm turns off.</td>
</tr>
<tr>
<td>Alarm Priority</td>
<td>None, Info Only, Low, Medium or High</td>
<td>Specifies the priority level of the standard alarm. When priority is set to Info Only, the alarm does not appear on the display.</td>
</tr>
<tr>
<td>Custom Priority</td>
<td>0-255</td>
<td>Select custom priority to view and configure the event priority of the event associated with the alarm. The event log cutoff value is displayed for reference; priorities above the cutoff are stored in the meter’s event log.</td>
</tr>
</tbody>
</table>
Sag/swell overview

Your meter monitors your power system’s voltage and current for sags and swells (INCITS (CBEMA) Type 2 and Type 3 disturbances); it then reports the disturbance’s magnitude and duration.

You can manually enter the limits (criteria) used by the meter to identify a sag or swell, or you can have your meter learn sag/swell limits by monitoring your power system.

Configuring sag/swell alarms using ION Setup

You can use ION Setup to configure the sag/swell alarm settings.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to Alarming > Sag/Swell.
4. Select the parameter you want to configure and click Edit. The setup dialog box for that parameter appears.
5. Configure the parameters as required.

The values you need to set vary depending on the type of sag/swell alarm you are configuring.

**Voltage sag/swell setup parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enabled or Disabled</td>
<td>Specifies if sag/swell recording and alarming is enabled.</td>
</tr>
<tr>
<td>Nominal</td>
<td>1 to 999,999</td>
<td>Specifies the nominal voltage value used for sag/swell detection.</td>
</tr>
<tr>
<td>Swell Limit</td>
<td>Percentage of nominal</td>
<td>Specifies the swell limit expressed as a percentage of the nominal voltage.</td>
</tr>
<tr>
<td>Sag Limit</td>
<td>Percentage of nominal</td>
<td>Specifies the sag limit expressed as a percentage of the nominal voltage.</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>Percentage – see description</td>
<td>Specifies the difference in magnitude between the sag or swell limit and the threshold for the power quality event to be considered over. For example, if the meter has the sag limit set to 90% of nominal and the hysteresis is set to 2%, this means that in a sag event, the voltage needs to return to 92% of nominal for the sag event to be considered over.</td>
</tr>
<tr>
<td>Alarm priority</td>
<td>See description</td>
<td>Select the alarm priority you want to associate with Sag/Swell alarms. To stop an alarm from being displayed without affecting other meter features, set the alarm priority to Info Only.</td>
</tr>
</tbody>
</table>

**Current sag/swell setup parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable</td>
<td>Enabled or Disabled</td>
<td>Specifies if sag/swell recording and alarming is enabled.</td>
</tr>
<tr>
<td>Nominal</td>
<td>1 to 999,999</td>
<td>Specifies the nominal current value used for current sag or current swell detection.</td>
</tr>
<tr>
<td>Pickup</td>
<td>Percentage of nominal</td>
<td>Specifies the percentage the current must deviate from the nominal current in order to be classified as a sag or a swell.</td>
</tr>
<tr>
<td>Dropout</td>
<td>Percentage of nominal</td>
<td>Specifies the percentage of nominal the current must recover to in order to signal the end of the sag or the swell.</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>N/A</td>
<td>Displays the difference in magnitude between the sag or swell Pickup and Dropout values. To change the hysteresis, change the Pickup or Dropout values.</td>
</tr>
<tr>
<td>Alarm priority</td>
<td>See description</td>
<td>Select the alarm priority you want to associate with Sag/Swell alarms. To stop an alarm from being displayed without affecting other meter features, set the alarm priority to Info Only.</td>
</tr>
</tbody>
</table>
Configuring transient alarms using ION Setup

You can use ION Setup to configure the transient alarm settings.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to Alarming > Transient.
4. Select Transient/Waveshape and click Edit.
   The setup dialog box for that parameter appears.
5. Configure the parameters as required.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled/Disabled</td>
<td>Enabled or Disabled</td>
<td>Specifies if transient recording and alarming is enabled.</td>
</tr>
<tr>
<td>Nominal</td>
<td>1 to 999,999</td>
<td>Specifies the nominal voltage value used for transient detection.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Percentage of nominal</td>
<td>Specifies the threshold expressed as a percentage of the nominal voltage, plus 100. For example, if you want transients recorded when voltage deviates from nominal by 20%, enter 120.</td>
</tr>
<tr>
<td>Alarm priority</td>
<td>See description</td>
<td>Select the alarm priority you want to associate with Transient alarms. To stop an alarm from being displayed without affecting other meter features, set the alarm priority to Info Only.</td>
</tr>
</tbody>
</table>

Configuring digital input alarms using ION Setup

You can use ION Setup to configure the digital alarm settings.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
4. Configure the digital input alarm settings by selecting an input and clicking Edit. Some settings are not configurable and are grayed out.
5. Click Save to save the changes to the meter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input On/ Input Off</td>
<td>Specifies the input state/alarm behavior:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Input On: the alarm is on when the digital input is on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Input Off: the alarm is on when the digital input is off.</td>
</tr>
<tr>
<td>Force Off</td>
<td>Checked/Unchecked</td>
<td>Forcing the alarm off disables all functions of the associated input.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To stop an alarm from being displayed without affecting digital input features, set the alarm priority to Info Only.</td>
</tr>
<tr>
<td>Label</td>
<td>String value</td>
<td>When available, lets you modify the default label so it more clearly identifies the alarm. Letters, numbers, and underscores are permitted.</td>
</tr>
<tr>
<td>Alarm Priority</td>
<td>None, Info Only, Low, Medium or High</td>
<td>Specifies the priority level of the digital input alarm. To disable the alarm, set priority to Info Only.</td>
</tr>
<tr>
<td>Custom Priority</td>
<td>0-255</td>
<td>Select custom priority to view and configure the event priority of the event associated with the alarm. The event log cutoff value is displayed for reference; event priorities above the cutoff are stored in the meter’s event log.</td>
</tr>
</tbody>
</table>
Alerting

An alert is an external notification from the meter to indicate changes, for example, a change of state for a digital input, or a power quality event such as a sag or swell.

When an alert condition occurs, a pulse or trigger is sent and generates the alert. You can configure alerts to send notification emails or messages to your energy management system through your meter’s existing Ethernet communications connections. You can configure alert messages as a simple text string or you can also include device information. You can configure the alert’s priority so that alerts are also recorded in the meter’s event log.

You can configure multiple alerts on a single meter, each having different activation triggers, messages and/or transmission types. For instance, you can have two alerts, one generating an email, the other sending a message to your energy management system, but using the same trigger conditions; or you can have two alerts with different conditions that send two unique emails to two different email addresses. You can also generate alerts based on triggers from devices connected to your meter.

Creating alerts is an advanced feature that requires familiarity with ION architecture and your power system and communications network. To create an alert, you must configure the Alert module using a configuration tool. You must also configure your device’s communications as needed to send the alerts, such as configuring your meter’s SMTP settings and connecting it via Ethernet to an SMTP mail server in order to send an alert by email.

Go to www.schneider-electric.com to see the ION meter alerts technical note for detailed information on creating and configuring alerts, and the ION Reference for detailed information about the Alert module and its operation.

Setpoint learning overview

Your meter can learn acceptable ranges or thresholds by monitoring normal operating values to determine what constitutes a voltage sag, swell or transient in order to help identify high and low setpoints.

**NOTE:** To help your meter learn the most accurate values possible, it is important that learning occur during a period of normal operation. Do not schedule learning during a period of unusual operations in your system. Do not modify your meter’s configuration during the learning period as it may stop the learning process.

You can configure the meter so that learned values are applied automatically once the learning period is complete or require that they are reviewed and manually applied. If a learned value is invalid, the learned values are not automatically applied, but logged for review.

Setpoint learning can be used to identify the following values:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setpoints (Alarms)</td>
<td>High limit</td>
</tr>
<tr>
<td></td>
<td>Low limit</td>
</tr>
<tr>
<td></td>
<td>Sustain until ON</td>
</tr>
<tr>
<td></td>
<td>Sustain until OFF</td>
</tr>
<tr>
<td>Sag</td>
<td>Voltage sag limit</td>
</tr>
<tr>
<td>Swell</td>
<td>Voltage swell limit</td>
</tr>
<tr>
<td>Transient</td>
<td>Threshold</td>
</tr>
</tbody>
</table>
Learning installation mode and learning duration

You can configure learning for manual or automatic mode.

There are two learning installation modes:

- Manual: the meter learns the applicable values but does not begin using the learned values. The learned values are recorded for review, and you can decide to use the learned values or adjust them as required before manually implementing the learned values.

- Automatic: the meter learns the applicable values and begins using those learned values automatically at the end of the learning period. If a learned value is invalid, the meter does not apply the value, but the value is recorded in the event log.

You can configure the maximum learning duration. The actual learning duration may vary, depending on the stability of the system. If the system is stable for a period equal to one quarter of the maximum learning duration, learning is complete; otherwise, the learning period will be the maximum learning duration.

Example: Setpoint learning duration in a stable system

In this example, the learning duration is 30 days. When the system is stable for 7.5 days (one quarter of 30 days) learning is complete.

![Graph showing learned swell and sag limits in a stable system]

Example: Setpoint learning duration in an unstable system

In this example, the learning duration is 30 days. Because the system is not stable for 7.5 days (one quarter of the 30 days) learning is complete at the end of the maximum learning duration.

![Graph showing learned swell and sag limits in an unstable system]

See the ION Reference, available from www.schneider-electric.com, for more information on Sag/Swell, Setpoint and Relative Setpoint modules.
Implementing standard alarm setpoint learning using ION Setup

You can use ION Setup to implement setpoint learning, which analyzes your power system and recommends settings.

**NOTE:** Your meter’s power system must be stable in order to learn valid setpoint values.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Alarming > Standard**.
   
   **NOTE:** You can manually configure setpoint values by selecting the setpoint and clicking **Edit**.

4. Select a setpoint and click **Learn**.
   
   The **Global Setpoint Learning** screen is displayed.

5. Select the setpoint tabs to view existing configured or learned setpoint information.

6. Click **Setup**.
   
   The **Alarm Learning Setup** screen is displayed.

### Setpoint learning parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install mode</td>
<td>Automatic, Manual</td>
<td>• Automatic: the learned values are automatically applied.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual: the learned values are stored for you to review and enter.</td>
</tr>
<tr>
<td>Duration</td>
<td>1-365 Days</td>
<td>Days for maximum learning duration.</td>
</tr>
</tbody>
</table>

7. Configure the learning parameters for each setpoint and click **Save**.

8. Click **Start All** to begin setpoint learning for all setpoints. Click **Yes** to confirm or **No** to cancel.
   
   – Learning status and time remaining are indicated in the Learning Status box.
   
   – Click **Abort** to stop learning for a specific setpoint. To stop all setpoint learning, repeat for each setpoint tab.

9. Apply the learned setpoint values:
   
   – Automatic: the setpoint values are automatically applied unless the learning process has issues or the learned values are invalid.
   
   – Manual: navigate to **Alarming > Setpoints** and click **Learn**. On each setpoint tab, click **Install** to apply the learned values to that setpoint.

   **NOTE:** If you click **Install** while learning is in progress (in either manual or automatic installation mode), it stops the learning process and prompts you for confirmation that you want to stop learning and install the learned values. Once you confirm, the learned values are automatically installed or prepared for manual installation.

Implementing sag/swell limit learning using ION Setup

You can use ION Setup to implement voltage sag/swell learning, which analyzes your power system and recommends settings.

**NOTE:** Your meter’s power system must be stable in order to learn valid sag/swell limits.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Alarming > Sag/Swell**.
4. Select **Voltage** and click **Learn**.
   
   **NOTE:** Learning is not supported for **Current Swell** and **Current Sag**.
   
   **NOTE:** You can manually configure the limit values by selecting the parameter and clicking **Edit**.

   The **Global Setpoint Learning** screen is displayed.

5. Click **Setup**.

   The **Alarm Learning Setup** screen is displayed.

<table>
<thead>
<tr>
<th>Sag/swell limit learning parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parameter</strong></td>
</tr>
</tbody>
</table>
| Install mode | Automatic, Manual | • Automatic: the learned values are automatically applied.  
• Manual: the learned values are stored for you to review and enter. |
| Duration | 1-365 Days | Days for maximum learning duration. |

6. Configure the sag/swell limit learning parameters and click **Save**.
7. Click **Start** to begin sag/swell limit learning.
   
   • Learning status and time remaining are indicated in the Learning Status box.
   
   • Click **Abort** to stop sag/swell limit learning.

8. Apply the learned sag/swell limits.
   
   • Automatic: the limits are automatically applied unless there are issues with the learning process.
   
   • Manual: navigate to **Alarming > Sag/Swell**. Select **Voltage** and click **Learn**. Click **Install** to apply the learned limits.
   
   **NOTE:** If you click **Install** while learning is in progress (in either manual or automatic installation mode), it stops the learning process and prompts you for confirmation that you want to stop learning and install the learned limits. Once you have confirmed, the learned limits are automatically installed or prepared for manual installation.

---

**Implementing transient learning using ION Setup**

You can use ION Setup to implement voltage transient learning, which analyzes your power system and recommends settings.

**NOTE:** Your meter’s power system must be stable in order to learn valid transient thresholds.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Alarming > Transient**.
4. Select **Transient/Waveshape** and click **Learn**.

   The **Global Setpoint Learning** screen is displayed.

5. Click **Setup**.

   The **Alarm Learning Setup** screen is displayed.

6. Configure the transient threshold learning parameters and click **Save**.
7. Click **Start** to begin transient learning.
   - Learning status and time remaining are indicated in the Learning Status box.
   - Click **Abort** to stop transient learning.

8. Apply the learned values.
   - Automatic: the threshold is automatically applied unless there are issues with the learning process.
   - Manual: navigate to **Alarming > Transient**. Select **Transient/Waveshape** and click **Learn**. Click **Install** to apply the learned values.

   **NOTE:** If you click **Install** while learning is in progress (in either manual or automatic installation mode), it stops the learning process and prompts you for confirmation that you want to stop learning and install the learned limits. Once you have confirmed, the learned values are automatically installed or prepared for manual installation.

**Transient learning parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install mode</td>
<td>Automatic, Manual</td>
<td>• Automatic: the learned values are automatically applied.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Manual: the learned values are stored for you to review and enter.</td>
</tr>
<tr>
<td>Duration</td>
<td>1-365</td>
<td>Days for maximum learning duration.</td>
</tr>
</tbody>
</table>
Power quality

Power quality overview

Your meter measures voltage and current harmonics, and calculates several harmonic distortion values, including K-factor and crest factor.

Configure your meter with the power system’s nominal values for voltage, current and frequency in order for the meter to perform power quality calculations.

Considerations for power quality configuration using ION Setup

Use ION Setup to configure sag/swell, transient and advanced power quality logging.

NOTE: For waveform recording to trigger automatically, enter your system’s nominal (normal) voltage and current values and the amount of deviation from the nominal that is considered a sag or a swell using the Metering > Basic or Alarming screen.

NOTE: Changing your meter’s data logging (including burst data logging) and waveform recording configuration clears your meter’s existing data logs, waveform records and COMTRADE waveform files.

Before setting up the PQ parameters, make sure the meter has been configured correctly:

• metering parameters such as volts mode and PT/CT ratios
• time sync settings, for integrating the meter in an energy management system such as Power Monitoring Expert
• nominal system parameters (nominal volts, nominal current and nominal frequency), for detecting power quality events
• amount of deviation from the nominal that is considered a sag or swell

Make sure you understand:

• the structure of the meter’s logging framework
• the meter’s existing logging configuration
• your data logging requirements

Changing the meter’s data recorder and waveform recorder configuration clears existing data and waveforms in those recorders.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATA LOSS</td>
</tr>
<tr>
<td>Ensure that all important data and waveforms have been recorded before configuring the data and waveform recorders.</td>
</tr>
<tr>
<td>Failure to follow these instructions can result in data loss.</td>
</tr>
</tbody>
</table>

Power quality logging

Sag/swell overview

Your meter monitors your power system’s voltage and current for sags and swells (INCITS (CBEMA) Type 2 and Type 3 disturbances).

When sag/swell limits are defined and alarming is enabled, the meter reports the disturbance’s magnitude and duration, and logs data and waveform records associated with the disturbance.
Configuring Sag/Swell logging using ION Setup

Use ION Setup to configure your meter to log data and waveform records related to sag/swell events, and to export the waveform data to COMTRADE files.

**NOTE:** There are 2 data recorders for logging sag/swell related data: Sag/Swell Log (Data Rec 5) records data for plotting the ITI(CBEMA) curve, and Sg/Sw HS Log (Data Rec 6) records voltage and current data from the High-Speed Power Meter module.

To set up the Sag/Swell Log, Sg/Sw HS Log, Sag/Swell Waveform Log and Sag/Swell COMTRADE files:

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Power Quality > Sag/Swell Logging**.
4. Select the data log and click **Edit**. Enter the meter password if prompted.
   
   The **Sag/Swell Logging Wizard** appears.

5. The **Device setting verification** screen displays results of the meter configuration check for potential errors related to sag/swell monitoring and reporting. Click **Fix** to view details, or click **Next** to ignore the results and proceed to the next screen.

6. The **Disturbance Logging Setup** screen displays the **Log Depth** setting for Sag/Swell Log (Data Rec 5). You can change the maximum number of records to store in this log. Click **Next** to proceed to the next screen.

7. The **High Speed Recording** screen displays the settings for the high-speed Sag/Swell data recorder (Sg/Sw HS Log - Data Rec 6). You can configure these settings for the meter to perform burst data logging.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Burst Data Logging</td>
<td>Select or clear this check box to turn burst data logging on or off.</td>
</tr>
<tr>
<td>Pre-trigger recording¹</td>
<td>Specifies, in seconds, how many pre-event records to capture. The actual number of records set in the high-speed Sag/Swell data recorder’s Pre-trigger Records setup register = (2 x system frequency) x (number of seconds).</td>
</tr>
<tr>
<td>Post-trigger recording¹</td>
<td>Specifies, in seconds, how many post-event records to capture. The actual number of records set in the high-speed Sag/Swell data recorder’s Post-trigger Records = (2 x system frequency) x (number of seconds).</td>
</tr>
<tr>
<td>Total # of recordings²</td>
<td>Specifies how many burst data log sets to save in long-term memory (NVRAM). The actual number of records is configured in the high-speed Sag/Swell data recorder’s Depth setup register = (Total # of recordings) x (Pre-trigger Records + Post-trigger Records + 1). See “Data recorder burst data”, page 167 for an example of how a data log set is calculated.</td>
</tr>
</tbody>
</table>

¹ If system frequency is changed, the recording duration for Pre-trigger recording and Post-trigger recording automatically adjusts to reflect the new frequency setting.

² When burst data logging is enabled, the equivalent number of records for 2 burst data log sets is allocated in short-term memory (RAM). The actual number of records set in the high-speed Sag/Swell data recorder’s Buffer Depth setup register = 2 x (Pre-trigger Records + Post-trigger Records + 1).
8. The **Waveform Log Setup** screen allows you to configure the waveform recorder for Standard or Delayed waveform capture.

   **NOTE:** The **Sag/Swell Logging Wizard** does not support Extended waveform capture. See "Waveform capture", page 168 for details on Standard, Delayed and Extended waveform capture.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform Depth</td>
<td>Specifies the maximum number of waveform records stored on the meter.</td>
</tr>
<tr>
<td>Waveform Format</td>
<td>Specifies the number of samples per cycle and the number of cycles that are stored in a waveform record.</td>
</tr>
<tr>
<td>Trigger Position</td>
<td>Specifies the number of cycles to capture before the waveform versus after the waveform. Trigger position can be set using the pre-cycle arrows or the slider bar.</td>
</tr>
</tbody>
</table>

   **NOTE:** The maximum number of cycles (pre-event + post-event) cannot exceed the total number of cycles in the waveform format.

Click **Next**.

9. Configure your meter’s COMTRADE settings:

   a. Select or clear the **Generate COMTRADE files** check box to enable or disable the creation of COMTRADE records.

      **NOTE:** The waveform viewer on your meter’s webpages uses the meter’s COMTRADE files. If you want to view waveforms on the meter’s webpages, select **Generate COMTRADE files**.

      **NOTE:** The factory-default configuration for COMTRADE only supports Standard waveform capture.

   b. Set the **Log depth** for the COMTRADE files to specify the maximum number of records stored on your meter’s SFTP site.

10. Click **Finish**.

    You are returned to the Sag/Swell Logging screen and the entry shows your new configuration.

    If nothing happens when you click **Finish**, check the log depths and buffer depths for all your other data logs to make sure that the meter has enough memory for these changes. Adjust the log depth and buffer depth of the data and waveform recorders if needed.

### Transient overview

Your meter monitors your power system’s voltage and detects ITI (CBEMA) type disturbances related to transients.

When voltage transient limits are defined and alarming is enabled, the meter reports the disturbance’s magnitude and duration, and logs data and waveform records associated with the disturbance.

### Configuring Transient logging using ION Setup

Use ION Setup to configure your meter to log data and waveform records related to voltage transient events, and to export the waveform data to COMTRADE files.

   **NOTE:** Transient Log (Data Rec 15) records voltage transient related data.

To set up the Transient Log, Transient Waveform Log and Transient COMTRADE files:

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to Power Quality > Transient Logging.
4. Select the data log and click **Edit**. Enter the meter password if prompted. The **Transient Logging Wizard** appears.

5. The **Device setting verification** screen displays the results of meter configuration check for potential errors related to transient monitoring and reporting. Click **Fix** to view details, or click **Next** to ignore the results and proceed to the next screen.

6. The **Transient Logging Setup** screen displays Transient data recorder’s **Log Depth** setting. You can change the maximum number of records to store in the Transient data log. Click **Next** to proceed to the next screen.

7. The **Waveform Log Setup** screen allows you to configure the waveform recorder for Standard or Delayed waveform capture.

   **NOTE:** The **Transient Logging Wizard** does not support Extended waveform capture. See “Waveform capture”, page 168 for details on Standard, Delayed and Extended waveform capture.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform Depth</td>
<td>Specifies the maximum number of waveform records stored on the meter.</td>
</tr>
<tr>
<td>Waveform Format</td>
<td>Specifies the number of samples per cycle and the number of cycles that are stored in a waveform record.</td>
</tr>
<tr>
<td>Trigger Position</td>
<td>Specifies the number of cycles to capture before the waveform versus after the waveform. Trigger position can be set using the pre-cycle arrows or the slider bar.</td>
</tr>
</tbody>
</table>

**NOTE:** The maximum number of cycles (pre-event + post-event) cannot exceed the total number of cycles in the waveform format.

Click **Next**.

8. Configure your meter’s COMTRADE settings:

   a. Select or clear the **Generate COMTRADE files** check box to enable or disable the creation of COMTRADE records.

      **NOTE:** The waveform viewer on your meter’s webpages uses the meter’s COMTRADE files. If you want to view waveforms on the meter’s webpages, select **Generate COMTRADE files**.

      **NOTE:** The factory-default configuration for COMTRADE only supports Standard waveform capture.

   b. Set the **Log depth** for the COMTRADE files to specify the maximum number of records stored on your meter’s internal SFTP site.

9. Click **Finish**.

You are returned to the Transient Logging screen and the entry shows your new configuration.

If nothing happens when you click **Finish**, check the log depths and buffer depths for all your other data logs to make sure that the meter has enough memory for these changes. Adjust the log depth and buffer depth of the data and waveform recorders if needed.

---

### Configuring Advanced PQ using ION Setup

Use ION Setup to configure your meter’s power quality (PQ) monitoring and logging settings for IEC 61000-4-30, EN 50160, IEEE 519 and Rapid Voltage Change (RVC).

The meter’s PQ frameworks are designed with logical dependencies. IEC 61000-4-30 must be enabled first if you want to monitor and record PQ parameters for EN 50160 or IEEE 519. In addition, the Sag/Swell feature must be enabled in order to monitor and detect disturbances such as RVC.
DATA LOSS

- Enable IEC 61000-4-30 before enabling other power quality monitoring and recording features.
- Enable Sag/Swell before configuring power quality disturbance related features.

Failure to follow these instructions can result in data loss.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
4. Select 4-30 Enable and click Edit to configure your meter’s IEC 61000-4-30 logging parameters.
5. Configure the settings as required:

   **IEC 61000-4-30 Setup**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Select if you want to enable IEC 61000-4-30 monitoring. <strong>NOTE:</strong> This option must be enabled when monitoring EN 50160 or IEEE 519 parameters.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Specifies the percentage of nominal voltage that defines a disturbance. For example, if you set this to 10% of 120 V nominal, the disturbance occurs when the voltage dips to 12 V and below.</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>Specifies the percentage above the Threshold that defines the end of the disturbance. For example, if you set this to 2%, the end of the disturbance occurs when the voltage rises to (10% + 2%) of nominal, or 14.4 V and above.</td>
</tr>
<tr>
<td>Log 4-30 3s measurements</td>
<td>Select if you want to enable IEC 61000-4-30 3-second interval data logging.</td>
</tr>
<tr>
<td>Log 4-30 10s measurements</td>
<td>Select if you want to enable IEC 61000-4-30 10-second interval data logging.</td>
</tr>
</tbody>
</table>

6. Click Send to save your changes.
   The Advanced PQ Logging screen shows the new configuration.
7. Select EN 50160 Enable.
   If you want to delete all logged EN 50160 data, click Reset, then click Yes to confirm.
8. Click Edit to configure your meter’s EN 50160 logging parameters.
   **NOTE:** You must enable IEC 61000-4-30 before the meter can start monitoring EN 50160 parameters.
9. Configure the settings as required:

   **EN50160 Configuration Setup**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Select if you want to enable EN 50160 monitoring.</td>
</tr>
<tr>
<td>Nominal Voltage</td>
<td>Specifies the nominal voltage value used for EN 50160.</td>
</tr>
<tr>
<td>Nominal Frequency</td>
<td>Specifies the nominal frequency used for EN 50160.</td>
</tr>
<tr>
<td>Log EN50160 measurements</td>
<td>Select if you want to log EN 50160 parameters. Note that you need to enable EN 50160 monitoring in order to log the parameters.</td>
</tr>
</tbody>
</table>
10. Click **Send** to save your changes.

The **Advanced PQ Logging** screen shows the new configuration.

11. Select **519 Enable** and click **Edit** to configure your meter’s IEEE 519 logging parameters.

   **NOTE:** You must enable IEC 61000-4-30 before the meter can start monitoring IEEE 519 parameters.

12. Configure the settings as required:

   **IEEE 519 Configuration**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal Voltage</td>
<td>Displays the nominal voltage value used for IEEE 519.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If you change the Nominal Voltage, you must return to</td>
</tr>
<tr>
<td></td>
<td>this setup screen and manually update the IEEE 519</td>
</tr>
<tr>
<td></td>
<td>configuration.</td>
</tr>
<tr>
<td>&lt;Bus voltage options&gt;</td>
<td>Select the bus voltage at the point of common coupling.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Disabled</strong> if you do not want to log IEEE 519 related data.</td>
</tr>
</tbody>
</table>

13. After specifying the bus voltage, click **Next** to configure the IEEE 519 current parameters.

   **IEEE 519 Configuration**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum short</td>
<td>Enter the maximum short-circuit current at the point of common</td>
</tr>
<tr>
<td>circuit current</td>
<td>coupling.</td>
</tr>
<tr>
<td>Maximum demand load current</td>
<td>Enter the maximum demand load current at the point of common</td>
</tr>
<tr>
<td></td>
<td>coupling.</td>
</tr>
<tr>
<td>Ratio</td>
<td>This displays the maximum short-circuit to maximum demand load</td>
</tr>
<tr>
<td></td>
<td>ratio. This is used to determine the voltage and current distortion</td>
</tr>
<tr>
<td></td>
<td>limits.</td>
</tr>
</tbody>
</table>

14. Click **Next** to view the screen that displays the voltage and current distortion limits for the harmonic content.

   Harmonics 2 to 50 and THD/TDD are displayed, with the corresponding set limits for Voltage Distortion % and Current Distortion %.

15. Click **Finish** to save your changes.

   The **Advanced PQ Logging** screen shows the new configuration.

16. Select **RVC Enable** and click **Edit** to configure your meter’s RVC (Rapid Voltage Change) feature.

   **NOTE:** You must enable the Sag/Swell module before the meter can start monitoring and detecting RVC.

17. Configure the settings as required:

   **Rapid Voltage Change Setup**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>• Disabled means ION Setup has detected that the Sag/Swell module is</td>
</tr>
<tr>
<td></td>
<td>disabled. Go to <strong>Alarming &gt; Sag/Swell</strong> and enable Sag/Swell first,</td>
</tr>
<tr>
<td></td>
<td>in order for the meter to detect RVC.</td>
</tr>
<tr>
<td></td>
<td>• Yes means RVC monitoring is on. Make sure the Sag/Swell module is</td>
</tr>
<tr>
<td></td>
<td>enabled, otherwise RVC will not be detected.</td>
</tr>
<tr>
<td></td>
<td>• No means RVC monitoring is off.</td>
</tr>
<tr>
<td>Threshold</td>
<td>Specifies, as a percentage, the RMS voltage limit that must be exceeded</td>
</tr>
<tr>
<td></td>
<td>for an RVC event to occur.</td>
</tr>
<tr>
<td>Hysteresis</td>
<td>Specifies, as a percentage, the difference in magnitude between the start</td>
</tr>
<tr>
<td></td>
<td>and end thresholds for an RVC event.</td>
</tr>
</tbody>
</table>
18. Click **Send** to save your changes.

The **Advanced PQ Logging** screen shows the new configuration.

### Rapid Voltage Change overview

Rapid Voltage Change (RVC) is a quick transition in RMS voltage between two steady-state conditions, during which the voltage does not exceed the sag/swell thresholds.

You can configure the Sag/Swell module to detect and measure RVC and record the event in the meter’s Event Log.

For more information on the Sag/Swell module, download the *ION Reference* at www.schneider-electric.com.

### Harmonics overview

Harmonics are integer multiples of the fundamental frequency of the power system.

Harmonics information is valuable for power quality analysis, determining properly rated transformers, maintenance and troubleshooting. Evaluation of harmonics is required for compliance to system power quality standards such as EN50160 and meter power quality standards such as IEC 61000-4-30.

Harmonics measurements include per-phase magnitudes and angles (relative to the fundamental frequency of the phase A voltage) for the fundamental and higher order harmonics relative to the fundamental frequency. The meter’s power system setting defines which phases are present and determines how line-to-line or line-to-neutral voltage harmonics and current harmonics are calculated.

Harmonics are used to identify whether the supplied system power meets required power quality standards, or if non-linear loads are affecting your power system. Power system harmonics can cause current flow on the neutral conductor, and damage to equipment such as increased heating in electric motors. Power conditioners or harmonic filters can be used to minimize unwanted harmonics.

### Viewing harmonics information using the display

You can view detailed harmonics data through the display.

1. Press the Home button on the display.

2. Navigate to **Power Quality > Harmonics**. The total harmonic distortion (THD) screens are displayed.

3. Press more, then use the up or down icons to select the desired harmonics. The per-phase harmonics are graphically displayed.

4. Press the left and right icons to move to individual harmonics. The harmonic number, magnitude and phase angle are displayed.

### Voltage crest factor

Crest factor is the ratio of peak to RMS voltage values.

For a pure sinusoidal waveform, crest factor is equal to 1.414. The meter uses the following equation to calculate crest factor:
Current crest factor

Crest factor is the ratio of peak to RMS current values.

For a pure sinusoidal waveform, crest factor is equal to 1.414. The meter uses the following equation to calculate crest factor:

\[ C = \frac{I_{\text{peak}}}{I_{\text{RMS}}} \]

K-factor

K-factor relates the heating effect of a distorted current in a transformer to a sinusoidal current with the same RMS magnitude — it describes a transformer’s ability to serve non-linear loads without exceeding rated temperature rise limits.

The K-factor is equal to the sum of the squares of the harmonic currents multiplied by the squares of the harmonic order. The meter uses the following equation to calculate K-factor:

\[ K = \sum_{n=1}^{h} (I_n^2 \times h^2) \]

Where \( K \) is the K-factor, \( h \) is the harmonic order and \( I_h \) is the true RMS current of harmonic order \( h \).

Harmonic content calculations

Harmonic content (\( H_C \)) is equal to the RMS value of all the non-fundamental harmonic components in one phase of the power system.

The meter uses the following equation to calculate \( H_C \):

\[ H_C = \sqrt{(H_2)^2 + (H_3)^2 + (H_4)^2 ...} \]

THD% calculations

THD% is a quick measure of the total distortion present in a waveform and is the ratio of harmonic content (\( H_C \)) to the fundamental harmonic (\( H_1 \)).

By default, the meter uses the following equation to calculate THD%:

\[ \text{THD} = \frac{H_C}{H_1} \times 100\% \]
thd and TDD

Your meter can be configured to provide thd (total harmonic distortion using the total RMS value for the content rather than the fundamental content) and TDD (total demand distortion, the harmonic current distortion against the maximum demand of the electrical system).

\[
\text{thd} = \frac{H_C}{\text{RMS}} \times 100\%
\]

\[
\text{TDD} = \frac{H_C}{\text{Demand}_{\text{Max}}} \times 100\%
\]

See the ION Reference, available from www.schneider-electric.com, for details about the Harmonics Measurement module.

Phasors

Phasors are used to represent the voltage and current magnitude and angles.

The length of the lines in the phasor diagram represent the relative magnitude of the voltages with respect to the other phase voltages, and the currents with respect to the other phase currents. All angles are measured with respect to the Vα/V1 phase. The Vα/V1 phasor is fixed to the right-hand horizontal axis (positive x-axis). Positive angles are measured counterclockwise.

Measured values are provided for the magnitude and relative angle for each voltage and current phase.

Delta vector diagrams can be configured to display two different ways:

- Instrument (voltage vectors appear 60 degrees apart - showing the actual voltage and current values that the meter is measuring).
- System (voltage vectors appear 120 degrees apart - showing true system operation including any calculated values).

Phasor information can be used to troubleshoot incorrect connections on the meter’s voltage and current inputs (for example, switched phase wiring or polarity errors), if you know how the phasors should be oriented for your power system.

Phasor information can be viewed using ION Setup, the webpages or display.

Power quality standards compliance

Your meter is compliant with the following power quality standards.

IEC 62586-1 and IEC 62586-2

Your meter is compliant with IEC 62586-1 and IEC 62586-2. The meter classification is PQI-A-FI1, defined as follows:

<table>
<thead>
<tr>
<th>Product Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PQI</td>
<td>Power quality instrument</td>
</tr>
<tr>
<td>A</td>
<td>Functions class A according to IEC 61000-4-30</td>
</tr>
<tr>
<td>F</td>
<td>Fixed installed equipment</td>
</tr>
<tr>
<td>I</td>
<td>Indoor application</td>
</tr>
<tr>
<td>1</td>
<td>Indoor environment with uncontrolled temperature variations</td>
</tr>
</tbody>
</table>

**NOTE:** Your meter has Power station electromagnetic immunity compliance in accordance with IEC 61000-6-5.
IEC 61000-4-30

IEC 61000-4-30 power quality standard compliance is provided by ION modules including: Power Quality Aggregator, Harmonics Measurement, Disturbance Analyzer, Symmetrical Components, Mains Signaling Evaluation, and Sag/Swell.

See the IEC 61000-4-30 compliance and ION meters technical note for details.

EN 50160

The EN 50160 framework includes ION modules, such as: Flicker, Mains Signaling Evaluation, Harmonics Evaluation and Voltage Harmonics.

Your meter’s framework is pre-configured for a low voltage system.

**NOTE:** Connect your meter to a UPS to avoid losing EN 50160 data in the event of a power outage.

See the Power quality: ION meters and EN 50160:2010 technical note for details.

IEEE 519

The IEEE 519 framework includes ION modules, such as: Harmonics Evaluation, Harmonics Measurement and Counter.

IEC 60255-24 (COMTRADE)

The meter provides waveforms in COMmon format for TRAnsient Data Exchange (COMTRADE) format. COMTRADE records are generated from the existing Waveform Recorder modules that are connected to the COMTRADE module.

See the COMTRADE and ION Technology technical note for details.

Disturbance direction detection overview

Your meter has disturbance direction detection capabilities to help you determine the location of a power system disturbance.

When a disturbance occurs, the meter analyzes the disturbance information to determine the direction of the disturbance relative to the meter. This analysis includes a confidence level indicating the level of certainty that the disturbance is in the determined direction, and is stored in your meter’s event log.

Disturbance direction detection is enabled on your meter by default and does not require any additional configuration beyond setting the nominal voltage and nominal frequency.

Disturbance direction detection can help locate the source of a disturbance when used in a system of disturbance direction detection devices. In the diagram below, meters (B), (C) and (D) are installed on the power consumer side, while meter (E) is installed on the utility side.
A. Disturbance location
B. Meter (B) reports downstream disturbance
C. Meter (C) reports upstream disturbance
D. Meters (D) report upstream disturbance
E. Meter (E) reports downstream disturbance

The arrows show the direction the meters have determined for the disturbance. With this information, you can determine that the disturbance occurred between meter (B) and meter (C), and can focus on that section of your system to find the cause of the disturbance.

**Disturbance direction detection events**

The results of the disturbance direction detection algorithm appear in the meter’s event log.

The image below shows an example of how the Disturbance Direction Detection event appears in your meter’s event log when viewed using ION Setup.

**NOTE:** You can view your meter’s event log through ION Setup, the meter webpages or display.

See the ION Reference, available from www.schneider-electric.com, for more detailed information about the Disturbance Direction Detection module.

**COMTRADE**

Your meter can generate COMTRADE files and store them on the meter’s internal SFTP site.

COMTRADE stands for COMmon format for TRAnsient Data Exchange defined by IEC 60255-24, and defines a common format for power quality event (disturbance) data in order to simplify retrieval, analysis and exchange of disturbance data between multiple sources and vendors.

The format of your meter’s COMTRADE files is as defined by IEC 60255-24.

COMTRADE can be used in conjunction with IEC 61850.
See the COMTRADE and ION technology technical note, available from www.schneider-electric.com, for detailed information about COMTRADE file formats and implementation.

**COMTRADE implementation overview**

COMTRADE is configured as part of the default waveform recording framework.

COMTRADE records are generated for sag/swell events. Configure your meter nominal voltages to enable waveform recording. COMTRADE records are stored as read-only files on your meter’s internal SFTP site, and are deleted when you perform a Master reset of the meter, upgrade firmware or make changes to the waveform recorders.

By default:

- The meter is configured so COMTRADE records are generated for the default waveform recorders.

  **NOTE:** If you add additional waveform recorders and you want COMTRADE files generated for these new recorders, you need to configure a new COMTRADE module using ION Setup Advanced mode. You can configure up to three COMTRADE modules.

- The oldest COMTRADE record is overwritten by the newest record when the COMTRADE depth is exceeded.

  **NOTE:** COMTRADE files can only be downloaded using an Ethernet connection. They cannot be downloaded using serial, modem or Ethernet gateway connections.

See the COMTRADE and ION technology technical note, available from www.schneider-electric.com, for detailed information about COMTRADE file formats and implementation.

**Waveforms on your meter’s webpages**

You can use the waveform viewer on the meter’s webpages to view waveforms generated as a result of power quality events.

**Overview of how to setup and view waveforms on your meter’s webpages**

Before you can view waveforms on the meter’s webpages, you need to perform some basic configuration to enable waveform capture and store the waveforms in COMTRADE format.
1. Enable waveform capture on your meter
   Set the meter’s nominal voltage using ION Setup or the webpages.

2. A waveform is captured when a power quality event occurs
   A COMTRADE record is generated and saved to your meter’s internal SFTP site.

3. View the waveform on the meter’s webpages
   Go to the waveform viewer (Monitoring > Waveforms) to explore the waveform data.

The waveform viewer uses the meter’s COMTRADE files to display the waveforms. If the events you want to capture are not included in the default framework, you can customize the meter’s waveform recording framework.

**Overview of the webpage waveform viewer**

After COMTRADE files are generated by your meter, you can view them using the waveform viewer.

- A. Select the COMTRADE module to view (COMTRADE_1 is set up by default; you can also set up COMTRADE_2 or COMTRADE_3)
- B. Select the particular COMTRADE waveform to view
- C. Show / hide parameters
- D. View details
- E. Zoom in / out
Viewing waveforms on your meter’s webpages

Use the waveform viewer on your meter’s webpages to view the meter’s COMTRADE waveform files.

Before you can view waveforms on your meter’s webpages, you need to make sure your meter is configured to record waveforms by setting the nominal voltage.

1. Launch a browser and go to the IP address for your meter, entering valid login credentials when requested.


   A screen displays with accordion menus for 3 COMTRADE modules (regardless of whether or not that COMTRADE module is being created by the meter). The waveform viewer for COMTRADE_1 is expanded.

   By default, COMTRADE_1 displays the sag/swell waveform records. COMTRADE_2 and COMTRADE_3 are used if you have configured additional waveform recorders and connected them to COMTRADE modules.

3. Select the accordion menu for the COMTRADE records you want to view, for example COMTRADE_2.

   The waveform viewer for those COMTRADE records is displayed.

4. Select the file you want to view from the record dropdown.

   The numbering starts at 0 (zero), which means you select cmt0_00004 to view the fifth file for COMTRADE_1.

5. Click or tap an individual voltage or current channel in the legend to show or hide it in the waveform viewer.

   – Visible
   – Hidden

6. Use the bar at the bottom to zoom in / zoom out on a particular section of the waveform, or to scan through the waveform with the selected zoom level.

   – Draw a window over a particular area to zoom in on that section of the waveform.
   – Drag the selected area to move the zoom across the waveform.
   – Drag the start and end points to expand or narrow the zoom.

7. Hover over or tap a spot on the waveform to view the values associated with that particular moment in time.

Burst data logging

Burst data logging is a recording method that captures a snapshot of data that occurred immediately before and immediately after a triggered recording.

Burst data logging is analogous to continuous shooting mode or “burst mode” in photography. An understanding of pre and post event data assists in the analysis of undesired power quality events such as sags or swells.

Burst logging is typically used for high-speed RMS (half-cycle) data capture, but the data recorder supports standard speed (1-second) recording as well.
depending on the ION modules connected to the inputs of the Data Recorder module.

**NOTE:** To maximize the performance of your power management system, it is recommended that devices be connected directly to an Ethernet network.

**Data recorder burst data**

The meter’s Data Recorder modules support burst data logging.

The Data Recorder module’s *Pre-trigger Records* setup register specifies how many pre-event records are saved with each triggered recording. The *Post-trigger Records* setup register specifies how many post-event records are saved with each triggered recording.

Both *Pre-trigger Records* and *Post-trigger Records* are set to zero by default. To configure the data recorder for burst data logging, either or both of these setup registers must be set to a non-zero positive integer value.

The data log set for each triggered recording is equal to the sum of *Pre-trigger Records* + *Post-trigger Records* + 1 (where 1 is the actual record when the Data Recorder module’s *Record* input was triggered).

For example, if *Pre-trigger Records* is set to 10 and *Post-trigger Records* is set to 5, the number of records for each data log set would be 16:

1 record triggered

10 Pre-trigger Records

5 Post-trigger Records

**Buffer Depth**

$6 \times 16 = 96$

**Depth**

$16 \times 16 = 256$

Data log set is $10 + 1 + 5 = 16$

Burst data log set = [pre-trigger records] + [post-trigger records] + [actual trigger record] = $10 + 5 + 1 = 16$.

When burst data logging is enabled, both *Buffer Depth* and *Depth* setup registers must be set to a positive integer multiple of the data log set.

Use the system frequency to calculate the number of records needed to capture 1 second of data:

- For 60 Hz, total number of records per second = 60 cycles/second x 2 half-cycles = 120
- For 50 Hz, total number of records per second = 50 cycles/second x 2 half-cycles = 100
You can use the **Power Quality** setup assistant in ION Setup to specify how many seconds of pre-trigger and post-trigger data you want to capture. ION Setup automatically calculates the required number of records based on your input.

### Waveform capture

The meter’s Waveform Recorder modules capture waveform data.

The Waveform Recorder module captures one waveform record every time its `Record` input is triggered. A waveform record is defined by the module’s `Format` setup register, expressed as (number of samples per cycle) x (number of cycles per waveform record). For example, if `Format` is set to 256x7, that means one waveform record is made up of 7 cycles of waveform data at 256 samples per cycle resolution.

#### Standard waveform capture

The meter’s Waveform Recorder modules support standard waveform capture.

A standard waveform capture saves 1 buffered waveform record at the `Record` trigger time. Only pre-trigger waveform data is captured in this mode. No post-trigger waveform cycles are recorded.

#### Delayed waveform capture

The meter’s Waveform Recorder modules support delayed waveform capture.

The Waveform Recorder module’s `Record Delay Cycles` setup register specifies how many cycles to delay the waveform capture after the `Record` input is triggered. This is for capturing post-trigger waveform data.
Extended waveform capture

The meter’s Waveform Recorder modules support extended waveform capture. The Waveform Recorder module’s Pre-trigger Records setup register specifies how many pre-event records are saved with each triggered recording. The Post-trigger Records setup register specifies how many post-event records are saved with each triggered recording.

Both Pre-trigger Records and Post-trigger Records are set to zero by default. To configure the waveform recorder for extended waveform capture, either or both of these setup registers must be set to a non-zero positive integer value. If you do this, you must also set the Record Delay Cycles setup register to zero in order to properly configure the extended waveform capture.
The waveform log set for each triggered recording is equal to the sum of Pre-trigger Records + Post-trigger Records + 1 (where 1 is the actual record when the Waveform Recorder module’s Record input was triggered).

For example, if Pre-trigger Records is set to 2 and Post-trigger Records is set to 6, the number of records for each waveform log set is 9:
The waveform log set for the extended waveform capture = [pre-trigger records] + [actual trigger record] + [post-trigger records]. The total waveform records captured in this example is 2 + 1 + 6 = 9.

When extended waveform capture is enabled, both Buffer Depth and Depth setup registers must be set to a positive integer multiple of the waveform log set.

**NOTE:** The COMTRADE module does not support extended waveform capture. The COMTRADE files saved are only for the trigger waveform record.
High-Speed Transient Capture (HSTC)

HSTC Overview

The high-speed transient capture (HSTC) feature is available on the ION9000T (METSEION95030 and METSEION95040).

The ION9000T meter is equipped with firmware and frameworks that enable the HSTC feature.

The ION9000T continuously monitors incoming voltage signals. In addition to standard transient monitoring, the ION9000T detects sub-microsecond high-voltage transients up to a peak voltage of 10 kV.

The default HSTC related settings suit most applications. Use the default settings or make changes based on your system needs.

Use the HSTC feature to:

- Expand power quality event detection capabilities when combined with standard transient capture.
- Record pre-event data to see the characteristics of the incoming voltage signal before the disturbance.
- Receive alarm notifications when a transient has been detected.
- Chart waveforms to better understand the transient event. For example, peak magnitude, duration and initial polarity of the transient.
- Record statistics, such as voltage stress, to provide an indication of cumulative impact to loads within the electrical system.
- Sort voltage transients by peak magnitude and duration.
- Quantify transients on a per phase basis.
- Detect and characterize transients to create mitigation strategies.

Refer to the ION Reference document at www.schneider-electric.com for information about the HSTC, HSTC waveform recorder and Data set recorder modules.

Go to www.schneider-electric.com and search for “An Overview of Transients in Power Systems” for information on transients and their effects in electrical power systems.

Prerequisites

To use the HSTC feature, you need the following:

- ION9000T meter.
- ION9000T frameworks files (v2.2.x or later).
- ION Setup (v3.2.x or later).

The HSTC feature is not supported on other ION9000 series meters.

How do I know if I have the correct frameworks?

The HSTC option is displayed as the HSTC feature set.

View the meter’s feature set using ION Setup, meter webpages or the display.

Viewing feature set using ION Setup

1. Open ION Setup and select the Setup Assistant for your meter.
2. Click Template > Save to PC > FAC1 Feature Set.
Viewing feature set using the meter webpages

1. Open a web browser and enter the IP address for your meter. Enter your login credentials when prompted.
2. Click Diagnostics > Statistics > Meter - Basic > Feature Set.

Viewing feature set using the display

Select Alt Display Mode > Nameplate > Feature Set.
See Display modes, page 106 for information about display modes.

How do I know if I have the correct version of ION Setup?

1. Open ION Setup.
2. Click Help > About ION Setup. An ION Setup dialog box opens and displays the ION Setup version.
   Download the latest version of ION Setup if your version is earlier than v3.2.x.

Downloading latest ION Setup

2. Download the installation file, then run it to upgrade ION Setup.

Commission HSTC

This section supplements the meter installation sheets and provides guidance on commissioning your meter to enable the HSTC feature.

See your device installation sheets for information related to installation.

System voltage

Potential transformer (PT) scaling is not applied in high-speed transient capture. High-speed transient measurements are performed on voltage levels present at the meter's voltage terminals.

Voltage reference

Set the voltage reference, Ve or Vn, according to your system configuration. High-speed transient voltage measurements are calculated between V1-V4 and neutral (Vn), or between V1-V4 and earth (Ve) depending on this setting.

Communications

Ethernet communication is recommended. HSTC waveform viewing is not supported over serial connections.

Set up HSTC

HSTC alarms are disabled by default. The HSTC feature is enabled when HSTC alarms are enabled.
HSTC related settings, such as magnitude and duration thresholds, are pre-configured at the factory. Use the default settings or make changes based on your system needs.

Review and configure the settings for the following functions before enabling the HSTC feature:

- HSTC alarms.
- HSTC logging.

### HSTC alarms

Use HSTC alarms to notify you when a specific condition is met, such as a voltage transient that exceeds a defined magnitude threshold.

HSTC alarms are included in the ION9000 series alarm system and are shown in the meter’s [Historical Alarm](#) screen(s).

### Default HSTC alarm settings

<table>
<thead>
<tr>
<th>Setup Register</th>
<th>Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>HSTC Alarm status</td>
<td>Disabled, enabled</td>
<td>Disabled</td>
</tr>
<tr>
<td>Voltage Reference</td>
<td>Vₑ, Vₙ</td>
<td>Vₑ</td>
</tr>
<tr>
<td>Magnitude Threshold</td>
<td>120 - 7100</td>
<td>1000</td>
</tr>
<tr>
<td>Duration Threshold</td>
<td>0 - 250.0</td>
<td>0</td>
</tr>
<tr>
<td>Alarm Priority</td>
<td>None, Info Only, Low, Medium, High</td>
<td>High</td>
</tr>
<tr>
<td>Custom Priority</td>
<td>0 - 255</td>
<td>192</td>
</tr>
</tbody>
</table>

To use HSTC alarms, perform the following:

- Enable HSTC alarms.
- Configure HSTC alarms.
  - Set the voltage reference.
  - Set the peak magnitude threshold and duration threshold.
  - Assign alarm priority.
  - Set a custom alarm priority.
- View and acknowledge alarms.

See [Alarms and alerts, page 138](#) for additional information about the ION9000 series alarms.

### Enable and configure HSTC alarms

Enable HSTC alarms using ION Setup or the display.

Configure HSTC alarms using ION Setup.

Changing your meter’s HSTC alarm configuration deletes all existing Data set and HSTC waveform logs.

---

**NOTICE**

**DATA LOSS**

Ensure that all important data has been recorded before configuring HSTC alarms.

Failure to follow these instructions can result in data loss.
Enabling and configuring HSTC alarms using ION Setup

1. Open ION Setup and select the Setup Assistant for your meter.
2. Click Alarming > Transient.
3. Select High Speed Transient and click Edit. The High Speed Transient Setup window is displayed.
4. View or modify parameters:
5. Click Save. ION Setup performs a configuration check and displays a message if the Magnitude Threshold setting is below the configured nominal voltage.

<table>
<thead>
<tr>
<th>Setup Register</th>
<th>Value/Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled/Disabled</td>
<td>Enabled or Disabled</td>
<td>Specifies if HS Transient capture is enabled.</td>
</tr>
<tr>
<td>Voltage Reference</td>
<td>Ve or Vn</td>
<td>Determines the voltage reference. Set the voltage reference to match your system configuration.</td>
</tr>
<tr>
<td>Magnitude Threshold</td>
<td>120 - 7100</td>
<td>Specifies the absolute voltage threshold that must be exceeded to trigger a HS transient capture. Note that this value is entered in RMS volts.</td>
</tr>
<tr>
<td>Duration Threshold</td>
<td>0 - 250.0</td>
<td>Specifies the length of time that the magnitude threshold must be exceeded to trigger a HS transient capture. If this register is set to zero, any voltage that exceeds the magnitude threshold will trigger a HS transient capture.</td>
</tr>
<tr>
<td>Alarm Priority</td>
<td>None, Info Only, Low, Medium, High</td>
<td>Select the alarm priority you want to associate with the HS transient alarms. To stop an alarm from being displayed without affecting other meter features, set the alarm priority to Info Only.</td>
</tr>
<tr>
<td>Custom Priority</td>
<td>0 - 255</td>
<td>Select custom priority to view and configure the priority associated with the alarm. The event log cutoff value is displayed for reference. Event priorities above the cutoff are stored in the meter’s event log.</td>
</tr>
</tbody>
</table>

Enabling HSTC alarms using the display

Enable and disable HSTC alarms using the display.

1. Review your meter’s nominal voltage settings.
2. Set the HSTC magnitude threshold to a value higher than the nominal voltage.

See Disabling and enabling alarms using the display, page 145 for instructions.

Log HSTC

HSTC logging

The HSTC logging function is enabled with HSTC alarms. When defined transient thresholds are exceeded the meter performs the following:
• HSTC data set logging.
• HSTC waveform logging.

The meter performs a set of calculations and stores separate records for each voltage phase. Records are captured for V1 - V4 regardless of which phase the transient occurred on.

Default HSTC logging settings

<table>
<thead>
<tr>
<th>Data Set Logging</th>
<th>HSTC Waveform Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 records</td>
<td>40 records, 20.0 ms</td>
</tr>
</tbody>
</table>

See Configuring HSTC logging using ION Setup, page 177 for information about these settings.

HSTC Data set logging

Use data set logging to record transient event information such as peak voltage magnitude and duration.

This feature also provides summary information such as volts-seconds stress accumulations for each phase and total unique transient events.

Each time the HSTC trigger criteria are met, the meter performs a set of calculations for each voltage phase:

HSTC Data set

- Event based analytics:
  - Peak voltage amplitude
  - Rise time
  - Duration
  - Voltage stress (volt-seconds)
  - Average voltage
  - Timestamps

HSTC Summary

- Event accumulations and statistics:
  - Total number of transient events on voltage phases V1 - V4
  - Total number of unique events
  - Date and time of the last transient event counter reset
  - Accumulated voltage stress (volt-seconds) for voltage phases V1 - V4
  - Date and time of the last voltage stress accumulations reset
  - Total number of transient events grouped by peak magnitude and duration. There are a total of nine bins:
    - Magnitude 1/Duration 1
    - Magnitude 1/Duration 2
    - Magnitude 1/Duration 3
    - Magnitude 2/Duration 1
    - Magnitude 2/Duration 2
    - Magnitude 2/Duration 3
    - Magnitude 3/Duration 1
    - Magnitude 3/Duration 2
    - Magnitude 3/Duration 3

HSTC waveform logging

Use HSTC waveform logging to capture voltage transient waveform data.
A transient detected on any voltage phase triggers a waveform capture for all connected voltage phases. The HSTC waveform recording feature detects long duration and repetitive disturbances and automatically extends high-speed transient capture if conditions persist.

Each transient waveform recording includes pre-event data to analyze the characteristics of the incoming voltage signal prior to the event that triggered the high-speed transient capture.

Use ION Setup or Power Monitoring Expert 2020 to chart and view waveforms.

**Enable and configure HSTC logging**

HSTC logging is enabled when HSTC alarms are enabled. Use the default settings or make changes based on your system needs.

Changing your meter’s HSTC logging configuration deletes all existing data log and waveform records.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATA LOSS</td>
</tr>
<tr>
<td>Ensure that all important data and waveforms have been recorded before configuring the data and waveform recorders.</td>
</tr>
<tr>
<td>Failure to follow these instructions can result in data loss.</td>
</tr>
</tbody>
</table>

**Enabling HSTC logging**

The HSTC logging function is enabled with HSTC alarms. See *Enable and configure HSTC alarms, page 174* for instructions on enabling or disabling the HSTC alarms.

**Configuring HSTC logging using ION Setup**

Configure data set and waveform logging using ION Setup.

To set different conditions:

1. Open ION Setup and select the Setup Assistant for your meter.
2. Click **Power Quality > HSTC logging**.
3. Select the data log and click **Edit**.
   
   The **HSTC Logging Wizard** displays
4. Set the **Data Set Depth** to the number of records to keep
5. Click **Next**.
   
   ION Setup prompts you if the number of records exceeds file size limits. Enter a lower number, then click **Next** to proceed.
6. Set the waveform storage **Log Depth** to the number of waveforms to keep.
   
   The total duration of log storage in milliseconds (ms) is displayed consistent with the **Log Depth** setting.
   
   ION Setup prompts you if the **Log Depth** setting exceeds the recommended memory allocation.
7. Click **Finish** to return to the **HSTC Logging** tab.
**View HSTC**

The ION9000T continuously monitors incoming voltage signals. When HSTC is enabled and defined transient thresholds are met the meter performs the following functions:

- HSTC alarms
- HSTC logging
  - Data set logging
  - HSTC waveform logging

**View and acknowledge alarms**

HSTC alarms are classified as historical alarms. Use the display to view and acknowledge HSTC alarms.

See *Viewing and acknowledging alarms using the display, page 143* for instructions.

**View HSTC logs**

The following logs are generated when a high-speed transient has been detected:

- HSTC data set logs
- HSTC summary logs
- HSTC waveform recorder logs

View HSTC logs using ION Setup, the meter webpages or the display.

**Viewing HSTC data sets using ION Setup**

1. Open ION Setup and select your meter.
2. Click **View > Data Screens**.
3. Go to the **High Speed Transient Capture** folder, then select the **HSTC Data Set** log.
   The **HSTC Data Set Recorder** log displays.

**Viewing HSTC summary using ION Setup**

1. Open ION Setup and select your meter.
2. Click **View > Data Screens**.
3. Go to the **High Speed Transient Capture** folder, then select the **HSTC Summary** log.
   The HSTC Summary log displays.

**Viewing HSTC summary using meter webpages**

1. Open a web browser and enter your meter’s IP address in the address box.
   The webpage login displays.
2. Enter your login credentials.
3. Select **Monitoring > Power Quality Summary > HSTC**.
   The **High-Speed Transient Summary** screen displays.
View HSTC waveforms

Use ION Setup or Power Monitoring Expert 2020 to view HSTC waveforms.

Viewing HSTC waveforms using ION Setup

Use the ION Setup waveform viewer to plot captured waveform logs.

1. Open ION Setup and select your meter.
2. Click View > Data Screens.
3. Go to the High Speed Transient Capture folder, then select the HSTC Waveform log.

The HSTC Waveform log displays. A progress bar at the bottom of the screen indicates when all waveform logs have been retrieved from the meter.

NOTE: Records are sorted by Start Date/Time, with the newest entries appearing at the top.

4. Select the data to plot:
   a. Select the record you want to view.
   b. Hold the SHIFT key while selecting the first and last entries to plot multiple records in the same view.
5. Click the chart icon to plot the selected records.
   A Chart Properties box opens.
6. Click OK.
   The HSTC Waveform Plot displays.

HSTC waveform viewer navigation

The HSTC waveform viewer provides user interface elements to help understand transient event information such as the peak magnitude, duration and initial polarity of the transient.
<table>
<thead>
<tr>
<th>Element</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Active window</td>
<td>This window displays a portion of the overall captured disturbance.</td>
</tr>
<tr>
<td>B</td>
<td>HSTC V1-V4 phase selector</td>
<td>Click to select a single voltage phase V1 through V4.</td>
</tr>
<tr>
<td>C</td>
<td>Slider control (top and bottom)</td>
<td>Click and drag to focus on an event in the Active window. The values shown in the information panel at the bottom of the screen will update to reflect the new slider positions.</td>
</tr>
</tbody>
</table>
| D       | Scale | Auto generated value based on the magnitude of the detected transient.  
**NOTE:** The color of the text matches the voltage phase selected. For example, blue text indicates HSTC V3 phase has been selected. |
| E       | Trigger point | The time when the transient thresholds are exceeded.  
**NOTE:** The color of the trigger point indicator arrow matches the voltage phase selected. For example, a red arrow indicates HSTC V1 phase has been selected. |
| F       | Histogram | The histogram shows the complete captured disturbance. Waveform samples are grouped into bins based on the peak magnitude of the sample. |
| G       | Active histogram window | This window functions as a coarse zoom. Select and drag the window to any point in the histogram to focus on a specific set of waveform samples. The waveform samples contained within this histogram window are displayed in the active window above.  
**NOTE:** The waveform samples in the active window reflect the selected HSTC phase. |
| H       | Magnitude thresholds | The peak magnitude of captured high-speed transients is sorted into three bin thresholds to aid in the classification and analysis of the captured event.  
Mag <= 1500 V  
1500 V < Mag < 4000 V  
4000 V <= Mag < 10 000 V  
Right click in the histogram to set the number of active bins and their corresponding thresholds.  
**NOTE:** The updated threshold settings are used for informational purposes only. They do not change the conditions set to detect transients, nor are they retained when the HSTC waveform viewer is closed. |
| I       | Trigger timestamp | Timestamp representing the point in time that the transient condition was detected. |
### Element Name Description

<table>
<thead>
<tr>
<th>Element</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J</td>
<td>Active window zoom</td>
<td>This window functions as a fine zoom. Click, hold and drag your cursor across any waveform portion in the active window. <strong>NOTE:</strong> The waveform samples in the active window zoom reflect the selected HSTC phase.</td>
</tr>
<tr>
<td>K</td>
<td>Spectral analysis</td>
<td>Right click within the histogram window to view the spectral analysis of the selected samples. <strong>NOTE:</strong> The spectral analysis window reflects the selected HSTC phase.</td>
</tr>
</tbody>
</table>

### HSTC events

HSTC events are logged the same as other meter events:
- External events such as the detection of a high-speed transient
- Configuration changes such as editing the HSTC magnitude threshold
- Other meter events

See the Event log overview, page 192 for more information about logging meter events.

### Viewing HSTC events

View the event log using ION Setup or the display.

### HSTC resets

There are two HSTC reset methods, depending on what information you want to clear:

Use the meter’s Master reset to clear HSTC Data set and Waveform logs.

Use the meter’s HSTC reset to clear HSTC event accumulations and statistics.

### NOTICE

**DATA LOSS**

Ensure that all important data has been recorded before performing a reset.

Failure to follow these instructions can result in data loss.

### Master reset

Perform a Master reset using ION Setup.

Alternatively, you can use the meter webpages or meter display.

See Resets, page 214 for more information about meter resets.

### HSTC reset

Perform an HSTC reset using ION Setup.

### Performing an HSTC reset using ION Setup

1. Open ION Setup and select your meter.
2. Click **View > Data Screens**.
3. Go to the **High Speed Transient Capture** folder, then select the **HSTC Summary** log.
   The **HSTC Summary** log displays

4. Click the **HSTC Reset** icon.

5. Click **Yes** to confirm HSTC reset.
Logging

Logging overview

The meter’s logging frameworks include factory-configured data recorders, waveform recorders and event logs.

The logging frameworks store data related to:

- Power quality and compliance
- Energy and demand
- Revenue metering
- Trending and forecasting
- Meter events

When your system’s nominal parameters are programmed into the meter, power quality events such as sags, swells and transients are automatically detected, and associated voltage and current data and waveforms are logged. Meter data is stored in non-volatile memory, so data is retained even if the meter loses power. If your system nominal values fluctuate, you can configure the meter’s setpoint learning feature to learn your power system’s normal operating values, then use that information to help identify voltage sags and swells.

The meter’s logging framework also supports burst data logging for sag/swell events. When burst data logging is enabled, additional data records immediately before and immediately after the sag/swell event are captured. Energy management systems can then retrieve this information for use in applications such as power event analysis.

**NOTE:** To maximize the performance of your power management system, it is recommended that devices be connected directly to an Ethernet network.

You can also configure the meter to email data from the logging frameworks. Download the *Internal email client feature* technical note at www.schneider-electric.com for instructions on how to configure your meter to email logged data.

Meter events are recorded in the meter’s onboard event log. You can also configure the meter to record events to an external SysLog (systems log) server.

Default data logging configuration

The meter’s default framework includes factory-configured data logs (data recorders).

These data logs and their configuration are used by other components of your power monitoring system. Do not change the default configuration of any of the logs unless you understand the impact of the change on these power monitoring system components, the data they use and your meter’s memory.

The meter can support up to 100 data logs (data recorders), which can each record up to 16 different parameters.

Revenue log

The Revenue Log (Data Rec 1) is configured for use with UTS MV-90 billing software. Factory settings for this data recorder:

- Log depth = 3360 records (35 days)
- Interval = 900 seconds (15 minutes)

By default, it logs the following values:
Historic data logs

Three historic data logs are used to record standard power system quantities, such as phase current, phase voltage and power factor. These logs are labeled Hist Mean Log, Hist High Log, and Hist Low Log. Factory settings for these data recorders:

- Log depth = 3360 records (35 days)
- Interval = 900 seconds (15 minutes)

By default, they log the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>kWh del int</td>
<td>Interval kWh delivered</td>
</tr>
<tr>
<td>kWh rec int</td>
<td>Interval kWh received</td>
</tr>
<tr>
<td>kVARh del int</td>
<td>Interval kVARh delivered</td>
</tr>
<tr>
<td>kVARh rec int</td>
<td>Interval kVARh received</td>
</tr>
</tbody>
</table>

### Hist Mean Log (Data Rec 2)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vll ab mean</td>
<td>Line-to-Line voltage mean</td>
</tr>
<tr>
<td>Vll bc mean</td>
<td>Line-to-Phase voltage mean</td>
</tr>
<tr>
<td>Vll ca mean</td>
<td>Line-to-Phase voltage mean</td>
</tr>
<tr>
<td>Vll avg mean</td>
<td>Line-to-Line voltage mean</td>
</tr>
<tr>
<td>Ia mean</td>
<td>Phase A current mean</td>
</tr>
<tr>
<td>Ib mean</td>
<td>Phase B current mean</td>
</tr>
<tr>
<td>Ic mean</td>
<td>Phase C current mean</td>
</tr>
<tr>
<td>I avg mean</td>
<td>Line-to-Line current mean</td>
</tr>
<tr>
<td>l 4 mean</td>
<td>Line-to-Phase current mean</td>
</tr>
<tr>
<td>kVA tot mean</td>
<td>Total kVA</td>
</tr>
<tr>
<td>PF lag mean</td>
<td>Power factor lag</td>
</tr>
<tr>
<td>PF lead mean</td>
<td>Power factor lead</td>
</tr>
<tr>
<td>Freq mean</td>
<td>Frequency</td>
</tr>
</tbody>
</table>

### Hist High Log (Data Rec 3)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vll ab high</td>
<td>Line-to-Line voltage high</td>
</tr>
<tr>
<td>Vll bc high</td>
<td>Line-to-Phase voltage high</td>
</tr>
<tr>
<td>Vll ca high</td>
<td>Line-to-Phase voltage high</td>
</tr>
<tr>
<td>Vll avg high</td>
<td>Line-to-Line voltage high</td>
</tr>
<tr>
<td>Ia high</td>
<td>Phase A current high</td>
</tr>
<tr>
<td>Ib high</td>
<td>Phase B current high</td>
</tr>
<tr>
<td>Ic high</td>
<td>Phase C current high</td>
</tr>
<tr>
<td>I avg high</td>
<td>Line-to-Line current high</td>
</tr>
<tr>
<td>l 4 high</td>
<td>Line-to-Phase current high</td>
</tr>
<tr>
<td>kW tot high</td>
<td>Total kW</td>
</tr>
<tr>
<td>PF lag high</td>
<td>Power factor lag</td>
</tr>
<tr>
<td>PF lead high</td>
<td>Power factor lead</td>
</tr>
<tr>
<td>Freq high</td>
<td>Frequency</td>
</tr>
</tbody>
</table>

### Hist Low Log (Data Rec 4)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vll ab low</td>
<td>Line-to-Line voltage low</td>
</tr>
<tr>
<td>Vll bc low</td>
<td>Line-to-Phase voltage low</td>
</tr>
<tr>
<td>Vll ca low</td>
<td>Line-to-Phase voltage low</td>
</tr>
<tr>
<td>Vll avg low</td>
<td>Line-to-Line voltage low</td>
</tr>
<tr>
<td>Ia low</td>
<td>Phase A current low</td>
</tr>
<tr>
<td>Ib low</td>
<td>Phase B current low</td>
</tr>
<tr>
<td>Ic low</td>
<td>Phase C current low</td>
</tr>
<tr>
<td>I avg low</td>
<td>Line-to-Line current low</td>
</tr>
<tr>
<td>l 4 low</td>
<td>Line-to-Phase current low</td>
</tr>
<tr>
<td>kW tot low</td>
<td>Total kW</td>
</tr>
<tr>
<td>PF lag low</td>
<td>Power factor lag</td>
</tr>
<tr>
<td>PF lead low</td>
<td>Power factor lead</td>
</tr>
<tr>
<td>Freq low</td>
<td>Frequency</td>
</tr>
</tbody>
</table>

Loss log

The Loss Log (Data Rec 9) is configured to record loss values. Factory settings for this data recorder:

- Log depth = 3360 records (35 days)
- Interval = 900 seconds (15 minutes)

By default, it logs the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MU Ia^2h int</td>
<td>Phase A interval current squared hours</td>
</tr>
<tr>
<td>MU Ib^2h int</td>
<td>Phase B interval current squared hours</td>
</tr>
<tr>
<td>MU Ic^2h int</td>
<td>Phase C interval current squared hours</td>
</tr>
<tr>
<td>MU Vllab^2h int</td>
<td>Phase A interval voltage Line-to-Line squared hours</td>
</tr>
<tr>
<td>MU Vllbc^2h int</td>
<td>Phase B interval voltage Line-to-Line squared hours</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MU Vlca^2h int</td>
<td>Phase C interval voltage Line-to-Line squared hours</td>
</tr>
<tr>
<td>MU Vln a^2h int</td>
<td>Phase A interval voltage Line-to-Neutral squared hours</td>
</tr>
<tr>
<td>MU Vln b^2h int</td>
<td>Phase B interval voltage Line-to-Neutral squared hours</td>
</tr>
<tr>
<td>MU Vln c^2h int</td>
<td>Phase C interval voltage Line-to-Neutral squared hours</td>
</tr>
</tbody>
</table>

**Harmonics logs**

Two harmonics logs record various harmonics data, including K-factor and Total Harmonic Distortion (THD). These recorders are labeled Harm Mean Log and Harm High Log. Factory settings for these data recorders:

- Log depth = 840 records (35 days)
- Interval = 3600 seconds (1 hour)

By default, they log the following values:

<table>
<thead>
<tr>
<th>Harm Mean Log (Data Rec 7)</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 THD mean</td>
</tr>
<tr>
<td>V2 THD mean</td>
</tr>
<tr>
<td>V3 THD mean</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Harm High Log (Data Rec 8)</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 THD high</td>
</tr>
<tr>
<td>V2 THD high</td>
</tr>
<tr>
<td>V3 THD high</td>
</tr>
</tbody>
</table>

**Energy and demand log**

The EgyDmd Log (Data Rec 10) records energy and demand data used by energy management software to generate reports. Factory settings for this data recorder:

- Log depth = 3360 records (35 days)
- Interval = 900 seconds (15 minutes)

By default, it logs the following values:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>kWh del</td>
<td>Active energy delivered</td>
</tr>
<tr>
<td>kWh rec</td>
<td>Active energy received</td>
</tr>
<tr>
<td>kWh del-rec</td>
<td>Active energy delivered minus received</td>
</tr>
<tr>
<td>kVARh del</td>
<td>Reactive energy delivered</td>
</tr>
<tr>
<td>kVARh rec</td>
<td>Reactive energy received</td>
</tr>
<tr>
<td>kVARh del-rec</td>
<td>Reactive energy delivered minus received</td>
</tr>
<tr>
<td>kWh del+rec</td>
<td>Apparent energy delivered plus received</td>
</tr>
<tr>
<td>kW sd del-rec</td>
<td>Active power demand delivered minus received</td>
</tr>
<tr>
<td>kVAR sd del-rec</td>
<td>Reactive power demand delivered minus received</td>
</tr>
<tr>
<td>kVA sd del+rec</td>
<td>Apparent power demand delivered plus received</td>
</tr>
</tbody>
</table>

**Daily nominal log**

The DailyNom Log (Data Rec 39) provides information about the meter’s nominal settings. Factory settings for this data recorder:
• Log depth = 450 records
• Interval = Triggered on demand

By default, it logs the following values from the Factory module’s setup registers:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAC1 Vnominal</td>
<td>Nominal voltage setting</td>
</tr>
<tr>
<td>FAC1 NomFreqNum</td>
<td>Expected frequency of operation</td>
</tr>
</tbody>
</table>

**Rapid voltage change log**

The RVC Log (Data Rec 23) provides details of rapid voltage changes related to sag/swells (power quality events). This data recorder is disabled by default. Factory settings for this data recorder:

• Log depth = 100 records
• Interval = Triggered on demand

If enabled, it logs the following by default:

<table>
<thead>
<tr>
<th>SS1 Delta Umax</th>
<th>SS1 Delta Uss</th>
<th>SS1 RVC Duration</th>
</tr>
</thead>
</table>

**Sag/swell log**

The Sag/swell Log (Data Rec 5) provides details of power quality events. Factory settings for this data recorder:

• Log depth = 100 records
• Interval = Triggered on demand

By default, it logs the following values:

<table>
<thead>
<tr>
<th>SS1 DistDur</th>
<th>SS1 DistV1Min</th>
<th>SS1 DistV1Max</th>
<th>SS1 DistV1Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>SS1 DistV1Engy</td>
<td>SS1 DistV2Min</td>
<td>SS1 DistV2Max</td>
<td>SS1 DistV2Avg</td>
</tr>
<tr>
<td>SS1 DistV2Engy</td>
<td>SS1 DistV3Min</td>
<td>SS1 DistV3Max</td>
<td>SS1 DistV3Avg</td>
</tr>
<tr>
<td>SS1 DistV3Engy</td>
<td>SS1 DistNominal</td>
<td>SS1 Swell Lim</td>
<td>SS1 Sag Lim</td>
</tr>
</tbody>
</table>

**Sg/Sw HS log**

The Sg/Sw HS Log (Data Rec 6) captures high-speed (half-cycle) voltage and current data that includes pre-event and post-event records related to the sag/swell event. This data recorder is disabled by default.

If enabled, it logs the following by default:

<table>
<thead>
<tr>
<th>HS Vln a</th>
<th>HS Vll ab</th>
<th>HS I a</th>
<th>HS Freq</th>
</tr>
</thead>
<tbody>
<tr>
<td>HS Vln b</td>
<td>HS Vll bc</td>
<td>HS I b</td>
<td>PQA1 Vavg Sliding Ref Voltage</td>
</tr>
<tr>
<td>HS Vln c</td>
<td>HS Vll ca</td>
<td>HS I c</td>
<td></td>
</tr>
</tbody>
</table>

**Transient log**

The Transient Log (Data Rec 15) provides details of power quality events. Factory settings for this data recorder:

• Log depth = 100 records
• Interval = Triggered on demand

By default, it logs the following values:
EN 50160 compliance logs

The EN 50160 compliance logs are used to record EN 50160 compliance parameters:

<table>
<thead>
<tr>
<th>Data recorder</th>
<th>EN50160 component logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN50160 Flicker (Data Rec 18)</td>
<td>Flicker</td>
</tr>
<tr>
<td>EN50160 Frq/Mg (Data Rec 17)</td>
<td>Power frequency and supply magnitude</td>
</tr>
<tr>
<td>EN50160 Hrm Vlt (Data Rec 29)</td>
<td>Voltage harmonics</td>
</tr>
<tr>
<td>EN50160 Ihm Vlt (Data Rec 30)</td>
<td>Voltage interharmonics</td>
</tr>
<tr>
<td>EN50160 Intrp (Data Rec 24)</td>
<td>Short/log interruptions</td>
</tr>
<tr>
<td>EN50160 MSignal (Data Rec 31)</td>
<td>Evaluation of mains voltage signals</td>
</tr>
<tr>
<td>EN50160 Prm-f/V (Data Rec 32)</td>
<td>Parameter data (disabled by default)</td>
</tr>
<tr>
<td>EN50160 Prm-Flk (Data Rec 33)</td>
<td>Parameter data (disabled by default)</td>
</tr>
<tr>
<td>EN50160 PrmHrm1 (Data Rec 12)</td>
<td>Parameter data (disabled by default)</td>
</tr>
<tr>
<td>EN50160 PrmHrm2 (Data Rec 11)</td>
<td>Parameter data (disabled by default)</td>
</tr>
<tr>
<td>EN50160 Swell (Data Rec 25)</td>
<td>Voltage swells</td>
</tr>
<tr>
<td>EN50160 Vlt Dp1 (Data Rec 19)</td>
<td>Supply voltage dips</td>
</tr>
<tr>
<td>EN50160 Vlt Dp2 (Data Rec 20)</td>
<td>Supply voltage dips</td>
</tr>
<tr>
<td>EN50160 Vunbal (Data Rec 28)</td>
<td>Voltage unbalance</td>
</tr>
</tbody>
</table>

The meter logs EN50160 counter data for present and previous observation periods as well as EN50160 events.

Download the EN50160 2010 compliance and ION meters technical note at www.schneider-electric.com for more information about your meter’s EN50160 compliance.

IEC 61000-4-30 compliance logs

The IEC 61000-4-30 compliance logs are used to log parameters related to the International Electrotechnical Commission’s IEC 61000-4-30 standards’ power quality compliance and to create reports:

4-30 3s RMS Log (Data Rec 38)

<table>
<thead>
<tr>
<th>PQFlag 2s ivd</th>
<th>I1 3s</th>
<th>V1 OverDev 3s</th>
<th>V3 OverDev 3s</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 3s</td>
<td>I2 3s</td>
<td>V2 UnderDev 3s</td>
<td></td>
</tr>
<tr>
<td>V2 3s</td>
<td>I3 3s</td>
<td>V2 OverDev 3s</td>
<td></td>
</tr>
<tr>
<td>V3 3s</td>
<td>V1 UnderDev 3s</td>
<td>V3 UnderDev 3s</td>
<td></td>
</tr>
</tbody>
</table>

4-30 10mRMS Log (Data Rec 16)

<table>
<thead>
<tr>
<th>PQFlag 10m</th>
<th>PQA1 I1 10m</th>
<th>V1 OverDev 10m</th>
<th>V3 OverDev 10m</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 10m</td>
<td>PQA1 I2 10m</td>
<td>V2 UnderDev 10m</td>
<td></td>
</tr>
<tr>
<td>V2 10m</td>
<td>PQA1 I3 10m</td>
<td>V2 OverDev 10m</td>
<td></td>
</tr>
<tr>
<td>V3 10m</td>
<td>V1 UnderDev 10m</td>
<td>V3 UnderDev 10m</td>
<td></td>
</tr>
</tbody>
</table>
4-30 2hrRMS Log (Data Rec 37)

<table>
<thead>
<tr>
<th>PqFlag 2hr</th>
<th>I1 2hr</th>
<th>V1 OverDev 2hr</th>
<th>V3 OverDev 2hr</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 2hr</td>
<td>I2 2hr</td>
<td>V2 UnderDev 2hr</td>
<td>Power Freq 2hr</td>
</tr>
<tr>
<td>V2 2hr</td>
<td>I3 2hr</td>
<td>V2 OverDev 2hr</td>
<td></td>
</tr>
<tr>
<td>V3 2hr</td>
<td>V1 UnderDev 2hr</td>
<td>V3 UnderDev 2hr</td>
<td></td>
</tr>
</tbody>
</table>

4-30 3s THD Log (Data Rec 26)

<table>
<thead>
<tr>
<th>PqFlag 3s THD</th>
<th>V3 THD 3s</th>
<th>I3 THD 3s</th>
<th>IUnbal u2 3s</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 THD 3s</td>
<td>I1 THD 3s</td>
<td>VUnbal u2 3s</td>
<td>IUnbal u0 3s</td>
</tr>
<tr>
<td>V2 THD 3s</td>
<td>I2 THD 3s</td>
<td>VUnbal u0 3s</td>
<td></td>
</tr>
</tbody>
</table>

4-30 10mTHD Log (Data Rec 27)

<table>
<thead>
<tr>
<th>PqFlag 10m</th>
<th>V3 THD 10m</th>
<th>PQ I3 THD 10m</th>
<th>IUnbal u2 10m</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 THD 10m</td>
<td>PQ I1 THD 10m</td>
<td>VUnbal u2 10m</td>
<td>IUnbal u0 10m</td>
</tr>
<tr>
<td>V2 THD 10m</td>
<td>PQ I2 THD 10m</td>
<td>VUnbal u0 10m</td>
<td></td>
</tr>
</tbody>
</table>

4-30 2hrTHD Log (Data Rec 34)

<table>
<thead>
<tr>
<th>PqFlag 2hr</th>
<th>V3 THD 2hr</th>
<th>I3 THD 2hr</th>
<th>IUnbal u2 2hr</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1 THD 2hr</td>
<td>I1 THD 2hr</td>
<td>VUnbal u2 2hr</td>
<td>IUnbal u0 2hr</td>
</tr>
<tr>
<td>V2 THD 2hr</td>
<td>I2 THD 2hr</td>
<td>VUnbal u0 2hr</td>
<td></td>
</tr>
</tbody>
</table>

4-30 10s Freq (Data Rec 21)

Power Frequency

4-30 Intrp Log(Data Rec 22)

V Intrp DrtnAll (voltage interruption duration - all voltages)

Download the IEC 61000-4-30 Compliance and ION Meters technical note at www.schneider-electric.com for more information about your meter’s IEC 61000-4-30 compliance.

IEEE 519 compliance logs

The IEEE 519 compliance logs are used to record IEEE 519 compliance parameters:

<table>
<thead>
<tr>
<th>Data recorder</th>
<th>IEEE 519 component logged</th>
</tr>
</thead>
<tbody>
<tr>
<td>519 Hrm I-X (Data Rec 35)</td>
<td>Current harmonics</td>
</tr>
<tr>
<td>519 Hrm I-Y (Data Rec 36)</td>
<td>Current harmonics</td>
</tr>
<tr>
<td>519 Hrm I-Z (Data Rec 14)</td>
<td>Current harmonics</td>
</tr>
<tr>
<td>519 Hrm V-X (Data Rec 42)</td>
<td>Voltage harmonics</td>
</tr>
<tr>
<td>519 Hrm V-Z (Data Rec 13)</td>
<td>Voltage harmonics</td>
</tr>
<tr>
<td>I1 Hrm 1-16 (Data Rec 44)</td>
<td>I1 current harmonics</td>
</tr>
<tr>
<td>I1 Hrm 17-32 (Data Rec 50)</td>
<td>I1 current harmonics</td>
</tr>
<tr>
<td>I1 Hrm 33-48 (Data Rec 56)</td>
<td>I1 current harmonics</td>
</tr>
<tr>
<td>I2 Hrm 1-16 (Data Rec 45)</td>
<td>I2 current harmonics</td>
</tr>
<tr>
<td>I2 Hrm 17-32 (Data Rec 51)</td>
<td>I2 current harmonics</td>
</tr>
<tr>
<td>I2 Hrm 33-48 (Data Rec 57)</td>
<td>I2 current harmonics</td>
</tr>
<tr>
<td>I3 Hrm 1-16 (Data Rec 46)</td>
<td>I3 current harmonics</td>
</tr>
</tbody>
</table>
### Configuring data logging using ION Setup

Use ION Setup to configure the meter’s data recorders.

Changing the meter’s data recorder configuration clears existing data in that data recorder.

---

**NOTICE**

**DATA LOSS**

Ensure that all important data has been recorded before configuring data recording.

Failure to follow these instructions can result in data loss.

---

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Logging > Memory**.
4. In the **Status** tab, select the data log and click **Edit**. The **Log Depth Setup** window appears.
5. Configure the settings as applicable:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Interval</td>
<td>How frequently records are logged</td>
</tr>
<tr>
<td>Log Depth</td>
<td>Maximum number of records stored in the log</td>
</tr>
<tr>
<td>Log Memory</td>
<td>Information only. This is automatically calculated, and displays how much memory the log uses based on the Log Interval and Log Depth</td>
</tr>
<tr>
<td>Log Storage</td>
<td>Information only. This is automatically calculated, and displays how much total memory is left after subtracting the Log Memory usage</td>
</tr>
</tbody>
</table>

---

**Waveform recording overview**

The meter’s factory-configured waveform recorders store waveform data related to power quality events.
Waveform information is used to help identify power system disturbances, which are an increasing concern for industrial plants, hospitals, data centers and other facilities where the equipment is sensitive to voltage or current sags, swells, transients, and momentary interruptions. Waveform information is also used to help ensure compliance with power quality standards.

In addition to measuring and recording numerical values for voltage and current, your meter can also capture the sinusoidal waveform data. The current and voltage waveform data provides additional information for analysis of the system’s power quality or a power quality event.

When your system’s nominal parameters are programmed into the meter, power quality events such as sags, swells and transients are automatically detected and voltage and current waveform data is logged. The default factory settings for sag/swell and transient detection are sufficient for most applications, but you can also modify the amount of deviation from the nominal required to trigger waveform recording.

### Waveform data storage format

Your meter’s waveform data storage format is defined by:

- Cycles: the number of cycles included in the waveform (its duration).
- Samples: samples per cycle, which is the number of waveform data points collected in each cycle.

This gives you the option to record a lot of information for a very short duration or less information over a longer duration. You can also configure the waveform recording to record pre-event and post-event data.

### Types of waveform data

You can use your meter to detect ITI (CBEMA) - type disturbances, and determine information regarding the magnitude and duration of each disturbance. This information can be used by your energy management system to plot the disturbance on an ITI (CBEMA) curve.

COMTRADE waveform data is available from your meter.

**NOTE:** If you are generating COMTRADE waveform information, the associated waveform recorders cannot be modified unless COMTRADE is disabled. If the waveform recorders are not configured identically, COMTRADE waveform information will not be generated.

### Key terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMTRADE</td>
<td>COMmon format for TRAnsient Data Exchange (COMTRADE) is a common format for waveform data.</td>
</tr>
<tr>
<td>ITI (CBEMA)</td>
<td>A curve that graphically describes an AC input voltage envelope which can be typically tolerated by information technology equipment. Meter waveform information is plotted on this curve to help evaluate power quality.</td>
</tr>
<tr>
<td>Nominal</td>
<td>The normal or usual parameter value. For example, the nominal voltage for many power systems is 120 V.</td>
</tr>
<tr>
<td>Sag</td>
<td>A power event where the voltage or current drops below the nominal value.</td>
</tr>
<tr>
<td>Swell</td>
<td>A power event where the voltage or current rises above the nominal value.</td>
</tr>
<tr>
<td>Transient</td>
<td>A power event where a short duration surge of electrical energy is detected.</td>
</tr>
</tbody>
</table>

See the ION Reference, available from www.schneider-electric.com, for more information on the Waveform Recorder module and its settings.
Default waveform recording configuration

The meter’s default framework includes factory-configured waveform logs (waveform recorders).

These waveform logs and their configuration are used by other components of your power monitoring system. Do not change the default configuration of any of the logs unless you understand the impact of the change on these power monitoring system components, the data they use and your meter’s memory.

Waveform Recorder modules

The factory-default Waveform Recorder modules are preconfigured to capture sag/swell and transient power quality events.

<table>
<thead>
<tr>
<th>Waveform recorder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wfm Rc V1-Sg/Sw (Wform Rec 1)</td>
<td>V1 voltage waveforms recorded during a defined sag or swell event.</td>
</tr>
<tr>
<td>Wfm Rc V2-Sg/Sw (Wform Rec 2)</td>
<td>V2 voltage waveforms recorded during a defined sag or swell event.</td>
</tr>
<tr>
<td>Wfm Rc V3-Sg/Sw (Wform Rec 3)</td>
<td>V3 voltage waveforms recorded during a defined sag or swell event.</td>
</tr>
<tr>
<td>Wfm Rc I1-Sg/Sw (Wform Rec 5)</td>
<td>I1 current waveforms recorded during a defined sag or swell event.</td>
</tr>
<tr>
<td>Wfm Rc I2-Sg/Sw (Wform Rec 6)</td>
<td>I2 current waveforms recorded during a defined sag or swell event.</td>
</tr>
<tr>
<td>Wfm Rc I3-Sg/Sw (Wform Rec 7)</td>
<td>I3 current waveforms recorded during a defined sag or swell event.</td>
</tr>
<tr>
<td>Vfm Rc V1-Tnst (Wform Rec 9)</td>
<td>V1 voltage waveforms recorded during a defined transient event.</td>
</tr>
<tr>
<td>Vfm Rc V2-Tnst (Wform Rec 10)</td>
<td>V2 voltage waveforms recorded during a defined transient event.</td>
</tr>
<tr>
<td>Vfm Rc V3-Tnst (Wform Rec 11)</td>
<td>V3 voltage waveforms recorded during a defined transient event.</td>
</tr>
<tr>
<td>Vfm Rc I1-Tnst (Wform Rec 13)</td>
<td>I1 current waveforms recorded during a defined transient event.</td>
</tr>
<tr>
<td>Vfm Rc I2-Tnst (Wform Rec 14)</td>
<td>I2 current waveforms recorded during a defined transient event.</td>
</tr>
<tr>
<td>Vfm Rc I3-Tnst (Wform Rec 15)</td>
<td>I3 current waveforms recorded during a defined transient event.</td>
</tr>
</tbody>
</table>

COMTRADE modules

The factory-default COMTRADE modules are preconfigured with their inputs linked to the Trigger outputs of the waveform recorders for sag/swell and transient monitoring.

<table>
<thead>
<tr>
<th>COMTRADE 1 inputs (sag/swell)</th>
<th>Linked Waveform Recorder (Trigger output)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveform Trigger 1</td>
<td>Wfm Rc V1-Sg/Sw (Wform Rec 1)</td>
</tr>
<tr>
<td>Waveform Trigger 2</td>
<td>Wfm Rc V2-Sg/Sw (Wform Rec 2)</td>
</tr>
<tr>
<td>Waveform Trigger 3</td>
<td>Wfm Rc V3-Sg/Sw (Wform Rec 3)</td>
</tr>
<tr>
<td>Waveform Trigger 4</td>
<td>Wfm Rc I1-Sg/Sw (Wform Rec 5)</td>
</tr>
<tr>
<td>Waveform Trigger 5</td>
<td>Wfm Rc I2-Sg/Sw (Wform Rec 6)</td>
</tr>
<tr>
<td>Waveform Trigger 6</td>
<td>Wfm Rc I3-Sg/Sw (Wform Rec 7)</td>
</tr>
</tbody>
</table>
Event log overview

Your meter records events produced by the meter’s ION modules or external meter events.

Meter events, such as meter configuration or changes to I/O state, have priority values associated with them, so you can control what events are logged. Each event has a priority based on its type and severity, and for most events you can configure the priority. The event log records the date and time of the event, along with relevant details about the event.

Your meter’s event log can be viewed through IONSetup and the display.

Event log data example:

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>Cause</th>
<th>Value</th>
<th>Ifont</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>11/1/2011 11:21:14:00 AM</td>
<td>Front Panel</td>
<td>Remote Display</td>
<td>Front Panel</td>
<td>DNS received on FMD</td>
</tr>
<tr>
<td>11/1/2011 11:21:14:50:00 AM</td>
<td>Front Panel</td>
<td>Remote Display</td>
<td>Front Panel</td>
<td>DNS server upgrade successful</td>
</tr>
</tbody>
</table>

NOTE: This example is representative only, and your meter’s event log may appear different than shown.

See the ION Reference, available from www.schneider-electric.com, for more information about the Event Log Controller module and other ION modules.

Default event log configuration

Your meter logs all configuration changes, meter access events, and power system events.

You can configure certain features, such as the digital inputs, so an event is logged when the feature changes state (for example, the digital input changes from off to on).

Your meter’s event log might be used by other components of your power monitoring system. Do not change the default event log configuration unless you understand the impact of the change on the power monitoring system components and the data they use and on your meter’s memory.

Changing the default event log configuration should only be undertaken by those with an advanced understanding of ION architecture and their meter’s template.

The event log is controlled by the Event Log Controller module, which allows you to set a priority cutoff for event logging. Events with a priority number greater than the cutoff value are logged, and events with lower priorities are discarded. By default, this value is set so that all relevant events are recorded in the meter’s event log. Event priority values range from 0 to 255 with a typical cutoff value of 5.

NOTE: Alarms are generated by events from certain ION modules. The alarm level is determined by the priority of the associated event. To disable the alarm but still record the associated event, set the alarm priority to **Info Only**. To disable the alarm and the event, set the alarm priority to **None**.
See the ION Reference, available from www.schneider-electric.com, for more information about the Event Log Controller module and event priorities for specific ION modules.

User triggered event log entries

The Event Log includes an association between security-related events and the username that was logged in to the meter during the event.

When a user produces an event, such as a reset, successful or unsuccessful login attempts, user lockout or setup change, it is written to the event log. Events created in standard security through the display or communications have the username USER0. Events created in advanced security through ION Setup or the display are associated with the username that was logged into the meter (USER1 - USER50).

Assigning a designated reader for event log notification

A user can be assigned the role of designated reader for the event log.

When the Designated Reader is configured, an entry in the event log is considered unread until it has been reviewed or backed up to external storage by the designated reader. When the designated reader is informed that the event log is nearly full, an event log review or backup strategy can be implemented before older entries are overwritten. This feature can assist in ensuring that event log entries are not overwritten before they can be reviewed. Use ION Setup to select a user to be the designated reader.

1. Open advanced configuration mode for your meter. See the ION Setup Help for instructions.
2. Open the EventLogCtl Modules folder and double click EventLogCtl.
3. Enter login credentials as necessary.
4. Click the Setup Registers tab.
5. Select Designated Reader and click Edit.
6. Set Designated Reader to the user that reviews the event log (USER0 - USER50) and click OK.

Syslog overview

Syslog uses the User Datagram Protocol (UDP) to transport event log information from the meter directly to a centralized syslog server.

The syslog server can receive logs from multiple devices, including meters, then store and filter the log information as needed. You can use ION Setup to modify the syslog network settings for your device. Syslog is a useful feature to help maintain meter log information for extended periods of time.

NOTE: Ethernet is required to use the syslog feature.

Syslog is an open standard allowing you to use any one of a number of syslog server applications currently available. The decision regarding which syslog server solution to use can be based on budget and your technical requirements. See the individual syslog server’s documentation for more information.
Configuring Syslog network settings using ION Setup

You can configure your syslog settings using ION Setup.

1. Open the Setup Assistant for your meter. See the ION Setup Help for instructions.

2. Select **Communications > Advanced Ethernet** and click the **SysLog** tab.

3. Select **Enable Syslog** and click **Edit**.

4. Select **Yes** to enable the syslog server feature or select **No** to disable it.

5. Click **OK**.

6. Select **Syslog Server** and click **Edit**.

7. Enter the IPv4 address or an IPv6 address for the syslog server.

   **NOTE:** You must enter the IP address for the syslog server, not the server’s fully-qualified domain name.

8. Click **OK**.

9. Verify that the Syslog server is receiving log information from the meter.

   **NOTE:** If the **Enable Syslog** register is enabled but the **Syslog Server** register does not contain an IP address, an event is generated in the event log to indicate that syslog is enabled with no server IP.

**Syslog severity to event log priority mapping**

Syslog severities map to ION event priorities (0-255).

Only four of the syslog severities are used in the mapping.

<table>
<thead>
<tr>
<th>Syslog severity</th>
<th>ION event priority name</th>
<th>ION event priority range</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - Critical condition</td>
<td>High</td>
<td>192-255</td>
</tr>
<tr>
<td>4 - Warning condition</td>
<td>Medium</td>
<td>128-191</td>
</tr>
<tr>
<td>5 - Normal but significant condition</td>
<td>Low</td>
<td>64-127</td>
</tr>
<tr>
<td>6 - Informational</td>
<td>None</td>
<td>0-63</td>
</tr>
</tbody>
</table>

**Advanced log setup and memory optimization**

You can configure your meter’s logs to help ensure the integrity of critical data and to optimize the meter’s memory usage.

Before you configure your meter’s logs, it is important to understand how logging functions and how the settings work together.

**NOTE:** Configuring your meter’s logs requires an in-depth understanding of the meter’s memory, how the logs function and the data you are capturing.

**Viewing log configuration and memory usage information**

You can use ION Setup to view log settings and memory usage information for your meter’s default logs.

This information can help you understand your log usage and how to optimize your logging configuration for your situation.

1. Start ION Setup.

2. Open the Setup Assistant for your meter.
3. Navigate to the Logging > Memory screen.

The Status tab:
- lists the default logs, their interval (Duration) and depth (Records), if applicable, and the percentage of available memory used by the log.
- provides information on how much of the meter’s memory is used for system tasks in the System Resources list item.
- displays the total meter memory and the percentage of memory in use versus memory available.

**Log depth configuration**

You can change the number of records (depth) stored in the log.

Use ION Setup to change the maximum number of records (depth) stored in the log in the meter’s long-term memory.

Data logs and circular-format waveform recorders have a minimum depth of 1 record. The maximum depth is dependent on your meter’s memory and the configuration of your other logs.

**Log interval configuration**

You can configure the logging interval, which is how frequently records are logged.

You can change the logging intervals for most logs using the ION Setup Assistant Logging > Memory screen.

Changing the interval for other logs (for example, logs that are related to standards or triggered by disturbances) is an advanced procedure that involves using the Advanced mode of ION Setup to modify settings in the module that is linked to the log’s Record input. See the ION Setup help and the ION Reference for more information.

Programming your meter to write to any data recorder at continuous intervals shorter than 60 seconds (heavy logging configuration) can cause loss of data in the event of a power failure.

**NOTICE**

DATA LOSS

Use an uninterruptible power supply (UPS) if you program your meter for heavy logging.

Failure to follow these instructions can result in data loss.

**Log mode configuration**

You can configure the log record mode, or how the log behaves when full.

Changing how the log records information (circular or stop-when-full) is an advanced procedure that requires changing the RecordMode setup register in the Data Recorder and Waveform Recorder modules.
Log buffer configuration

The log buffer depth is the maximum number of records that can be stored in the meter’s short-term memory (RAM) for a particular log.

After records are captured in the log buffer in the meter’s short-term memory, they are replicated to the long-term memory. Because of inherent differences between short-term (volatile) and long-term (non-volatile) memory, records can be added more quickly to the short-term memory than they can be copied to long-term memory.

The logs in the default logging framework have their log buffer depths pre-configured to a value suitable for most applications. But you can configure the log buffer depth for your applications, if required (for example, to help ensure the continuity of critical data in high-speed logging scenarios or to optimize usage of your meter’s memory for your particular logging configuration).

If you are logging data at high speeds, it is important to review your logging needs, and find the right balance between data retention and memory optimization for your particular situation.

**NOTE:** If you get a message that you do not have sufficient memory when you try to create a new log or change the configuration of an existing log, you may need to reduce the log buffer depths of other logs in order to make memory available for the new log.

**Fully buffered logs**

A fully buffered log (e.g., a Data Recorder or Waveform Recorder module) is one where the value of the Buffer Depth setup register is the same as the Depth setup register. This means the buffer (short-term memory) is set up to use all the available long-term memory allocated for that log. This ensures the buffer does not run out of space before all the records are replicated to the long-term memory, regardless of the recording speed (i.e., the rate of record captures).

You may want to use this configuration if you are logging critical data (for example, revenue logs) or logging data at frequent intervals (for example, intervals less than 60 seconds). However, it is important to note that this configuration uses the most short-term memory, or RAM (the meter has a maximum 10 MB of RAM available for the log buffer depth).

**Partially buffered logs**

A partially buffered log (e.g., for a Data Recorder or Waveform Recorder module) is one where the value of the Buffer Depth setup register is less than the Depth setup register. This means the buffer (short-term memory) is set up to use only a portion of the available long-term memory allocated for that log. This configuration allows for a much larger log size (i.e., number of records). However this does not

---

A. Circular (FIFO) logging mode: when the log is full, a new record overwrites the oldest record

B. Stop-when-full logging mode: when the log is full, any new records are not logged

---

**NOTE:** If you get a message that you do not have sufficient memory when you try to create a new log or change the configuration of an existing log, you may need to reduce the log buffer depths of other logs in order to make memory available for the new log.
ensure that the buffer does not run out before all the records are replicated to the long-term memory (e.g., in the case of high-speed recording).

You may want to use this configuration for logs with intervals greater than 60 seconds or with less critical data. Because the records are partially replicated, this configuration uses less of the meter’s short-term memory, or RAM, in a log that is otherwise configured the same. This allows you to make more RAM available for other logs with a higher logging frequency or more critical data.

However, depending on your configuration, there may be instances where the log buffer fills up faster than it can replicate records to long-term memory. In this case, you may lose records and see gaps in your data.

**NOTE:** The Insert Outage Records functionality does not work if the data recorder is configured as partially buffered. In order to use this functionality, you must configure the data recorder to be fully buffered. See the Data Recorder module description in the ION Reference, available for download from www.schneider-electric.com, for more information on Insert Outage Records functionality.

**Example: fully buffered log records replicated from short-term to long-term memory**

In this example, the log buffer equals the log depth and all the records are replicated in both the short-term memory and the long-term memory.

**Example: Partially buffered log records replicated from short-term memory to long-term memory**

In this example, the buffer depth equals 20. The first record has already replicated to the long-term memory, making room in the log buffer for the new records (including the newest record, in gray).
Example: Resulting gaps in data when a partially buffered log is full

In the graphic on the left, the log buffer (A) is full, and the oldest record has not replicated to the long-term memory yet. This means that the new record (C) is not logged, and is permanently lost. In the graphic on the right, the oldest record (D) has been replicated to long-term memory, making space in the buffer. The new record at the next interval (E) is logged but there is a gap in the data for the lost record (C).

Changing log interval and depth settings using ION Setup

You can configure log intervals, log depths and buffer depths to optimize your memory usage.

Before you begin, make sure you understand:

• the structure of the meter’s logging framework
• the meter’s existing logging configuration
• your data logging requirements

Changing your meter’s log configuration deletes all existing records from that log.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATA LOSS</td>
</tr>
<tr>
<td>Ensure that all important data has been recorded before configuring a log.</td>
</tr>
<tr>
<td>Failure to follow these instructions can result in data loss.</td>
</tr>
</tbody>
</table>

The default log settings are designed to meet the needs of most users.

This procedure provides the steps for configuring settings for a subset of data logs using the ION Setup Assistant. Configuring these settings for custom logs, and logs not listed in the Logging > Memory screen, is an advanced procedure; see the ION Setup help for more information.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to the Logging > Memory screen.
4. Select the log you want to edit and click Edit.
5. Set the log depth and log interval as required for your logging needs.
   - **Log Interval**: you can change the interval units to seconds, minutes, hours or days.
   - **Log Depth**: You can set the depth in time (seconds, hours, days, etc.) or the number of records.

   **NOTE**: For some log types, you only set the log depth (for example, waveform recorders).

   Log Memory shows the estimated impact of the changes on the total size of the log and Log Storage displays the estimated available log memory on the meter.

   **NOTE**: If you receive a message stating that there is not enough memory when you change a log’s configuration, check the configuration of your meter’s other logs. You may not have enough RAM, or short-term memory, to allow for the new configuration. You may need to use ION Setup Advanced mode to check the detailed configuration of your logs.

6. Click **Finish**.

   In some case, you may see a **Next** button instead of **Finish**. In this case, the next screen allows you to configure the buffer depth for the log. The screen displays the overall log depth and a field for setting the log buffer depth. It also shows the impact of the **Buffer Depth** setting to your meter’s short-term memory (RAM).
Time and timekeeping

Time overview

Your meter’s internal clock is used for keeping time, timestamping data and determining intervals for time-based measurements.

Local meter time is displayed based on the meter’s time sync source and the settings used for timezone and daylight savings time. You can configure and view your meter’s date and time information through software such as ION Setup or through the meter display.

Your meter monitors time using the frequency of an internal oscillator or the frequency of the line power being measured. Your meter’s battery powers the internal clock so that time is maintained when the meter is unpowered.

Your meter supports different time types and time synchronization methods to adjust its internal clock. To improve your meter clock’s accuracy, you can use an external time reference such as a Global Positioning System (GPS) signal, Network Time Protocol (SNTP/NTP) server or Precision Time Protocol (PTP) Master.

Go to www.schneider-electric.com and download the *Time synchronization and timekeeping* technical note for more information about time formats and settings and the *ION Reference* for a detailed description of the Clock module and its operation.

Internal clock temperature compensation

The time accuracy of the meter has been improved by compensating for clock drift if the meter’s operating temperature falls outside the optimum temperature range.

Your meter’s internal clock is adjusted based on the internal clock temperature compensation parameters.

Time synchronization

Your meter’s clock controls the timing of metering parameters, such as demand intervals or power quality measurement aggregation over time intervals.

Adjustments to the clock are made by synchronizing the meter’s time with another time source, determined by the *Time Sync Source*. Time synchronization messages can be automatically generated and sent to your meter from your energy management system software or other time sources such as an SNTP/NTP server, PTP Master or GPS receiver. You can also manually trigger a time synchronization message from your energy management system or configuration software.

**NOTE:** To help maintain data integrity, some energy management systems impose a blackout rule where time synchronization messages near energy interval boundaries are ignored.

Supported time synchronization sources

Several time synchronization sources are available to your meter.
<table>
<thead>
<tr>
<th>Time sync source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meter configuration software (ION Setup)</td>
<td>Configuration software can manually synchronize the time of your meter based on the clock of the computer running the configuration software. Configuration software synchronization is usually performed when the meter is initially commissioned.</td>
</tr>
<tr>
<td>Energy management system</td>
<td>Energy management systems can synchronize the time of your meter to be consistent with other meters on the network.</td>
</tr>
<tr>
<td>GPS receiver (IRIG-B)¹</td>
<td>A GPS receiver using IRIG-B can synchronize the time of a meter up to ± 1 ms of Coordinated Universal Time (UTC). A dedicated serial network is required to implement a GPS scheme. For IRIG-B, one of your meter’s digital inputs must be connected to the IRIG-B network, and the digital input must be configured for IRIG-B time synchronization in addition to configuring your meter’s clock.</td>
</tr>
<tr>
<td>GPS over serial</td>
<td>A GPS receiver can synchronize the time of a meter up to ± 1 ms of Coordinated Universal Time (UTC). For GPS over serial, your meter’s serial port must be connected to a GPS receiver, and the serial port communications must be configured with the correct protocol setting.</td>
</tr>
<tr>
<td>Simple Network Time Protocol (SNTP)</td>
<td>SNTP can synchronize the time of your meter up to ± 1 second of other meters on an Ethernet network. For SNTP time synchronization, your meter must be connected to an Ethernet network that has an active SNTP server and be configured with the server’s information.</td>
</tr>
<tr>
<td>Network Time Protocol (NTP)</td>
<td>NTP can typically synchronize the time of a meter to ± 10 to 100 ms, depending on network configuration. To implement NTP time synchronization, your meter must be connected to an Ethernet network that has an active NTP server and be configured with the server’s information.</td>
</tr>
<tr>
<td>Precision Time Protocol (PTP)²</td>
<td>PTP can synchronize the meter time to ± 1 ms of other devices connected to a local area network. To implement PTP time synchronization, your meter must have PTP selected as the time sync source and be connected to an Ethernet network that has a valid PTP Master (Grandmaster Clock).</td>
</tr>
</tbody>
</table>

1 Use the digital inputs located on the meter base for IRIG-B time synchronization and other high-accuracy applications.

2 This clock precision assumes your meter is installed in a Star network topology only.

**Clock source**

The *Clock Source* setup register defines the meter’s representation of a one second period, and can be set to:

**LINE FREQUENCY**

The meter monitors the ISO Grid Operation line frequency, and adjusts the one second period based on the measured line frequency. All devices connected to the grid network are synchronized to maintain a consistent time base. If a power outage occurs, the clock automatically synchronizes with the meter’s internal crystal until power is restored. Once power is restored, the clock resynchronizes with the line frequency.

**NOTE:** Do not use **LINE FREQUENCY** when your meter is synchronized to an external time sync source.

**INTERNAL**

The meter clock is synchronized to the meter’s internal crystal.
The meter clock is synchronized to an external time sync source. Use this for the Clock Source if:

- The Time Sync Source setup register is set to a serial communications port to receive GPS time synchronization signals.
- The Time Sync Source setup register is set to ETHERNET-PTP and your meter is installed in a trusted PTP network.
- The Time Sync Source setup register is set to IRIG-B.

### Clock source time quality flag

The meter’s clock source time quality flag is primarily used to report time quality information for digital input events, such as status alarms, in Sequence-of-Events Recording (SER) applications.

The meter keeps track of the time difference between the meter’s internal clock and the time sync source.

When the meter’s Clock module’s Use Clock Source Qual Flag is set to USE FLAG, the Diagnostics module’s Receiver Status output register is set to:

- **LOCKED** if the time difference between the GPS time sync source or PTP master and meter clock is within ±1 ms of each other
- **UNLOCKED** if the time difference between the GPS time sync source or PTP master and meter clock is greater than ±1 ms of each other

### PTP system setting recommendations

Your meter has been configured by default to be compatible in typical PTP supported systems.

In a PTP system, the grandmaster clock determines the reference time for the entire system. To ensure correct implementation and operation of the protocol, it is recommended to set the following parameters in your system grandmaster clock:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PTP device type</td>
<td>End to End transparent clock</td>
<td>A transparent clock that supports the use of the end-to-end delay measurement mechanism between slave clocks and the master clock.</td>
</tr>
<tr>
<td>Peer delay mechanism</td>
<td>2 step</td>
<td>A clock that provides time information using the combination of an event message and a subsequent general message.</td>
</tr>
<tr>
<td>Clock domain</td>
<td>0-3</td>
<td>A logical grouping of clocks that synchronize to each other using the protocol, but that are not necessarily synchronized to clocks in another domain</td>
</tr>
<tr>
<td>Ethernet switches</td>
<td>PTP V2 compatible</td>
<td>All switches and other devices in the network must support IEEE 1588 PTP V2 to achieve the stated time precision and accuracy</td>
</tr>
</tbody>
</table>

### Star network topology

In addition to PTP system related settings, the accuracy of your meter clock also depends on your physical network configuration. A star network topology is required to achieve the level of clock precision specified.
Configuring time information using ION Setup

You can set the time and date and configure the time synchronization settings using ION Setup.

**NOTE:** The clock screen is where you set the start day of the week for the time of use feature.

**NOTE:** You must manually adjust the date and time information if the device is installed in a different time zone location from the computer running ION Setup.

1. Start ION Setup.
2. Open the Setup Assistant for your device.
3. Navigate to Clock and select the Timezone tab.
4. Select any parameter and click TimeSync to synchronize your device’s date and time with the computer that is running ION Setup.
5. Click the DST Settings tab to modify your meter’s daylight savings time start and end dates, if required.
6. Select the parameter that you want to configure and click **Edit**. Enter the password if prompted.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| Time Zone          | -             | Sets the timezone based on the time zones available from the computer’s operating system.  
**NOTE:** This is also where you can synchronize your meter’s DST settings with the computer’s. |
| Time Sync Type     | UTC or LOCAL  | Specifies the time format of the time sync message. UTC (Coordinated Universal time) is equivalent to Greenwich Mean Time (GMT). LOCAL is the local time with DST and time zone information applied.  
• For SNTP/NTP and PTP time synchronization, set the **Time Sync Type** to **UTC**. |
| Time Sync Source   | COM1, COM4, ETHERNET, ETHERNET - ION, ETHERNET - DNP, ETHERNET - PTP, IRIG-B | Sets which device port accepts time synchronization messages. Time synchronization messages on other ports are ignored.  
• For GPS time synchronization, set the **Time Sync Source** to **COM1 (or COM4)**.  
• For SNTP/NTP time synchronization, set the **Time Sync Source** to **ETHERNET**.  
• For ION time synchronization, set the **Time Sync Source** to **ETHERNET-ION**.  
• For DNP time synchronization, set the **Time Sync Source** to **ETHERNET-DNP**.  
• For PTP time synchronization, set the **Time Sync Source** to **ETHERNET-PTP**.  
• For IRIG-B time synchronization, set the **Time Sync Source** to **IRIG-B**. |
| Clock Source       | Internal, Line Freq, COMM | Sets the source for the clock:  
• Internal: the meter’s internal clock.  
• Line Freq: the measured line frequency of the power system is the clock source.  
• COMM: the meter’s communication port (used by the IRIG-B, GPS or ETHERNET-PTP time sync source). |
| DST Offset         | Numeric Bounded Format/Elapsed Interval Format | Specifies the amount of time the displayed local time is moved forward when entering Daylight Savings. A value of zero disables this feature and local time is not adjusted for DST. |
| Start of the Week  | Monday - Sunday | Specifies the start day of the week used for Trending and Forecasting.  
**NOTE:** Changing the start day of the week clears all trending and forecasting data. |

7. If using SNTP/NTP time synchronization, you must also enter the following information under **Communications > Advanced Ethernet > NTP**:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable NTP Time Sync        | NTP, SNTP, No                  | NTP: specifies NTP time synchronization. SNTP: specifies SNTP time synchronization.  
**NOTE:** SNTP is recommended for revenue-related applications. No: neither NTP nor SNTP time synchronization are used. |
| NTP Time Sync Interval      | Numeric value or elapsed interval value | Specifies how often the meter synchronizes over SNTP.  
**NOTE:** This parameter is not used for NTP. |
| Event Logging Threshold (NTP and PTP only) | 0.000001 to 1.000000 | Specifies the minimum time difference (in seconds) for a time synchronization to be logged as an event. This parameter can be configured to help prevent the meter’s event log from being flooded with time synchronization events. |
| NTP Server                  | Server IP address or domain name | Specifies the IP address (or fully qualified domain name if DNS is active) of the SNTP or NTP server. |
8. If using serial GPS time synchronization, you must also enter the following information under Communications > Serial settings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol</td>
<td>Select the GPS setting that matches your GPS receiver.</td>
</tr>
<tr>
<td>Baud rate</td>
<td>The recommended baud rate for GPS time synchronization is 9600 bps.</td>
</tr>
<tr>
<td>Serial port</td>
<td>The recommended stop bits/parity for GPS time synchronization is 8N1.</td>
</tr>
</tbody>
</table>

**Configuring time information using the display**

Use the meter’s display to configure a variety of time parameters.

**NOTE:** If your device is installed in a region where DST is observed, it is recommended to use ION Setup to configure the time zone for your locale.

1. Go to Setup Menu > Date/Time/Clock Setup > Date & Time Setup.
2. Configure your time and date formats, time zone offset, and daylight savings time offset. Press the down button to access the Clock Setup screen.
3. Configure the clock and time synchronization source, and the time synchronization time format.

**Date & time setup**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Format</td>
<td>12 H, 24 H</td>
<td>Specifies how the time is displayed</td>
</tr>
<tr>
<td>Date Format</td>
<td>MM/DD/YYYY, DD/MM/YYYY, YYYY/MM/DD</td>
<td>Specifies how the date is displayed</td>
</tr>
<tr>
<td>TZ Offset</td>
<td>-12:00:00 to 13:00:00</td>
<td>Sets the time zone of the meter’s location, relative to UTC</td>
</tr>
<tr>
<td>DST Offset</td>
<td>-3:00:00 to 3:00:00</td>
<td>Sets the daylight savings time offset of the meter’s location</td>
</tr>
</tbody>
</table>

**Clock setup**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clock Source</td>
<td>Internal, Line Freq, COMM</td>
<td>Specifies the time synchronization source</td>
</tr>
<tr>
<td>Time Sync Source</td>
<td>COM1, COM4, ETHERNET, ETHERNET - ION, ETHERNET - DNP, ETHERNET - PTP, IRIG-B</td>
<td>Specifies the port to receive time synchronization signals</td>
</tr>
<tr>
<td>Time Sync Type</td>
<td>UTC, Local</td>
<td>Specifies whether time synchronization signals are received in local time or UTC</td>
</tr>
</tbody>
</table>
Measurements

Energy
Your meter provides bi-directional, 4-quadrant, revenue accurate energy metering:
• kWh, kVARh, kVArh delivered and received
• kWh, kVARh, kVArh net (delivered - received)
• kWh, kVARh, kVArh total (delivered + received)
• Volt-squared-hours and amp-squared-hours
• Integration of any instantaneous measurement
Energy parameters can be logged automatically on a programmed schedule.
All energy values represent the total for all three phases.

Demand
Your meter supports several demand calculation methods, including block, rolling block, synchronized and predicted demand.
It can measure demand on any instantaneous value and record peak (maximum) demand with time and date information.
• kW, kVAR, kVA demand
• kW, kVAR, kVA peak demand
• Amps, Volts demand

Instantaneous measurements
Your meter provides one second and half-cycle true RMS readings.
Instantaneous readings include:
• 3-phase voltages (line-to-line, line-to-neutral): per phase and average
• Line-to-earth voltages per phase and V4, neutral-to-earth voltage
• 3-phase currents: per phase and average
• I4 and I5 currents, measured
• Residual current, calculated (I calc res)
• Active (kW), reactive (kVAR) and apparent (kVA) power: per phase and total
• Power factor per phase and total
• System frequency
• Voltage and current unbalance
• Phase reversal

Harmonics
Your meter provides harmonic distortion metering, recording and real-time values for all voltage and current inputs.
• Individual harmonics (including magnitude, phase angle phase and inter-harmonics) up to the 63rd harmonic
• Total even harmonic distortion (TEHD), total odd harmonic distortion (TOHD)
• Total harmonic distortion (THD), total demand distortion (TDD)
• K-factor, Crest factor

**Min/max recording**

Your meter records new minimum and maximum data every recording interval for a variety of values.

- Voltage and current
- kW, kVAR and kVA
- Power factor
- Frequency
- Voltage unbalance

**Power quality**

Your meter monitors the voltage channels, detects and records power quality events.

The meter measures and records:

- Sag/swells: ITIC/CBEMA and SEMI curves
- Transients: 20 microseconds or longer in duration on any voltage channel

Power quality standards compliance:

- EN50160, including Flicker
- IEC 61000-4-30 Class A
- IEEE 519

The meter supports advanced power quality features:

- Disturbance Direction Detection: the meter can capture sag/swell and transient disturbances, analyze the information and determine the direction of the disturbance relative to the meter. Determining the source of a disturbance more quickly and accurately helps prevent repeat occurrences and minimize facility downtime.
- COMTRADE: the meter can save waveform data in COMmon format for TRAnsient Data Exchange (COMTRADE) format, which is available for download using an SFTP client application. This is intended for use in conjunction with IEC 61850.
- Setpoint learning: You can configure your meter to learn certain disturbance-related values, such as what constitutes a sag, swell, transient, or high or low setpoint.

**Power and power factor**

The sampled measurements taken at the meter’s voltage and current inputs provide data for calculating power and power factor.

In a balanced 3-phase alternating current (AC) power system source, the AC voltage waveforms on the current-carrying conductors are equal but offset by one-third of a period (a phase angle shift of 120 degrees between the three voltage waveforms).

**Power factor (PF)**

Power factor (PF) is the ratio of real power (P) to apparent power (S).

PF is provided as a number between -1 and 1 or as a percentage from -100% to 100%, where the sign is determined by the convention.
A purely resistive load has no reactive components, so its power factor is 1 (PF = 1, or unity power factor). Inductive or capacitive loads introduce a reactive power (Q) component to the circuit which causes the PF to become closer to zero.

**True PF and displacement PF**

The meter supports true power factor and displacement power factor values:

- True power factor includes harmonic content.
- Displacement power factor only considers the fundamental frequency.

**NOTE:** Unless specified, the power factor displayed by the meter is true power factor.

**Apparent, active and reactive power (PQS)**

Apparent power (S) is the capacity of your measured power system to provide active (real power, P) and reactive power (Q).

A typical AC electrical system load has both resistive and reactive (inductive or capacitive) components. Resistive loads consume real power (P). Reactive power (Q) is either consumed (inductive loads) or generated (capacitive loads).

The units for power are watts (W or kW) for real power P, vars (VAR or kVAR) for reactive power Q, and volt-amps (VA or kVA) for apparent power S.

Positive real power P(+) flows from source to load, and negative real power P(-) flows from the load to the power source.

**Current phase shift from voltage**

Electrical current can lag, lead, or be in phase with the AC voltage waveform, and is typically associated with the type of load — inductive, capacitive or resistive.

For purely resistive loads, the current waveform is in phase with the voltage waveform. For capacitive loads, current leads voltage. For inductive loads, current lags voltage.
The following diagrams show how voltage and current waveforms shift based on load type under ideal (laboratory) conditions.

<table>
<thead>
<tr>
<th>Current and voltage in phase (resistive)</th>
<th>Current leads voltage (capacitive)</th>
<th>Current lags voltage (inductive)</th>
</tr>
</thead>
</table>

**Power demand**

Power demand is a measure of average power consumption over a fixed time interval.

**NOTE:** If not specified, references to demand are assumed to mean power demand.

The meter measures instantaneous consumption and can calculate demand using various methods.

**Peak demand**

Peak (or maximum) demand is the highest demand level recorded over the billing period.

Power utilities generally bill commercial customers based on their peak usage levels, called peak demand (in kW) and energy consumption (in kWh). Peak (or maximum) demand is the highest demand level recorded over the billing period. You can view peak demand values on your meter’s display.

Your meter calculates the average current demand and kW, kVAR and kVA demand using sliding window demand methods. It supports coincident demand values when a peak demand is detected.

Your meter’s default configuration is suitable for most applications, or you can customize it for your specific application. You can configure the minimum time between consecutive demand resets.

**NOTE:** If not specified, references to demand are assumed to mean power demand.

**Peak demand reset lockout**

The demand reset lockout time sets the minimum time allowed between consecutive demand resets; the meter ignores any attempts to reset demand that occur within the lockout period.

The peak demand reset lockout period is user-configurable (typical default value is 25 days).

See the ION Setup online help for instructions on how to configure demand peak and the demand reset lockout period on your meter.
See the ION Reference, available from www.schneider-electric.com, for detailed information on how Sliding Window Demand modules measure and calculate demand values.

### Sliding window demand

To calculate demand values, your meter uses the sliding window averaging (or rolling interval) method which divides the demand interval into a set number of subintervals of specified duration.

The demand is measured based on the average load level over the most recent set of subintervals. Sliding window demand also provides predicted demand values.

### Examples of sliding window demand

This example shows two different ways of configuring a 15-minute demand interval:

- **Single interval (also called block or timed block):** the 15-minute demand interval is defined as a single subinterval with a duration of 15 minutes.
- **Sliding window (also called rolling block):** the 15-minute demand interval is defined as three subintervals with a duration of 5 minutes each. This method offers better response time than a single interval.

#### Single interval (block)

<table>
<thead>
<tr>
<th>Time (min)</th>
<th>Calculation updates at the end of the interval</th>
<th>Demand value is the average for the last completed interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>15-30-45</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Sliding window (rolling block)

<table>
<thead>
<tr>
<th>Time (min)</th>
<th>Calculation updates at the end of the subinterval (5 minutes)</th>
<th>Demand value is the average for the last completed interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>15-20-25-30-35-40-45</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Incremental energy

Incremental energy allows you to define a start time, end time, and the time interval (increments) for incremental energy accumulation.

At the end of each interval, the energy accumulated during that period is stored. By default, the meter only records the previous interval’s incremental energy and the instantaneous energy accumulations in the active interval.

The first interval of incremental energy accumulation begins at the specified start time. Incremental energy ends at the specified end time, which may result in a
truncated interval if the interval duration does not divide evenly into the overall incremental energy duration. For example, an interval duration of three hours with an overall duration of five hours truncates the last interval duration to two hours. The latest value for the specified end time is midnight (24:00).

Your start time must be before the end time and after midnight, and the period over which incremental energy is accumulated cannot include midnight. This is because your meter’s start and end times are defined relative to midnight.

<table>
<thead>
<tr>
<th>Start: 6AM, End: 12AM, interval: 3 hrs</th>
<th>Incremental energy accumulates from 6AM to midnight in intervals of 3 hours.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start: 6AM, End: 2AM, interval: 3 hrs</td>
<td>Incremental energy will not function. End time must be after start time and before or equal to midnight.</td>
</tr>
</tbody>
</table>

Incremental energy helps provide information for analyzing energy and power usage against present or future utility rates, and is useful for measuring energy consumption by shift or for a specific process.

When configuring incremental energy, shorter incremental energy periods provide more granular data which can make the data easier to use for comparison purposes.

Incremental energy example

- Start time: 8AM or 08:00
- End time: 12AM or 24:00
- Interval: 420 minutes (7 hours)

The first incremental energy interval is from 8AM (start time) to 3PM, and is 7 hours long. The second incremental energy interval is from 3PM to 10PM, and is also 7 hours long. The third interval is from 10PM to 12AM, and is only 2 hours long because 12AM is the specified end time. These intervals repeat every 24 hours until the configuration is changed or incremental energy feature is disabled.

Configuring incremental energy using ION Setup

You can configure incremental energy using ION Setup.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
4. Select Status and click Edit. The Incremental Energy Setup screen is displayed.
5. Select Enable to display parameters for configuration.
6. Select the parameter to configure.

   **NOTE:** Configuring any parameter resets the incremental energy values recorded by your meter.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start time</td>
<td>12:00 am to 11:59 pm</td>
<td>The incremental energy first interval’s start time. The start time must be prior to the end time for energy accumulation.</td>
</tr>
<tr>
<td>End time</td>
<td>12:01 am to 12:00 am</td>
<td>The end time for incremental energy. The end time must be after the start time and be less than or equal to 12AM (midnight).</td>
</tr>
<tr>
<td>Interval duration</td>
<td>Configurable</td>
<td>The increment period for the incremental energy duration.</td>
</tr>
</tbody>
</table>

7. Click **OK** to save your changes.

### Conditional energy

Conditional energy allows you to define an accumulation period for real and reactive energy using one of your meter’s digital inputs.

You can use conditional energy to track four-quadrant accumulated energy during a specific period. For example, you can track accumulated energy values during a particular process that is controlled by a programmable logic controller (PLC).

Conditional energy is accumulated until it is reset. The conditional energy reset date and time information is stored in the meter’s event log.

#### Configuring conditional energy using ION Setup

You can enable and configure conditional energy settings using ION Setup.

When configuring your meter, the configuration interface may show all of the possible ports, regardless of what is physically available on your meter.

One of your device’s digital inputs must be connected and configured to define when conditional energy is accumulated.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Energy Applications > Digital Input Based**. Review the digital inputs assigned to applications to help ensure there are no conflicting usages.
4. Select **Conditional Energy** and click **Edit**. The **Conditional Energy Setup** screen is displayed.
5. Select **Enabled** to enable the conditional energy feature.
6. Click **Select** to define the digital input. The input’s state determines whether conditional energy is accumulated. When this digital input is on, conditional energy is accumulated.
   
   **NOTE:** It is recommended to set **Assigned Input** to No Connection to disable the conditional energy feature by removing any port associations.
7. Click **OK** to save your configuration.

### Trending and forecasting overview

Trending and forecasting is a feature on your device that predicts the next set of measured or calculated data by plotting and analyzing trends in historical data.
Trending and forecasting data is a useful tool to help analyze changes in load and power quality and forecasting values such as demand. For your meter’s trending and forecasting feature to work, you only need to give the meter time to accumulate data.

Trending and forecasting implementation

Data used for trending and forecasting is logged for specific intervals:

- Every hour for the last 24 hours
- Every day for the last month
- Every week for the last 8 weeks
- Every month for the last 12 months

The following parameters are configured for trending and forecasting using ION Setup:

<table>
<thead>
<tr>
<th>kW sd del-rec (demand)</th>
<th>Freq (frequency)</th>
</tr>
</thead>
<tbody>
<tr>
<td>V ll ab</td>
<td>I a mean</td>
</tr>
<tr>
<td>V ll bc</td>
<td>I b mean</td>
</tr>
<tr>
<td>V ll ca</td>
<td>I c mean</td>
</tr>
<tr>
<td>V ll avg</td>
<td>I avg mean</td>
</tr>
</tbody>
</table>

You can configure the start day of the week for trending and forecasting using the Clock setup assistant in ION Setup.

Viewing trending and forecasting data on your meter’s webpages

You can select data for forecasting and trending and view the resulting information using your meter’s webpages.

For trending and forecasting to operate, your meter must have accumulated data for at least two of the specified intervals; for example, if you want to view a daily graph, your meter must have accumulated data for at least two previous days before the present day.

1. Log in to your meter’s webpages

2. Click Monitoring > Trending & Forecasting

3. Select the Target and Interval. The graph for the selected data is displayed.
Resets

Meter resets

Resets allow you to clear various accumulated parameters stored on your meter, reinitialize the meter or reinitialize meter accessories.

Meter resets clear your meter’s onboard data logs and other related information. Resets are typically performed after you make changes to the meter’s basic setup parameters to clear invalid or obsolete data to prepare the meter for active service.

Option modules reset

Perform an option module reset if your option modules are not communicating with your meter.

During an option module reset, the option module may not operate normally, and digital and analog outputs may change state.

⚠️ WARNING

UNINTENDED OPERATION

Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury or equipment damage.

You can reset your meter’s option module bus using ION Setup or through the display. This power cycles all the modules attached to your meter. If you have queued firmware updates for option modules on your meter’s internal SFTP site, the firmware updates are performed.

By default, your meter is configured to automatically perform an option module bus reset to help keep the option modules operating normally. Contact Technical Support for instructions on changing this default configuration.

Available resets

You can perform various meter resets using ION Setup, the meter webpages or through the display.

<table>
<thead>
<tr>
<th>Reset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Reset</td>
<td>• Clears all cumulative and derived quantities from the meter, including: demand, peak demand, energy, revenue and test mode parameters.</td>
</tr>
<tr>
<td></td>
<td>• Clears meter event and waveform logs.</td>
</tr>
<tr>
<td></td>
<td>• Clears COMTRADE waveform records stored in the meter’s internal SFTP site.</td>
</tr>
<tr>
<td></td>
<td>• Clears meter data logs.</td>
</tr>
<tr>
<td>Peak Demand Reset</td>
<td>Clears meter peak demand values.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The peak demand reset has a lockout period that sets the minimum time allowed between consecutive resets.</td>
</tr>
<tr>
<td>Min/Max Reset</td>
<td>Clears all accumulated maximum and minimum values stored in the meter.</td>
</tr>
<tr>
<td>Digital Input Count Reset</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clears the digital input status change counters.</td>
</tr>
<tr>
<td>Harmonics Min/Max Reset</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clears all accumulated maximum and minimum harmonics values stored in the meter.</td>
</tr>
<tr>
<td>Disturbance Count Reset</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Clears the sag/swell event counter. The sag/swell event counter counts the number of sag/swells that have occurred since power-up or the last reset to provide power quality information to energy management systems.</td>
</tr>
</tbody>
</table>
Performing meter resets using ION Setup

You can perform meter resets on your meter using ION Setup.

Revenue-locked meters must be unlocked to perform resets that impact revenue data.

Meter resets clear the meter’s onboard data logs and other related information.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
</table>

DATA LOSS

Ensure all important data from the device has been retrieved before performing a reset.

Failure to follow these instructions can result in data loss.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Select the Verification screen.
4. Select Normal Mode and click Display.
5. Select the desired tab in the Normal Mode dialog box. Depending on the tab selected, different resets are available.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Reset available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Energy</td>
<td>Master Reset</td>
</tr>
<tr>
<td>Rolling Demand</td>
<td>Peak Reset</td>
</tr>
<tr>
<td></td>
<td>Master Reset</td>
</tr>
<tr>
<td>Volts, Amps and Power</td>
<td>Master Reset</td>
</tr>
<tr>
<td>Conditional Energy</td>
<td>Cnd Reset</td>
</tr>
<tr>
<td></td>
<td>Master Reset</td>
</tr>
<tr>
<td>Input Metering</td>
<td>IM(n) Reset</td>
</tr>
</tbody>
</table>

**NOTE:** n is the input metering number, for example IM1.

6. Click the appropriate button to perform the reset. For some resets, the meter indicates that the reset is in progress.

Do not configure or power down your meter until it indicates that the reset is complete or some parameters may not be completely reset.

Performing meter resets using the meter webpages

You can perform meter resets using the meter webpages.

Meter resets clear the meter’s onboard data logs and related information.

<table>
<thead>
<tr>
<th>Reset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EN50160 Reset</td>
<td>Clears all EN50160 parameters and statistics accumulated in the meter.</td>
</tr>
<tr>
<td>Option Modules Reset</td>
<td>Resets communications to expansion modules connected to the meter.</td>
</tr>
<tr>
<td>Conditional (Cnd) Energy Reset</td>
<td>Clears the conditional energy values stored in the meter.</td>
</tr>
<tr>
<td>Input Metering Reset</td>
<td>Clears the input metering values stored in the meter.</td>
</tr>
</tbody>
</table>
**NOTICE**

**DATA LOSS**

Ensure all important data from the device has been retrieved before performing a reset.

Failure to follow these instructions can result in data loss.

1. Connect to your meter’s webpages.
2. **Control > Resets.**
3. Click **Reset** for the values you want to clear.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Reset</td>
<td>• Clears all cumulative and derived quantities from the meter, including: demand, peak demand, energy, revenue and test mode parameters.</td>
</tr>
<tr>
<td></td>
<td>• Clears meter event and waveform logs.</td>
</tr>
<tr>
<td></td>
<td>• Clears COMTRADE waveform records stored in the meter’s internal SFTP site.</td>
</tr>
<tr>
<td></td>
<td>• Clears meter data logs.</td>
</tr>
<tr>
<td>Peak Demand Reset</td>
<td>Clears meter peak demand values.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The peak demand reset has a lockout period that sets the minimum time allowed between consecutive resets.</td>
</tr>
<tr>
<td>Min/Max Reset</td>
<td>Clears all accumulated maximum and minimum values stored in the meter.</td>
</tr>
<tr>
<td>Digital Input Count Reset</td>
<td></td>
</tr>
<tr>
<td>Harmonics Min/Max Reset</td>
<td></td>
</tr>
<tr>
<td>Disturbance Count Reset</td>
<td></td>
</tr>
<tr>
<td>EN50160 Reset</td>
<td>Clears all EN50160 parameters and statistics accumulated in the meter.</td>
</tr>
</tbody>
</table>

**Performing meter resets using the display**

You can perform meter resets using the display after entering a valid password.

Revenue-locked meters must be unlocked to perform resets that impact revenue data.

Your meter’s digital and analog outputs may change state or may not function during resets.

**WARNING**

**UNINTENDED OPERATION**

Do not use the meter for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury or equipment damage.

Meter resets clear the meter’s onboard data logs and related information.
NOTICE

DATA LOSS
Ensure all important data from the device has been retrieved before performing a reset.
Failure to follow these instructions can result in data loss.

1. Press the Home button on the display.
2. Navigate to Setup Menu > Resets.
3. Press Select.
4. Press Edit. Enter your meter’s password, if prompted.
5. Press the up or down icons to navigate available resets. A gray bar appears behind the active selection.

<table>
<thead>
<tr>
<th>Reset</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Reset</td>
<td>• Clears all cumulative and derived quantities from the meter, including: demand, peak demand, energy, revenue and test mode parameters.</td>
</tr>
<tr>
<td></td>
<td>• Clears meter event and waveform logs.</td>
</tr>
<tr>
<td></td>
<td>• Clears COMTRADE waveform records stored in the meter’s internal SFTP site.</td>
</tr>
<tr>
<td></td>
<td>• Clears meter data logs.</td>
</tr>
<tr>
<td>Peak Demand Reset</td>
<td>Clears meter peak demand values. <strong>NOTE:</strong> The peak demand reset has a lockout period that sets the minimum time allowed between consecutive resets.</td>
</tr>
<tr>
<td>Min/Max Reset</td>
<td>Clears all accumulated maximum and minimum values stored in the meter.</td>
</tr>
<tr>
<td>Digital Input Count Reset</td>
<td>Clears the digital input status change counters.</td>
</tr>
<tr>
<td>Harmonics Min/Max Reset</td>
<td>Clears all accumulated maximum and minimum harmonics values stored in the meter.</td>
</tr>
<tr>
<td>Disturbance Count Reset</td>
<td>Clears the sag/swell event counter. The sag/swell event counter counts the number of sag/swells that have occurred since power-up or the last reset to provide power quality information to energy management systems.</td>
</tr>
<tr>
<td>EN50160 Reset</td>
<td>Clears all EN50160 parameters and statistics accumulated in the meter.</td>
</tr>
<tr>
<td>Option Modules Reset</td>
<td>Resets communications to expansion modules connected to the meter.</td>
</tr>
</tbody>
</table>

7. Press Select to accept the change.

When you select Master Reset, the message ALL RECORDED DATA WILL BE LOST, RESET SELECTED PARAMETERS? is displayed.

8. Press Select to confirm.
Maintenance overview

The meter does not contain any user-serviceable parts. If the meter requires service, contact your local Schneider Electric Technical Support representative.

**NOTICE**

**METER DAMAGE**

- Do not open the meter case.
- Do not attempt to repair any components of the meter.

Failure to follow these instructions can result in equipment damage.

Do not open the meter. Opening the meter voids the warranty.

Firmware and templates overview

Firmware is the meter’s operating system that enables the functions of your meter. You can view the firmware version on the display, webpages and through ION Setup. The firmware includes a digital signature which helps ensure the authenticity of the firmware.

The meter template defines features such as power measurement and analyzing functionality. Your meter ships from the factory with a default template, or you can customize the template to create features specific to your application.

You can upload different firmware versions and templates. When new firmware is available you can upgrade to the latest version to get added features and functionality. You must load a meter template as part of the firmware upgrade process. Save your meter’s existing template before performing a firmware upgrade and then reload it back onto the meter if you do not want to change your meter’s template.

Firmware updates and new factory templates are available for download from www.schneider-electric.com.

The remote display and options modules use firmware information from the meter, but may also need to have their internal firmware updated to support new or improved features. To update the remote display or option module firmware you need to copy the file onto your meter’s internal SFTP site. Go to www.schneider-electric.com to download firmware files.

Typical workflows

To update your meter to the latest available firmware and factory template:

- Download the latest firmware and template for your meter.
- Load the firmware onto your meter; the firmware upgrade process includes upgrading the meter template.

To take an existing meter out of service and replace it with a new meter:

- Save the template from the existing meter
- Load the existing meter’s template onto the new meter; the new meter will now have the customized features from the existing meter.

To update your meter’s firmware without updating your meter’s template:

- Save your meter’s template.
• Download the latest firmware.
• Load the firmware onto your meter. When prompted for a template file, select the template you saved from your meter.

To update the firmware on your meter’s remote display:
• Download the display firmware.
• Load the firmware onto the meter’s internal server using an SFTP client application or ION Setup. The results of the firmware update are stored in the meter’s event log.

To update the firmware on your meter’s option module(s):
• Download the option module firmware; make sure that the firmware matches the option module type.
• Load the firmware onto the meter’s internal SFTP site using an SFTP client application or ION Setup.
• Power cycle or perform an option bus reset to start the option module firmware update.

**NOTE:** If the meter is power cycled or an option module reset is performed while there are option module firmware upgrade files loaded on the meter’s SFTP site, the option module firmware is upgraded.

Visit the company website at www.schneider-electric.com and search for your meter type to see the available firmware and templates.

See the online ION Setup help for instructions on how to load meter templates.

**Laptop computer upgrade considerations**

The connection between the laptop and the device must be maintained in order for the upgrade to proceed.

Laptop computers generally have different default power properties than desktop computers.

If the laptop’s hard disk shuts down or the laptop enters system standby mode, this connection is broken and the upgrade procedure must be restarted.

If you are upgrading your meter’s firmware using a laptop computer, follow these guidelines:
• Plug the laptop computer into a wall outlet. Do not run the laptop on its battery.
• Configure the laptop’s hard disks so that they do not shut down after a certain period of time (for example, set to “never”).
• Turn off the laptop’s power suspension (for example, system stand-by) and hibernate options.
• Disable the laptop’s option to power down when it is closed. This prevents a shut down if the laptop is accidentally closed.
• Disable the laptop’s screen saver as they can burden the CPU.

**Firmware upgrade considerations**

Ensure that the firmware version you are upgrading to is compatible with your meter, and that the version number is greater than your existing firmware (or else you will downgrade your meter).

Your meter’s existing template may not work with different firmware versions if significant meter features have been added or modified.

Your firmware upgrade files have digital signature confirmation to help ensure your firmware’s authenticity. Once you have upgraded your firmware to a version that uses digital signature confirmation, you cannot downgrade to an earlier firmware version that did not use digital signature authentication.
Remote display (RMD) upgrade behavior

Your meter’s remote display will upgrade as soon as the upgrade file is put in the remote display upgrade folder on your meter’s internal SFTP site. It is deleted as part of the upgrade process.

**NOTE:** If your meter’s remote display loses power during firmware upload, the display will revert to its original firmware and you will have to reload the firmware file.

The results of your remote display firmware upgrade are stored in your meter’s event log. Detailed information about your remote display, such as serial number and firmware version is provided in the Factory module.

See the ION Reference, available from www.schneider-electric.com, for more information about the Factory module.

Option module(s) upgrade behavior

To upgrade option modules, you must load the upgrade file into the appropriate folder on the meter’s internal SFTP site. The upgrade is triggered by either a power cycle or option module reset. After the upgrade is performed, the upgrade file is deleted from the meter’s internal SFTP site before the option module is reset to run the new firmware. The option module firmware will not upgrade if more than one upgrade file is in the folder. The upgrade file must be the correct file type and match the type of module being upgraded.

All option modules do not perform their regular functions during firmware upgrade. If more than one option module is being upgraded, the firmware on the option module closest to the meter is done first, then the next closest, proceeding to the furthest module from the meter base requiring upgrading. A single option module firmware upgrade should not take more than five minutes.

The option module upgrade results are stored in your meter’s event log. Detailed information about the option module, such as serial number and firmware version is provided in the Factory module. Information about the option module type and details of the option module’s state is provided in the Diagnostics module.

See the ION Reference, available from www.schneider-electric.com, for more information about the Factory and Diagnostic modules.

Accumulated energy values and upgrades

The firmware upgrade process clears accumulated energy values in the meter. If you want to retain these values across a firmware upgrade, you can use the Register Edit feature in ION Setup to manually restore pre-upgrade values back to your meter.

Editing accumulated energy values using ION Setup

You can edit energy values such kWh and kVARh using ION Setup.

**NOTE:** Ensure you have recorded accumulated energy values before upgrading your meter’s firmware. You can then re-enter these values after the upgrade.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Select the **Template** screen.
4. Click the **Register Edit** tab, click **Energy** then click **Display.** Enter your meter’s password (if prompted) and click **OK.** The Register Editor screen displays.
5. Click **Edit** to enable editing.
6. Enter values for kWh, kVAh and kVARh as required. Click **Send** to finish.
   **NOTE:** Only values that have the checkbox selected will be sent to the meter.

7. Click **Close** to close the Register Editor screen.

**Loading meter firmware using ION Setup**

You can load firmware onto your meter using ION Setup.

You can download firmware for your meter from [www.schneider-electric.com](http://www.schneider-electric.com).

You must load a meter template as part of the firmware upgrade process. You can save your meter’s existing template by navigating to **Template > Save to PC** in the ION Setup Assistant and clicking **Save** to save your meter’s template as a .DCF file. You can also use a template that you have saved from another meter of the same type, or download a factory template from [www.schneider-electric.com](http://www.schneider-electric.com).

Ensure that you record your meter’s user and password information in a secure location before upgrading the meter’s firmware. If your meter’s user and password information is lost, you must return the meter for factory reconfiguration, which resets your meter to its factory defaults and destroys all logged data.

Any digital and analog outputs associated with your device may change state during a firmware upgrade.

---

**WARNING**

**UNINTENDED OPERATION**

Do not use this device for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

---

Loading firmware or template onto your meter clears the meter’s recorded data.

---

**NOTICE**

**DATA LOSS**

Ensure that all important data has been recorded before uploading firmware or a template to your device.

Failure to follow these instructions can result in data loss.

---

1. Obtain the meter firmware (.UPG or .UPx) and framework (.DCF or .FWN) that you want to load onto your meter. Save the files where they can be accessed by the computer running ION Setup.

2. Start ION Setup.

3. Open the Setup Assistant for your meter.

4. Select the **Template** screen.

5. Click the **Firmware Upgrade** tab, then click **Upgrade**. Enter your meter’s password (if prompted) and click **OK**.
   **NOTE:** If you want to retain customized meter template settings, other than those listed in the Template Paste Options dialog box (see Step 8), click on the **Save to PC** tab and click **Save**. Save your template as a .DCF file. Select this file in Step 7 instead of the file obtained from the website.

6. Navigate to the meter firmware (.UPG or .UPx) file and click **Open**. Enter your ION Setup password when prompted and click **OK**.
7. Navigate to the meter framework (.DCF or .FWN) file and click OK. The Template Paste Options dialog box appears.

8. Select the check boxes for the settings you want to retain (not overwrite) and click OK.

A dialog box describes the template upload and firmware upgrade progress, verifies the firmware, and finishes with an overview stating whether the firmware and framework were successfully uploaded onto your meter.

**Post-requisite:**
After upgrading your meter’s firmware or template, make sure that the meter’s settings, either for existing functionality or new features, are appropriate for your system.

### Loading webpages using ION Setup

You can upgrade your meter’s webpages using ION Setup with an Ethernet connection.

You must have:

- Your meter’s webpage upgrade files (.zip folder). Go to www.schneider-electric.com to download upgrade files.
- SFTP access to your meter from the computer running ION Setup.

1. Obtain the webpage upgrade files (.zip folder) that you want to upload onto your meter. Save the files where they can be accessed by the computer running ION Setup.

2. Start ION Setup.

3. Open the Setup Assistant for your meter.

4. Select **Template > Web**.

> **NOTE:** You can preview meter webpages using the Test Web Viewing feature. Select an IP addressing method from the drop-down menu to generate a test link using your default web browser.

5. Click **Upload** to navigate to the folder (.zip) containing the meter upgrade files. Select the folder and click **Open**

6. An ION Setup dialog box will open. Click **Yes** to confirm uploading of the webpage files.

> **NOTE:** The upload process replaces files with matching filenames only.

Confirmation of uploaded files will be displayed in the bottom status bar.

### Loading webpages using SFTP

You can upgrade your meter’s webpages using your meter’s internal SFTP site.

You must have:

- Your meter’s webpage upgrade files. Go to www.schneider-electric.com to download upgrade files.
- Access to your meter’s internal SFTP site.

1. Connect to your meter’s internal SFTP site and open the webpages (**web**) folder.

2. Navigate to the location on your local machine where you saved the webpage upgrade files.

> **NOTE:** Extract the contents of the upgrade file.
3. Drag the **resources** and **examples** folders into the **web** folder. Confirm to overwrite existing files when prompted.
   The files are immediately transferred to the meter.

### Loading remote display firmware using ION Setup

This procedure is specific to meters with a remote display.

You can load updates to your meter’s remote display firmware using ION Setup over an Ethernet connection.

You must have:

- The remote display connected to your meter.
- SFTP access to your meter from the computer running ION Setup.

**NOTE:** If your meter’s remote display loses power during firmware upload, the display will revert to its original firmware and you will have to reload the firmware file.

1. Obtain the Remote Display firmware file (.BIN) that you want to load onto your display. Save the files where they can be accessed by the computer running ION Setup.
2. Start ION Setup.
3. Open the Setup Assistant for your meter.
4. Select the **Template** screen.
5. Click the **Firmware Upgrade** tab, then click **Upgrade**. Enter your meter’s password (if prompted) and click **OK**.
6. Navigate to where you have stored the remote display firmware. Select the Remote Display firmware file (*.BIN) as the file type.
7. Select the remote display firmware (.BIN) file and click **Open**.
8. Enter your ION Setup password when prompted and click **OK**.

A dialog box describes the firmware upgrade progress, verifies the firmware, and finishes with an overview stating whether the firmware was successfully uploaded.

### Loading remote display firmware using SFTP

You can upload firmware to your meter’s remote display by loading the firmware upgrade file onto your meter’s internal S site.

You must have:

- The remote display connected to your meter, and have access to your meter’s internal SFTP site.

1. Connect to your meter’s internal SFTP site.
2. Open the remote display upgrade (rmdUpg) folder.
3. Drag the remote display firmware file into the remote display upgrade folder. The file is immediately transferred to the remote display, and is not stored on the meter.
4. Watch your meter’s display to confirm the firmware upgrade is taking place.
5. Review the remote display firmware upgrade details stored in the meter’s event log to confirm that the upload was successful.

See Remote display troubleshooting icons, page 114 for more information about icons shown on your meter’s remote display.

See Transferring files using SFTP, page 63 for instructions on transferring files using SFTP.

Loading option module firmware using ION Setup

You can upload firmware to your meter’s option modules using ION Setup over an Ethernet connection.

You must perform the upload process separately for each type of module.

You must have:

• The option module connected to your meter.
• SFTP access to your meter from the computer running ION Setup.

Your meter’s digital and analog outputs may change state during a firmware upgrade. Option modules are offline during an option module firmware upgrade; they will not communicate to the meter and the outputs may change state during the upgrade process.

⚠️ WARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

NOTE: If your meter’s option module loses power during firmware upload, the option module will revert to its original firmware and you will have to reload the firmware file.

1. Obtain the Option Module firmware files (.S19) that you want to load onto your option module(s). Save the files where they can be accessed by the computer running ION Setup.

2. Start ION Setup.

3. Open the Setup Assistant for your meter.

4. Select the Template screen.

5. Click the Firmware Upgrade tab, then click Upgrade. Enter your meter’s password if prompted and click OK.

6. Navigate to where you have stored the option module firmware. Select the Option Module firmware file (*.S19) as the file type.

7. Select the option module firmware file and click Open.

An ION Setup window will open. Click Yes to confirm the firmware upgrade.

8. The Option Card Upgrade window opens. Select the Slot that corresponds to the Option Module type. You can select multiple slots for the same option module type.

9. Click Start.

A dialog box describes the firmware upgrade progress, verifies the firmware, and finishes with an overview stating whether the firmware was successfully uploaded.
Loading option module firmware using SFTP

You can upload firmware to your meter’s option modules by loading the firmware upgrade file onto your meter’s internal SFTP site.

You must have:

- Your meter’s option module firmware upgrade (.S19) file(s). Go to www.schneider-electric.com to download upgrade files.
- The option module connected to your meter, and have access to your meter’s internal SFTP site.

Your meter’s digital and analog outputs may change state during a firmware upgrade. Option modules are offline during an option module firmware upgrade; they will not communicate to the meter and the outputs may change state during the upgrade process.

⚠️ WARNING

**UNINTENDED OPERATION**

Do not use this device for critical control or protection applications where human or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

---

NOTE: If your meter’s option module loses power during firmware upload, the option module will revert to its original firmware and you will have to reload the firmware file.

1. Connect to your meter’s internal SFTP site. Open the option module upgrade (optionModuleUpg) folder.
2. Drag the option module firmware file into the option module upgrade folder.
   - The file is immediately transferred to the option module, and is not stored on the meter.
3. Review the option module firmware upgrade details stored in the meter’s event log to confirm that the upload was successful.

---

Test mode

Test mode is typically used for verifying meter functions.

The meter is usually reading data from a test power supply while function verification is performed.

The values shown in the test mode display screens represent different accumulators than those shown in norm or alt mode (although they perform some of the same basic measurements). The test mode display values are for accuracy checking purposes; they only accumulate while the meter is in test mode.

You can create custom test mode screens and modify the existing test mode screens.

**NOTE:** You cannot place revenue-locked meters into test mode.

Several things to note about test mode:

- All of the billing quantities that are recorded when the meter is in Normal mode stop accumulating when the meter is switched to test mode – the data is sent to special test mode registers instead.
- The values accumulated in these test registers are displayed on the test mode displays and in ION Setup.
- The regular normal mode billing registers are unaffected while the meter is in test mode; accumulation of this data continues as soon as you exit test mode.
- All test registers are reset to zero when you exit test mode.
Test mode default screens

Your meter has default test mode display screens.

**NOTE:** You can modify the test mode display screens or add custom screens using ION Setup.

<table>
<thead>
<tr>
<th>Screen</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand test</td>
<td>This screen shows test mode kW delivered and received values. Both quantities are produced from a sliding window (rolling block) demand calculation.</td>
</tr>
<tr>
<td>Reactive energy test</td>
<td>This screen shows test mode kVARh delivered and received values.</td>
</tr>
<tr>
<td>Active energy test</td>
<td>This screen shows test mode kWh delivered and received values.</td>
</tr>
</tbody>
</table>

Putting your meter in test mode using the display

You can put your meter into test mode using the display.

**NOTE:** You cannot place a revenue-locked meter into test mode.

1. Press the Home button.
2. Press Up or Down to navigate to **Normal Display Mode**.
3. Press Select.
4. Press Down to navigate to **Test Mode**.
5. Press Select to enter the **Test Mode Screens**. Enter the meter password if prompted and press Select.
   - The **Test Mode** menu displays briefly before switching to the first **Test Mode** screen.
6. View the test mode screens by pressing Up or Down.
7. Press the Home button to return to **Test Mode Screens**. Press Down to highlight **Exit Test Mode**, then press Select.

Putting your meter in test mode using ION Setup

You can put your meter into test mode using the ION Setup.

**NOTE:** You cannot place a revenue-locked meter into test mode.

1. Start ION Setup.
2. Open the Setup Assistant for your meter.
3. Navigate to **Verification** and select the **Verification** tab.
4. Select **Test Mode** and click **Display**.
   - Your meter is now in test mode, and the **Test Mode** screen is displayed.
5. Select the different tabs to view your meter’s test mode values and modify test mode parameters.
6. Click **Close** to take your meter out of test mode.

Device-specific information

Manufacturing-related information about the meter is available from the Factory module or through Modbus commands.

The meter’s Factory module stores meter details such as device type, serial number and vendor name. You can use ION Setup in advanced mode to view the
contents of the Factory module’s setup registers. Similarly, you can use Modbus commands to read the Modbus registers mapped to the corresponding Factory module’s registers.

**NOTE:** Not all ION device setup registers are mapped to Modbus registers by default.

Other device-specific details, such as Product Code, are not stored in the Factory module. Product Code (also known as Modbus Product ID) is a number that the manufacturer assigned to a product to uniquely identify it, for use by systems that specifically require this information. You can use the device’s Modbus map and Modbus commands to read the Modbus Product ID.

The *ION Reference* describes the Factory module in detail. You can download the *ION Reference* and your device’s Modbus map from www.schneider-electric.com.

---

**Troubleshooting**

**Option module troubleshooting**

Your meter’s option modules operate sequentially; if one module is non-functional all downstream modules may be affected.

If your meter cannot communicate with an option module, by default it cycles power to that module and all downstream modules, making multiple attempts to communicate. After the maximum number of communication attempts has been exceeded the meter will remove power to that module and all downstream modules.

When troubleshooting option modules, attach each option module directly to the meter and verify its operation. If each option module operates when directly connected, use combinations of modules or known good modules to help identify the issue.

Events related to option module initialization and operation are stored in your meter’s onboard event log. Perform an option bus reset to restart the option bus and re-initialize the option modules attached to your meter.

Information about your option module’s type, serial number, firmware version and present status is available in the Factory and Diagnostics modules.

See the ION Reference, available from www.schneider-electric.com, for more information about the Factory and Diagnostics modules.

---

**Technical assistance**

Go to www.schneider-electric.com and search for support to get assistance with troubleshooting.

Have the meter model, serial number and firmware version information ready. See “Device-specific information”, page 226 for details about obtaining this information.

You may be asked by a customer care agent to enable factory access to the device for troubleshooting. Factory access is gained after a unique diagnostic access code is used to login to the device over a secure protocol.

Factory access is:

- Disabled by default.
- Temporarily enabled for a duration defined in the Factory Access minutes register.
- Requires adequate user privileges to enable.
- Provides read and write permissions.
Revenue

Revenue metering overview

A revenue meter provides, over a defined range of operating conditions, measurements that are within international and national defined standards and industry-accepted accuracy limits.

It also provides protection against unauthorized alteration of these measured quantities. National and utility-based standards regulate protection against unauthorized alteration of measured quantities.

Revenue metering components

To meet government regulations and utility security requirements, the meter incorporates three types of security systems:

- traditional anti-tamper mechanical seals on the meter (refer to the installation sheet shipped with your meter)
- password entry to reset meter values, for example, Master reset
- hardware locking mechanism that prevents modification of revenue quantities after they are locked

Revenue firmware security features

Your revenue meter has additional firmware security features:

- You can only upgrade to revenue-qualified firmware and frameworks.
- Your firmware upgrades are recorded in your meter’s event log. An additional firmware upgrade log is stored on your meter. Contact Technical Support for information on upgrade log retrieval.
- When revenue-locked, you cannot perform resets, configure some revenue-specific parameters or upgrade your meter.

Protected features and settings

Your revenue meter has features and settings that cannot be changed while revenue-locked.

In order to prevent changes to revenue-related features, settings and meter data, you can apply revenue-locking after all revenue-metering setup is complete. For a complete listing of revenue-locked features and settings, download the ION Device Template Reference, available from www.schneider-electric.com

Revenue locking

Revenue locking may be required to help meet government regulations and utility security requirements.

Revenue locking your meter helps:

- prevent changes to revenue-related features, settings and meter data
- prevent tampering with your meter’s voltage and current connections
- ensure the validity of revenue data
Revenue-locking summary

You must configure and revenue lock your meter before installing it.

- Unlock your revenue meter if it is locked.
- Configure the required revenue settings specific for installation.
  
  **NOTE:** If you are using ION Setup to configure your meter, allow for any communication delays before removing power to your meter.

- Verify the revenue settings have been implemented.
- Clear all accumulated meter data.
- Revenue lock your meter.
- Verify the meter is revenue-locked.
- Install the meter and install the terminal covers according to your meter’s installation sheet.

Revenue lock switch

The revenue lock switch located on the meter base is used to revenue lock your meter.

This switch is accessed through a sealable cover.

Revenue lock LED behavior

The revenue lock LED indicates the lock status of the meter.

<table>
<thead>
<tr>
<th>LED behavior</th>
<th>Revenue lock status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The meter is not revenue locked.</td>
</tr>
<tr>
<td>On</td>
<td>The meter is revenue locked.</td>
</tr>
<tr>
<td>Flashing</td>
<td>New revenue lock state is pending; power cycle your meter to set the revenue lock to on or off.</td>
</tr>
</tbody>
</table>
Revenue locking your meter

You can lock and unlock your meter using the revenue lock switch located on the meter base.

⚠️ DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH

- Apply appropriate personal protective equipment (PPE) and follow safe electrical work practices. See NFPA 70E in the USA, CSA Z462 or applicable local standards.
- Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
- Always use a properly rated voltage sensing device to confirm that all power is off.

Failure to follow these instructions will result in death or serious injury.

1. Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
2. Always use a properly rated voltage sensing device to confirm that all power is off.
3. Open the revenue lock switch cover.
4. Locate the revenue lock switch.
5. Toggle revenue lock switch on or off.
6. Close the revenue lock switch cover and make sure it is firmly in place.
7. Seal the revenue lock switch cover if required.

Anti-tamper sealing

The meter has several anti-tamper sealing points which can be sealed by a wire seal or lock.

In certain countries, the meter is no longer revenue certified if the anti-tamper seals are broken.

See your meter’s installation sheet for sealing point locations.

⚠️ NOTICE

LOSS OF COMPLIANCE

Ensure that you re-certify your meter with the appropriate revenue metering authorities if you remove the anti-tamper seals.

Failure to follow these instructions may render your device non-compliant for billing purposes.
PT/CT correction

Potential transformer / current transformer correction (PT/CT correction), also called instrument transformer correction, can help reduce the need to replace transformers in installations where high accuracy is required.

The primary application for PT/CT correction is to apply correction factors for ratio errors and phase angle errors to instrument transformers. PT/CT correction is done for each current and voltage input to the meter and only affects 1-second power meter data and values derived from it, such as energy or demand. No high-speed, harmonics or waveform values are affected by the correction.

NOTE: For those familiar with ION architecture, the relevant 1-second Power Meter module outputs are compensated using the Instr Xformer (ITC) Correction module. All other modules that use the 1-second Power Meter module’s data are also compensated.

See the ION Setup online help, available from www.schneider-electric.com, for instructions on how to configure PT/CT correction on your device.

See the ION Reference, available from www.schneider-electric.com, for detailed information about the Instr Xformer Correction (ITC) module and how it applies PT/CT correction to your device.

Transformer loss compensation

Transformer Loss Compensation (TLC) is the method for compensating for the measurable losses that occur when there is a physical separation between the meter and the actual billing point.

TLC is used when a meter’s actual location is different from the electrical location where change of ownership occurs, for example, if meters are connected on the
low-voltage side of power transformers but the ownership change occurs on the high-side of the transformer. Meters are usually installed on the low-voltage side of a transformer because it is more cost-effective.

**NOTE:** Due to the variation in installations, advanced knowledge of power systems and connection methods is required before transformer loss compensation can be properly implemented. Data parameters should only be programmed by qualified personnel that have appropriate training and experience with Transformer Loss Compensation calculations.

There are cases where the change of ownership occurs halfway along a transmission line, where it is impractical to install a meter. In this case, power metering must be compensated using line loss calculations.

See the *Transformer / line loss calculations* technical note available from www.schneider-electric.com.

### Time of use

Time of Use (TOU) is often used when a utility has set up schedules with different rates based on time of day, type of day and date when energy is consumed.

You can view the TOU active rates and seasons through your meter’s display.

See the ION Setup online help, available from www.schneider-electric.com, for instructions on how to configure time of use on your meter.


### Energy pulsing LED behavior

The visible and infrared LEDs are configured by default to pulse based on energy measured by the meter.

You can configure the pulse weight (pulses per kWh) and the energy source.

Energy pulsing is used to help verify the energy measurement accuracy of your meter for revenue purposes.
Verifying accuracy

Overview of meter accuracy

All meters are tested and verified at the factory in accordance with International Electrotechnical Commission (IEC) and American National Standards Institute (ANSI) standards.

Your digital power meter typically does not require re-calibration. However, in some installations a final accuracy verification of the meters is required, especially if the meters will be used for revenue or billing applications.

Accuracy test requirements

The most common method for testing meter accuracy is to apply test voltages and currents from a stable power source and compare the meter’s readings with readings from a reference device or energy standard.

Signal and power source

The meter maintains its accuracy during voltage and current signal source variations but its energy pulsing output needs a stable test signal to help produce accurate test pulses. The meter’s energy pulsing mechanism needs approximately 10 seconds to stabilize after every source adjustment.

The meter must be connected to control power in order to conduct accuracy verification testing. Refer to your meter’s installation documentation for power supply specifications.

⚠️ DANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Verify the device’s power source meets the specifications for your device’s power supply.

Failure to follow these instructions will result in death or serious injury.

Control equipment

Control equipment is required for counting and timing the energy pulse outputs from a visible LED, infrared LED or onboard digital output.

- Most standard test benches have an arm equipped with optical sensors to detect LED pulses (the photodiode circuitry converts detected light into a voltage signal).
- The reference device or energy standard typically has digital inputs that can detect and count pulses coming from an external source (i.e., the meter’s onboard digital output).

**NOTE:** The optical sensors on the test bench can be disrupted by strong sources of ambient light (such as camera flashes, fluorescent tubes, sunlight reflections, floodlights, etc.). This can cause test errors. Use a hood, if necessary, to block out ambient light.

Environment

The meter should be tested at the same temperature as the testing equipment. The ideal temperature is about 23 °C (73 °F). Make sure the meter is warmed up sufficiently before testing.
A warm-up time of 30 minutes is recommended before beginning energy accuracy verification testing. At the factory, the meters are warmed up to their typical operating temperature before calibration to help ensure that the meters will reach their optimal accuracy at operating temperature.

Most high precision electronic equipment requires a warm up time before it reaches its specified performance levels. Energy meter standards allow the manufacturers to specify meter accuracy derating due to ambient temperature changes and self-heating.

Your meter complies with and meets the requirements of these energy metering standards.

For a list of accuracy standards that your meter complies to, contact your local Schneider Electric representative or download the meter brochure from www.schneider-electric.com.

Reference device or energy standard

To help ensure the accuracy of the test, it is recommended that you use a reference device or reference energy standard with a specified accuracy that is 6 to 10 times more accurate than the meter under test. Before you start testing, the reference device or energy standard should be warmed up as recommended by its manufacturer.

**NOTE:** Reference equipment with a traceable calibration certificate is recommended when performing accuracy testing.

Energy pulsing

Energy pulsing LEDs and digital outputs can be used for energy pulsing.

Your meter is equipped with two types of energy pulsing LEDs: visible light and infrared. These LEDs emit pulses that are then used to determine the accuracy of the meter’s energy measurements. The pulses of light indicate accumulated energy; the meter’s accumulations are compared with the reference/standard’s accumulated energy in order to help determine the meter’s accuracy.

The meter’s digital output can also be used for energy pulsing. A closing (low impedance) and then opening (high impedance) of the digital output represents a pulse. If the accuracy testing equipment has a voltage requirement, a current-limited wetting supply voltage must be provided.

**NOTE:** Digital outputs on option modules should not be used for meter accuracy testing.

Verifying accuracy test meter settings

Your meter’s power system and other parameters must be configured for accuracy testing.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volts mode</td>
<td>4W-Wye (4 wire Wye)</td>
</tr>
<tr>
<td>PT/CT correction</td>
<td>Disabled</td>
</tr>
<tr>
<td>Test mode</td>
<td>Active</td>
</tr>
</tbody>
</table>

**NOTE:** In test mode, your meter’s billing quantities stop accumulating, and the data is sent to special test mode registers. These registers are cleared when you exit test mode.
Verifying accuracy test

The following tests are guidelines for accuracy testing your meter; your meter shop may have specific testing methods.

**DANGER**

**HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH**

- Apply appropriate personal protective equipment (PPE) and follow safe electrical work practices. See NFPA 70E in the USA, CSA Z462 or applicable local standards.
- Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.
- Always use a properly rated voltage sensing device to confirm that all power is off.
- Do not exceed the device’s ratings for maximum limits.
- Verify the device’s power source meets the specifications for your device’s power supply.

*Failure to follow these instructions will result in death or serious injury.*

1. Turn off all power supplying this device and the equipment in which it is installed before working on the device or equipment.

2. Use a properly rated voltage sensing device to confirm that all power is off.

3. Connect the test voltage and current source to the reference device or energy standard. Ensure all voltage inputs to the meter under test are connected in parallel and all current inputs are connected in series.

4. Connect the control equipment used for counting the standard output pulses using one of these methods:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Energy pulsing LED</td>
<td>Align the red light sensor on the standard test bench armature over the energy pulsing LED.</td>
</tr>
<tr>
<td>Onboard Digital output</td>
<td>Connect the meter’s onboard digital output to the standard test bench pulse counting connections.</td>
</tr>
</tbody>
</table>

*NOTE: When selecting which method to use, be aware that energy pulsing LEDs and digital outputs have different pulse rate limits.*
5. Before performing the verification test, let the test equipment power up the meter and apply voltage for at least 30 seconds. This helps stabilize the internal circuitry of the meter.

6. Configure your meter power settings (such as voltage, current and frequency) to align with the reference device.

7. Depending on the method selected for counting the energy pulses, configure the meter’s energy pulsing LED or one of the digital outputs to perform energy pulsing. Set the meter’s energy pulse constant so it is in sync with the reference test equipment.

8. Perform accuracy verification on the test points. Run each test point for at least 30 seconds to allow the test bench equipment to read an adequate number of pulses. Allow 10 seconds of dwell time between test points.

**Calculate the number of required pulses**

The reference test equipment typically requires you to specify the number of pulses required for a test duration of “t” seconds.

Normally, the number of pulses required is at least 25 pulses, and the test duration is greater than 30 seconds.

Use the following formula to calculate the required number of pulses:

\[
\text{Number of pulses} = \frac{N_e \times V \times I \times PF \times t}{3600 \times K_t}
\]

<table>
<thead>
<tr>
<th>Ne</th>
<th>Number of metering elements used</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>Test point voltage in line-to-neutral volts (V) per phase</td>
</tr>
<tr>
<td>I</td>
<td>Test point current in amps (A) per phase</td>
</tr>
<tr>
<td>t</td>
<td>Test duration in seconds (s) which must be longer than 30 seconds</td>
</tr>
<tr>
<td>PF</td>
<td>Power factor</td>
</tr>
<tr>
<td>Kt</td>
<td>Pulse constant programmed in the meter under test in Wh/pulse</td>
</tr>
</tbody>
</table>

Round up the result of the calculation to the nearest integer number of pulses.

**Calculation for number of required pulses**

This example calculates the number of pulses required for an inductive load 3-phase test point with a test duration of 60s; the source is configured to use V = 120V, I = 5A, PF = -0.5; the pulse constant of the meter under test is Kt = 1.8 Wh/pulse.

\[
8.3 = \frac{3 \times 120 \times 5 \times 0.5 \times 60}{3600 \times 1.8}
\]

Round the number up to the nearest integer: Number of pulses = 9

**Percentage error calculation for accuracy verification testing**

Accuracy verification testing requires you to calculate the percentage error between the meter being tested and the reference/standard.

Calculate the percentage error for every test point using the following formula:
Energy error = \( \frac{(EM - ES)}{ES} \times 100\% \)

Where:

- \( EM \) = energy measured by the meter under test
- \( ES \) = energy measured by the reference device or energy standard.

**NOTE:** If accuracy verification reveals inaccuracies in your meter, they may be caused by typical sources of test errors. If there are no sources of test errors present, please contact your local Schneider Electric representative.

### Typical sources of test errors

If you see excessive errors during accuracy testing, examine your test setup and test procedures to eliminate typical sources of measurement errors.

Typical sources of accuracy verification testing errors include:

- Loose connections of voltage or current circuits, often caused by worn-out contacts or terminals. Inspect terminals of test equipment, cables, test harness and the meter under test.
- Meter ambient temperature is significantly different than 23 °C (73 °F).
- Floating (ungrounded) neutral voltage terminal in any configuration with unbalanced phase voltages.
- Inadequate meter control power, resulting in the meter resetting during the test procedure.
- Ambient light interference or sensitivity issues with the optical sensor.
- Unstable power source causing energy pulsing fluctuations.
- Incorrect test setup: not all phases connected to the reference device or the energy standard. All phases connected to the meter under test should also be connected to the reference meter/standard.
- Moisture (condensing humidity), debris or pollution present in the meter under test.

### Accuracy verification test points

The meter should be tested at full and light loads and at lagging (inductive) power factors to help ensure testing over the entire range of the meter.

The test amperage and voltage input rating are labeled on the meter. Refer to the installation sheet or data sheet for your meter’s nominal current, voltage and frequency specifications.

<table>
<thead>
<tr>
<th>Watt-hour test point</th>
<th>Sample accuracy verification test point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full load</td>
<td>100% to 200% of the nominal current, 100% of the nominal voltage and nominal frequency at unity power factor or one (1).</td>
</tr>
<tr>
<td>Light load</td>
<td>10% of the nominal current, 100% of the nominal voltage and nominal frequency at unity power factor or one (1).</td>
</tr>
<tr>
<td>Inductive load (lagging power factor)</td>
<td>100% of the nominal current, 100% of the nominal voltage and nominal frequency at 0.50 lagging power factor (current lagging voltage by 60° phase angle).</td>
</tr>
<tr>
<td>VAR-hour test point</td>
<td>Sample accuracy verification test point</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Full load</td>
<td>100% to 200% of the nominal current, 100% of the nominal voltage and nominal frequency at zero power factor (current lagging voltage by 90° phase angle).</td>
</tr>
<tr>
<td>Light load</td>
<td>10% of the nominal current, 100% of the nominal voltage and nominal frequency at zero power factor (current lagging voltage by 90° phase angle).</td>
</tr>
<tr>
<td>Inductive load (lagging power factor)</td>
<td>100% of the nominal current, 100% of the nominal voltage and nominal frequency at 0.87 lagging power factor (current lagging voltage by 30° phase angle).</td>
</tr>
</tbody>
</table>
## ION9000 Specifications

### Specifications overview

This section provides additional specifications for your meter and accessories.

The information contained in this section is subject to change without notice. You can download updated documentation from www.schneider-electric.com or contact your local Schneider Electric representative for the latest updates.

See your device’s installation sheet for specifications related to installation, such as measured current and voltage ranges, inputs/outputs and control power information.

### Mechanical characteristics

**ION9000 series meter**

<table>
<thead>
<tr>
<th>Mounting options</th>
<th>DIN rail: IEC 60715 (DIN EN 60715), TH 35–7.5 or TH 35–15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel mount:</td>
<td>with 9B2BMA</td>
</tr>
<tr>
<td>Orientation</td>
<td>Vertical, retaining clips located on bottom of meter</td>
</tr>
<tr>
<td>IP degree of protection</td>
<td>IP30 (except connectors)</td>
</tr>
<tr>
<td>Maximum number of option modules</td>
<td>4 (based on maximum operating temperature)</td>
</tr>
</tbody>
</table>

### Mechanical compliance

<table>
<thead>
<tr>
<th>Vibration</th>
<th>IEC 60068-2-6</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IEC 60068-2-57</td>
</tr>
<tr>
<td>Shock</td>
<td>IEC 60068-2-27</td>
</tr>
<tr>
<td></td>
<td>IEC 60068-2-31, Test Ec Free fall procedure 1</td>
</tr>
</tbody>
</table>

### Electrical characteristics

True RMS 4–quadrant metering up to the 63rd harmonic on three-phase systems, 1024 samples per cycle.

### Measurement accuracy

<table>
<thead>
<tr>
<th>Metric</th>
<th>Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active energy (Wh)</td>
<td>IEC 62053-22 Class 0.1 S</td>
</tr>
<tr>
<td>Reactive energy (VARh)</td>
<td>IEC 62053–24 Class 0.5 S</td>
</tr>
<tr>
<td>Power monitoring device (PMD)</td>
<td>IEC 61557–12 PMD/SD/K70/0.2 and PMD/SS/K70/0.2</td>
</tr>
<tr>
<td>Active power (P)</td>
<td>IEC 61557-12 Class 0.1</td>
</tr>
<tr>
<td>Reactive power (Qv)</td>
<td>IEC 61557-12 Class 1</td>
</tr>
<tr>
<td>Apparent power (Sv)</td>
<td>IEC 61557-12 Class 0.2</td>
</tr>
<tr>
<td>Apparent energy (EapV)</td>
<td>IEC 61557–12 Class 0.2</td>
</tr>
<tr>
<td>Current (I)</td>
<td>IEC 61557-12 Class 0.1</td>
</tr>
<tr>
<td>Voltage (U)</td>
<td>IEC 61557-12 Class 0.1</td>
</tr>
<tr>
<td>Frequency (f)</td>
<td>IEC 61557-12 Class 0.02</td>
</tr>
</tbody>
</table>

**NOTE:** Reactive energy and demand values, by default, are based only on the fundamental frequency, and do not include higher harmonics. Active and apparent energy and demand values are measured using the entire signal including harmonics. Contact Technical Support for more information.
### Power quality

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power quality instrument (PQI)</td>
<td>IEC 62586-1/2 PQI-A</td>
</tr>
<tr>
<td></td>
<td>IEC 61000-4-30 Class A ($U_{IN} = 230$ V)</td>
</tr>
<tr>
<td></td>
<td>IEC 61000–4–15 Class F1 ($U_{IN} = 230$ V / 50 Hz, 120 V / 60 Hz)</td>
</tr>
<tr>
<td>Voltage unbalance ($U_{b}$)</td>
<td>IEC 61557-12 Class 0.2</td>
</tr>
<tr>
<td>Voltage harmonics ($U_{h}$)</td>
<td>IEC 61557-12 Class 1</td>
</tr>
<tr>
<td>Voltage THD ($THD_{u}$)</td>
<td>IEC 61557-12 Class 1</td>
</tr>
<tr>
<td>Current harmonics ($I_{h}$)</td>
<td>IEC 61557-12 Class 1</td>
</tr>
<tr>
<td>Current THD ($THD_{i}$)</td>
<td>IEC 61557-12 Class 1</td>
</tr>
<tr>
<td>Waveform capture</td>
<td>16 - 1024 cycles per sample</td>
</tr>
</tbody>
</table>

### Voltage inputs

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified accuracy range</td>
<td>57 to 400 V L-N / 100 to 690 V L-L (Wye) or 100 to 600 V L-L (Delta or Wye with unearthed neutral)</td>
</tr>
<tr>
<td>Specified accuracy frequency</td>
<td>50/60 Hz ± 15% / 400 Hz ± 10%</td>
</tr>
<tr>
<td>Overload</td>
<td>600 V L-N or 1035 V L-L</td>
</tr>
<tr>
<td>Impedance</td>
<td>&gt; 5 MΩ</td>
</tr>
<tr>
<td>Measurement category</td>
<td>III</td>
</tr>
</tbody>
</table>

### Current inputs

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nominal</td>
<td>IEC: 1A / 5A (Class 0.1 S)</td>
</tr>
<tr>
<td></td>
<td>ANSI: Current Class 2, 10, 20 (Accuracy Class 0.1)</td>
</tr>
<tr>
<td>Specified accuracy current range</td>
<td>10 mA – 20 A</td>
</tr>
<tr>
<td>Starting current</td>
<td>1 mA</td>
</tr>
<tr>
<td>Withstand</td>
<td>30 A continuous, 50 A @ 10 sec/hr, 500 A @ 1 sec/hr</td>
</tr>
<tr>
<td>Impedance</td>
<td>0.3 mΩ (typical)</td>
</tr>
<tr>
<td>Burden</td>
<td>0.01 VA max at 5 A</td>
</tr>
</tbody>
</table>

### Control power

#### AC control power

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating range</td>
<td>50/60 Hz ± 10%; 90 to 480 V ± 10%</td>
</tr>
<tr>
<td></td>
<td>400 Hz: 90 to 120 V ± 10%</td>
</tr>
<tr>
<td>Burden (meter only)</td>
<td>max: 16.5 W / 38 VA @ 480 V (45 – 65 Hz)</td>
</tr>
<tr>
<td></td>
<td>max: 13 W / 24 VA @ 120 V (400 Hz)</td>
</tr>
<tr>
<td>Burden (fully optioned meter)</td>
<td>max: 40 W / 80 VA @ 480 V (45 – 65 Hz)</td>
</tr>
<tr>
<td></td>
<td>max: 36 W / 58 VA @ 120 V (400 Hz)</td>
</tr>
<tr>
<td>Ride-through time (no optional accessories)</td>
<td>100 ms (6 cycles at 60 Hz) typ., 120 V AC</td>
</tr>
<tr>
<td></td>
<td>400 ms (24 cycles at 60 Hz) typ., 240 V AC</td>
</tr>
<tr>
<td></td>
<td>1200 ms (72 cycles at 60 Hz) typ., 480 V AC</td>
</tr>
</tbody>
</table>

#### DC control power

<table>
<thead>
<tr>
<th>Specification</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating range</td>
<td>110 to 480 V DC ± 15%</td>
</tr>
<tr>
<td>Burden (meter only)</td>
<td>max. 13.5 W at 480 V DC</td>
</tr>
<tr>
<td>Burden (fully optioned meter)</td>
<td>37 W at 480 V DC</td>
</tr>
<tr>
<td>Overvoltage category</td>
<td>III</td>
</tr>
</tbody>
</table>
### Digital output (Form A)

<table>
<thead>
<tr>
<th>Number</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Form A solid-state</td>
</tr>
<tr>
<td>Reference voltage</td>
<td>40 V</td>
</tr>
<tr>
<td>Maximum load voltage</td>
<td>30 V AC / 60 V DC</td>
</tr>
<tr>
<td>Maximum load current</td>
<td>75 mA</td>
</tr>
<tr>
<td>ON resistance</td>
<td>13 – 40 Ω at 25 °C (77 °F)</td>
</tr>
<tr>
<td>Signal type</td>
<td>Continuous or pulse</td>
</tr>
<tr>
<td>Pulse frequency</td>
<td>≤ 25 Hz</td>
</tr>
</tbody>
</table>

### Relay output (Form C)

<table>
<thead>
<tr>
<th>Number</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Form C mechanical relay</td>
</tr>
<tr>
<td>Maximum load voltage</td>
<td>250 V AC / 30 V DC</td>
</tr>
</tbody>
</table>
| Maximum load current | 8 A @ 250 V AC  
5 A @ 24 V DC  
20k cycles (resistive) |
| Operate time | max: 10 ms |
| Release time | max: 5 ms |
| Lifetime | No Load: 10,000,000 operations  
Rated Voltage and Load: 50,000 operations |

### Digital inputs

<table>
<thead>
<tr>
<th>Number</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Externally excited, 24 V DC whetting voltage available from the meter</td>
</tr>
<tr>
<td>Reference voltage</td>
<td>40 V</td>
</tr>
<tr>
<td>Event timestamp accuracy</td>
<td>± 1 ms</td>
</tr>
<tr>
<td>Maximum voltage</td>
<td>30 V AC / 60 V DC</td>
</tr>
<tr>
<td>Pulse frequency</td>
<td>≤ 25 Hz</td>
</tr>
<tr>
<td>Response time</td>
<td>1 cycle</td>
</tr>
<tr>
<td>Minimum pulse width</td>
<td>20 ms</td>
</tr>
</tbody>
</table>
| Current draw | ON: ≤ 2.5 mA  
OFF: ≤ 0.5 mA |
| Voltage ON state | 4 to 30 V AC / 4 to 60 V DC |
| Voltage OFF state | 0 to 1.4 V AC / 0 to 2.0 V DC |
| IRIG-B | IRIG-B00x format (unmodulated IRIG-B time code)  
Coded expressions 0 to 7 are supported but the year data is not used. |

### Environmental characteristics

<table>
<thead>
<tr>
<th>Operating temperature</th>
<th>-25 ºC to Max temp (-13 ºF to Max temp)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong></td>
<td>Maximum operating temperature could change based on the quantity and type of attached option modules. See Maximum operating temperature with option modules, page 242.</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>-40 ºC to 85 ºC (-40 ºF to 185 ºF)</td>
</tr>
</tbody>
</table>
Humidity rating  |  5% – 95% RH non-condensing  
Maximum dewpoint: 37 °C (99 °F)

Pollution degree  |  2

Altitude  |  < 3000 m (9843 ft) above sea level

Location/mounting  |  Not suitable for wet locations  
For indoor use only  
Must be permanently connected and fixed

**Maximum operating temperature with option modules**

<table>
<thead>
<tr>
<th>Maximum operating temperature</th>
<th>PM89M2600 Digital (2 out, 6 in)</th>
<th>PM89M0024 Analog (2 out, 4 in)</th>
</tr>
</thead>
<tbody>
<tr>
<td>70 °C (158 °F)</td>
<td>0 - 4</td>
<td>0,1</td>
</tr>
<tr>
<td>70 °C (158 °F)</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>60 °C (140 °F)</td>
<td>1, 2</td>
<td>2 - 4</td>
</tr>
</tbody>
</table>

**LEDs**

**Energy pulsing LEDs (visible and infrared)**

| Type                           | Visible orange, infrared
|-------------------------------|-------------------------|
| Wavelength                    | 600 – 609 nm (orange), 825 – 925 nm (infrared)
| Maximum pulse rate            | 10 Hz (100 ms)

**Status LEDs (visible)**

| Type                           | Bi-color, red/green

**EMC (electromagnetic compatibility)**

| EMC standards                  | IEC 62052-11, IEC 61326-1, IEC 61000-6-5
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Immunity to electrostatic discharge</td>
<td>IEC 61000-4-2</td>
</tr>
<tr>
<td>Immunity to radiated fields</td>
<td>IEC 61000-4-3</td>
</tr>
<tr>
<td>Immunity to fast transients</td>
<td>IEC 61000-4-4</td>
</tr>
<tr>
<td>Immunity to surges</td>
<td>IEC 61000-4-5</td>
</tr>
<tr>
<td>Immunity to conducted disturbances</td>
<td>IEC 61000-4-6, IEC 61000-4-16</td>
</tr>
<tr>
<td>Immunity to power frequency magnetic fields</td>
<td>IEC 61000-4-8</td>
</tr>
<tr>
<td>Immunity to conducted disturbances, 2 - 150 kHz</td>
<td>CLC/TR 50579</td>
</tr>
<tr>
<td>Immunity to voltage dips and interruptions</td>
<td>IEC 61000-4-11</td>
</tr>
<tr>
<td>Immunity to ring waves</td>
<td>IEC 61000-4-12</td>
</tr>
<tr>
<td>Conducted and radiated emissions</td>
<td>EN 55011 and EN 55032 Class B, FCC part 15 Class B, ICES-003 Class B</td>
</tr>
<tr>
<td>Surge withstand capability (SWC)</td>
<td>IEEE/ANSI C37.90.1</td>
</tr>
</tbody>
</table>
## Safety

| Safety construction | IEC/EN 61010-1, CAT III, 400 VLN / 690 V LL  
UL 61010-1 and CSA-C22.2 No. 61010-1, CATIII, 347 V LN / 600 V LL  
IEC/EN 62052-31, Protective Class II |

## Ethernet communications

| Number of ports | 2 (switched mode) |
| Maximum cable length | 100 m (328 ft), per TIA/EIA 568-5-A |
| Cable type | CAT5 (or higher) |
| Connector type | Unshielded RJ45 modular connector (2) |
| Mode | 10Base-T, 100Base-TX, Auto-MDIX |
| Data rate | up to 100 Mbps |

## RS-485 communications

| Number of ports | 2 |
| Cable type | Shielded twisted pair |
| Maximum cable length | 1200 m (4000 ft) |
| Maximum number of devices (unit loads) | Up to 32 devices on the same bus |
| Parity | None, even, odd |
| Baud rate | 2400 – 115200, 19200 recommended |

## Real-time clock

| Clock drift (time error) | Meter Powered ON: 5 ppm max  
Meter Powered OFF: 20 ppm max at 25 °C (77 °F) |
| Battery backup time | Minimum 7 years under specified storage conditions |

## Display

**METSERD192 display**

| Display type | Capacitive touchscreen, WVGA color graphic TFT LCD 800 x 480 resolution |
| Display backlight | White LED |
| Viewable area | 152.5 x 91.5 mm (6.00 x 3.60 in) |
| Weight | 0.9 kg (2.0 lb) |

### Communications ports

| Optical communications ports | ANSI C12.18 optical port  
IEC 1107 optical port adapter |
| USB communications ports | USB host port: Type A USB  
USB device port: Mini-B USB |

### Control power
### METSERD192 display (Continued)

<table>
<thead>
<tr>
<th>Power over Ethernet (PoE) power</th>
<th>PD Type 1 Class 3 per IEEE 802.3af, 10W max.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary control power (Not required for PoE applications)</td>
<td>24 V DC ± 20%</td>
</tr>
<tr>
<td>DC burden 10 W max.</td>
<td>Use UL listed or UL recognized NEC class 2 (or equivalent SELV or PELV) power source</td>
</tr>
</tbody>
</table>

#### Communication connection

<table>
<thead>
<tr>
<th>Cable type</th>
<th>CAT5 (or higher). Use with unshielded RJ45 modular connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable length</td>
<td>100 m (330 ft) max.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Direct, point-to-point</td>
</tr>
</tbody>
</table>

#### Environment

<table>
<thead>
<tr>
<th>Operating temperature</th>
<th>-20 ºC to 60 ºC (-4 ºF to 140 ºF)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage temperature</td>
<td>-40 ºC to 85 ºC (-40 ºF to 185 ºF)</td>
</tr>
<tr>
<td>Humidity rating</td>
<td>5% – 95% RH non-condensing. Maximum dewpoint: 37 ºC (99 ºF)</td>
</tr>
<tr>
<td>Pollution degree</td>
<td>2</td>
</tr>
<tr>
<td>Altitude</td>
<td>&lt; 3000 m (9843 ft) above sea level</td>
</tr>
<tr>
<td>IP degree of protection</td>
<td>Front: IP65 Rear: IP30</td>
</tr>
</tbody>
</table>

**For UL Type 12 applications, install display on a flat surface of a Type 12 enclosure.**

**Not suitable for wet locations.**

**For indoor use only.**

### METSEPM89RD96 display

<table>
<thead>
<tr>
<th>Display</th>
<th>1/4 VGA color graphic TFT LCD 320 x 240 resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display backlight</td>
<td>White LED</td>
</tr>
<tr>
<td>Keypad</td>
<td>5 button</td>
</tr>
<tr>
<td>Viewable area</td>
<td>70.6 x 52.9 mm (2.78 x 2.08 in)</td>
</tr>
</tbody>
</table>

#### Communication connection

<table>
<thead>
<tr>
<th>Cable type</th>
<th>CAT5 (or higher). Use with unshielded RJ45 modular connector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable length</td>
<td>100 m (330 ft) max.</td>
</tr>
<tr>
<td>Connection type</td>
<td>Direct, point-to-point</td>
</tr>
</tbody>
</table>

#### Environment

| IP degree of protection | Front: IP54 Rear: IP30 |

### Option modules

See your option module’s installation sheet for additional option module specifications.

#### METSEPM89M0024 Analog (2 out, 4 in)

<table>
<thead>
<tr>
<th>Maximum number of modules</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input resistance</td>
<td>&lt; 300 Ω (current mode)</td>
</tr>
<tr>
<td></td>
<td>&gt; 500 kΩ (voltage mode)</td>
</tr>
<tr>
<td>Input voltage mode</td>
<td>0–30 V DC</td>
</tr>
</tbody>
</table>
METSEPM89M0024 Analog (2 out, 4 in) (Continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input current mode</td>
<td>4–20 mA, 0–20 mA</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>-25 to 70 °C (-13 to 158 °F)</td>
</tr>
<tr>
<td></td>
<td>Maximum operation temperature is based on the quantity and type of attached option modules. See Maximum operating temperature with option modules, page 242.</td>
</tr>
</tbody>
</table>

METSEPM89M2600 Digital (2 out, 4 in)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of modules</td>
<td>4</td>
</tr>
<tr>
<td>Operating temperature</td>
<td>-25 to 70 °C (-13 to 158 °F)</td>
</tr>
<tr>
<td></td>
<td>Maximum operation temperature is based on the quantity and type of attached option modules. See Maximum operating temperature with option modules, page 242.</td>
</tr>
</tbody>
</table>

Other

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight (meter only)</td>
<td>1.5 kg (3.3 lb)</td>
</tr>
<tr>
<td>Meter start time¹</td>
<td>20 seconds: Measurements</td>
</tr>
<tr>
<td></td>
<td>30 seconds: Communications</td>
</tr>
<tr>
<td></td>
<td>45 seconds: Display initialization</td>
</tr>
<tr>
<td>Meter memory</td>
<td>2000 MB</td>
</tr>
<tr>
<td>Data update rate</td>
<td>Regular data: 1 second</td>
</tr>
<tr>
<td></td>
<td>High-speed: 50 – 60 Hz half-cycle</td>
</tr>
<tr>
<td>Advanced security user accounts</td>
<td>Up to 50 users</td>
</tr>
</tbody>
</table>

¹ Meter start up time is expressed as the typical elapsed time from the application of control power to the result indicated in the description field.
Open source software components

This Schneider Electric product is provided with certain open source software components (collectively, “OSS”) developed by third parties. The OSS is licensed in accordance with the OSS license terms set forth below.

1. The following open source software components are licensed in accordance with the Apache License, Version 2.0.
   a. MSTP-LIB

   Copyright © 2011-2017 Adi Gostin

   Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with the License.

2. The following open source software components are licensed in accordance with the MIT License reprinted below.
   a. jQuery

   Copyright © 2013 jQuery Foundation and other contributors, http://jqueryui.com/

   This software consists of voluntary contributions made by many individuals (AUTHORS.txt, http://jqueryui.com/about) For exact contribution history, see the revision history and logs, available at http://jquery-ui.googlecode.com/svn/.

Apache License Version 2.0, January 2004

   http://www.apache.org/licenses/

   TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

   "License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections 1 through 9 of this document.

   "Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the License.

   "Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by, or are under common control with that entity. For the purposes of this definition, "control" means (i) the power, direct or indirect, to cause the direction or management of such entity, whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial ownership of such entity.

   "You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.

   "Source" form shall mean the preferred form for making modifications, including but not limited to software source code, documentation source, and configuration files.

   "Object" form shall mean any form resulting from mechanical transformation or translation of a Source form, including but not limited to compiled object code, generated documentation, and conversions to other media types.

   "Work" shall mean the work of authorship, whether in Source or Object form, made available under the License, as indicated by a copyright notice that is included in or attached to the work (an example is provided in the Appendix below).

   "Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from) the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent, as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not
include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic, verbal, or written communication sent to the Licensor or its representatives, including but not limited to communication on electronic mailing lists, source code control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but excluding communication that is conspicuously marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, where such license applies only to those patent claims licensable by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work constitutes direct or contributory patent infringement, then any patent licenses granted to You under this License for that Work shall terminate as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any medium, with or without modifications, and in Source or Object form, provided that You meet the following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and

2. You must cause any modified files to carry prominent notices stating that You changed the files; and

3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent, trademark, and attribution notices from the Source form of the Work, excluding those notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You distribute must include a readable copy of the attribution notices contained within such NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source form or documentation, if provided along with the Derivative Works; or, within a display generated by the Derivative Works, if and wherever such third-party notices normally appear. The contents of the NOTICE file are for informational purposes only and do not modify the License. You may add Your own attribution notices within Derivative Works that You distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such additional attribution notices cannot be construed as modifying the License. You may add Your own copyright statement to Your modifications and may provide additional or different license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise complies with the conditions stated in this License.
5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License, without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or modify the terms of any separate license agreement You may have executed with Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or product names of the Licensor, except as required for reasonable and customary use in describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the Work and assume any risks associated with Your exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special, incidental, or consequential damages of any character arising as a result of this License or out of the use or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability obligations and/or rights consistent with this License. However, in accepting such obligations, You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

The MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.